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บทคัดย่อ 
 

การวิจัยครั้งนี้มีวัตถุประสงค์เพื่อ  1) พัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
2) หาประสิทธิภาพบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมตามเกณฑ์ 80/80  3) ประเมิน 
ผลงานจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม  4) เปรียบเทียบผลการเรียนของนักเรียน
ก่อนเรียนและหลังเรียนจากเว็บช่วยสอนแบบการเรียนรู้เป็นทีม  5) ประเมินความสามัคคีของนักเรียน
จากบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม  6) ศึกษาความพึงพอใจของนักเรียนในการใช้
บทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม  

กลุ่มตัวอย่าง คือ นักเรียนชั้นมัธยมศึกษาปีที่ 5 โรงเรียนสวนกุหลาบวิทยาลัย รังสิต จังหวัด
ปทุมธานี จ านวน 33 คน โดยการสุ่มอย่างง่าย ด้วยวิธีการจับฉลากเลือก 1 ห้องเรียน จากจ านวน 14 
ห้อง เครื่องมือที่ใช้ในการวิจัยได้แก่ บทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม แบบทดสอบผล
การเรียนรู้ แบบประเมินผลงานนักเรียน แบบประเมินความสามัคคีส าหรับนักเรียนประเมินตนเอง
และส าหรับครูประเมินนักเรียน และแบบประเมินความพึงพอใจ การวิจัยเป็นการวิจัยกึ่งทดลองแบบ 
The Pretest-Posttest One Group Design การวิเคราะห์ข้อมูลได้แก่ การหาค่า E1/E2 ค่าเฉล่ีย ค่าส่วน
เบี่ยงเบนมาตรฐาน และการทดสอบค่าทีแบบไม่อิสระต่อกัน 
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สามัคคี ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 5 มีประสิทธิภาพ 88.29/84.33 2) ผลงานจากการเรียนด้วย
เว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความสามัคคีมีคะแนนรวมเฉล่ียอยู่ในระดับดี 3) ผล
การเรียนหลังเรียนสูงกว่าก่อนเรียนจากเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความสามัคคี 
อย่างมีนัยส าคัญทางสถิติที่ระดับ .05 4) ความสามัคคีของนักเรียนต่อการเรียนด้วยเว็บช่วยสอนแบบ
การเรียนรู้เป็นทีมส าหรับนักเรียนประเมินตนเอง อยู่ในระดับมากที่สุด ส่วนครูประเมินนักเรียน อยู่ใน
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ระดับมากที่สุด 5) ความพึงพอใจของนักเรียนต่อการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อ
ส่งเสริมความสามัคคี อยู่ในระดับมาก 
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ABSTRACT 
  

The purposes of this research were; 1) develop a group study lesson on LMS  2)  measure 
the effectiveness of group study system according to 80/80 criteria  3)  assess students' works on 
group study  4)  compare the result of pretest and posttest on LMS  5)  assess the unity of the 
students and  6)  assess the satisfaction of the students.  

The subjects of the study was conducted on 33 students who studied in matthayomsuksa 
5, Suankularb Wittayalai Rangsit School. The sample class was randomly selected from 14 
classrooms. The instruments using in this research is the Web-based Instruction Lesson with Team 
Learning Promoting on Unity, learning outcome test, students’ works evaluation forms, the unity of 
the students evaluation forms for students self-assess and teacher-assess, and the satisfaction of the 
students evaluation forms. This research is the quasi- experiment research using the pretest-posttest 
one group design. The data analysis were E1/E2, mean, standard deviation and t-test dependent. 
 The result showed that; 1) the Web-based Instruction Lesson with Team Learning 
Promoting on Unity is efficiency at the 88.29/84.33 2) the overall performance of the work on Web-
based Instruction Lesson with Team Learning is good 3) the learning outcomes of post-test score on 
Web-based Instruction Lesson with Team Learning significantly increases from their pre-test at 
statistically level .05 4) the unity of students learning with Web-based Instruction Lesson with Team 
Learning by students-assess, the overall average is the highest level, the teacher-assess has the 
highest level 5) the satisfaction with Web-based Instruction Lesson with Team Learning of students 
at a high level. 
Keywords:  web-based instruction, team learning, unity 
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บทที่ 1 
 

บทน ำ 
 
1.1  ที่มำและควำมส ำคญัของปญัหำ 
 ปัจจุบันนี้ความสามัคคีถือว่าเป็นส่ิงท่ีส าคัญที่สุดที่จะช่วยกอบกู้วิกฤติที่ก าลังเกิดขึ้นอยู่ใน
ประเทศไทยซ่ึงจะเห็นได้จากความวุ่นวายจากการเมืองที่มีการชุมนุมในสถานที่ต่างๆ ที่เรียกร้องหา
ความยุติธรรม หาประชาธิปไตย ซ่ึงจากวันที่ 19 พฤษภาคม 2553 ที่ผ่านมา เกิดเหตุการณ์ต่างๆ ที่
ส่งผลเสียหายต่อประเทศนานับประการ ท้ังการเมือง เศรษฐกิจ สังคม การท่องเที่ยว สภาพจิตใจของ
คนไทยทุกคนที่เห็นคนไทยด้วยกันเกิดการแตกแยก สู้รบกันเอง รวมถึงภาพลักษณ์ของประเทศไทย
ต่อนานาอารยประเทศทั่วโลก ซ่ึงจากเหตุการณ์นี้ประเทศของเราก าลังก้าวถอยหลังลงทุกที นี่แสดงให้
เห็นว่าเราทุกคนต้องหันกลับมาทบทวนและช่วยกันน าประเทศไทยที่สงบ ร่มเย็น ประชาชนรู้รัก
สามัคคี ของพวกเราทุกคนกลับคืนมาอีกครั้ง 
 ดังพระราชด ารัสของพระบาทสมเด็จพระเจ้าอยู่หัว  ว่า  “...ในปัจจุบันนี้เป็นที่ทราบว่า 
ประเทศชาติอยู่ในภาวะที่ต้องอาศัยความเข้มแข็ง เพื่อที่จะให้อยู่รอด ประเทศไทยจะอยู่ได้ก็ด้วยทุก
คน ทุกฝ่ายสามัคคีกัน ความสามัคคีนั้นได้พูดอยู่เสมอว่าต้องมี แต่อาจจะเข้าใจยากว่าท าไมสามัคคีจะ
ท าให้บ้านเมืองอยู่ได้ สามัคคีก็คือ การเห็นแก่บ้านเมืองและช่วยกันทุกวิถีทาง เพื่อที่จะสร้างบ้านเมือง
อยู่ได้ สามัคคีนี้ก็คือ การเห็นแก่บ้านเมือง และช่วยกันทุกวิถีทาง เพื่อที่จะสร้างบ้านเมืองให้เข้มแข็ง 
ด้วยการเห็นอกเห็นใจซ่ึงกันและกัน และไม่ท าลายงานของกันและกัน และท างานด้วยความซ่ือสัตย์
สุจริต ต้องส่งเสริมงานของกันและกัน และไม่ท าลายงานของกันและกัน มีเรื่องอะไรให้ได้พูด
ปรองดองกัน อย่าเรื่องใครเรื่องมัน และงานก็ท างานอย่างตรงไปตรงมา นึกถึงประโยชน์ส่วนรวม...”  
(พระราชด ารัสของพระบาทสมเด็จพระเจ้าอยู่หัว พระราชทานในพิธีประดับยศนายต ารวจชั้นนายพล 
ณ พระต าหนักจิตรลดารโหฐาน วันพฤหัสบดีที่ 15 มกราคม 2519) 
 สอดคล้องกับพระราชบัญญัติการศึกษา 2542 มาตราที่ 7 ในกระบวนการเรียนรู้ต้องมุ่ง
ปลูกฝังจิตส านึกที่ถูกต้องเกี่ยวกับการเมืองการปกครองในระบอบประชาธิปไตยอันมีพระมหากษตัรยิ์
เป็นประมุข รู้จักรักษาและส่งเสริมสิทธิ หน้าที่ เสรีภาพ ความเคารพกฎหมาย ความเสมอภาค และ
ศักดิ์ศรีความเป็นมนุษย์ มีความภาคภูมิใจในความเป็นไทย รู้จักรักษาผลประโยชน์ส่วนรวมและของ
ประเทศชาติ รวมท้ังส่งเสริมศาสนา ศิลปะ วัฒนธรรมของชาติ การกีฬา ภูมิปัญญาท้องถ่ิน ภูมิปัญญา
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ไทย และความรู้อันเป็นสากล ตลอดจนอนุรักษ์ทรัพยากรธรรมชาติ และส่ิงแวดล้อม มีความสามารถ
ในการประกอบอาชีพ รู้จักพึ่งตนเอง มีความริเริ่มสร้างสรรค์ ใฝ่รู้ และเรียนรู้ด้วยตนเองอย่างต่อเนื่อง 
(พระราชบัญญัติการศึกษาแห่งชาติ พ.ศ. 2542 และที่แก้ไขเพิ่มเติม (ฉบับที่ 2) , 2545) 
 จากเหตุการณ์ข้างต้นนั้นการจะช่วยประเทศชาตินี้ท าได้ไม่ยากเพียงทุกคนร่วมมือกัน โดย
ปลูกฝังความคิด ความส านึก ความสามัคคีและความรักชาติให้กับเยาวชนที่ก าลังจะเติบโตเป็นอนาคต
ของชาติต่อไป ซ่ึงผู้วิจัยก็เป็นครูคนหนึ่งที่จะช่วยท าหน้าที่นี้เพื่อให้ประเทศไทยของเรากลับกลายเป็น
ประเทศที่พัฒนาก้าวหน้าทันนานาประเทศได้ และการจะเรียนให้เกิดการเรียนรู้ที่ดี เข้าใจบทเรียนนั้น
ก็จะต้องเกิดจากการจัดการเรียนการสอนที่ท าให้ผู้เรียนได้มีส่วนร่วมในกิจกรรมต่างๆ รวมถึงได้ใช้
เทคโนโลยีในการจัดการเรียนการสอนด้วย ซ่ึงจะปฏิเสธไม่ได้เลยว่าขณะนี้เทคโนโลยีเข้ามามีบทบาท
เป็นอย่างมากในการจัดการเรียนการสอน โดยเฉพาะการจัดการเรียนการสอนผ่านเว็บซ่ึงจะท าให้
ผู้เรียนเกิดการเรียนรู้อย่างมีประสิทธิภาพ สามารถเรียนรู้ได้ทุกที่ ทุกเวลา  ผู้เรียนจะเรียนกี่ครั้งก็ได้
และที่ส าคัญคือผู้เรียนสามารถเรียนรู้เองได้จากบทเรียน 
 ดังที่ ภูริพัฒน์ พฤกษาพิทักษ์ กล่าวว่า ในปัจจุบันเทคโนโลยีคอมพิวเตอร์และอินเทอร์เน็ต
ได้พัฒนาเติบโตอย่างรวดเร็วและได้ก้าวมาเป็นเครื่องมือชิ้นส าคัญที่เปล่ียนแปลงรูปแบบการเรียนการ
สอน การฝึกอบรม รวมทั้งการถ่ายทอดความรู้ โดยพัฒนา CAI เดิมๆ ให้เป็น WBI (Web Based 
Instruction) หรือการเรียนการสอนผ่านบริการเว็บเพจ ส่งผลให้ข้อมูลในรูปแบบ WBI สามารถ
เผยแพร่ได้รวดเร็วและกว้างไกลกว่าส่ือ CAI ปกติ ทั้งนี้ก็มาจากประเด็นส าคัญอีก 2 ประการ ประเด็น
แรก ได้แก่ สามารถประหยัดเงินที่ต้องลงทุนในการจัดหาซอฟต์แวร์สร้างส่ือ (Authoring Tools) ไม่
จ าเป็นต้องซ้ือโปรแกรมราคาแพงมาใช้เป็นเครื่องมือในการสร้างส่ือการเรียนการสอนเพราะสามารถ
ใช้ NotePad ที่มาพร้อมกับ Microsoft Windows ทุกรุ่น หรือ Text Editor ใดๆ ก็ได้ลงรหัส HTML 
(HyperText Markup Language) สร้างเอกสาร HTML ที่มีลักษณะการถ่ายทอดความรู้ด้านการศึกษา 
ประเด็นที่สอง เนื่องจากคุณสมบัติของเอกสาร HTML ที่สามารถน าเสนอข้อมูลได้ทั้งข้อความ ภาพ 
เสียง VDO และสามารถสร้างจุดเชื่อมโยงไปต าแหน่งต่างๆ ได้ตามความต้องการของผู้พัฒนา ส่งผล
ให้การพัฒนาส่ือการเรียนการสอนในรูปแบบ WBI เป็นที่นิยมอย่างสูง และได้รับการพัฒนาปรับปรุง
รูปแบบมาเป็นส่ือการเรียนการสอนในรูปแบบ E - Learning (Electronic Learning) ซ่ึงก าลังได้รับ
ความนิยมอย่างสูงในปัจจุบัน (ภูริพัฒน์ พฤกษาพิทักษ์) 
 สอดคล้องกับ ศิริญรัตน์ ไชยศรีหา (2547) กล่าวว่า ในยุคที่ เทคโนโลยีสารสนเทศ  
(information technology)  ได้รับการพัฒนาท าให้โลกก้าวเข้าสู่ยุคแห่งโลกาภิวัตน์ globaliza  หรือโลก
ไร้พรมแดน ซ่ึงความเจริญก้าวหน้าของเทคโนโลยีสารสนเทศ ก่อให้เกิดการพัฒนาด้านการจัดระบบ
และเผยแพร่และเปล่ียนข้อมูล ข่าวสารเพื่อให้สอดคล้องกับความต้องการของมนุษย์ เทคโนโลยี
สารสนเทศจึงเป็นปัจจัยหนึ่งของการพัฒนาในทุกวงการและทุกวิชาชีพ โดยเฉพาะอย่างยิ่งมีอิทธิพล
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ต่อวงการศึกษาอย่างเ ล่ียงไม่ได้ โดยส่งผลกระทบถึงการศึกษ าในทุกระดับตั้งแต่อนุบาลถึง
ระดับอุดมศึกษา  
 สอดคล้องกับ ธวัชชัย อดิเทพสถิต (2545) กล่าวว่า ปัจจุบันเทคโนโลยีสารสนเทศและ
อินเทอร์เน็ตเป็นส่ิงที่ก าลังเข้ามามีบทบาทเป็นอย่างมากในด้านการเรียนการสอนและการศึกษา
ค้นคว้าวิจัยในสถานศึกษา  โดยระบบเทคโนโลยีสารสนเทศและอินเทอร์เน็ตท าให้การติดต่อส่ือสาร
ท าได้อย่างรวดเร็วและมีประสิทธิภาพสูง ช่วยให้ผู้เรียนสามารถค้นคว้าข้อมูลและความรู้จากแหล่ง
ต่างๆ ที่มีอยู่ทั่วโลกได้อย่างรวดเร็วและทันต่อเหตุการณ์ เทคโนโลยีสารสนเทศและอินเทอร์เน็ตจึงถูก
น ามาใช้ส าหรับการเรียนการสอนเป็นเทคโนโลยีที่ทันสมัย เช่น วิดีโอโปรเจคเตอร์  วิดีโอเทเลคอน
เฟอเรนซ์ ระบบวิดีโอออนดีมานด์  ไฮเปอร์เท็กซ์ คอมพิวเตอร์และระบบอินเทอร์เน็ต เป็นต้น  
 และสอดคล้องกับ ถนอมพร เลาหจรัสแสง  และคณะ (2545)  กล่าวว่า  บทเรียน
อิเล็กทรอนิกส์บนเครือข่าย (e-Learning courseware) เป็นบทเรียนคอมพิวเตอร์ที่อาศัยระบบ
อินเทอร์เน็ตและน าเทคโนโลยีของเว็บในการถ่ายทอดเนื้อหา ผู้ เรียนที่ เรียนจาก e-Learning 
courseware สามารถศึกษาเนื้อหาบทเรียนในรูปแบบออนไลน์ ซ่ึงเนื้อหาของ e-Learning courseware 
จะน าเสนอในลักษณะมัลติมีเดีย โดยมีข้อได้เปรียบของการน าเสนอเนื้อหาบทเรียนในลักษณะ
มัลติมีเดียว่าสามารถท าให้ผู้เรียนเกิดการเรียนรู้ได้ดีกว่าการเรียนจากส่ือข้อความเพียงอย่างเดียว
นอกจากนี้การที่เนื้อหาอยู่ในรูปของข้อความอิเล็กทรอนิกส์ ซ่ึงได้แก่ ข้อความที่ได้รับการจัดเก็บ 
ประมวลผลน าเสนอและเผยแพร่ทางคอมพิวเตอร์จึงท าให้มีส่ืออ่ืนๆ หลายประการ โดยเฉพาะอย่างยิ่ง
การเข้าถึงข้อมูลที่ต้องการด้วยความสะดวกรวดเร็วและความคงทนของข้อมูล รวมทั้งความสามารถ
ในการปรับข้อมูลให้ทันสมัยอยู่ตลอดเวลา 
 จาก พรบ. การศึกษาดังกล่าวส่งเสริมให้กระบวนการจัดการเรียนการสอนนั้นต้องสอนให้
นักเรียนรู้รักสามัคคีซ่ึงสอดคล้องกับพระราชด ารัสของพระบาทสมเด็จพระเจ้าอยู่หัวดังกล่าว 
นอกจากการจัดการเรียนการสอนให้มีคุณภาพแล้วรูปแบบวิธีและกระบวนการการจัดการเรียนการ
สอนก็เป็นส่ิงส าคัญที่จะท าให้การเรียนมีประสิทธิภาพซ่ึงจะเห็นว่าการจัดการเรียนการสอนที่ผ่านมา
จะเน้นให้ผู้เรียนเป็นศูนย์กลางการเรียนรู้ (Child Center) ซ่ึงยังขาดการร่วมมือช่วยเหลือกันของผู้เรียน
เอง ดังนั้นเพื่อให้การเรียนการสอนมีประสิทธิภาพมากยิ่งขึ้นผู้จัดท าจึงเล็งเห็นว่าควรจัดการเรียนการ
สอนแบบทีมเรียนรู้ (Team Learning) เพื่อให้ผู้เรียนได้เรียนรู้จากบทเรียนและช่วยเหลือแบ่งปัน
ความรู้แก่กันในการเรียนซ่ึงจะท าให้การจัดการเรียนการสอนบนเว็บมีประสิทธิภาพและประสิทธิผล
สูงขึ้น 
 ความส าคัญของปัญหาดังกล่าวข้างต้น ผู้วิจัยจึงมีความเห็นว่าควรท าการพัฒนาบทเรียนบน
เว็บช่วยสอนแบบการเรียนรู้เป็นทีม โดยน าบทเรียนที่พัฒนาไปจัดการเรียนการสอนบนเว็บและใช้
รูปแบบการเรียนการสอนเป็นทีมเข้ามาช่วยเพื่อส่งเสริมให้ผู้เรียนเกิดความสามัคคีในหมู่คณะและเกิด
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การเรียนรู้จากบทเรียนที่เรียนอย่างมีความสุข ซ่ึงบทเรียนนี้จะเป็นการปลูกฝังให้ผู้เรียนรู้จักการ
ช่วยเหลือเผื่อแผ่รักเพื่อนพ้องและเกิดความสามัคคีในทีมของตนเองและในชั้นเรียน ซ่ึงจากจุดเล็กๆ 
จะเป็นก าลังท่ีจะส่งผลประโยชน์ในอนาคต เพราะเยาวชนในวันนี้จะเป็นผู้ใหญ่ในวันข้างหน้าที่จะน า
ความรู้หรือส่ิงท่ีถูกปลูกฝังไปใช้ในการด ารงชีวิต ทั้งการเรียน การท างานและการพัฒนาประเทศให้
ก้าวหน้าต่อไปเท่าทันนานาประเทศ  
 
1.2  วัตถุประสงค์กำรวิจัย 
 1. เพื่อพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
 2. เพื่อหาประสิทธิภาพบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม ตามเกณฑ์ 80/80 

3. เพื่อประเมินผลงานจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
 4. เพื่อเปรียบเทียบผลการเรียนของนักเรียนก่อนเรียนและหลังเรียนบนเว็บช่วยสอนแบบ
การเรียนรู้เป็นทีม 
 5. เพื่อประเมินความสามัคคีของนักเรียนจากบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็น
ทีม 
 6. เพื่อศึกษาความพึงพอใจของนักเรียนในการใช้บทเรียนบนเว็บช่วยสอนแบบการเรียนรู้
เป็นทีม 
 
1.3  สมมติฐำนกำรวิจัย 
 1. บทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม มีประสิทธิภาพตามเกณฑ์ 80/80 
 2. นักเรียนที่เรียนจากบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมมีผลการเรียนหลัง
เรียนสูงกว่าก่อนเรียนอย่างมีนัยส าคัญทางสถิติ  
  
1.4  ขอบเขตกำรวิจัย 
 ประชำกร 
 นักเรียนชั้นมัธยมศึกษาปีที่ 5 โรงเรียนสวนกุหลาบวิทยาลัย รังสิต จังหวัดปทุมธานี จ านวน 
526 คน ภาคเรียนที่ 2  ปีการศึกษา 2555 
 กลุ่มตัวอย่ำง 
 นักเรียนชั้นมัธยมศึกษาปีที่ 5  โรงเรียนสวนกุหลาบวิทยาลัย รังสิต จังหวัดปทุมธานี 
จ านวน 33 คน โดยการสุ่มอย่างง่าย (Simple Random Sampling) โดยวิธีการจับฉลากเลือก 1 
ห้องเรียน จากจ านวน 14 ห้อง ภาคเรียนที่ 2  ปีการศึกษา 2555 
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 ขอบเขตเนื้อหำ 
 1. เนื้อหาท่ีใช้ในการทดสอบสมมติฐานครั้งนี้เป็นเนื้อหาในรายวิชาการน าเสนอส่ือประสม 
เรื่อง การน าเสนอส่ือประสมเบื้องต้น กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี ระดับชั้น
มัธยมศึกษาปีที่ 5  
 2. ระบบการจัดการเรียนการสอนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม มีรายละเอียดการ
ท างานดังนี้ 
 2.1 ส่วนสมัครเรียนและจดัการผู้เรยีน 
 2.2 ส่วนของบทเรียน 
 2.3 ส่วนผู้ดูแลระบบ 
 2.4 ส่วนของส่ิงอ านวยความสะดวก 
 
1.5  ตัวแปรที่ศึกษำ 
 ตัวแปรต้น 
 บทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
 ตัวแปรตาม 
 1. ประสิทธิภาพของบทเรียน 
 2. ผลการเรียนรู ้
 3. ผลงานนักเรียน 
 4. ความสามัคค ี
 5. ความพึงพอใจในการใช้บทเรียน 
 
1.6  ค ำจ ำกัดควำมทีใ่ชใ้นกำรวิจัย 

1. บทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม หมายถึง  บทเรียนคอมพิวเตอร์ที่ผู้วิจัย
สร้างขึ้นตามสาระและมาตรฐานการเรียนรู้กลุ่มสาระการงานอาชีพและเทคโนโลยี เรื่องการน าเสนอ
ส่ือประสมเบื้องต้น ชัน้มัธยมศึกษาปีที่ 5 เพื่อให้สามารถเรียนบนเว็บได้โดยใช้เว็บเป็นส่ือช่วยในการ
จัดการเรียนรู้แบบทีม 

2. ประสิทธิภาพของบทเรียน หมายถึง  ความสามารถในการท าแบบฝึกหัดและ
แบบทดสอบวัดผลการเรียนรู้ทางการเรียนกลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี รายวิชา
การน าเสนอส่ือประสม เรื่อง การน าเสนอส่ือประสมเบื้องต้น ชัน้มัธยมศึกษาปีที่ 5  ตามเกณฑ์  80/80 
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 เกณฑ์  80 ตัวแรก หมายถึง ค่าเฉล่ียของผลรวมของคะแนนที่นักเรียนทั้งหมดที่ท าใบ
งานที่ 1-4 ใบงานละ 5 คะแนน รวม 20 คะแนน และท าแบบทดสอบย่อย 4 ครั้ง ครั้งละ 10 คะแนน 
รวม 40 คะแนน ซ่ึงมีค่าเฉล่ียร้อยละ 80  ขึ้นไป 

 เกณฑ์  80 ตัวหลัง หมายถึง ค่าเฉล่ียของผลรวมของคะแนนที่นักเรียนทั้งหมดที่ท า
แบบทดสอบวัดผลการเรียนรู้  ซ่ึงมีค่าเฉล่ียร้อยละ 80  ขึ้นไป 

3. ผลงานนักเรียน  หมายถึง  คะแนนที่ได้จากชิ้นงานทีน่ักเรียนที่เป็นสมาชิกในทีมร่วมกัน
สร้างขึ้นมา โดยวัดได้จากแบบประเมินผลงานนักเรียนที่ผู้วิจัยสร้างขึ้น 

4. ผลการเรียนรู้ หมายถึง คะแนนที่ได้จากการทดสอบก่อนและหลังเรียนด้วยบทเรียนบน
เว็บช่วยสอนแบบการเรียนรู้เป็นทีม เรื่องการน าเสนอส่ือประสมเบื้องต้น ชัน้มัธยมศึกษาปีที่ 5 ซ่ึงเป็น
แบบทดสอบแบบปรนัยชนิดเลือกตอบ 4 ตัวเลือก จ านวน 30 ข้อ 

5. ความสามัคคี หมายถึง พฤติกรรมที่ผู้เรียนแสดงออกถึงความเป็นหนึ่งเดียวกัน  รักหมู่
คณะ ไม่แตกแยก ไม่ทะเลาะวิวาท  สามารถปรับตนเองให้เข้ากับผู้อ่ืน ยอมรับฟังความคิดเห็นของผู้อ่ืน  
รู้บทบาทของตนทั้งในฐานะผู้น าและผู้ตามที่ดี   มีความเอ้ือเฟื้อซ่ึงกันและกัน ร่วมมือกันท างานเพื่อ
ประโยชน์ของหมู่คณะและมีความสุขกับการท างานเป็นทีม โดยวัดได้จากแบบประเมินความสามัคคีที่
ที่ผู้วิจัยสร้างขึ้นเพื่อให้ผู้เรียนประเมินตนเองและผู้สอนประเมินผู้เรียน 
 6. ความพึงพอใจในการใช้บทเรียน หมายถึง ความรู้สึกชื่นชอบของผู้เรียนที่มีต่อบทเรียน
บนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม ซ่ึงวัดได้จากแบบประเมินความพึงพอใจที่ผู้วิจัยสร้างขึ้น 
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1.7  กรอบแนวคิดกำรวิจัย 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
ภำพที่ 1.1  กรอบแนวคิดการวิจัย 

ควำมสำมัคคี  
พฤติกรรมที่แสดงถึงความสามัคคี มีดังนี้ 
-  การปรับตนเองให้เข้ากับผู้อื่น  
-  ยอมรับฟังความคิดเห็นของผู้อื่น  
-  รู้บทบาทของตนทั้งในฐานะผู้น าและผู้
ตามที่ดี  
-  รักหมู่คณะ เป็นหนึ่งเดียวกัน  ไม่
แตกแยก ไม่ทะเลาะวิวาท   
-  มีความเอื้อเฟื้อซึ่งกันและกัน 
-  ร่วมมือกันท างานเพื่อประโยชน์ของ
หมู่คณะ 
-  มีความสุขกับการท างานเป็นทีม 
(กรมวิชาการ, 2535 ; รุจิร์ ภู่สาระและ
คณะ, 2535 ; ส านักงานเลขาธิการสภา
การศึกษา , 2550) 
 
 
พระราชด ารัสของพระบาทสมเด็จพระ
เจ้าอยู่หัว , 2519 ; พจนานุกรมฉบับ
ราชบัณฑิตยสถาน , 2542 ; พระราชสุธี) 

ควำมพึงพอใจต่อบทเรียน 
-  ความรู้สึกของผู้เรียนที่มีต่อบทเรียน
บนเว็บช่วยสอนแบบการเรียนรู้เป็น
ทีมว่าชอบหรือไม่ชอบ 
 

ผลกำรเรียนรู้  
-  คะแนนที่ได้จากการทดสอบก่อนและ
หลังเรียนด้วยบทเรียนบนเว็บช่วยสอน
แบบการเรียนรู้เป็นทีม 
 

กำรเรียนรู้เป็นทีม  (Team  Learning) 
          ขั้นตอนการจัดการเรียนรู้เป็นทีมประกอบด้วย 7  
ขั้นตอน 
1. มีการจัดต้ังทีมส าหรับการเรียนรู้   
2. ระบุวัตถุประสงค์และเป้าหมายของรายวิชา 
3. จัดเนื้อหาสาระของรายวิชาเข้าเป็นหน่วยการเรียนรู้ 
4. สร้างคู่มือส าหรับผู้เรียนในแต่ละหน่วย  
5. สร้างแบบฝึกหัด/กิจกรรมที่ส่งเสริมการท างานเป็นทีม  
6. สร้างแบบทดสอบ   
7. สร้างแบบประเมิน  
 
 (วรรณภรณ์  วีระพงษ ์, ออนไลน์ , 2551 ;  
เอกชัย กี่สุขพันธ์ , 2538 ; Marquardt , 1996) 
 
 
 
 
 
 
 

กำรเรียนกำรสอนบนเว็บช่วยสอน 
         ขั้นตอนการออกแบบเว็บช่วยสอน มี 6 ขั้นตอน
ดังนี้ 
1. ศึกษาเกี่ยวกับผู้เรียนและเนื้อหาที่สอน 
2. ก าหนดวัตถุประสงค์การเรียน 
3. ออกแบบโครงสร้างของการน าเสนอข้อมูล 
4. พัฒนาเว็บเพจตามโครงเรื่อง (Storyboard) 
5. ทดลองใช้เว็บในการเรียนการสอน 
6. ประเมินผลการใช้งาน 
      
(ดิลลอน , 1991 ; ฮิรูมิและเบอร์มูเดส , 1996 ) 
 
 
 

บท
เรีย

นบ
นเ
ว็บ

ช่ว
ยส

อน
แบ

บก
าร
เรีย

นร
ู้เป
็นท

ีม 

ผลงำนนักเรียน 
-  คะแนนที่ได้จากช้ินงานที่นักเรียนที่
เป็นสมาชิกในทีมร่วมกันสร้างขึ้นมา  
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1.8  ประโยชน์ที่คำดว่ำจะได้รับ 
 1. ได้บทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม รายวิชาการน าเสนอส่ือประสม เรื่อง 
การน าเสนอส่ือประสมเบื้องต้น  ที่ผ่านการทดลองใช้เพื่อหาประสิทธิภาพแล้วสามารถน าไปใช้กับ
การเรียนการสอนในชั้นเรียนปกติหรือใช้เป็นบทเรียนเสริมและทบทวนได้ 
 2. นักเรียนที่เรียนด้วยบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเกิดความสามัคคี
ภายในทีม 
 3. ได้บทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมท่ีใช้เป็นแนวทางในการจัดการเรียน
การสอนเรื่องอ่ืนๆ หรือในรายวิชาอ่ืนๆ ต่อไป 
 



บทที่ 2 
 

เอกสารและงานวิจัยที่เกี่ยวขอ้ง 
 
 การวิจัยครั้งนี้มีวัตถุประสงค์เพื่อพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
หาประสิทธิภาพบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม ตามเกณฑ์ 80/80  ประเมินผลงาน
จากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม  เปรียบเทียบผลการเรียนของนักเรียนก่อนเรียน
และหลังเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม  ประเมินความสามัคคีของนักเรียนจากบทเรียน
บนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม  และศึกษาความพึงพอใจของนักเรียนในการใช้บทเรียนบน
เว็บช่วยสอนแบบการเรียนรู้เป็นทีม  ซ่ึงผู้วิจัยได้ท าการศึกษาแนวคิด ทฤษฎี หลักการ บทความและ
งานวิจัยที่เกี่ยวข้องจากเอกสารส่ิงพิมพ์และเอกสารอิเล็กทรอนิกส์ โดยมีรายละเอียดดังต่อไปนี้ 
 2.1.  การเรียนการสอนบนเว็บช่วยสอน 
 2.2.  การเรียนรู้เป็นทีม 
 2.3.  ความสามัคคี 
 2.4.  ตัวชี้วัดและสาระการเรียนรู้แกนกลาง 
 2.5.  งานวิจัยที่เกี่ยวข้อง 
 
2.1  การเรียนการสอนบนเว็บช่วยสอน 
 2.1.1  ความหมายของการเรียนการสอนบนเว็บช่วยสอน 

ราชบัณฑิตยสถาน (2542) ได้บัญญัติค าศัพท์ "Web-Based Instruction" ไว้ว่า "การสอนโดย
ใช้เว็บเป็นฐาน" หรือ "การสอนบนเว็บ" เนื่องจากค าว่า "การสอนบนเว็บ" เป็นค าท่ีนิยมใช้กันมาก 
 การเรียนการสอนผ่านเว็บ หรือ Web-Based Instruction เป็นรูปแบบหนึ่งของการประยุกต์ 
ใช้บริการเครือข่ายอินเทอร์เน็ตที่นักการศึกษาให้ความสนใจเป็นอย่างมาก ในปัจจุบันมีความพยายาม
ในการน าคุณสมบัติต่าง ๆ ของอินเทอร์เน็ตมาใช้เพื่อสนับสนุนการจัดการเรียนการสอนเพื่อให้เกิด
ประสิทธิภาพสูงสุด มีนักวิชาการและนักการศึกษาหลายท่านได้ให้ความหมายของการเรียนการสอน
ผ่านเว็บ ไว้ดังนี้ 

Clark (1996) ได้ให้ค าจ ากัดความของเว็บช่วยสอนว่าเป็นการสอนรายบุคคลที่น าเสนอโดย 
การใช้เครือข่ายคอมพิวเตอร์สาธารณะหรือส่วนบุคคล และแสดงผลในรูปของการใช้เว็บบราวเซอร์ 
สามารถเข้าถึงข้อมูลที่ติดตั้งไว้ได้โดยผ่านเครือข่าย 
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Khan (1997) ได้ให้ค าจ ากัดความของเว็บช่วยสอนเอาไว้ว่าเป็นโปรแกรมไฮเปอร์มีเดียที่
ช่วยในการสอน โดยการใช้ประโยชน์จากคุณลักษณะและทรัพยากรของอินเตอร์เน็ต มาสร้างให้เกิด
การเรียนรู้อย่างมีความหมาย โดยส่งเสริมและสนับสนุนการเรียนรู้ในทุกทาง 

Relan and Gillani (1997) ได้ให้ค าจ ากัดความของเว็บในการสอนเอาไว้เช่นกันว่าเป็นการ
กระท าของคณะหนึ่งในการเตรียมการคิดในกลวิธีการสอน โดยกลุ่มคอนสตัคติวิซ่ึม และการเรียนรู้
ในสถานการณ์ร่วมมือกัน โดยใช้ประโยชน์จากคุณลักษณะและทรัพยากรในเวิลด์ไวด์เว็บ 

ใจทิพย์ ณ สงขลา (2542) ได้ให้ความหมายการเรียนการสอนผ่านเว็บว่าหมายถึง การผนวก 
คุณสมบัติไฮเปอร์มีเดียเข้ากับคุณสมบัติของเครือข่ายเวิลด์ไวด์เว็บ เพื่อสร้างส่ิงแวดล้อมแห่งการเรียน
ในมิติที่ไม่มีขอบเขตจ ากัดด้วยระยะทางและเวลาที่แตกต่างกันของผู้ เรียน (Learning without 
Boundary) 

วิชุดา รัตนเพียร (2542) ได้กล่าวว่า การเรียนการสอนบนเว็บ เป็นรูปแบบหนึ่งของการน า
คุณสมบัติต่าง ๆ ที่ดีของอินเทอร์เน็ตมาใช้สนับสนุนการเรียนการสอนต่างไปจากรูปแบบเดิม 
เนื่องจากอินเทอร์เน็ตเป็นเทคโนโลยีที่มีศักยภาพ ในการท างานสูง มีบริการรูปแบบที่หลากหลาย 
สามารถเอ้ืออ านวยประโยชน์ในการจัดการเรียนการสอน 
 กิดานันท์ มลิทอง (2543) ให้ความหมาย การเรียนการสอนผ่านเว็บว่าเป็นการใช้เว็บในการ
เรียนการสอน โดยอาจใช้เว็บเพื่อน าเสนอบทเรียนในลักษณะส่ือหลายมิติของวิชาทั้งหมดตาม
หลักสูตร หรือใช้เพียงการเสนอข้อมูลบางอย่างเพื่อประกอบการสอนก็ได้ รวมทั้งใช้ประโยชน์จาก
คุณลักษณะต่างๆ ของการส่ือสารที่มีอยู่ในระบบอินเทอร์เน็ต เช่น การเขียนโต้ตอบกันทางไปรษณีย์
อิเล็กทรอนิกส์ การพูดคุยสดด้วยข้อความและเสียงมาใช้ประกอบด้วย เพื่อให้เกิดประสิทธิภาพสูงสุด 
         ถนอมพร เลาจรัสแสง (2544) ให้ความหมายว่า การสอนบนเว็บ (Web-Based Instruction) 
เป็นการผสมผสานกันระหว่างเทคโนโลยีปัจจุบันกับกระบวนการออกแบบการเรียนการสอนเพื่อเพิ่ม
ประสิทธิภาพทางการเรียนรู้และแก้ปัญหาในเรื่องข้อจ ากัดทางด้านสถานที่และเวลา โดยการสอนบน
เว็บจะประยุกต์ใช้คุณสมบัติและทรัพยากรของเวิลด์ ไวด์ เว็บ ในการจัดสภาพแวดล้อมที่ส่งเสริมและ
สนับสนุนการเรียนการสอน ซ่ึงการเรียนการสอนที่จัดขึ้นผ่านเว็บนี้อาจเป็นบางส่วนหรือทั้งหมดของ
กระบวนการเรียนการสอนก็ได้ 

สรรรัชต์ ห่อไพศาล (2544) ให้ความหมายของการเรียนการสอนบนเว็บ ว่าหมายถึง การใช้
เครือข่ายอินเทอร์เน็ตเพ่ือการเรียนการสอนเป็นการน าเอาคุณสมบัติของอินเทอร์เน็ตมาออกแบบเพื่อ
ใช้ในการศึกษา การจัดการเรียนการสอนผ่านเครือข่าย (Web-Based Instruction) มีชื่อเรียกหลาย
ลักษณะ  เช่น  การจัดการเรียนการสอนบนเว็บ (Web-Based Instruction)  เว็บการเรียน (Web-Based 
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Learning)  เว็บฝึกอบรม (Web-Based Training) อินเทอร์เน็ตฝึกอบรม (Internet-Based Training)  
อินเทอร์เน็ตช่วยสอน (Internet-Based Instruction)  เวิลด์ไวด์เว็บฝึกอบรม (WWW-Based Training)  
เวิลด์ไวด์เว็บช่วยสอน (WWW-Based Instruction) 

น้ ามนต์ เรืองฤทธ์ิ (2546) กล่าวว่า การเรียนการสอนผ่านเว็บ หมายถึง การจัดสภาพการ
เรียนการสอนโดยอาศัยทรัพยากรต่าง ๆ ที่มีอยู่อินเทอร์เน็ตมาใช้เป็นส่ือกลางในการเรียนการสอน 
เช่น WWW, E-mail, Web Board, IRC เพื่อให้การด าเนินการเรียนการสอนเป็นไปอย่างมี
ประสิทธิภาพ การเรียนการสอนผ่านเว็บจึงถือเป็นวิธีการใหม่ที่ช่วยส่งเสริมพัฒนาให้เกิดการเรียนรู้ 
และช่วยขจัดปัญหาเรื่องอุปสรรคของการเรียนการสอนทางด้านสถานที่และเวลา   
 ลัดดาวัลย์ สวัสดิ์หลง (2550 ) การเรียนการสอนบนเว็บ (web-based-instruction) เป็นการ
จัดการเรียนการสอนที่มีสภาพการเรียนต่างไปจากรูปแบบเดิม โดยอาศัยศักยภาพและความสามารถ
ของอินเทอร์เน็ต ซ่ึงเป็นส่ือการเรียนการสอนที่มีเทคโนโลยีสูงสุดในขณะนี้ให้มาช่วยเอ้ืออ านวยและ
เป็นเครื่องมือและแหล่งสนับสนุนการเรียนการสอน ให้เกิดการเรียนรู้อย่างมีความหมายเชื่อมโยง
เครือข่ายท่ีสามารถเรียนได้ทุกสถานที่และทุกเวลา ซ่ึงท าให้มีช่ือเรียกหลายลักษณะ ได้แก่ การทดสอบ
ผ่านเว็บ (web-based instruction) การเรียนรู้ผ่านเว็บ (web-based training) การสอนผ่านอินเทอร์เน็ต 
(internet-based instruction) การสอบผ่านเวิลด์ไวด์เว็บ (www-based instruction) การเรียนรู้ผ่าน 
เวิลด์ไวด์เว็บ (www training) การเรียนผ่านเว็บ (web-based learning) 

นัฏพันธ์ุ นันทวาศ (2551) กล่าวว่า การเรียนการสอนผ่านเว็บหมายถึง การใช้โปรแกรมส่ือ
หลายมิติที่อาศัยประโยชน์จากคุณลักษณะและทรัพยากรของอินเทอร์เน็ต และเวิลด์วายเว็บ มา
ออกแบบเป็นเว็บเพื่อการเรียนการสอน สนับสนุนและส่งเสริมให้เกิดการเรียนรู้อย่างมีความหมาย 
เชื่อมโยงเป็นเครือข่ายท่ีสามารถเรียนได้ทุกที่ทุกเวลา โดยมีลักษณะที่ผู้สอนผู้เรียนมีปฏิสัมพันธ์กัน
โดยผ่านระบบเครือข่ายคอมพิวเตอร์ที่เชื่อมโยงซ่ึงกันและกัน  

จากนิยามและความคิดเห็นของนักวิชาการและนักการศึกษา ทั้งในต่างประเทศและ
ภายในประเทศไทยดังท่ีกล่าวมาแล้วนั้นใช้ค าที่หลากหลาย เช่น การเรียนการสอนผ่านเว็บ การเรียน
บนเว็บ หรือเว็บช่วยสอน ซ่ึงในงานวิจัยนี้ผู้วิจัยจะใช้ค าว่า เว็บช่วยสอน สามารถสรุปได้ว่า การเรียน
การสอนผ่านเว็บช่วยสอน เป็นการจัดสภาพการเรียนการสอนที่ได้รับการออกแบบอย่างมีระบบ โดย
น าเสนอบทเรียนในลักษณะส่ือหลายมิติ รวมทั้งจัดสภาพการเรียนการสอนให้ผู้เรียนกับผู้สอนและ
ระหว่างผู้เรียนด้วยกันมีปฏิสัมพันธ์กันผ่านกระดานเรียนรู้ (Web Board) การสนทนาออนไลน์ (Chat) 
และส่งงานที่ได้รับมอบหมายผ่านทาง E-mail ซ่ึงอาศัยคุณสมบัติและทรัพยากรของเวิลด์ไวด์เว็บ มา
เป็นส่ือกลางในการถ่ายทอดเพื่อส่งเสริมสนับสนุนการเรียนการสอนให้มีประสิทธิภาพ โดยที่ผู้เรียน
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และผู้สอนไม่จ าเป็นต้องอยู่ในสถานที่และเวลาเดียวกันเป็นการช่วยขจัดปัญหาอุปสรรคของการเรียน
การสอนทางด้านสถานที่และเวลา 
  

2.1.2  ลักษณะของการเรียนการสอนบนเว็บช่วยสอน 
ลักษณะการเรียนการสอนบนเว็บช่วยสอน มีลักษณะการจัดสภาพการเรียนการสอนที่มี

ความแตกต่างจากการเรียนการสอนในชั้นเรียนปกติ ผู้เรียนจะเรียนผ่านจอคอมพิวเตอร์ที่เชื่อมโยงกับ
เครือข่ายโดยผู้เรียนแต่ละคนที่เป็นสมาชิกเครือข่ายอินเทอร์เน็ต สามารถเข้าสู่ระบบเครือข่าย เพื่อ
ศึกษาเนื้อหาบทเรียนจากที่ใดก็ได้ในเวลาใดก็ได้  และผู้เรียนแต่ละคนยังสามารถติดต่อส่ือสารกับ
ผู้สอนหรือผู้เรียนคนอ่ืนๆ ได้ทันทีทันใดเหมือนกับได้เผชิญหน้ากันจริง จัดเป็นการเรียนรู้ที่มีลักษณะ
เป็นเครือข่าย ซ่ึงมีลักษณะดังนี้ (Chute, Sayers and Gardner,1997) ดังภาพ 

 
 

 
 
 
 
 
 
 
 
 
 
ภาพท่ี 2.1  แสดงลักษณะการเรียนการสอนบนเว็บชว่ยสอน 
 

อาจกล่าวไดว้่า การเรียนการสอนบนเว็บช่วยสอน เป็นการเรียนรู้แบบระบบเครือข่ายมี
ลักษณะการเรียนการสอน ดังนี ้

2.1.2.1  ตอบสนองความต้องการการเรียนรู้อย่างต่อเนื่อง (the needs for continuous 
learning) จากสภาพการเรียนรู้ในปัจจุบันได้มีการปรับเปล่ียนไปตามกระแสของโลกาภิวัฒน์ 
มีการเรียนรู้จากส่ืออิเล็คทรอนิกส์กันมากขึ้น ทั้งในและนอกระบบโรงเรียน 

ผู้เรียนทางไกล 
(Distance Learner) 

ผู้อ านวยความ
สะดวก/ผู้สอน 

 

ผู้เช่ียวชาญเนื้อหา 
(Subject Matter) 

บริการสนับสนุน 
(Support Services) 

ห้องสมุดเหมือนจริง 
(Virtual Library) 

ผู้เรียนอื่นๆ 
(Other student) 

อินเทอร์เน็ต 
(Internet) 



13 
 

2.1.2.2  มีลักษณะการเชื่อมโยงเครือข่ายการเรียนรูใ้นเวิลดไ์วด์เว็บ (distance learning 
networks) 

1) เครือข่ายประเภทเสียง (audio network) ได้แก ่การถามตอบ 
2) เครือข่ายประเภทวิดโีอ (video network) ได้แก ่ISDN, MCUC ประกอบดว้ย

บทเรียนที่ประกอบด้วย รูปภาพ สไลด์ วิดีโอเทป ข้อมูลต่าง ๆ ที่หลากหลาย 
2.1.2.3  การเรียนการสอนบนเครือข่าย 

1) มีการปฏิสัมพันธ์ในและนอกเครือข่าย 
2) มีการถามตอบ 
3) มีส่วนของการระดมสมอง 
4) มีการอภิปราย case (case study) 
5) มีบทบาทสมมุติ (role playing) 

2.1.2.4  บทบาทของการบริการสนับสนุนการเรียนการสอน ได้แก่ 
1) ผู้เรียนได้รับการบริการด้านการลงทะเบียนเรียน การค้นหาข้อมูล การประเมินผล

การเรียน ข้อมูลการเรียนการสอนในโปรแกรมการเรียน และวิธีการเรียนผ่านเว็บและในห้องเรียน 
การปรึกษาผู้สอน ผู้ทรงคุณวุฒิ และการติดต่อส่ือสาร ระหว่างผู้สอน ผู้เชี่ยวชาญและผู้เรียนด้วยกัน 

2) มีผู้เชีย่วชาญ และผู้ให้การปรกึษาส าหรับผู้เรียนเมื่อมีปัญหา 
2.1.2.5  บริการบนอินเทอร์เนต็ 

1) ไปรษณีย์อิเล็กทรอนิกส์ (e-mail) 
2) ข้อมูลและส่ืออ้างอิง 
3) เครื่องมือในอินเทอร์เนต็ เช่น มัลติมีเดีย รูปภาพ ภาพเคล่ือนไหว ฯลฯ 
4) เนื้อหาในโฮส ได้แก ่วิทย ุวีดีโอ รูปภาพ อีเมล มัลติมีเดีย 
5) การทดสอบ ได้แก ่ลักษณะของการตอบ เช่น ถูกผิด, ค าตอบส้ัน ๆ 

2.1.2.6  ห้องสมุดเสมือนจริง เป็นห้องสมุดที่รวมห้องสมุดทั่วโลกไว้ ให้ผู้เรียนได้สามารถ
ค้นหาข้อมูลได้เหมือนอยู่ในห้องสมุดนั้น ๆ โดยใช้อินเทอร์เน็ต การบริการส่ังจองหนังสือและส่ือการ
เรียน ต่าง ๆ เป็นต้น 

2.1.2.7  ส่ิงแวดล้อมการเรียนรู้ที่เหมือนจริง การเรียนรู้ที่ผู้เรียนสามารถเรียนได ้4 ทางคือ 
1) เวลาเดียวกัน และสถานที่เดียวกัน แบบ face to face 
2) เวลาเดียวกัน แต่คนละสถานที่ ได้แก ่teleconference 
3) เวลาต่างกัน แต่สถานที่เดียวกัน ได้แก ่การเรียนแบบกลุ่ม 
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4) เวลาต่างกัน และสถานที่ต่างกัน 
การเรียนการสอนบนเว็บชว่ยสอน มีขั้นตอนการเรียนการสอนดังตัวอย่างต่อไปนี ้

1) ผู้เรียนที่เป็นสมาชิกอินเทอร์เน็ตเข้าสู่ระบบดว้ยการบนัทึกเข้า (login) 
2) พิมพ์ท่ีอยู่ของเว็บเพจที่ต้องการเข้าไปศกึษา 
3) เมื่อเข้าสู่เว็บท่ีต้องการแล้ว ผู้เรียนศึกษาเนื้อหาบทเรียนที่น าเสนอผ่านทางหน้า 

จอคอมพิวเตอร ์
4) ในบางช่วงบางตอนของบทเรียนจะถูกกระตุ้นให้มีปฏิกิริยาสนองตอบเนื้อหาของ 

บทเรียน โดยผู้เรียนสามารถโต้ตอบกับบทเรียนผ่านเว็บ หรือสามารถโต้ตอบกับผู้เรียนคนอ่ืน ๆ 
หรือแม้แต่ผู้สอนที่เข้าสู่บทเรียนในเวลาเดียวกันหรือคนละเวลาก็ได้ 

5) ผู้เรียนสามารถศึกษาเนื้อหาเท่าที่ก าหนดในเว็บเพจหนึ่ง ๆ หรืออาจเข้าสู้เว็บเพจ 
อ่ืน ๆ ที่เกี่ยวข้องก็ได้เพื่อเป็นการขยายขอบเขตของความรู้ (วิชุดา รัตนเพียร, 2542) 

ลักษณะของการเรียนการสอนโดยการใช้ระบบอินเทอร์ เน็ต ถ้าแบ่งตามรูปแบบของ
เครื่องมือที่ใช้บนอินเทอร์เน็ต (Cramer, 1994) ก็จะแบ่งออกเป็น 2 ลักษณะ คือ 

1) แบบที่เป็นข้อมูลอย่างเดียว (text-only) เป็นลักษณะของการเรียนการสอนโดย
อาศัยอินเทอร์เน็ต ซ่ึงมีข้อจ ากัดบางอย่างในการเข้าถึงข้อมูล โดยมีลักษณะที่เป็นข้อความอย่างเดียว 
เช่น 

- ไปรษณีย์อิเล็กทรอนิกส์ (electronic mail : e-mail) 
- กระดานข่าวสาร (bulletin board) 
- ห้องสนทนา (chat room) 
- โปรแกรมดาวน์โหลด (software downloading) 
2) แบบที่เป็นมัลติมีเดีย (multimedia) เป็นแบบที่สองของอินเทอร์เน็ตเพื่อการเรียน

การสอนที่มีโครงสร้างลักษณะเป็นกราฟิก การสืบค้นโดยใช้ภาพในรูปแบบของเว็บ การใช้เว็บช่วย
สอนก็จะมีคุณลักษณะของเว็บท่ีแตกต่างไปจากส่ืออ่ืนๆ โดยเฉพาะ 

จากนิยามและความคิดเห็นของนักวิชาการและนักการศึกษา ทั้งภายในประเทศไทยและ
ต่างประเทศ ดังที่กล่าวมาแล้วนั้น สรุปได้ว่า  ลักษณะของการเรียนการสอนบนเว็บช่วยสอนมีลักษณะ
ดังนี้ คือ การเรียนการสอนผ่านเครือข่ายโดยผู้เรียนจะต้องเข้าสู่ระบบเครือข่ายเพื่อศึกษาเนื้อหา
บทเรียน และเลือกเรียนบทเรียนได้ตามต้องการ ท่ีไหนเวลาใดก็ได้ อีกทั้งผู้เรียนสามารถมีปฏิสัมพันธ์
กับบทเรียน ผู้เรียนและผู้สอนได้และทราบผลการเรียนได้ในทันที 
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 2.1.3  ประเภทของการเรียนการสอนบนเว็บช่วยสอน 
 การเรียนการสอนผ่านเว็บสามารถท าได้ในหลายลักษณะ โดยแต่ละเนื้อหาของหลักสูตรก็

จะมีวิธีการจัดการเรียนการสอนผ่านเว็บที่แตกต่างกันออกไป ซ่ึงในประเด็นนี้มีนักการศึกษาหลาย
ท่านได้ให้ข้อเสนอแนะเกี่ยวกับประเภทของการเรียนการสอนผ่านเว็บ ดังต่อไปนี้ 
         พาร์สัน (Parson, 1997) ได้แบ่งประเภทของการเรียนการสอนผ่านเว็บออกเป็น 3 ลักษณะ
คือ 
         1.  เว็บช่วยสอนแบบรายวิชาอย่างเดียว (Stand - Alone Courses) เป็นรายวิชาที่มีเครื่องมือ
และแหล่งที่เข้าไปถึงและเข้าหาได้โดยผ่านระบบอินเทอร์เน็ตอย่างมากที่สุด ถ้าไม่มีการส่ือสารก็
สามารถที่จะไปผ่านระบบคอมพิวเตอร์ส่ือสารได้ ลักษณะของเว็บช่วยสอนแบบนี้มีลักษณะเป็นแบบ
วิทยาเขตมีนักศึกษาจ านวนมากที่เข้ามาใช้จริงแต่จะมีการส่งข้อมูลจากรายวิชาทางไกล 
         2.  เว็บช่วยสอนแบบเว็บสนับสนุนรายวิชา (Web Supported Courses) เป็นรายวิชาที่มี
ลักษณะเป็นรูปธรรมที่มีการพบปะระหว่างครูกับนักเรียนและมีแหล่งให้มาก เช่น การก าหนดงานที่
ให้ท าบนเว็บ การก าหนดให้อ่าน การส่ือสารผ่านระบบคอมพิวเตอร์ หรือการมีเว็บที่สามารถชี้
ต าแหน่งของแหล่งบนพื้นที่ของเว็บไซต์โดยรวมกิจกรรมต่างๆ เอาไว้ 
         3.  เว็บช่วยสอนแบบศูนย์การศึกษา (Web Pedagogical Resources) เป็นชนิดของเว็บไซต์ที่
มีวัตถุดิบเครื่องมือ ซ่ึงสามารถรวบรวมรายวิชาขนาดใหญ่เข้าไว้ด้วยกันหรือเป็นแหล่งสนับสนุน
กิจกรรมทางการศึกษา ซ่ึงผู้ที่เข้ามาใช้ก็จะมีส่ือให้บริการอย่างรูปแบบอย่างเช่น เป็นข้อความ เป็น
ภาพกราฟิก การส่ือสารระหว่างบุคคล และการท าภาพเคล่ือนไหวต่างๆ เป็นต้น 
         อีกแนวคิดหนึ่งของเว็บช่วยสอนซ่ึงแยกตามโครงสร้างและประโยชน์การใช้งาน ตาม
แนวคิดของ เจมส์ (James, 1997) สามารถแบ่งได้ 3 ลักษณะใหญ่ ๆ คือ 
         1. โครงสร้างแบบค้นหา (Eclectic Structures) ลักษณะของโครงสร้างเว็บไซต์แบบนี้ เป็น
แหล่งของเว็บไซต์ที่ใช้ในการค้นหาไม่มีการก าหนดขนาด รูปแบบ ไม่มีโครงสร้างที่ผู้เรียนต้องมี
ปฏิสัมพันธ์กับเว็บลักษณะของเว็บไซต์แบบนี้จะมีแต่การให้ใช้เครื่องมือในการสืบค้นหรือเพื่อบางส่ิง
ที่ต้องการค้นหาตามท่ีก าหนดหรือโดยผู้เขียนเว็บไซต์ต้องการ โครงสร้างแบบนี้จะเป็นแบบเปิดให้
ผู้เรียนได้เข้ามาค้นคว้าในเนื้อหาในบริบท โดยไม่มีโครงสร้างข้อมูลเฉพาะให้ได้เลือกแต่โครงสร้าง
แบบนี้จะมีปัญหากับผู้เรียนเพราะผู้เรียนอาจจะไม่สนใจข้อมูลที่ไม่มีโครงสร้าง โดยไม่ก าหนด
แนวทางในการสืบค้น 
        2. โครงสร้างแบบสารานุกรม (Encyclopaedic Structures) ถ้าเราควบคุมของสร้างของเว็บท่ี
เราสร้างขึ้นเองได้ เราก็จะใช้โครงสร้างข้อมูลในแบบต้นไม้ในการเข้าสู่ข้อมูล ซ่ึงเหมือนกับหนังสือที่
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มีเนื้อหาและมีการจัดเป็นบทเป็นตอน ซ่ึงจะก าหนดให้ผู้เรียนหรือผู้ใช้ได้ผ่านเข้าไปหาข้อมูลหรือ
เครื่องมือที่อยู่ในพื้นที่ของเว็บหรืออยู่ภายในและ นอกเว็บ เว็บไซต์จ านวนมากมีโครงสร้างในลักษณะ
ดังกล่าวนี้ โดยเฉพาะเว็บไซต์ทางการศึกษาท่ีไม่ได้ก าหนดทางการค้า องค์กร ซ่ึงอาจจะต้องมีลักษณะ
ที่ดูมีมากกว่านี้ แต่ในเว็บไซต์ทางการศึกษาต้องรับผิดชอบต่อการเรียนรู้ของผู้เรียน กลวิธีด้าน
โครงสร้างจึงมีผลต่อการเรียนรู้ของผู้เรียน 
         3. โครงสร้างแบบการเรียนการสอน (Pedagogic Structures) มีรูปแบบโครงสร้างหลาย
อย่างในการน ามาสอนตามต้องการ ทั้งหมดเป็นที่รู้จักดีในบทบาทของการออกแบบทางการศึกษา
ส าหรับคอมพิวเตอร์ช่วยสอนหรือเครื่องมือมัลติมีเดีย ซ่ึงความจริงมีหลักการแตกต่างกันระหว่าง
คอมพิวเตอร์ช่วยสอนกับเว็บช่วยสอนนั้นคือความสามารถของ HTML ในการที่จะจัดท าในแบบ
ไฮเปอร์เท็กซ์กับการเข้าถึงข้อมูลหน้าจอโดยผ่านระบบอินเทอร์เน็ต 

Doherty (1997 อ้างถึงใน ณัฐกร สงคราม, 2543) กล่าวถึงการเรียนการสอนผ่านเว็บต้อง
อาศัยบทบาทของระบบอินเทอร์เน็ตเป็นส าคัญ การใช้อินเทอร์เน็ตในการเรียนการสอนจะมีวิธีการใช้
ใน 3 ลักษณะ 
 1. การน าเสนอ (Presentation) เป็นไปในแบบเว็บไซต์ที่ประกอบไปด้วยข้อความ 
ภาพกราฟิกซ่ึงสามารถน าเสนอได้อย่างเหมาะสมในลักษณะของส่ือ คือ 

1.1 การน าเสนอแบบส่ือทางเดียว เช่น เป็นข้อความ 
1.2 การน าเสนอแบบส่ือคู่ เช่น ข้อความกับภาพกราฟิก บางครั้งจะอยู่ในรูปแบบ 

PDF ผู้เรียนสามารถดาวน์โหลดไฟล์ได้ (Jeanne, 1996) การน าเสนอแบบมัลติมีเดีย คือ ประกอบด้วย
ข้อความ ภาพกราฟิก ภาพเคล่ือนไหว เสียง และภาพยนตร์ หรือวิดีโอ (แต่ความเร็วจะไม่เท่ากับ
วิดีโอเทป) 
 2. การส่ือสาร (Communication) การส่ือสารเป็นส่ิงจ าเป็นที่จะต้องใช้ทุกวันในชีวิต 
ซ่ึงเป็นลักษณะส าคัญของอินเทอร์เน็ต โดยมีการส่ือสารบนอินเทอร์เน็ตหลายแบบ เช่น 
 2.1 การส่ือสารทางเดียว โดยดูจากเว็บเพจ 
 2.2 การส่ือสารสองทาง เช่น การส่งไปรษณีย์อิเล็กทรอนิกส์โต้ตอบกัน 
 2.3 การส่ือสารแบบหนึ่งแหล่งไปหลายที่ เป็นการส่งข้อความจากแหล่งเดียว
แพร่กระจายไปหลายแหล่ง เช่น การอภิปรายจากคนเดียวให้คนอ่ืน ๆ ได้รับฟังด้วย หรือการประชุม
ทางคอมพิวเตอร์ 

2.4 การส่ือสารจากหลายแหล่งไปสู่หลายแหล่ง เช่น การใช้กระบวนการกลุ่มในการ
ส่ือสารบนเว็บ โดยมีคนใช้หลายคนเช่นกัน 
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 3. การท าให้เกิดความสัมพันธ์ (Dynamic Interaction) เป็นคุณลักษณะที่ส าคัญของ
อินเทอร์เน็ตและส าคัญที่สุด ซ่ึงมี 3 ลักษณะ คือ 

3.1 การสืบค้น 
3.2 การหาวิธีการเข้าสู่เว็บ 
3.3 การตอบสนองของมนุษย์ในการใช้เว็บ 

 ข่าน (Khan, 1997 อ้างถึงใน วิชุดา รัตนเพียร, 2542) ได้กล่าวไว้ถึงคุณลักษณะ 2 ประการ
ของโปรแกรมการเรียนการสอนผ่านเว็บ มีดังนี้ 
 1. คุณลักษณะหลัก (Key Features) เป็นคุณลักษณะพื้นฐานของโปรแกรมการเรียนการ
สอนผ่านเว็บทุกโปรแกรม ตัวอย่างเช่น การสนับสนุนให้ผู้เรียนมีปฏิสัมพันธ์กับบทเรียน ผู้สอน หรือ
ผู้เรียนคนอ่ืนๆ การน าเสนอบทเรียนในลักษณะของส่ือหลายมิติ (Multimedia)การน าเสนอบทเรียน
ระบบเปิด (Open System) กล่าวคือ อนุญาตให้ผู้เรียนสามารถเชื่อมโยงเข้าสู่เว็บเพจอ่ืนๆ ที่เกี่ยวข้อง
ได้ ผู้เรียนสามารถสืบค้นข้อมูลบนเครือข่ายได้ (Online Search) ผู้เรียนควรที่จะสามารถเข้าสู่
โปรแกรมการสอนผ่านเว็บจากที่ใดก็ได้ทั่วโลก รวมท้ังผู้เรียนควรที่จะสามารถควบคุมการเรียนของ
ตนเองได้ 
 2. คุณลักษณะเพิ่มเติม (Additional Features) เป็นคุณลักษณะประกอบเพิ่มเติมซ่ึงขึ้นอยู่กับ
คุณภาพและความยากง่ายของการออกแบบเพื่อน ามาใช้งานและการน ามาประกอบกับคุณลักษณะ
หลักของโปรแกรมการเรียนการสอนผ่านเว็บ ตัวอย่างเช่น ความง่ายในการใช้โปรแกรม มีระบบ
ป้องกันการลักลอบข้อมูล รวมทั้งระบบให้ความช่วยเหลือบนเครือข่าย มีความสะดวกในการแก้ไข
ปรับปรุงโปรแกรม เป็นต้น 
 
 แฮนนัม (Hannum, 1998) ได้แบ่งประเภทของการเรียนการสอนผ่านเว็บ ออกเป็น 4 
ลักษณะใหญ่ ๆ คือ 
 1. รูปแบบการเผยแพร่ รูปแบบนี้สามารถแบ่งได้ออกเป็น 3 ชนิด คือ 

1.1 รูปแบบห้องสมุด (Library Model) เป็นรูปแบบที่ใช้ประโยชน์จากความสามารถ 
ในการเข้าไปยังแหล่งทรัพยากรอิเล็กทรอนิกส์ที่มีอยู่หลากหลาย โดยวิธีการจัดหาเนื้อหาให้ผู้เรียน
ผ่าน การเชื่อมโยงไปยังแหล่งเสริมต่างๆ เช่น สารานุกรม วารสาร หรือหนังสือออนไลน์ทั้งหลาย ซ่ึง
ถือได้ว่า เป็นการน าเอาลักษณะทางกายภาพของห้องสมุดที่มีทรัพยากรจ านวนมหาศาลมาประยุกต์ใช้
ส่วนประกอบของรูปแบบนี้ ได้แก่ สารานุกรมออนไลน์ วารสารออนไลน์ หนังสือออนไลน์ สารบัญ
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การอ่าน ออนไลน์ (Online Reading List) เว็บห้องสมุด เว็บงานวิจัย รวมทั้งการรวบรวมรายชื่อเว็บที่
สัมพันธ์กับวิชาต่างๆ 
 1.2 รูปแบบหนังสือเรียน (Textbook Model) การเรียนการสอนผ่านเว็บรูปแบบนี้ 
เป็น การจัดเนื้อหาของหลักสูตรในลักษณะออนไลน์ให้แก่ผู้เรียน เช่น ค าบรรยาย สไลด์ นิยามค าศัพท์
และส่วนเสริม ผู้สอนสามารถเตรียมเนื้อหาออนไลน์ที่ใช้เหมือนกับที่ใช้ในการเรียนในชั้นเรียนปกติ
และสามารถท าส าเนาเอกสารให้กับผู้เรียนได้ รูปแบบนี้ต่างจากรูปแบบห้องสมุดคือรูปแบบนี้จะ
เตรียมเนื้อหาส าหรับการเรียนการสอนโดยเฉพาะ ขณะที่รูปแบบห้องสมุดช่วยให้ผู้เรียนเข้าถึงเนื้อหา
ที่ต้องการจากการเชื่อมโยงท่ีได้เตรียมเอาไว้ ส่วนประกอบของรูปแบบหนังสือเรียนนี้ประกอบด้วย 
บันทึกของหลักสูตร บันทึกค าบรรยาย ข้อแนะน าของห้องเรียน สไลด์ที่น าเสนอ วิดีโอและภาพที่ใช้
ในชั้นเรียน เอกสารอ่ืนที่มีความสัมพันธ์กับชั้นเรียน เช่น ประมวลรายวิชา รายชื่อในชั้น กฎเกณฑ์
ข้อตกลงต่างๆ ตารางการสอบ และตัวอย่างการสอบครั้งที่แล้วความคาดหวังของชั้นเรียน งานที่
มอบหมาย เป็นต้น 

1.3 รูปแบบการสอนที่มีปฎิสัมพันธ์ (Interactive Instruction Model) รูปแบบนี้จัดให้ 
ผู้เรียนได้รับประสบการณ์การเรียนรู้จากการมีปฎิสัมพันธ์กับเนื้อหาที่ได้รับ โดยน าลักษณะของ
บทเรียนคอมพิวเตอร์ช่วยสอน (CAI) มาประยุกต์ใช้ เป็นการสอนแบบออนไลน์ที่เน้นการมี
ปฏิสัมพันธ์ มีการให้ค าแนะน า การปฏิบัติ การให้ผลย้อนกลับ รวมท้ังการให้สถานการณ์จ าลอง 
 2.  รูปแบบการส่ือสาร (Communication Model) การเรียนการสอนผ่านเว็บรูปแบบนี้เป็น
รูปแบบที่อาศัยคอมพิวเตอร์มาเป็นส่ือเพื่อการส่ือสาร (Computer - Mediated Communications 
Model) ผู้เรียนสามารถที่จะส่ือสารกับผู้เรียนคนอ่ืนๆ ผู้สอนหรือกับผู้เชี่ยวชาญได้ โดยรูปแบบการ
ส่ือสารที่หลากหลายในอินเทอร์เน็ตซ่ึงได้แก่ จดหมายอิเล็กทรอนิกส์ กลุ่มอภิปราย การสนทนาและ
การอภิปรายและการประชุมผ่านคอมพิวเตอร์ เหมาะส าหรับการเรียนการสอนที่ต้องการส่งเสริมการ
ส่ือสารและปฏิสัมพันธ์ระหว่างผู้ที่มีส่วนร่วมในการเรียนการสอน 
 3.  รูปแบบผสม (Hybrid Model) รูปแบบการเรียนการสอนผ่านเว็บรูปแบบนี้เป็นการน าเอา
รูปแบบ 2 ชนิด คือ รูปแบบการเผยแพร่ กับรูปแบบการส่ือสารมารวมเข้าไว้ด้วยกัน เช่น เว็บไซท์ที่
รวมเอารูปแบบห้องสมุดกับรูปแบบหนังสือเรียนไว้ด้วยกัน เว็บไซท์ที่รวบรวมเอาบันทึกของ
หลักสูตร รวมท้ังค าบรรยายไว้กับกลุ่มอภิปราย หรือเว็บไซท์ท่ีรวมเอารายการแหล่งเสริมความรู้ต่างๆ 
และความสามารถของจดหมายอิเล็กทรอนิกส์ไว้ด้วยกัน เป็นต้น รูปแบบนี้มีประโยชน์เป็นอย่างมาก
กับผู้เรียน เพราะผู้เรียนจะได้ใช้ประโยชน์ของทรัพยากรที่มีในอินเทอร์เน็ตในลักษณะที่หลากหลาย 
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 4.  รูปแบบห้องเรียนเสมือน (Virtual classroom model) รูปแบบห้องเรียนเสมือนเป็นการ
น าเอาลักษณะเด่นหลายๆ ประการของแต่ละรูปแบบที่กล่าวมาแล้วข้างต้นมาใช้ ฮิลทซ์ ได้นิยามว่า
ห้องเรียนเสมือนเป็นสภาพแวดล้อมการเรียนการสอนที่น าแหล่งทรัพยากรออนไลน์มาใช้ในลักษณะ
การเรียนการสอนแบบร่วมมือ โดยการร่วมมือระหว่างนักเรียนด้วยกัน นักเรียนกับผู้สอน ชั้นเรียนกับ
สถาบันการศึกษาอ่ืน และกับชุมชนที่ไม่เป็นเชิงวิชาการ ส่วนเทอรอฟฟ์ กล่าวถึงห้องเรียนเสมือนว่า
เป็น สภาพแวดล้อมการเรียนการสอนที่ตั้งขึ้นภายใต้ระบบการส่ือสารผ่านคอมพิวเตอร์ในลักษณะ
ของการเรียนแบบร่วมมือ ซ่ึงเป็นกระบวนการที่เน้นความส าคัญของกลุ่มที่จะร่วมมือท ากิจกรรม
ร่วมกัน นักเรียนและผู้สอนจะได้รับความรู้ใหม่ ๆ จากกิจกรรม การสนทนาแลกเปล่ียนความคิดเห็น
และข้อมูล ลักษณะเด่นของการเรียนการสอนรูปแบบนี้ก็คือ ความสามารถในการลอกเลียนลักษณะ
ของห้องเรียนปกติมาใช้ในการออกแบบการเรียนการสอนผ่านเครือข่ายอินเทอร์เน็ต โดยอาศัย
ความสามารถต่างๆ ของอินเทอร์เน็ต โดยมีส่วนประกอบคือ ประมวลรายวิชา เนื้อหาในหลักสูตร 
รายชื่อแหล่งเนื้อหาเสริมกิจกรรมระหว่างผู้เรียนผู้สอน ค าแนะน า และการให้ผลป้อนกลับ การ
น าเสนอในลักษณะมัลติมีเดีย การเรียนแบบร่วมมือ รวมทั้งการส่ือสารระหว่างกัน รูปแบบนี้จะช่วย
ให้ผู้เรียนได้รับประโยชน์จากการเรียนโดยไม่มีข้อจ ากัดในเรื่องของเวลาและสถานที่ 
 จากการศึกษาความคิดเห็นของนักวิชาการและนักการศึกษา ทั้งภายในประเทศไทยและ
ต่างประเทศ ดังที่กล่าวมาแล้วนั้น สรุป ประเภทของการเรียนการสอนผ่านเว็บได้ว่า การเรียนการสอน
ผ่านเว็บมีลักษณะการเรียนการสอนเน้นผู้เรียนเป็นส าคัญ เป็นการจัดการเรียนการสอนที่ผู้เรียนสร้าง
องค์ความรู้ด้วยตนเอง ส่งเสริมการเรียนรู้แบบเครือข่ายเพราะผู้เรียนสามารถติดต่อกับผู้เรียนด้วยกัน
เอง ผู้สอน ผู้เชี่ยวชาญและนักวิจัยจากทั่วทุกมุมโลก ผู้เรียนสามารถเรียนตามเวลาที่ต้องการตาม
สถานที่ท่ีตนเองอยู่ ดังนั้นเป็นการลดข้อจ ากัดในการเรียนเรื่องเวลาและสถานที่ในส่วนของรูปแบบ
ของการเรียนการสอนผ่านเว็บนั้นมีการน าเสนอในรูปแบบที่หลากหลายเป็นการผสมผสานส่ือต่างๆ 
เข้ามาใช้ในการเรียนการสอน มีการน าเสนอบทเรียน การจัดกิจกรรมในการเรียนการสอนที่
หลากหลาย เช่น น าเสนอเป็นข้อความ ภาพเคล่ือนไหว เสียงประกอบ และอาศัยคุณสมบัติของ
อินเทอร์เน็ตเป็นส่ือกลางในการติดต่อส่ือสาร เช่น การสนทนา การอภิปรายและการส่งจดหมาย
อิเล็กทรอนิกส์ ท่ีท าให้การจัดกิจกรรมการเรียนการสอนมีความเสมือนจริงมากที่สุด 
 

2.1.4  รูปแบบการเรียนการสอนบนเว็บช่วยสอน 
เป็นการเรียนการสอนโดยใช้ระบบอินเทอร์เน็ตมาใช้  จึงเป็นการจัดการเรียนการสอน

ทางไกล (distance education) ประเภทหนึ่ง เพราะมีระบบเครือข่ายเชื่อมโยงติดต่อกัน โดยผู้เรียนอยู่
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ต่างสถานที่และห่างไกลกัน การเรียนรู้ลักษณะนี้มีทั้งภาพ เสียง และข้อมูลให้แก่ผู้เรียนซ่ึงสามารถ
เรียนรู้ได้ทั้งในเวลาจริง (real time) และไม่ใช่เวลาจริง (non-real-time) นอกจากนั้นแล้วยังมีการ
ติดต่อส่ือสารกันแบบสองทาง (two-way communication) หรือทางเดียวก็ได้จะติดต่อกันแบบพบหน้า
กันแบบเผชิญหน้า (face to face) ย่อมสามารถท าได้ เนื่องจากมีการเชื่อมโยงเครือข่ายคอมพิวเตอร์ ท า
ให้ผู้ใช้สามารถรับส่งข่าวสารข้อมูลรูปแบบต่าง ๆ ถึงกันได้ด้วยความสะดวกและรวดเร็ว ดังนั้น การ
น าอินเทอร์เน็ตมาใช้ประโยชน์กับการศึกษาจะมีส่วนส าคัญในการพัฒนาการเรียนการสอนได้อย่างมี
ประสิทธิภาพเพราะสามารถน าข้อมูลการศึกษาจากแหล่งข้อมูลต่าง ๆ ทั่วโลกมาใช้ประโยชน์ได้อย่าง
รวดเร็ว  เนื่องจากการรับส่งข้อมูลข่าวสารบนเครือข่ายอินเทอร์เน็ต สามารถท าได้ 2 ลักษณะใหญ่ ๆ 
ด้วยกันคือ การติดต่อในเวลาเดียวกันและการติดต่อต่างเวลากัน ท าให้รูปแบบการเรียนการสอน 
บนเว็บ สามารถแบ่งเป็น 2 ลักษณะคือ 

1.  Synchonous Learning คือ รูปแบบการเรียนการสอนที่มีกิจกรรมการเรียนการสอนใน
เวลาเดียวกัน ผู้เรียนต้องมาเรียนพร้อม ๆ กัน โดยใช้การรับส่งข่าวสารข้อมูลที่ผู้ส่งและผู้รับสาร
ติดต่อกันได้ในเวลาเดียวกันหรือพร้อมกัน เช่น บริการพูดคุยสนทนา (chat) บริการรับส่งข้อความ 
เสียง และภาพ และภาพเคล่ือนไหว เป็นต้น 

2.  Asynchronous Learning คือ รูปแบบการเรียนการสอนบนเว็บ ที่ผู้เรียนและผู้สอน ไม่
จ าเป็นต้องมีกิจกรรมการเรียนการสอนในเวลาเดียวกัน เพราะเป็นรูปแบบการรับส่งข้อมูลข่าวสารที่
ผู้รับและผู้ส่งไม่จ าเป็นต้องท างานพร้อมกัน เช่น บริการจดหมายอิเล็กทรอนิกส์(e-mail) กลุ่มสนทนา 
(newsgroup) รวมทั้งบริการเวิลด์ไวด์เว็บ เป็นต้น ที่เป็นเครือข่าย ข้อมูลความรู้ โดยผู้เรียนจะเข้ามา
เรียนรู้เม่ือใด ที่ไหน ย่อมสามารถท าได้โดยปราศจากข้อจ ากัดใด ๆ ทั้งส้ิน (Zhao, 1998) 

จากการศึกษาความคิดเห็นของนักวิชาการและนักการศึกษา ทั้งภายในประเทศไทยและ
ต่างประเทศ ดังที่กล่าวมาแล้วนั้น สรุปรูปแบบการเรียนการสอนบนเว็บช่วยสอน ได้ว่า รูปแบบการ
เรียนการสอนที่ผู้วิจัยน าไปใช้ในการพัฒนาบทเรียนคือการจัดกิจกรรมการเรียนการสอนในเวลา
เดียวกัน ผู้เรียนต้องมาเรียนพร้อม ๆ กัน เช่น ห้องสนทนา (chat room) และที่ผู้เรียนและผู้สอน ไม่
จ าเป็นต้องมีกิจกรรมการเรียนการสอนในเวลาเดียวกัน เช่น กระดานสนทนา (webboard) 

 
 2.1.5  หลักการจัดการเรียนการสอนบนเวบ็ช่วยสอน 
การจัดการเรียนผ่านเว็บมีลักษณะการเรียนการสอนที่แตกต่างไปจากการเรียนการสอนใน

ชั้นเรียนปกติที่คุ้นเคยกันดี ซ่ึงการจัดการเรียนการสอนแบบดั้งเดิมในชั้นเรียนส่วนใหญ่จะมีลักษณะที่
เน้นให้ผู้สอนเป็นผู้ป้อนความรู้ให้แก่ผู้เรียนท าให้ผู้เรียนไม่ใฝ่ท่ีจะหาความรู้ เพิ่มเติม 
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         การจัดการเรียนการสอนโดยการใช้เว็บช่วยสอนจะมีวิธีการจัดที่แตกต่างไปจากการจัดการ
เรียนการสอนตามปกติ เพราะคุณลักษณะและรูปแบบของเว็บเป็นส่ือที่มีลักษณะเฉพาะของตนเอง ซ่ึง
แตกต่างไปจากการจัดการเรียนการสอนด้วยส่ือแบบอ่ืน ๆ จึงต้องค านึงถึงการออกแบบระบบการ
สอนที่สอดคล้องกับคุณลักษณะของเว็บ เช่น การส่ือสารระหว่างผู้เรียนกับครู การส่ือสารระหว่าง
ผู้เรียนกับผู้เรียน ที่กระท าได้แตกต่างไปจากการเรียนการสอนแบบเดิม เช่น การใช้เว็บช่ วยสอน
สามารถส่ือสารกันได้โดยผ่านเว็บโดยตรงในรูปคุยกันในห้องสนทนา(Chat Room) การฝากข้อความ
บนกระดานอิเล็กทรอนิกส์หรือกระดานข่าวสาร (Bulletin Board) หรือจะส่ือสารกันโดยผ่านไปรษณยี์
อิเล็กทรอนิกส์ (e-mail) ก็สามารถกระท าได้ในระบบนี้ ความเป็นเว็บช่วยสอนจึงไม่ใช่แค่การสร้าง
เว็บไซต์เนื้อหาวิชาหนึ่งหรือรวบรวมข้อมูลซักเรื่องหนึ่งแล้วบอกว่าเป็นเว็บช่วยสอน เว็บช่วยสอนมี
ความหมายกว้างขวางอันเกิดจากการรวมเอาคุณลักษณะของเว็บ โปรแกรมและเครื่องมือส่ือสารใน
ระบบอินเทอร์เน็ตและการออกแบบระบบการเรียนการสอนเข้าด้วยกัน ท าให้เกิดการเรียนรู้ขึ้นอย่างมี
ความหมายไม่เป็นเพียงแค่แหล่งข้อมูลเท่านั้น (ปรัชญนันท์ นิลสุข, 2543) 
         เองเจลโล (Angelo, 1993 อ้างถึงใน วิชุดา รัตนเพียร, 2542) ได้สรุปหลักการพื้นฐานของ
การจัดการเรียนการสอนกับการเรียนการสอนผ่านเว็บ 5 ประการดังนี้คือ 
      1. ในการจัดการเรียนการสอนโดยทั่วไปแล้ว ควรส่งเสริมให้ผู้เรียนและผู้สอนสามารถ
ติดต่อ ส่ือสารกันได้ตลอดเวลา การติดต่อระหว่างผู้เรียนและผู้สอนมีส่วนส าคัญในการสร้างความ
กระตือรือล้นกับการเรียนการสอน โดยผู้สอนสามารถให้ความช่วยเหลือผู้เรียนได้ตลอดเวลาในขณะ
ก าลังศึกษา ทั้งยังช่วยเสริมสร้างความคิดและความเข้าใจ ผู้เรียนที่เรียนผ่านเว็บสามารถสนทนา
แลกเปล่ียนความคิดเห็นรวมท้ังซักถามข้อข้องใจกับผู้สอนได้โดยทันทีทันใด เช่น การมอบหมายงาน
ส่งผ่านอินเทอร์เน็ตจากผู้สอน ผู้เรียนเมื่อได้รับมอบหมายก็จะสามารถท างานที่ได้รับมอบหมายและ
ส่งผ่านอินเทอร์เน็ต กลับไปยังอาจารย์ผู้สอน หลังจากนั้นอาจารย์ผู้สอนสามารถตรวจและให้คะแนน
พร้อมท้ังส่งผลย้อนกลับไปยังผู้เรียนได้ในเวลาอันรวดเร็วหรือในทันทีทันใด 
         2. การจัดการเรียนการสอนควรสนับสนุนให้มีการพัฒนาความร่วมมือระหว่างผู้เรียน ความ
ร่วมมือระหว่างกลุ่มผู้เรียนจะช่วยพัฒนาความคิดความเข้าใจได้ดีกว่าการท างานคนเดียว ทั้งยังสร้าง
ความสัมพันธ์เป็นทีมโดยการแลกเปล่ียนความคิดเห็นระหว่างกันเพื่อหาแนวทางที่ดีที่สุด เป็นการ
พัฒนาการแก้ไขปัญหาการเรียนรู้และการยอมรับความคิดเห็นของคนอ่ืนมาประกอบเพื่อหาแนวทางที่
ดีที่สุด ผูเ้รียนที่เรียนผ่านเว็บแม้ว่าจะเรียนจากคอมพิวเตอร์ที่อยู่กันคนละที่ แต่ด้วยความสามารถของ
เครือข่ายอินเทอร์เน็ตที่เชื่อมโยงเครือข่ายคอมพิวเตอร์ทั่วโลกไว้ด้วยกัน ท าให้ผู้เรียนสามารถ
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ติดต่อส่ือสารกันได้ทันทีทันใด เช่น การใช้บริการสนทนาแบบออนไลน์ที่สนับสนุนให้ผู้ เรียน
ติดต่อส่ือสารกันได้ตั้งแต่ 2 คนขึ้นไปจนถึงผู้เรียนที่เป็นกลุ่มใหญ่ 
         3. ควรสนับสนุนให้ผู้เรียนรู้จักแสวงหาความรู้ด้วยตนเอง (Active Learners) หลีกเล่ียงการ
ก ากับให้ผู้สอนเป็นผู้ป้อนข้อมูลหรือค าตอบ ผู้เรียนควรเป็นผู้ขวนขวายใฝ่หาข้อมูลองค์ความรู้ต่ างๆ 
เองโดยการแนะน าของผู้สอน เป็นที่ทราบดีอยู่แล้วว่าอินเทอร์เน็ตเป็นแหล่งข้อมูลที่ใหญ่ที่สุดในโลก 
ดังนั้นการจัดการเรียนการสอนผ่านเว็บนี้ จะช่วยให้ผู้เรียนสามารถหาข้อมูลได้ด้วยความสะดวกและ
รวดเร็ว ท้ังยังหาข้อมูลได้จากแหล่งข้อมูลทั่วโลกเป็นการสร้างความกระตือรือร้นในการใฝ่หาความรู้ 
         4. การให้ผลย้อนกลับแก่ผู้เรียนโดยทันทีทันใดช่วยให้ผู้เรียนได้ทราบถึงความสามารถของ
ตน อีกทั้งยังช่วยให้ผู้เรียนสามารถปรับแนวทางวิธีการหรือพฤติกรรมให้ถูกต้องได้ ผู้เรียนที่เรียนผ่าน
เว็บ สามารถได้รับผลย้อนกลับจากทั้งผู้สอนเองหรือแม้กระทั่งจากผู้เรียนคนอ่ืนๆ ได้ทันทีทันใด 
แม้ว่าผู้เรียนแต่ละคนจะไม่ได้นั่งเรียนในชั้นเรียนแบบเผชิญหน้ากันก็ตาม 
         5. ควรสนับสนุนการจัดการเรียนการสอนที่ไม่มีขีดจ ากัด ส าหรับบุคคลที่ใฝ่หาความรู้ การ
เรียนการสอนผ่านเว็บเป็นการขยายโอกาสให้กับทุกๆคนที่สนใจศึกษา เนื่องจากผู้เรียนไม่จ าเป็น
จะต้องเดินทางไปเรียน ณ ท่ีใดที่หนึ่ง ผู้ท่ีสนใจสามารถเรียนได้ด้วยตนเองในเวลาท่ีสะดวก จะเห็นได้
ว่าการเรียนการสอนผ่านเว็บนี้มีคุณลักษณะที่ช่วยสนับสนุนหลักพื้นฐานการจัดการเรียนการสอนทั้ง 
5 ประการได้อย่างมีประสิทธิภาพ 
         การเรียนการสอนผ่านเว็บได้มีการด าเนินการอย่างจริงจังท่ัวโลก โดยเฉพาะอย่างยิ่งในกลุ่ม 
ประเทศทางซีกโลกตะวันตก ส าหรับวงการการศึกษาในประเทศไทยเริ่มมีความเปล่ียนแปลงจากเป็น
เพียงผู้รับข้อมูลและสังเกตการณ์การเรียนการสอนบนเครือข่ายเป็นความพยายามในการจัดการเรียน
การสอนและใช้เครื่องมือบนเครือข่ายเวิลด์ไวด์เว็บเสริมในชั้นเรียนปกติ และบางมหาวิทยาลัยที่
ด าเนินการเรียนการสอนแบบทางไกลก าลังด าเนินการที่จะสร้างชั้นเรียนเสมือนให้เกิดขึ้นจริง การ
ด าเนินการเรียนการสอนผ่านเว็บมีรายละเอียดดังต่อไปนี้ (ใจทิพย์ ณ สงขลา, 2542) 
         1. ความพร้อมของเครื่องมือและทักษะการใช้งานเบ้ืองต้น ความไม่พร้อมของเครื่องมือและ 
การขาดทักษะทางเทคนิคที่จ าเป็นในการใช้เครื่องมือหรือโปรแกรมเป็นสาเหตุส าคัญที่ก่อให้เกดิความ 
สับสนและผลทางลบต่อทัศนคติของผู้ใช้ จากการศึกษาการน าเทคโนโลยีเครือข่ายมาใช้พบว่าผู้ ใช้ที่ 
ไม่มีความพร้อมทางทักษะการใช้จะพยายามแก้ปัญหาและศึกษาเรื่องของเทคนิค มากกว่าจ ากัด ความ
สนใจอยู่ที่เนื้อหา นอกจากนั้นจากงานวิจัยของใจทิพย์ ณ สงขลา (2542) พบว่ายังไม่มีความ พร้อม
ทางด้านทักษะการใช้ภาษาเขียนและภาษาต่างประเทศ ซ่ึงเป็นทักษะจ าเป็นพื้นฐานที่จ า เป็นอีก
ประการหนึ่งส าหรับการส่ือสารผ่านเครือข่าย 
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         2. การสนับสนุนจากฝ่ายบริหารและผู้ใช้เช่นเดียวกับการน าเทคโนโลยีอ่ืนเข้าสู่องค์กรต้อง
อาศัยการสนับสนุนอย่างจริงจังจากฝ่ายบริหาร ทั้งในการสนับสนุนด้านเครื่องมือและนโยบาย
ส่งเสริมการใช้เครือข่ายเวิลด์ไวด์เว็บเพื่อประโยชน์ทางการศึกษา การก าหนดการใช้เครื่องมือดังกล่าว
จึงไม่สามารถเป็นไปในลักษณะแนวดิ่ง (Top down) โดยการก าหนดจากฝ่ายบริหารเพียงฝ่ายเดียว แต่
ต้องเป็นการประสานจากทั้งสองฝ่ายคือฝ่ายบริหารและผู้ใช้จะต้องมีการประสานจากแนวล่างขึ้นบน 
ผู้ใช้จะต้องมีทัศนะที่ยอมรับการใช้ส่ือดังกล่าวเพื่อประโยชน์ทางการศึกษา ฝ่ายบริหารสามารถสร้าง
นโยบายที่กระตุ้นแรงจูงใจของผู้ใช้ เช่น สร้างแรงจูงใจจากภายในของผู้ใช้ให้รู้สึกถึงความท้าทายและ
ประโยชน์ที่จะได้รับหรือสร้างแรงจูงใจจากภายนอก เช่น สร้างเงื่อนไขผลตอบแทนพิเศษทั้งในรูป
นามธรรมและรูปธรรม 
         3.  การเปล่ียนพฤติกรรมผู้เรียนจากการเรียนรู้แบบตั้งรับ (Passive) โดยพึ่งพิงการป้อนจาก
ครูผู้สอนมาเป็นพฤติกรรมการเรียนที่สอดคล้องกับการเรียนรู้แบบผู้เรียนเป็นศูนย์กลาง กล่าวคือ เป็น
ผู้เรียนที่เรียนรู้วิธีการเรียน (Learning How to learn) เป็นผู้เรียนที่กระตือรือร้นและมีทักษะที่สามารถ
เลือกรับข้อมูล วิเคราะห์ และสังเคราะห์ข้อมูลได้อย่างมีระบบนั้น ผู้สอนจะต้องสร้างวุฒิทางการเรียน
ให้เกิดกับผู้ เรียนก่อน กล่าวคือจะต้องเตรียมการให้ผู้เรียนพัฒนาทักษะพื้นฐานที่จ าเป็นต่อการ
เลือกสรร วิเคราะห์และสังเคราะห์ในการเรียนผ่านเครือข่ายทักษะดังกล่าว ได้แก่ ทักษะการอ่านเขียน 
ทักษะในเชิงภาษา ทักษะในการอภิปรายและที่จ าเป็นคือ ทักษะในการควบคุมตรวจสอบการเรียนรู้
ของตนเอง 
         4.  บทบาทของผู้สอนในการเรียนการสอนบนเครือข่าย จะต้องมีการเปล่ียนแปลงไปสู่
บทบาทที่เอ้ือต่อการเรียนการสอนที่ผู้เรียนเป็นศูนย์กลาง โดยในเบื้องต้นจะเป็นบทบาทผู้น าเพื่อ
สนับสนุนกลุ่มและวัฒนธรรมการเรียนรู้บนเครือข่าย ผู้สอนต้องใช้เวลามากไปกว่าการเรียนการสอน
ในชั้นเรียนธรรมดา 
         5.  การสร้างความจ าเป็นในการใช้ ผู้สอนที่จะน าการเรียนการสอนผ่านเครือข่ายมาใช้ควร
ค านึงถึงความจ าเป็นและผลประโยชน์ที่ต้องการจากกิจกรรมบนเครือข่าย ซ่ึงจะเป็นตัวก าหนด
รูปแบบการใช้ว่าผู้สอนเพียงต้องการใช้เครือข่ายเพื่อเสริมการเรียนหรือเป็นการศึกษาทางไกล ผู้สอน
ต้องสร้างสภาวะให้ผู้ใช้มีความจ าเป็นที่ต้องใช้เช่น การส่งผ่านข้อมูลที่จ าเป็นทางการเรียนให้กับผู้ใช้
ผ่านทางเครือข่ายหรือสร้างแรงจูงใจที่เป็นผลประโยชน์ทางการเรียนให้กับผู้ใช้ 
         6.  ผู้สอนต้องออกแบบการเรียนการสอนและใช้ประโยชน์ของความเป็นเครือข่ายอย่าง
สูงสุด และเหมาะสมวิธีออกแบบการเรียนการสอนควรต้องพัฒนาให้เข้ากับคุณสมบัติ ความเป็น
คอมพิวเตอร์เครือข่ายซ่ึงมีความแตกต่างจากการออกแบบส าหรับโปรแกรมช่วยสอนในคอมพิวเตอร์
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ทั่วไป นอกเหนือจากเนื้อหาบทเรียนที่ผู้สร้างเสนอส่งผ่านเครือข่าย ผู้สอนสามารถสร้างการเชื่อมโยง
แหล่งข้อมูลอ่ืนที่สนับสนุนเนื้อหาหลักที่ผู้สอนสร้างเป็นการแนะแนวทางให้ผู้ เรียนได้ศึกษา ทั้งนี้
เนื้อหาและการเชื่อมโยง ควรจะต้องปรับปรุงให้ทันสมัยตลอดเวลาและควรจะต้องมีการจัดกิจกรรม
การปฏิสัมพันธ์ให้ผู้เรียนได้ประโยชน์จากการศึกษาร่วมกับผู้อ่ืน การจัดการเรียนการสอนผ่านเว็บนั้น 
ผู้สอนและผู้เรียนจะต้องมีปฏิสัมพันธ์กันโดยผ่านระบบเครือข่ายคอมพิวเตอร์ ที่เชื่อมโยงคอมพิวเตอร์
ของผู้เรียนเข้าไว้กับเครื่องคอมพิวเตอร์ของผู้ให้บริการเครือข่าย (File Server) และเครื่องคอมพิวเตอร์
ของผู้ให้บริการเว็บ (Web Server) อาจเป็นเป็นการเชื่อมโดยระยะใกล้หรือเชื่อมโยงระยะไกลผ่านทาง
ระบบการส่ือสารและอินเทอร์เน็ต การจัดการเรียน การสอนทางอินเทอร์เน็ตที่เป็นเว็บนั้นผู้สอน
จะต้องมีขั้นตอนการจัดการเรียนการสอนดังนี้ (ปทีป เมธาคุณวุฒิ, 2540) 
         1. ก าหนดวัตถุประสงค์ของการเรียนการสอน 

2. การวิเคราะห์ผู้เรียน 
         3. การออกแบบเนื้อหารายวิชา 
          - เนื้อหาตามหลักสูตรและสอดคล้องกับความต้องการของผู้เรียน 

- จัดล าดับเนื้อหา จ าแนกหัวข้อตามหลักการเรียนรู้และลักษณะเฉพาะในแต่ละ   
   หัวข้อ 

          - ก าหนดระยะเวลาและตารางการศกึษาในแต่ละหัวข้อ 
         - ก าหนดวิธีการศกึษา 
          - ก าหนดส่ือที่ใช้ประกอบการศกึษาในแต่ละหัวข้อ 
          - ก าหนดวิธีการประเมินผล 
         - ก าหนดความรู้และทักษะพื้นฐานทีจ่ าเป็นต่อการเรียน 
          - สร้างประมวลรายวิชา 
         4.  การก าหนดกิจกรรมการเรียนการสอนทางอินเทอร์เน็ต โดยใช้คุณสมบัติของ
อินเทอร์เน็ตที่เหมาะสมกับกิจกรรมการเรียนการสอนนั้นๆ 
         5. การเตรียมความพร้อมส่ิงแวดล้อมการเรียนการสอนทางอินเทอร์เน็ต ได้แก่ ส ารวจแหล่ง
ทรัพยากรสนับสนุนการเรียนการสอนที่ผู้เรียนสามารถเชื่อมโยงได้ ก าหนดสถานที่และอุปกรณ์ที่
ให้บริการและที่ต้องใช้ในการติดต่อทางอินเทอร์เน็ตสร้างเว็บเพจเนื้อหาความรู้ตามหัวข้อของการ
เรียนการสอนรายสัปดาห์ สร้างแฟ้มข้อมูลเนื้อหาวิชาเสริมการเรียนการสอนส าหรับการถ่ายโอน
แฟ้มข้อมูล 
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         6. การปฐมนิเทศผู้เรียน ได้แก่ 
          - แจ้งวัตถุประสงค์ เนื้อหา และวิธีการเรียนการสอน 
          - ส ารวจความพร้อมของผู้เรียนและเตรียมความพร้อมของผู้เรียน ในขั้นตอนนี้
ผู้สอนอาจจะต้องมีการทดสอบหรือสร้างเว็บเพจเพิ่มขึ้น เพื่อให้ผู้เรียนที่มีความรู้พื้นฐานไม่เพียงพอ
ได้ศึกษาเพิ่มเติมในเว็บเพจเรียนเสริมหรือให้ผู้เรียนถ่ายโอนข้อมูลจากแหล่งต่างๆ ไปศึกษาเพิ่มเติม
ด้วยตนเอง 
         7. จัดการเรียนการสอนตามแบบที่ก าหนดไว้ โดยในเว็บเพจจะมีเทคนิคและกิจกรรมต่างๆ 
ที่สามารถสร้างขึ้นได้แก่ 
          - การใช้ข้อความเร้าความสนใจที่อาจเป็นภาพกราฟฟกิส์ ภาพการเคล่ือนไหว 
          - แจ้งวัตถุประสงค์เชิงพฤตกิรรมของรายวิชา หรือหัวข้อในแต่ละสัปดาห์ 
          - สรุปทบทวนความรู้เดิม หรือโยงไปหัวข้อที่ศึกษาแล้ว 
          - เสนอสาระของหัวข้อต่อไป 
         - เสนอแนะแนวทางการเรียนรู้ เช่น กิจกรรมสนทนาระหว่างผู้สอนกับผู้เรียน
และระหว่างผู้เรียนกับผู้เรียนกิจกรรมการอภิปรายกลุ่ม กิจกรรมการค้นคว้าหาข้อมูลเพิ่มเติม กิจกรรม
การตอบ ค าถาม กิจกรรมการประเมินตนเอง และกิจกรรมการถ่ายโอนข้อมูล  
         - เสนอกิจกรรมดังกล่าวมาแล้ว แบบฝึกหัด หนังสือหรือบทความ การบ้าน การ
ท ารายงานเดี่ยว รายงานกลุ่มในแต่ละสัปดาห์ และแนวทางในการประเมินผลในรายวิชานี้ 
          - ผู้เรียนท ากิจกรรม ศึกษา ท าแบบฝึกหัด และการบ้านส่งผู้สอนทั้งทางเอกสาร
ทางเว็บเพจผลงานของผู้เรียนเพื่อให้ผู้เรียนคนอ่ืนๆได้รับทราบด้วยและผู้เรียนส่งผ่านทางไปรษณีย์
อิเล็กทรอนิกส์  
          - ผู้สอนตรวจผลงานของผู้เรียน ส่งคะแนนและข้อมูลย้อนกลับเข้าสู่เว็บเพจ
ประวัติของผู้เรียน รวมท้ังการให้ความคิดเห็นและข้อเสนอแนะต่างๆ ไปสู่เว็บเพจผลงานของผู้เรียน
ด้วย 
         8. การประเมินผล ผู้สอนสามารถใช้การประเมินผลระหว่างเรียนและการประเมินผลเมื่อ
ส้ินสุดการเรียน รวมท้ังการที่ผู้เรียนประเมินผลผู้สอนและการประเมินผลการจัดการเรียนการสอนทั้ง
รายวิชา เพื่อให้ผู้สอนน าไปปรับปรุงแก้ไขระบบการเรียนการสอนทางอินเทอร์เน็ต 
 จากการศึกษาความคิดเห็นของนักวิชาการและนักการศึกษา ทั้งภายในประเทศไทยและ
ต่างประเทศ ดังที่กล่าวมาแล้วนั้น สรุปหลักการจัดการเรียนการสอนบนเว็บช่วยสอนได้ ดังนี้ คือ การ
จัดการเรียนการสอนที่เน้นผู้เรียนเป็นศูนย์กลาง ครูเป็นเพียงผู้ชี้แนะเท่านั้น โดยที่ผู้เรียนและผู้สอน
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สามารถติดต่อส่ือสารกันได้ตลอดเวลา สนับสนุนให้มีการพัฒนาความคิดหรือร่วมมือกันระหว่างกลุ่ม  
ให้ผู้เรียนรู้จักแสวงหาความรู้ด้วยตนเอง การให้ผลย้อนกลับแก่ผู้เรียนทันที และการจัดการเรียนการ
สอนที่ไม่มีขีดจ ากัดส าหรับผู้ที่ใฝ่หาความรู้ 
 
 2.1.6 การออกแบบการเรียนการสอนบนเวบ็ช่วยสอน 
         ในการออกแบบและพัฒนาเว็บการเรียนการสอนผ่านเว็บให้มีประสิทธิภาพนั้นมีนักการ
ศึกษาหลายท่านให้ข้อเสนอแนะเกี่ยวกับกระบวนการที่จะใช้เป็นแนวทางในการออกแบบการเรียน
การสอน ดังนี้ 

Heinich & Others (1982 อ้างถึงใน วราภรณ์ ตระกูลสฤษดิ์, 2545) ได้น าโมเดล ASSURE 
มาใช้ในการออกแบบการเรียนการสอนบนเว็บได้ ซ่ึงมีรายละเอียด ดังนี้ 

1. วิเคราะห์คุณลักษณะผู้เรียน (analyze learner characteristics) 
2. ล าดับขั้นจุดประสงค์ (state objective) 
3. เลือกและปรับ หรือออกแบบวัสดุ (select modify or design materials) 
4. การใช้วัสดุ (materials) 
5. ตอบสนองความต้องการของผู้เรียน (require learner response) 
6. ประเมินผล (evaluation) 

         ดิลลอน (Dillon, 1991) ได้ให้แนวคิดเกี่ยวกับขั้นตอนในการสร้างบทเรียนที่มีลักษณะเป็น
ส่ือหลายมิติ (Hypermedia) ซ่ึงหลักการนี้สามารถน าไปประยุกต์ใช้ในการออกแบบและพัฒนาเว็บเพื่อ
การเรียนการสอน แนวคิดดังกล่าวมีขั้นตอน ดังนี้ 
         1. ศึกษาเกี่ยวกับผู้ เรียนและเนื้อหาที่จะน ามาพัฒนาเพื่อก าหนดวัตถุประสงค์และหา
แนวทางในการจัดกิจกรรมการเรียน 
         2. วางแผนเกี่ยวกับการจัดรูปแบบโครงสร้างของเนื้อหา ศึกษาคุณลักษณะของเนื้อหาที่จะ
น า มาใช้เป็นบทเรียนว่าควรจะน าเสนอในลักษณะใด 
         3. ออกแบบโครงสร้างเพื่อการเข้าถึงข้อมูลอย่างมีประสิทธิภาพ โดยผู้ออกแบบควรศึกษา
ท าความเข้าใจกับโครงสร้างของบทเรียนแบบต่างๆ โดยพิจารณาจากลักษณะผู้เรียนและเนื้อหาว่า
โครงสร้างลักษณะใดจะเอ้ืออ านวยต่อการเข้าถึงข้อมูลของผู้เรียนได้ดีที่สุด 
         4. ทดสอบรูปแบบเพื่อหาข้อผิดพลาด จากนั้นท าการปรับปรุงแก้ไขและทดสอบซ้ าอีกครั้ง
จน แน่ใจว่าเป็นบทเรียนที่มีประสิทธิภาพก่อนที่จะน าไปใช้งาน 



27 
 

         ฮิรูมิ และ เบอร์มูเดส (Hirumi and Bermudez, 1996) เสนอกระบวนการในการออกแบบ
และพัฒนาการเรียนการสอนผ่านเว็บไว้ 5 ขั้นตอน คือ 
         1. วิเคราะห์ทรัพยากรต่างๆ ท่ีเกี่ยวข้อง 
         2. ออกแบบการเรียนการสอน 
         3. พัฒนาเว็บเพจโดยใช้แผนโครงเรื่อง (Storyboard) ช่วยในการสร้างและก าหนด
โครงสร้างของข้อมูล 
         4. น าเว็บไปใช้ในการเรียนการสอน 
         5. ประเมินผลการใช้งาน 
         อาแวนิติส (Arvanitis, 1997) ได้ให้ข้อเสนอแนะว่าในการสร้างเว็บไซต์นั้น ควรจะ
ด าเนินการ ตามขั้นตอนต่อไปนี้ 
         1. ก าหนดวัตถุประสงค์ โดยพิจารณาว่าเป้าหมายของการสร้างเว็บไซต์นี้เพื่ออะไร 
         2. ศึกษาคุณลักษณะของผู้ที่จะเข้ามาใช้ ว่ากลุ่มเป้าหมายใดที่ผู้สร้างต้องการส่ือสาร ข้อมูล 
อะไรที่พวกเขาต้องการ โดยขั้นตอนนี้ควรจะปฏิบัติควบคู่ไปกับขั้นตอนที่หนึ่ง 
         3. วางลักษณะโครงสร้างของเว็บ  
         4. ก าหนดรายละเอียดให้กับโครงสร้าง ซ่ึงพิจารณาจากวัตถุประสงค์ที่ตั้งไว้โดยตั้งเกณฑ์
ใน การใช้ เช่น ผู้ใช้ควรจะท าอะไรบ้าง จ านวนหน้าควรมีเท่าใด มีการเชื่อมโยงมากน้อยเพียงไร 
         5. หลังจากนั้นจึงท าการสร้างเว็บแล้วน าไปทดลอง เพื่อหาข้อผิดพลาดและท าการปรับปรุง 
แก้ไข แล้วจึงค่อยน าเข้าสู่เครือข่ายอินเทอร์เน็ตเป็นขั้นตอนสุดท้าย 
         เพอร์นิสิ และ คาสาติ (Pernici and Casati, 1997) ได้แยกย่อยกระบวนการออกเป็น 4 
ขั้นตอน ดังนี้ 
           1. การวิเคราะห์องค์ประกอบต่างๆ ที่จ าเป็นต่อการออกแบบ ซ่ึงประกอบด้วยการตั้ง
วัตถุประสงค์ การก าหนดผู้เรียน และส่ิงท่ีจ าเป็นในด้านฮาร์ดแวร์และซอฟต์แวร์ 
         2. ผู้สอนต้องก าหนดแนวทางในการสร้างเว็บไซต์ ได้แก่ เนื้อหาที่จะใช้ กิจกรรมต่างๆ 
ขั้นตอนการเรียนการสอน 
         3. เป็นการออกแบบในแนวกว้าง (Design in the Large) โดยผู้สอนจะต้องวางแผนลักษณะ
การเข้าสู่เนื้อหา (Navigation) ซ่ึงรวมถึงการก าหนดรายการต่างๆ (Menus) และการเรียงล าดับของ
ข้อมูล 
         4. เป็นการออกแบบในแนวแคบ (Design in the Small) คือการก าหนดรายละเอียดต่างๆ ที่มี
ในแต่ละหน้า 
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         ควินแลน (Quinlan, 1997) เสนอวิธีด าเนินการ 5 ขั้นตอนเพื่อการออกแบบและพัฒนาการ
เรียนการสอนผ่านเว็บท่ีมีประสิทธิภาพ คือ 
         1. ท าการวิเคราะห์ความต้องการของผู้เรียน รวมท้ังจุดแข็งและจุดอ่อน ของผู้เรียน 
           2. การก าหนดเป้าหมาย วัตถุประสงค์ และกิจกรรม 
         3. ควรเลือกเนื้อหาท่ีจะใช้น าเสนอพร้อมกับหางานวิจัยอ่ืนๆ ท่ีเกี่ยวข้องและช่วยสนับสนุน
เนื้อหา 
         4. การวางโครงสร้างและจัดเรียงล าดับข้อมูลรวมทั้งก าหนดสารบัญ เครื่องมือ การเข้าสู่
เนื้อหา (Navigational Aids) โครงร่างหน้าจอและกราฟิกประกอบ 
         5. ด าเนินการสร้างเว็บไซต์โดยอาศัยแผนโครงเรื่อง 
         โจนส์และฟาร์เควอร์ (Jones and Farquar, 1997) ได้แนะน าหลักการออกแบบเบื้องต้นที่จะ
เป็นจุดเริ่มในการพัฒนาเว็บเพื่อการเรียนการสอน ดังนี้ 
         1. ควรมีการจัดโครงสร้างหรือจัดระเบียบข้อมูลที่ชัดเจน การที่เนื้อหามีความต่อเนื่องไปไม่
ส้ินสุดหรือกระจายมากเกินไปอาจท าให้เกิดความสับสนต่อผู้ใช้ได้ ฉะนั้นจึงควรออกแบบให้มี
ลักษณะที่ชัดเจนแยกย่อยออกเป็นส่วนต่างๆจัดหมวดหมู่ในเรื่องท่ีสัมพันธ์กัน รวมท้ังอาจมีการแสดง
ให้ผู้ใช้เห็นแผนที่โครงสร้างเพื่อป้องกันความสับสนได้ 
         2. ก าหนดพื้นที่ส าหรับการเลือก (Selectable Areas) ให้ชัดเจนซ่ึงโดยทั่วไปจะมีมาตรฐาน
ที่ชัดเจนอยู่แล้วเช่น ลักษณะของไฮเปอร์เท็กซ์ที่เป็นค าสีฟ้าและขีดเส้นใต้ พยายามหลีกเล่ียงการ
ออกแบบที่ขัดแย้งกับมาตรฐานทั่วไปท่ีคนส่วนใหญ่ใช้ยกเว้นจะมีความจ าเป็นที่ต้องใช้ นอกจากนี้ยัง
รวมไปถึงการท าให้ตัวเลือกเกิดการเปล่ียนแปลง ซ่ึงปกติเมื่อมีการคลิกค าหรือข้อความใดๆ เมื่อ
กลับมาท่ีหน้าเดิมค าหรือข้อความนั้นๆ ก็จะเปล่ียนจากสีฟ้าเป็นสีแดงเข้มเพื่อบอกให้ทราบว่าผู้ใช้ได้
เลือกส่วน นั้นไปแล้ว ในการออกแบบจึงควรใช้มาตรฐานเดิมแบบนี้เช่นกัน 
          3. ก าหนดให้แต่หน้าจอภาพส้ันๆ ทั้งนี้จากการวิจัยพบว่าผู้ใช้ไม่ชอบการเล่ือนขึ้นลง 
(Scroll) (Nielsen, 1996 อ้างถึงใน Jones and Farquar, 1997) อีกทั้งยังเสียเวลาในการโหลดนานและ
ยุ่งยาก ต่อการพิมพ์ที่ผู้ใช้ต้องการเนื้อหาเพียงบางส่วน แต่ถ้ามีความจ าเป็นต้องใช้หน้ายาวก็ควร
ก าหนดเป็นพื้นที่แต่ละส่วนของหน้า โดยให้ผู้เรียนสามารถเลือกไปยังจุดต่างๆ ได้ในหน้าเดียวใน
ลักษณะของบุ๊คมาร์ค (Bookmark) 
         4. ลักษณะการเชื่อมโยงท่ีปรากฏในแต่ละหน้า หากมีทั้งการเชื่อมโยงในหน้าเดียวกันและ
การเชื่อมโยงไปยังหน้าอ่ืนๆหรือออกจากหน้าจอไปยังหน้าจอใหม่จะก่อให้เกิดการสับสนได้ 
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โดยเฉพาะอย่างยิ่งถ้าผู้เรียนใช้ปุ่มมาตรฐานที่มีอยู่ในโปรแกรมค้นผ่าน (Web Browser) อาจท าให้
ผู้เรียนหลงทางได้ ฉะนั้นจึงต้องออกแบบให้มีความแตกต่างและชัดเจน 
         5. ต้องระวังเรื่องของต าแหน่งในการเชื่อมโยง การที่จ านวนการเชื่อมโยงมากและกระจัด 
กระจายอยู่ทั่วไปในหน้าอาจก่อให้เกิดความสับสน การออกแบบที่ดีควรจัดการเชื่อมโยงไปยังหน้า
อ่ืนๆ อยู่รวมกันเป็นสัดส่วนมีล าดับก่อนหลังหรือมีหมายเหตุประกอบ เช่น จัดรวมไว้ส่วนล่างของ
หน้าจอ เป็นต้น 
          6. ความเหมาะสมของค าท่ีใช้เชื่อมโยง ค าที่ใช้ส าหรับการเชื่อมโยงจะต้องเข้าใจง่ายมีความ 
ชัดเจนและไม่ส้ันจนเกินไป 
         7. ความส าคัญของข้อมูลควรอยู่ส่วนบนของหน้าจอภาพ หลีกเล่ียงการใช้กราฟิกด้านบน
ของหน้าจอเพราะถึงแม้จะดูดีแต่ผู้เรียนจะเสียเวลาในการได้รับข้อมูลที่ต้องการ 
           ส าหรับนักวิชาการศึกษาในประเทศไทยได้กล่าวถึง การออกแบบการเรียนการสอนผ่าน
เว็บไว้หลายท่านดังนี้ 
        ปทีป เมธาคุณวุฒิ (2540) กล่าวว่าการออกแบบโครงสร้างของการเรียนการสอนผ่านเว็บ
ควรจะประกอบด้วย  
         1. ข้อมูลเกี่ยวกับรายวิชา ภาพรวมรายวิชา (Course Overview) แสดงวัตถุประสงค์ของ
รายวิชา สังเขปรายวิชาค าอธิบาย เกี่ยวกับหัวข้อการเรียน หรือหน่วยการเรียน 
        2. การเตรียมตัวของผู้เรียนหรือการปรับพื้นฐานผู้เรียน เพื่อที่จะเตรียมตัวเรียน  
         3. เนื้อหาบทเรียน พร้อมท้ังการเชื่อมโยงไปยังส่ือสนับสนุนต่างๆในเนื้อหาบทเรียนนั้นๆ  
         4. กิจกรรมที่มอบหมายให้ท าพร้อมท้ังการประเมินผล การก าหนดเวลาเรียนการส่งงาน  
         5. แบบฝึกหัดที่ผู้เรียนต้องการฝึกฝนตนเอง  
         6. การเชื่อมโยงไปแหล่งทรัพยากรที่สนับสนุนการศึกษาค้นคว้า  
         7. ตัวอย่างแบบทดสอบ ตัวอย่างรายงาน  
         8. ข้อมูลทั่วไป (Vital Information) แสดงข้อความที่จะติดต่อผู้สอนหรือผู้ที่เกี่ยวข้องการ
ลงทะเบียนค่าใช้จ่าย การได้รับหน่วยกิตและการเชื่อมโยงไปยังสถานศึกษาหรือหน่วยงานและมีการ
เชื่อมโยงไปสู่รายละเอียดของหน้าที่เกี่ยวข้อง 
         9. ส่วนแสดงประวัติของผู้สอนและผู้ท่ีเกี่ยวข้อง  
         10. ส่วนของการประกาศข่าว (Bulletin Board)  
         11. ห้องสนทนา (Chat Room) ที่เป็นการสนทนาในกลุ่มผู้เรียนและผู้สอน 
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        จากการศึกษางานวิจัยที่เกี่ยวข้องสามารถสรุปขั้นตอนในการออกแบบการเรียนการสอน
บนเว็บได้ดังนี้ 

1.  ศึกษาเกี่ยวกับผู้ เรียนและเนื้อหาที่จะน ามาพัฒนาเพื่อก าหนดวัตถุประสงค์และหา
แนวทางในการจัดกิจกรรมการเรียน 

2.  วางแผนและออกแบบโครงสร้างของเนื้อหา ศึกษาคุณลักษณะของเนื้อหาที่จะน ามาใช้
เป็นบทเรียนว่าควรจะน าเสนอในลักษณะใด และควรจัดกิจกรรมอย่างไร 

3.  ออกแบบและพัฒนาเว็บเพจโดยใช้โครงสร้างของเนื้อหามาช่วยในการสร้างและก าหนด
โครงสร้างของข้อมูล โดยในเว็บเพจจะต้องมีการแสดงเนื้อหาบทเรียนและกิจกรรมการให้ผู้เรียนเข้า
ไปเรียนได้อย่างอิสระไม่มีข้อจ ากัดทางสถานที่และเวลา และอนุญาตให้มีการติดต่อส่ือสารทั้งแบบ
เวลาเดียว (Synchronous Communication) เช่น Chat และต่างเวลากัน (Asynchronous 
Communication) เช่น Web Board  เป็นต้น 

4.  น าไปทดลองเพื่อหาข้อผิดพลาดและท าการปรับปรุง แก้ไข แล้วจึงค่อยน าไปใช้ 
 
2.1.7  ประโยชน์การเรียนการสอนบนเว็บช่วยสอน 

         ประโยชน์ของการเรียนการสอนผ่านเว็บมี มากมายหลายประการ ทั้งนี้ขึ้นอยู่กับ
วัตถุประสงค์ของการน าไปใช้ในการจัดการเรียนการสอน ซ่ึงเป็นมิติใหม่ของเครื่องมือและ
กระบวนการในการเรียนการสอน โดยมีผู้กล่าวถึงประโยชน์ของการเรียนการสอนผ่านเว็บไว้ดังนี้ 
         ถนอมพร เลาหจรัสแสง (2544) ได้กล่าวถึงการสอนบนเว็บมีข้อดีอยู่หลายประการ 
กล่าวคือ 
         1. การสอนบนเว็บเป็นการเปิดโอกาสให้ผู้เรียนที่อยู่ห่างไกล หรือไม่มีเวลาในการมาเข้าช้ัน
เรียนได้เรียนในเวลาและสถานที่ ๆ ต้องการ ซ่ึงอาจเป็นที่บ้าน ที่ท างาน หรือสถานศึกษาใกล้เคียงที่
ผู้เรียนสามารถเข้าไปใช้บริการทางอินเทอร์เน็ตได้ การที่ผู้เรียนไม่จ าเป็นต้องเดินทางมายังสถานศึกษา
ที่ก าหนดไว้จึงสามารถช่วยแก้ปัญหาในด้านของข้อจ ากัดเกี่ยวกับเวลา และสถานที่ศึกษาของผู้เรียน
เป็นอย่างดี 
         2. การสอนบนเว็บยังเป็นการส่งเสริมให้เกิดความเท่าเทียมกันทางการศึกษา ผู้เรียนที่ศึกษา
อยู่ในสถาบันการศึกษาในภูมิภาคหรือในประเทศหนึ่งสามารถที่จะศึกษา ถกเถียง อภิปราย กับอาจารย ์
ครูผู้สอนซ่ึงสอนอยู่ที่สถาบันการศึกษาในนครหลวงหรือในต่างประเทศก็ตาม 
         3. การสอนบนเว็บนี้ ยังช่วยส่งเสริมแนวคิดในเรื่องของการเรียนรู้ตลอดชีวิต เนื่องจากเว็บ
เป็นแหล่งความรู้ที่เปิดกว้างให้ผู้ท่ีต้องการศึกษาในเรื่องใดเรื่องหนึ่ง สามารถเข้ามาค้นคว้าหาความรู้
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ได้อย่างต่อเนื่องและตลอดเวลาการสอนบนเว็บ สามารถตอบสนองต่อผู้เรียนที่มีความใฝ่รู้รวมทั้งมี
ทักษะในการตรวจสอบการเรียนรู้ด้วยตนเอง (Meta-cognitive Skills) ได้อย่างมีประสิทธิภาพ 
         4. การสอนบนเว็บ ช่วยทลายก าแพงของห้องเรียนและเปล่ียนจากห้องเรียน 4 เหล่ียมไปสู่
โลกกว้างแห่งการเรียนรู้ เปิดโอกาสให้ผู้เรียนสามารถเข้าถึงแหล่งข้อมูลต่างๆได้อย่างสะดวกและมี
ประสิทธิภาพสนับสนุนส่ิงแวดล้อมทางการเรียนที่เชื่อมโยงส่ิงท่ีเรียนกับปัญหาท่ีพบในความเป็นจริง 
โดยเน้นให้เกิดการเรียนรู้ตามบริบทในโลกแห่งความเป็นจริง  (Contextualization) และการเรียนรู้จาก
ปัญหา (Problem-based Learning) ตามแนวคิดแบบ Constructivism 
         5. การสอนบนเว็บเป็นวิธีการเรียนการสอนที่มีศักยภาพ เนื่องจากที่เว็บได้กลายเป็นแหล่ง
ค้นคว้าข้อมูลทางวิชาการรูปแบบใหม่ครอบคลุมสารสนเทศทั่วโลกโดยไม่จ ากัดภาษา การสอนบน
เว็บช่วยแก้ปัญหาของข้อจ ากัดของแหล่งค้นคว้าแบบเดิมจากห้องสมุดอันได้แก่ ปัญหาทรัพยากร
การศึกษาที่มีอยู่จ ากัดและเวลาที่ใช้ในการค้นหาข้อมูล เนื่องจากเว็บมีข้อมูลที่หลากหลายและเป็น
จ านวนมาก รวมท้ังการที่เว็บใช้การเชื่อมโยงในลักษณะของไฮเปอร์มิเดีย (ส่ือหลายมิติ) ซ่ึงท าให้การ
ค้นหาท าได้สะดวกและง่ายดายกว่าการค้นหาข้อมูลแบบเดิม 
         6. การสอนบนเว็บจะช่วยสนับสนุนการเรียนรู้ที่กระตือรือร้น ทั้งนี้เนื่องจากคุณลักษณะ
ของเว็บที่เอ้ืออ านวยให้เกิดการศึกษา ในลักษณะที่ผู้เรียนถูกกระตุ้นให้แสดงความคิดเห็นได้อยู่
ตลอดเวลา โดยไม่จ าเป็นต้องเปิดเผยตัวตนที่แท้จริง ตัวอย่างเช่น การให้ผู้เรียนร่วมมือกันในการท า
กิจกรรมต่าง ๆ บนเครือข่ายการให้ผู้เรียนได้มีโอกาสแสดงความคิดเห็นและแสดงไว้บนเว็บบอร์ด
หรือการให้ผู้เรียนมีโอกาสเข้ามาพบปะกับผู้เรียนคนอ่ืน ๆ อาจารย์ หรือผู้เชี่ยวชาญในเวลาเดียวกันที่
ห้องสนทนา เป็นต้น 
         7. การสอนบนเว็บเอ้ือให้เกิดการปฏิสัมพันธ์ ซ่ึงการเปิดปฏิสัมพันธ์นี้อาจท าได้ 2 รูปแบบ 
คือ ปฏิสัมพันธ์กับผู้เรียนด้วยกันและ/หรือผู้สอน ปฏิสัมพันธ์กับบทเรียนในเนื้อหาหรือส่ือการสอน
บนเว็บ ซ่ึงลักษณะแรกนี้จะอยู่ในรูปของการเข้าไปพูดคุย พบปะ แลกเปล่ียน ความคิดเห็นกัน ส่วนใน
ลักษณะหลังนั้นจะอยู่ในรูปแบบของการเรียนการสอน แบบฝึกหัดหรือแบบทดสอบท่ีผู้สอนได้จัดหา
ไว้ให้แก่ผู้เรียน 
          8. การสอนบนเว็บยังเป็นการเปิดโอกาสส าหรับผู้เรียนในการเข้าถึงผู้เชี่ยวชาญสาขาต่าง ๆ 
ทั้งในและนอกสถาบันจากในประเทศและต่างประเทศทั่วโลก โดยผู้เรียนสามารถติดต่อสอบถาม
ปัญหาขอข้อมูลต่าง ๆ ท่ีต้องการศึกษาจากผู้เชี่ยวชาญจริงโดยตรงซ่ึงไม่สามารถท าได้ในการเรียนการ
สอนแบบดั้งเดิม นอกจากนี้ยังประหยัดทั้งเวลาและค่าใช้จ่ายเมื่อเปรียบเทียบกับการติดต่อส่ือสารใน
ลักษณะเดิม ๆ 
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        9. การสอนบนเว็บเปิดโอกาสให้ผู้เรียนได้มีโอกาสแสดงผลงานของตน สู่สายตาผู้อ่ืนอย่าง
ง่ายดาย ท้ังนี้ไม่ได้จ ากัดเฉพาะเพื่อนๆ ในชั้นเรียนหากแต่เป็นบุคคลทั่วไปท่ัวโลกได้ ดังนั้นจึงถือเป็น
การสร้างแรงจูงใจภายนอกในการเรียนอย่างหนึ่งส าหรับผู้เรียน ผู้เรียนจะพยายามผลิตผลงานที่ดีเพื่อ
ไม่ให้เสียชื่อเสียงตนเองนอกจากนี้ผู้เรียนยังมีโอกาสได้เห็นผลงานของผู้อ่ืนเพื่อน ามาพัฒนางานของ
ตนเองให้ดียิ่งขึ้น 
         10. การสอนบนเว็บเปิดโอกาสให้ผู้สอนสามารถปรับปรุงเนื้อหาหลักสูตร ให้ทันสมัยได้
อย่าง สะดวกสบายเนื่องจากข้อมูลบนเว็บมีลักษณะเป็นพลวัตร ( Dynamic ) ดังนั้นผู้สอนสามารถ
อัพเดตเนื้อหาหลักสูตรที่ทันสมัยแก่ผู้เรียนได้ตลอดเวลา นอกจากนี้การให้ผู้เรียนได้ส่ือสารและแสดง
ความคิดเห็นที่เกี่ยวข้องกับเนื้อหา ท าให้เนื้อหาการเรียนมีความยืดหยุ่นมากกว่าการเรียนการสอน
แบบเดิมและเปล่ียนแปลงไปตามความต้องการของผู้เรียนเป็นส าคัญ การสอนบนเว็บสามารถน าเสนอ
เนื้อหาในรูปของมัลติมีเดีย ได้แก่ ข้อความ ภาพนิ่ง เสียง ภาพเคล่ือนไหว วีดีทัศน์ ภาพ 3 มิติ โดย
ผู้สอนและผูเ้รียนสามารถเลือกรูปแบบของการน าเสนอเพื่อให้เกิดประสิทธิภาพสูงสุดทางการเรียน 

ปรัชญนันท์ นิลสุข (2543) ได้กล่าวถึงคุณลักษณะส าคัญของเว็บซ่ึงเอ้ือประโยชน์ต่อการ
จัดการเรียนการสอน มีอยู่ 7 ประการ ได้แก่ 
         1.  การที่เว็บเปิดโอกาสให้เกิดการปฏิสัมพันธ์ (Interactive) ระหว่างผู้เรียนกับผู้สอนและ
ผู้เรียนกับผู้เรียนหรือผู้เรียนกับเนื้อหาบทเรียน 
         2.  การที่เว็บสามารถน าเสนอเนื้อหาในรูปแบบของส่ือประสม (Multimedia) 
         3.  การที่เว็บเป็นระบบเปิด (Open System) ซ่ึงอนุญาตให้ผู้ใช้มีอิสระในการเข้าถึงข้อมูลได้
ทั่วโลก 
         4. การที่เว็บอุดมไปด้วยทรัพยากร เพื่อการสืบค้นออนไลน์ (Online Search/Resource) 
         5.  ความไม่มีข้อจ ากัดทางสถานที่และเวลาของการสอนบนเว็บ (Device, Distance and 
Time Independent) ผู้เรียนที่มีคอมพิวเตอร์ในระบบใดก็ได้ ซ่ึงต่อเข้ากับอินเทอร์เน็ตจะสามารถเข้า
เรียนจากที่ใดก็ได้ในเวลาใดก็ได้ 
         6.  การที่เว็บอนุญาตให้ผู้เรียนเป็นผู้ควบคุม (Learner Controlled) ผู้เรียนสามารถเรียนตาม
ความพร้อมความถนัดและความสนใจของตน 
         7.  การที่เว็บมีความสมบูรณ์ในตนเอง (Self- contained) ท าให้เราสามารถจัดกระบวนการ
เรียนการสอนทั้งหมดผ่านเว็บได้ การที่ เว็บอนุญาตให้มีการติดต่อส่ือสารทั้งแบบเวลาเดียว 
(Synchronous Communication) เช่น Chat และต่างเวลากัน (Asynchronous Communication) เช่น 
Web Board เป็นต้น 
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        จากการศึกษาความคิดเห็นของนักวิชาการและนักการศึกษา ทั้งภายในประเทศไทยและ
ต่างประเทศ ดังที่กล่าวมาแล้วนั้น  สรุปประโยชน์ของการเรียนการสอนบนเว็บช่วยสอนได้ดังนี้ คือ  
สามารถเรียนรู้ได้ทุกสถานที่ทุกเวลา    ผู้เรียนมีความรับผิดชอบในตนเองมากขึ้น ผู้เรียนสามารถเลือก
เรียนเนื้อหาท่ีตนเองอยากเรียนได้  ประหยัดเวลาในการเรียนและการเดินทาง 
 

2.1.8  การประเมินผลการเรียนการสอนบนเว็บช่วยสอน 
         การประเมินผลการเรียนที่มีการเรียนการสอนผ่านเว็บนั้น มีลักษณะที่แตกต่างอยู่บ้าง แต่ก็
อยู่บนพื้นฐานความต้องการให้มีการเรียนการสอนผ่านเว็บท่ีมีคุณภาพและประสิทธิภาพต่อการเรียน
การสอน ส าหรับการประเมินในแง่ของการจัดการเรียนการสอนผ่านเว็บ ซ่ึงจัดว่าเป็นการจัดการเรียน
การสอนทางไกล วิธีในการประเมินผลสามารถท าได้ทั้งผู้สอนประเมินผู้ เรียนหรือให้ผู้ เรียน
ประเมินผลผู้สอน ซ่ึงองค์ประกอบที่ใช้เป็นมาตรฐานจะเป็นคุณภาพของการเรียนการสอน วิธี
ประเมนิผลที่ใช้กันอยู่ในการประเมินผลมีหลายวิธีการ แต่ถ้าจะประเมินผลมีการเรียนการสอนผ่าน
เว็บก็ต้องพิจารณาวิธีการที่เหมาะสมและทันกับเทคโนโลยีที่เปล่ียนแปลงอย่างรวดเร็ว 
         โดยเฉพาะกับเว็บซ่ึงเป็นการศึกษาทางไกลวิธีหนึ่ง การประเมินผลแบบทั่วไป ที่เป็นการ
ประเมินระหว่างเรียน(Formative Evaluation) กับการประเมินรวมหลังเรียน (Summative Evaluation) 
เป็นวิธีการประเมินผลส าหรับการเรียนการสอน โดยการประเมินระหว่างเรียนสามารถท าได้
ตลอดเวลา ระหว่างมีการเรียนการสอน เพ่ือดูผลสะท้อนของผู้เรียนและดูผลที่คาดหวังไว้ อันจะน าไป
ปรับปรงุการสอนอย่างต่อเนื่องขณะที่การประเมินหลังเรียนมักจะใช้การตัดสินในตอนท้ายของการ
เรียนโดยการใช้แบบทดสอบเพื่อวัดผลตามจุดประสงค์ของรายวิชา (ปรัชญนันท์ นิลสุข, 2546) 
 พอตเตอร์ (Potter, 19100) ได้เสนอวิธีการประเมินการเรียนการสอนผ่านเว็บ ซ่ึงเป็นวิธีการ
ที่ใช้ประเมินส าหรับการเรียนการสอนทางไกลผ่านเว็บของมหาวิทยาลัยจอร์จ เมสัน โดยแบ่งการ
ประเมินออกเป็น 4 แบบ คือ 

1.  การประเมินด้วยเกรดในรายวิชา (Course Grades) เป็นการประเมินที่ผู้สอนให้คะแนน
กับผู้เรียน ซ่ึงวิธีการนี้ก าหนดองค์ประกอบของวิชาชัดเจน เช่น คะแนน 100 % แบ่งเป็นการสอบ 30% 
จากการมีส่วนร่วม 10% จากโครงงานกลุ่ม 30% และงานที่มอบหมายในแต่ละสัปดาห์อีก30% เป็นต้น 

2.  การประเมินรายคู่ (Peer Evaluation) เป็นการประเมินกันเองระหว่างคู่ของผู้เรียนที่เลือก
จับคู่กันในการเรียนทาง ไกลด้วยกันไม่เคยพบกันหรือท างานด้วยกัน โดยให้ท าโครงงานร่วมกันให้
ติดต่อกันผ่านเว็บและสร้างโครงงานเป็นเว็บท่ีเป็น แฟ้มสะสมงาน โดยแสดงเว็บให้นักเรียนคนอ่ืนๆ 
ได้เห็น และจะประเมินผลรายคู่จากโครงงาน 
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3.  การประเมินต่อเนื่อง (Continuous Evaluation) เป็นการประเมินที่ผู้เรียนต้องส่งงานทุกๆ
สัปดาห์ให้กับผู้สอนโดยผู้สอนจะให้ ข้อเสนอแนะและตอบกลับในทันที ถ้ามีส่ิงท่ีผิดพลาดกับผู้เรียน
ก็จะแก้ไขและประเมินตลอดเวลาในช่วงระยะเวลาของวิชา 

4.  การประเมินท้ายภาคเรียน (Final Course Evaluation) เป็นการประเมินผลปกติของการ
สอนที่ผู้เรียนน าส่งสอน โดยการท าแบบสอบถามส่งผ่านไปรษณีย์อิเล็กทรอนิกส์หรือเครื่องมืออ่ืนใด 
บนเว็บตามแต่จะก าหนด เป็นการประเมินตามแบบการสอนปกติที่จะต้องตรวจสอบความก้าวหน้า 
และผลสัมฤทธ์ิการเรียนของผู้เรียน 
         โซวอร์ด (Soward, 1997) ได้กล่าวถึงการประเมินการเรียนการสอนผ่านเว็บว่า จะต้องอยู่
บนฐานที่ผู้ใช้เป็นศูนย์กลาง โดยให้นึกถึงเสมอว่าเว็บไซต์ควรเน้นให้ผู้ใช้สามารถเข้าใช้ได้สะดวกไม่
ประสบปัญหาติดขัดใดๆการประเมินเว็บไซต์มีหลักการ ท่ีต้องประเมินคือ 
         1. การประเมินวัตถุประสงค์ (Purpose) จะต้องก าหนดวัตถุประสงค์ว่า เพื่ออะไร เพื่อใคร 
และกลุ่มเป้าหมายคือใคร 
         2. การประเมินลักษณะ (Identification) ควรจะทราบได้ทันทีเมื่อเปิดเว็บไซต์เข้าไปว่า
เกี่ยวข้องกับ เรื่องใด ซ่ึงในหน้าแรก (Homepage) จะท าหน้าที่เป็นปกในของหนังสือ (Title) ที่บอก
ลักษณะและรายละเอียดของเว็บนั้น 
         3. การประเมินภารกิจ (Authority) ในหน้าแรกของเว็บจะต้องบอกขนาดของเว็บและ
รายละเอียดของโครงสร้างของเว็บ เช่น แสดงที่อยู่และเส้นทางภายในเว็บ และชื่อผู้ออกแบบเว็บ 
         4. การประเมินการจัดรูปแบบและการออกแบบ (Layout and Design) ผู้ออกแบบควรจะ 
ประยุกต์แนวคิดตามมุมมองของผู้ใช้ ความซับซ้อน เวลา รูปแบบที่เป็นที่ต้องการของผู้ใช้ 
         5. การประเมินการเชื่อมโยง (Links) การเชื่อมโยงถือเป็นหัวใจของเว็บ เป็นส่ิงท่ีจ าเป็นและ
มีผลต่อการใช้ การเพิ่มจ านวนเชื่อมโยงโดยไม่จ าเป็นจะไม่เป็นประโยชน์ต่อผู้ใช้ ควรใช้เครื่องมือ
สืบค้นแทนการเชื่อมโยงท่ีไม่จ าเป็น 
         6. การประเมินเนื้อหา (Content) เนื้อหาท่ีเป็นข้อความ ภาพ หรือเสียง จะต้องเหมาะสมกับ
เว็บและให้ความส าคัญกับองค์ประกอบทุกส่วนเท่าเทียมกัน 
 จากการศึกษาความคิดเห็นของนักวิชาการและนักการศึกษา ทั้งภายในประเทศไทยและ
ต่างประเทศ ดังที่กล่าวมาแล้วนั้น  สรุปการประเมินผลการเรียนการสอนบนเว็บช่วยสอนได้ดังนี้ คือ  
ควรจัดให้มีการประเมินระหว่างเรียนเพื่อจะได้ทราบผลสะท้อนของผู้เรียนแล้วน าผลไปปรับปรุงการ
จัดการเรียนการสอนต่อไป  และการประเมินผลการเรียนหลังเรียนซ่ึงเป็นการตัดสินผลการเรียน
นอกจากนี้ยังสามารถจัดให้ผู้เรียนประเมินผลงานของผู้เรียนที่เรียนร่วมกันได้ด้วย 
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2.2  การเรียนรู้เป็นทีม 
2.2.1  แนวคิดเกี่ยวกับการเรียนรู้เป็นทีม 

 การเรียนรู้เป็นทีม เป็นวิธีการเรียนการสอนเพื่อเสริมสร้างศักยภาพท่ีเน้นให้ผู้เรียนเรียนเปน็
กลุ่มและลงมือปฏิบัติกิจกรรม เพื่อให้ค้นพบความรู้ด้วยตัวของผู้เรียนเอง การเรียนรู้ดังกล่าว จัดได้ว่า
เป็นการเรียนรู้ที่ยึดผู้เรียนเป็นศูนย์กลางของการเรียน ซ่ึงประพันธ์ศิริ  สุเสารัจ (2540) ได้แสดง
ความเห็นไว้ว่า การจัดการเรียนการสอนโดยใช้กระบวนการกลุ่ม จะก่อให้เกิดความสัมฤทธ์ิผล
ทางการเรียนได้สูงสุดเพราะเป็นการศึกษาจากประสบการณ์จริงโดยที่ผู้เรียนได้เรียนรู้จากการปฏิบัติ
ซ่ึงตลอดจนมีปฏิสัมพันธ์ร่วมกับคนอ่ืน ๆ อันท าให้การเรียนรู้ต่าง ๆ เต็มไปด้วยความสนุกสนานมี
ชีวิตชีวาเป็นผลให้ผู้เรียนซาบซ้ึงและจดจ าได้นาน ตลอดจนสามารถฝึกนิสัยให้สามารถเข้าสังคมและ
ท างานร่วมกับคนอ่ืนได้ดี ในการจัดให้เด็กท างานรวมกันเป็นกลุ่ม นอกจากจะเป็นการเร้าให้เด็กเกิด
ความสนใจในการท างานแล้วยังเป็นการฝึกนิสัยการท างานที่ต้องการได้อีกหลายอย่างที่ไม่อาจฝึกได้
ในการท างานคนเดียว เช่น การแบ่งงานกันท า การร่วมมือกันท างาน การเสียสละ เป็นต้น 
  
 2.2.2  ความหมายของการเรียนรู้เป็นทีม 
 Slavin (1990) กล่าวว่า การเรียนรู้เป็นทีมมีความหมายเดียวกับการเรียนรู้แบบร่วมมือกัน 
ดังนี้ เพียงแต่ความแตกต่างกันตรงที่ การเรียนรู้เป็นทีม จะท าให้ความส าคัญและมุ่งในความสัมพันธ์
ส่วนตัว เป็นความรู้สึกผูกพัน (cohesion) กับไว้วางใจกัน (trust) และเป็นการเรียนรู้กระบวนการกลุ่ม 
(group process หรือ group dynamic) สมาชิกมีบทบาทของผู้น า บทบาทสมาชิกซ่ึงทุกคนจะมีความ
รับผิดชอบส่วนบุคคลที่มีร่วมกันต่อกลุ่ม การน ากระบวนการกลุ่มมาใช้ในการเรียนรู้เป็นทีมนี้เอง 
สามารถส่งเสริมและพัฒนาทักษะการรู้คิด และการเข้าใจ (cognition) การติดต่อส่ือสาร ทักษะการ
สร้างสัมพันธภาพระหว่างบุคคล ความสามารถในการคิดวิเคราะห์(creative thinking) การแก้ปัญหา
และช่วยให้ผู้เรียนรู้ด้วยตนเอง (active learning) 
 Peter Senge (1990 อ้างถึงใน สุพาณี สอนซ่ือ, 2543) กล่าวว่า team learning หมายถึงการให้
องค์การสร้างการถ่ายทอดความรู้ซ่ึงกันและกัน เป็นการสร้างบทเรียนแห่งความส าเร็จ เพื่อขยายผล
ต่อไปในหน่วยงานอ่ืน เป็นการคิดและสร้างสรรค์ส่ิงใหม่ภายใต้การประสานงานร่วมกัน การเรียนรู้
ร่วมกันเป็นทีมเป็นการเรียนรู้ร่วมกันของสมาชิกโดยอาศัยความรู้  ความคิดของสมาชิกในกลุ่มมา
แลกเปล่ียนความคิดเห็นเพื่อพัฒนาความรู้และความสามารถของทีม ให้เกิดขึ้น การเรียนรู้ร่วมกันโดย
การแลกเปล่ียนข้อมูลแลกเปล่ีนความคิดเห็นและประสบการณ์ซ่ึงกันและกันอย่างสม่ าเสมอและ
ต่อเนื่อง จนเกิดเป็นความคิดร่วมกันของกลุ่ม และกลุ่มควรลดส่ิงท่ีก่อให้เกิดอิทธิพลครอบง าแนวคิด
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ของสมาชิกคนอ่ืน ๆ พร้อมท้ังกระตุ้นให้กลุ่มมีการสนทนา และอภิปรายกันอย่างกว้างขวาง ซ่ึงการ
อภิปราย เป็นการน า vision ของแต่ละคนมาแลกเปล่ีนกัน และหาข้อสรุป เพื่อให้เกิดกิจกรรมร่วมกัน 
ท าให้องค์การบรรลุเป้าหมายได้ การที่จะเกิดความคิดสร้างสรรคใหม่ ๆ ได้จะต้องมีการสนทนา โดย
จะต้องท าควบคู่กันไป ดังนั้นทีมจึงต้องใช้ทั้งการพูดคุยอภิปราย (discussion – dialogue) กลุ่มจึงจะ
เกิดการท างานเป็นทีมเพื่อไปสู่เป้าหมายขององค์การ 
 Peter Senge (1994)  กล่าวว่าการเรียนรู้ร่วมกันเป็นทีม เป็นกระบวนการปรับแนวคิด 
ปฏิบัติ รวมท้ังจุดมุ่งหมายของทีมให้เป็นไปในแนวทางเดียวกัน และพัฒนาความสามารถเพื่อให้ได้ผล
ลัพธ์ที่สมาชิกในทีมทุกคนต้องการอย่างแท้จริง และเสนอแนะว่าการเรียนรู้ร่วมกันเป็นทีมมี
องค์ประกอบ 3 ประการ คือ 1) คุณลักษณะของสมาชิกในการเรียนรู้ร่วมกันเป็นทีม อันเป็น
ปัจจัยพื้นฐานที่ส่งผลให้บุคคลแสดงพฤติกรรมในการเรียนรู้ร่วมกันได้อย่างเหมาะสม 2) พฤติกรรม
การส่ือสารในการเรียนรู้ร่วมกันเป็นทีม เป็นวิธีการในการสนทนาและอภิปรายเพื่อแลกเปล่ียนเรียนรู้
ระหว่างสมาชิกในทีม และ 3) พฤติกรรมการเรียนรู้ร่วมกันเป็นทีมเป็นการเรียนรู้สภาพความเป็นจริง
ในปัจจุบันและการเรียนรู้วิธีปฏิบัติ โดยสมาชิกในทีมต้องมีการน าทฤษฎีหรือแนวคิดตามที่ได้เรียนรู้
มาปฏิบัติเพื่อเพิ่มความสามารถและเรียนรู้ร่วมกัน ด้วยองค์ประกอบท้ังสามประการนี้จะช่วยให้ผู้เรียน
ได้รับประโยชน์จากการเรียนรู้โดยการปฏิบัติของตนเอง กระตุ้นให้บุคคลได้แนวการคิดวิเคราะห์
อย่างลึกซ้ึงพร้อมกับน าเสนอแนวคิดในเรื่องท่ีสนใจ อีกทั้งปฏิสัมพันธ์ระหว่างบุคคลที่เข้าร่วมในการ
แลกเปล่ียนเรียนรู้ยังช่วยให้บุคคลได้เห็นมุมมองในเรื่องเดียวกันจากความคิดเห็นของบุคคลเป็นการ
ขยายมุมมองให้กว้างมากขึ้นแล้วจะน ามาหลอมรวมเข้ากับประสบการณ์การเดิมของบุคคลท าให้เกิด
การพัฒนาความคิดสร้างสรรค์เป็นผลงานหรือองค์ความรู้ใหม่ให้แก่ปัจเจกบุคคลและกลุ่ม  

Marquardt (1996) กล่าวว่า การเรียนรู้ร่วมกันเป็นทีม มุ่งเนน้ไปที่ท่ีกระบวนการจดัการและ
พัฒนาความสามารถของทีมเพื่อสร้างการเรียนรู้ และผลลัพธ์อันเกิดจากสมาชิกให้ได้เป็นไปตามความ
ต้องการ 
 Allee (1997) กล่าวว่า การเรียนรู้ร่วมกันเป็นทีม  เป็นวิธีการเรียนรู้ร่วมกันของสมาชิกที่
อาศัยความรู้ความคิดของแต่ละคนมาแลกเปล่ียนเรียนรู้เพื่อพัฒนาและยกระดับความรู้ความสามารถ
ของทีม โดยเน้นให้สมาชิกได้เสริมสร้างศักยภาพของตนเองเพื่อให้ค้นพบความรู้ด้วยตนเองและน ามา
ถ่ายทอด แลกประสบการณ์ และความคิดเห็นให้สมาชิกในกลุ่มได้เรียนรู้ร่วมกัน การเรียนรู้ร่วมกัน
เป็นทีมจึงเป็นการมองกระบวนการภายในของสมาชิกที่ร่วมกันเป็นทีมเพื่อสร้างหรือก าหนดแนว
ปฏิบัติให้เป็นไปในทิศทางเดียวกันรวมถึงการมองกระบวนการภายนอกเพื่อสร้างความรู้จากการ
เรียนรู้ร่วมกัน การเรียนรู้ของบุคคลและของทีมจึงเกิดขึ้นเสมอไม่ว่าบุคคลจะตั้งใจหรือไม่ก็ตาม 
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  สุพาณี สอนซ่ือ (2543) ได้สรุปความหมาย การเรียนรู้เป็นทีม คือ การที่สมาชิกได้รวมตัว
กันเพื่อเรียนรู้ส่ิงต่างๆ ร่วมกัน โดยการแลกเปล่ียนข้อมูลและประสบการณ์อย่างสม่ าเสมอและ
ต่อเนื่องโดยอาศัย สารสนเทศเพื่อท างานในกลุ่มคนที่มาจากหลากหลายฝ่ายงานจนเกิดเป็นความคิด
ร่วมกันเป็นทีม จะกระตุ้นให้กลุ่มมีการสนทนา และการอภิปรายกันอย่างกว้างขวาง แล้วจึงน า
วิสัยทัศน์ของแต่ละคนมาแลกเปล่ียนกัน เพื่อหาข้อสรุปออกมาเป็นแนวปฏิบัติร่วมกันเพื่อไปสู่
เป้าหมายขององค์กร 
 สิริลักษณ์ จิเจริญ (2545) กล่าวว่า การเรียนรู้เป็นทีม เป็นกระบวนการส่งเสริมความรู้ 
ทัศนคติ และความช านาญระหว่างสมาชิกทุกคนในทีมงานอย่างต่อเนื่อง ท าให้เกิดการเปล่ียนแปลง
ทางพฤติกรรมในทางสร้างสรรค์ที่น าไปสู่การเพิ่มประสิทธิภาพยกระดับมาตรฐานในการท างานของ
หน่วยงานท างานให้เจริญขึ้นเพื่อพัฒนาไปสู่องค์กรเอ้ือการเรียนรู้ 
  พรธิดา วิเชียรปัญญา (2547) กล่าวว่า การเรียนรู้เป็นทีม เป็นการเรียนรู้ร่วมกันของสมาชิก
โดยอาศัยความรู้และความคิดของสมาชิกในกลุ่มมาแลกเปล่ียนความคิดเห็นเพื่อพัฒนาความรู้และ
ความสามารถของทีมให้เกิดขึ้น การเรียนรู้ร่วมกันเป็นทีมจะเกิดขึ้นได้ต่อเมื่อมีการรวมพลังของ
สมาชิกในทีมให้ได้มีโอกาสเรียนรู้ส่ิงต่างๆ ร่วมกัน โดยแลกเปล่ียนข้อมู ล ความคิดเห็น และ
ประสบการณ์ซ่ึงกันและกันอย่างสม่ าเสมอและต่อเนื่องจนเกิดเป็นความคิดร่วมกันของกลุ่ม (group 
thinking) และกลุ่มควรลดส่ิงท่ีก่อให้เกิดอิทธิพลครอบง าแนวความคิดของสมาชิกคนอ่ืนๆ พร้อมทั้ง
กระตุ้นให้กลุ่มมีการสนทนา (dialogue) และการอภิปราย (discussion) กันอย่างกว้างขวาง ซ่ึงการ
อภิปรายเป็นการน าวิสัยทัศน์ของแต่ละคนมาแลกเปล่ียนกันเพื่อหาข้อสรุปออกมาเป็นกิจกรรมรว่มกนั 
ท าให้องค์การบรรลุเป้าหมายได้ การที่เกิดความคิดสร้างสรรค์ใหม่ๆ ได้จะต้องมีการสนทนา โดย
จะต้องท าควบคู่กันไป ดังนั้น ทีมจึงต้องใช้การสนทนาและการอภิปรายกลุ่มจึงจะเกิดการท างานเป็น
ทีม เพื่อไปสู่เป้าหมายขององค์การ 
 นิษฐา พุฒิมานรดีกุล (2548) กล่าวว่า การเรียนรู้เป็นทีม เป็นการเรียนรู้ร่วมกันของสมาชิก
ในที่ท างานโดยอาศัยการแลกเปล่ียนข้อมูล ความคิดเห็นและประสบการณ์ซ่ึงกันและกันอย่าง
สม่ าเสมอและต่อเนื่อง เพื่อพัฒนาความรู้และความสามารถของทีมให้เกิดขึ้น ด้วยการกระตุ้นให้
สมาชิกในทีมมีการสนทนาและอภิปรายกันแล้วน าวิสัยทัศน์ของแต่ละคนมาแลกเปล่ียนหาข้อสรุป
เพื่อเป็นแนวปฏิบัติร่วมกันเพื่อมุ่งสู่เป้าหมายขององค์กร 
 จากความหมายของ การเรียนรู้ร่วมกันเป็นทีม ที่ได้มีนักวิชาการกล่าวไว้ข้างต้น พอสรุปได้
ว่า การเรียนรู้ร่วมกันของสมาชิกโดยอาศัยความรู้และความคิดของสมาชิกในกลุ่มมาแลกเปล่ียนข้อมลู 
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ความคิดเห็น และประสบการณ์ซ่ึงกันและกันอย่างสม่ าเสมอและต่อเนื่องจนเกิดเป็นความคิดและแนว
ปฏิบัติร่วมกันของกลุ่ม ซ่ึงต้องใช้การสนทนาและการอภิปรายกลุ่มจึงจะเกิดการท างานเป็นทีม 
 

2.2.3  บทบาทของครูในการสนบัสนุนให้เกดิการเรียนรู้เปน็ทีม 
Bolton (1999  อ้างถึงใน วราภรณ ์ตระกูลสฤษดิ,์ 2545) ไดน้ าเสนอรูปแบบของบทบาท

หน้าที่ของครใูนการช่วยชี้แนะ สนับสนุนให้ผู้เรียนเกดิการเรียนรู้ร่วมกัน 3 โมดูล (Module) 
โมดูลที ่1 ครูท าหน้าที่จดัการเรียนรูใ้ห้ผู้เรียนได้เรียนรู้เกี่ยวกับทีม (team training) โดยใช ้

กระบวนการกลุ่ม (group dynamics or group process) เพื่อช่วยให้กลุ่มรวมตวักนัง่ายขึน้ มีความรู ้
ความเข้าใจในบทบาทหน้าทีข่องกนัและกัน ในเรื่องของบทบาทหน้าที่ของผู้น า บทบาทหน้าที่ 
ของสมาชิกทีม (team role) กระบวนการท างานรว่มกนั (team process) การมีปฏิสัมพันธ์ต่อกันใน 
กลุ่ม การตดัสินใจแก้ไขปัญหาต่าง ๆ ในกลุ่ม (group decisions) 

โมดูลที ่2 ช่วยให้ทีมสามารถจดัการกับความขดัแย้งได ้โดยการเปิดโอกาสให้ฝึกแก ้
สถานการณ ์ปัญหาความขดัแย้งท่ีเกดิขึ้น โดยการใช้สถานการณจ์ าลอง ใช้บทบาทสมมุติการฝึก 
การให้ข้อมูลย้อนกลับซ่ึงกันและกัน เป็นผู้ท ากิจกรรมเพื่อละลายพฤติกรรมของสมาชิกในทีม (ice 
breaker) ฝึกให้สมาชิกมีใจกว้างยอมรับฟังเหตุผลของผู้อ่ืน 

โมดูลที ่3 สนับสนุนให้ผู้เรียนได้เรียนรู้จากประสบการณ์ในการท างานกลุ่ม โดยครูต้องแจ้ง 
ให้ผู้เรียนได้ทราบถึง วัตถุประสงคข์องการเรียนรู ้ทิศทางการเรียนรู ้บอกเกณฑก์ารประเมินผล 

1. รูปแบบการสร้างและการบริหารทีม (team building and management) 
รูปแบบการสร้างทีมและบริหารทีม เป็นกิจกรรมภายในทมีท่ีสร้างขึ้นเพื่อชี้น าบทบาทหน้าที่ของ 
สมาชิกแต่ละคน อันจะน าไปสู่การปฏิบัติเพื่อให้บรรลุตามวัตถุประสงค์ของทีม รูปแบบดังกล่าวนี้ม ี
ลักษณะที่ส าคัญในการสร้างทีม ให้ประสบความส าเร็จ ดังตาราง 
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ตารางที ่ 2.1  แสดงองค์ประกอบการสร้างทีม  
 

องค์ประกอบของการสร้างทีม 
(team building exercise elements) 

รายละเอียด 
(element description) 

1. การจูงใจ (motivation)  - การกระตุน้ให้บคุคลมีแรงผลักดนัจนสามารถกระท า
กิจกรรมต่าง ๆ จนบรรลุวัตถุประสงค ์

2. การบรูณาการ (integration)  - การประสานและมีความเกี่ยวข้องกันในเรื่องของ
ผลประโยชน์ของแต่ละบุคคลร่วมกับผลประโยชนข์อง
กลุ่ม 

3. ความละเอียดอ่อน (granularity) - กิจกรรมภายในกลุ่มมีความซับซ้อนและละเอียดอ่อน 
ซ่ึงมีความสัมพันธ์กับบุคคลแต่ละคนในทีม และมี
ผลกระทบต่อพฤติกรรมของสมาชิก 

4. การเจาะจง (focus) - ทั้งบุคคลและทีมต่างมีวตัถุประสงค์ที่ชัดเจน
เฉพาะเจาะจง 

5. ความเป็นกลาง(neutrality)  - ผู้น าในทีมต้องมีความยุติธรรมและมีความเป็นกลาง 
ซ่ึงจะเป็นส่ิงแวดล้อมท่ีดีในการเรียนรู้และท างาน
ร่วมกนัเป็นทีม  

6. การมีทักษะแตกต่างกัน  - สมาชิกในทีมควรมีความรู ้ความสามารถที่แตกต่างกัน 
เพื่อประโยชน์ในการชว่ยเหลือซ่ึงกันและกัน 

7. บทบาทหน้าที่แตกต่างกัน  - เป็นโอกาสของสมาชิกในทีมจะได้ชว่ยกนับริการ
จัดการร่วมมือในทีม 

8. การศึกษา (education)  - ควรมกีารศกึษาเกี่ยวกับการจูงใจ และมีการเรียนรู้
ทักษะและความรูใ้หม ่ๆ อยู่เสมอ  

9. ความผูกพนัต่อกนั (social bonding )  - ควรมโีอกาสสร้างความสัมพันธ์เพื่อน าไปสู่ความผูกผนั
กันในทีม และเรียนรู้บุคลิกและลักษณะของสมาชิกในทีม 

10. การควบคุมและการดูแล (control and 
oversight) 

- ภายในทีมควรมีระบบการดูแลและตรวจตราท่ีดี 
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2.  การท าให้ทีมประสบความส าเร็จ (promoting team effectiveness) ปัจจัยที่ช่วย
ส่งเสริมสนับสนุนให้ทีมงานมีประสิทธิผลดี ประกอบดว้ย 5 องค์ประกอบดังนี ้(Salavin, 1990) 

ก) การเลือกสมาชิกของทีม (team – member selection) 
ข) การสร้างทีมงาน (team building) 
ค) การให้ความรู้เกี่ยวกับทีมแก่สมาชกิ (team training) 
ง) การพฒันาทักษะของผู้น าทีม (leadership development) 
จ) การออกแบบโครงสร้างของงาน (work redesign / restructuring) 

 จากการศึกษางานวิจัยที่เกี่ยวข้องสามารถสรุปบทบาทของของครใูนการสนับสนุนให้เกิด
การเรียนรู้เป็นทีมได้ดังนี้ คือ  
 1.  ครูต้องอธิบายให้นกัเรียนรูจ้ักลักษณะการการท างานเป็นทีม 
 2.  ครูต้องเปิดโอกาสให้สมาชิกในทีมแก้ปญัหาความขัดแย้งท่ีเกิดขึน้ 
 3.  สนันสนุนให้ผู้เรียนได้เรียนรู้จากการท างานร่วมกัน 
 

2.2.4  วิธีสร้างการเรียนรู้เป็นทีม 
 การเรียนรู้เป็นทีม ท าให้การเรียนรู้มีพลังมากขึ้น ในการที่เสนอความคิดเห็นหรือความรู้
ไปสู่องค์การและพัฒนาความรู้ไปสู่การปฏิบัติ นอกจากนี้ยังส่งเสริมบทบาทของสมาชิกในทีมต่อทีม
อ่ืนๆ ให้เกิดการเรียนรู้ร่วมกันอย่างต่อเนื่อง ซ่ึงการเรียนรู้เป็นทีมมีวิธีที่ส าคัญ ดังต่อไปนี้ 
 วิธีที่ 1 ใช้การสนทนา (Dialogue)  
 การสนทนาในการเรียนรู้เป็นทีม (Dialogue) เป็นการพูดคุยร่วมกันของสมาชิกในทีม โดย
สมาชิกสามารถแสดงความรู้สึกหรือความคิดเห็นในเรื่องต่างๆ ได้อย่างอิสระ รับฟังถึงส่ิงที่อยู่ในใจ
และร่วมคิดด้วยกันอย่างจริงใจ ทุกคนในทีมจะพูดคุยด้วยความเคารพต่อความคิดเห็นของกันและกัน 
ไม่โอ้อวดความคิดของตนเองหรือทับถมความคิดของผู้อ่ืน เปิดเผยความคิดและความรู้สึกกันโดย
ปราศจากความกลัวหรือความอาย การรับฟังทัศนคติ มุมมองต่างๆได้กว้างขวางยิ่งขึ้น เกิดสมมติฐาน
ใหม่ซ่ึงจะหาไม่ได้จากจากการพูดคุยกันเฉพาะบุคคล ช่วยให้ทีมสามารถแก้ปัญหาที่ยากและ
สลับซับซ้อนจากความคิดอันหลากหลายในการแลกเปล่ืยนข้อคิดเห็นซ่ึงกันและกัน 
 เป้าหมายของการสนทนา คือ เพื่อแสวงหาความหมายหรือสร้างความเข้าใจใหม่ในเรื่องที่
คลุมเคลือไม่แน่ใจ หรือยากจะตีความ ตลอดจนเพื่อส ารวจความคิดความเชื่อของตนเองและผู้อ่ืน มี
ความเข้าใจแตกต่างกันเช่นไร ท าให้ได้รับรู้ความคิดที่หลากหลาย ซ่ึงไม่จ าเป็นต้องได้ข้อตกลงหรือ
ข้อสรุปหลังจากการสนทนานั้น แต่เป็นการยกระดับทัสนคติของสมาชิกให้สูงขึ้น สร้างความเข้าใจใน
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ความรู้สึกของกันและกันมากขึ้น ซ่ึงในบางครั้งการสนทนาท าให้การเปล่ียนแปลงทางความคิดเห็น 
หรือพฤติกรรมของสมาชิกอย่างถาวร และอาจช่วยการตัดสินใจในอนาคตโดยมีการปฏิบัติ ดังนี้ 
 1. เริ่มต้นด้วยหัวข้อของการสนทนาโดยให้ทีมร่วมกันคิดพิจารณากันเองโดยไม่มีการ
ก าหนดข้อสมมติฐานหรือทางเลือกใดๆ ไว้ล่วงหน้า 
 2. ในการเสวนาทุกครั้งให้เกิดประสิทธิภาพ สมาชิกแต่ละคนจะต้องมีความคิดและจิตใจที่
เปิดกว้าง ยอมรับข้อคิดเห็นและเหตุผลของกันและกัน 
 3. ห้ามยึดตัวเองเป็นใหญ่และต าแหน่งหน้าที่การงานมาใช้ในการเสวนา เพราะจะท าให้เกิด
อุปสรรคต่อการเรียนรู้ร่วมกัน 
 4. สมาชิกต้องเข้าใจ รับรู้ความคิดความเชื่อของตนเองเสียก่อนที่จะเปิดเผยให้ผู้อ่ืนทราบ  
 5. สมาชิกต้องแสดงออกถึงความคิด ความเชื่อของตนเองให้ทุกคนทราบอาจเป้นข้อสังเกต 
ความรู้สึกหรือความคิดเห็นก็ได้ 
 6. สมาชิกต้องเปิดโอกาสให้ผู้อ่ืนได้ซักถามและแลกเปล่ียนความคิดเห็น 
 7. สมาชิกต้องหลีกเล่ียงการตั้งวาระการประชุม ไม่ก าหนดหัวข้อที่จะพูดคุย เพื่อเปิดกว้าง
ทางความคิดและทุกคนไม่ควรเตรียมตัวที่จะสนทนาอย่างมุ่งม่ัน เพราะจะท าให้การสนทนาขาดอิสระ 
ไม่สร้างสรรค์ ขาดความพร่างพรในการแลกเปล่ียนความคิด 
 8. สมาชิกต้องตั้งกฎพ้ืนฐานไว้เป็นข้อตกลงร่วมกันในการพูดคุย อาทิ ข้อตกลงให้ทุกคน
พูดความจริง การก าจัดเวลาในการพูด เป็นต้น 
 วิธีที่ 2 ใช้การอภิปราย (Discussion) 
 การอภิปราย (Discussion) โดยมีการจัดเตรียมข้อสมมติฐานและทางเลือกต่างๆ ไว้ล่วงหน้า
เพื่อน ามาอภิปรายในการเรียนรู้เป็นทีม สมาชิกแต่ละคนจะแสดงความคิดเห็นของตนเองโดยมีการ
แลกเปล่ียนความคิดเห็นที่แตกต่างกันอย่างเต็มที่ และแสดงเหตุผลปกป้องความคิดเห็นของตน เพื่อให้
สมาชิกทุกคนได้วิเคราะห์สถานการณ์ทั้งหมด การอภิปรายเน้นการวิเคราะห์และแยกประเด็นที่สนใจ
ออกเป็นส่วนๆ เป็นการแสดงเหตุผลเพื่อให้สมาชิกในทีมยอมรับแนวคิดมุมมองท่ีที่ตนเสนอเป้าหมาย
ของการอภิปราย คือ เพื่อการตัดสินใจเลือกหาข้อตกลง ข้อสรุป หรือหาทางแก้ปัญหาที่มีการตกลง
ร่วมกัน เพื่อใช้เป็นแนวทางการปฏิบัติของทีมในช่วงเวลานั้น 
 Senge (1994) ได้ยกตัวอย่างบริษัทฮอนด้ามอร์เตอร์ของประเทศญี่ปุ่นที่ได้รับการยกย่องว่า
เป็นบริษัทที่ประสบความส าเร็จมากที่สุดบริษัทหนึ่งในโลก ฮอนด้าจะใช้การประชุมเผชิญหน้าที่
เรียกว่า ไวกากะ หมายถึง การพูดคุยอย่างเป็นกันเอง มีวัตถุประสงค์เพื่อการเรียนรู้และการแก้ไข ความ
ขัดแย้ง ในการประชุมนี้ สถานภาพและต าแหน่งงานจะถูกมองข้ามไป บุคคลจะได้รับการกระตุ้นให้
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พูดในส่ิงที่คิดอยู่ในใจ “ไวกากะ” จะใช้กับพนักงานทุกระดับของบริษัทตั้งแต่ระดับล่างถึงระดับ
ผู้บริหาร การอภิปรายอย่างตรงไปตรงมา และความคิดเห็นต่างๆที่ลากหลาย จากการอภิปราย ท าให้
ความขัดแย้งของบริษัทกลายปล่ียนเป้นการตัดสินใตจที่ดีขึ้น นอกจากนี้ Senge (1994) ยังได้เปรีย
นเทียบวิธีการสนทนา เหมือนกับการเล่นดนตรี Jazz ส่วนการอภิปรายเหมือน Chamber Music และ
เพื่อให้เกิดการเรียนรู้ร่วมกันเป็นทีม การอภิปรายมีความจ าเป็นต้องปฏิบัติควบคู่กับการสนทนา และ
ควรจัดให้มีการสนทนากันก่อน เพ่ือช่วยสร้างบรรยากาศที่ดีในการอภิปรายต่อไป 
 วิธีที่ 3 ใช้เทคนิคของการบริหารเป็นทีม (Team Management) 
 เทคนิคของการบริหารเป็นทีม (Team Management) เป็นเรื่องของการใช้ความสามารถของ
หัวหน้าทีมในความเป็นผู้น า (Leadership) และความเข้าใจในจิตวิทยาของการบริหารทีมงาน เพื่อให้
เกิดการเรียนรู้จากผลส าเร็จหรือความผิดพลาดร่วมกันโดยที่ผู้น าต้องมีความสามารถในการจูงใจให้
ผู้อ่ืนปฏิบัติตามเพื่อให้บรรลุเป้าหมายขององค์กร เป็นศิลปะและทักษะในการบริหารที่ส าคัญอย่างยิ่ง
ของผู้น าองค์กรและผู้บริหารองค์กรทุกระดับในการที่จะน าองค์กรไปสู่ความส าเร็จ 
 วิธีที่ 4 ใช้เทคนิคของการบริหารโครงการธุรกิจ (Bussiness Project Management) 
 เทคนิคของการบริหารโครงการธุรกิจ (Bussiness Project Management) โดยหลักการ
บริหารมีหัวหน้าและสมาชิกในโครงการมีจุดเริ่มต้นและก าหนดแล้วเสร็จที่ชัดเจน มีกิจกรรมพร้อม
ผู้รับผิดชอบตลอดจนมีกระบวนการของการบริหารอย่างเป็นระบบ โดยสมาชิกทุกคนในองค์การจะมี
โอกาสได้รับความรู้ความเข้าใจในงานทุกขั้นตอนโดยเท่าเทียมกัน มีการก าหนดกิจกรรมและ
ผู้รบัผิดชอบส าหรับแต่ละกิจกรรม ประกอบด้วยขั้นตอนการบริหารโครงการ ดังนี้ 
 1. การประเมินงานโครงการ (Estimating) 
 2. การวางแผนงานโครงการ (Planning) 
 3. การก าหนดกิจกรรมและเวลา (Scheduling) 
 4. การปฏิบัติงานตามโครงการ (Implementation) 
 5. การติดตามผลความก้าวหน้า (Tracking & Control) 
 6. การปรับปรุงแก้ไข (Fine Tuning) 
 7. การส่งมอบโครงการ (Hand Over) 
 วิธีที่ 5 ใช้การเรียนรู้จากการปฏิบัติ (Action Learning) 
 การเรียนรู้จากการปฏิบัติ (Action Learning) เป็นวิธีที่ได้รับความนิยม เป็นการให้พนักงาน
ได้เรียนรู้ด้วยตนเองจากการแก้ปัญหาในงาน ซ่ึงท าได้โดยการปฏิบัติและการเรียนรู้ร่วมกันจากบุคคล
อ่ืน โดยการมอบหมายงานอ่ืนให้ท า และให้พนักงานได้มีส่วนร่วมในการท างาน การเรียนรู้ด้วยการ
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ปฏิบัตินี้จะเริ่มต้นได้อย่างมีประสิทธิภาพเมื่อบุคคลได้เผชิญกับปัญหาจากประสบการณ์ร่วมกันกับ
ผู้ร่วมงาน ซ่ึงถือเป็นพื้นฐานท าให้เกิดการพัฒนาทักษะและการปฏิบัติงานของแต่ละบุคคลได้ และ
เป็นการสร้างเสริมการเรียนรู้เป็นทีม ดังนั้นหัวใจส าคัญของการเรียนรู้โดยการปฏิบัติ คือการเรียนรู้
ร่วมกันในการที่จะค้นหาค าตอบในเรื่องนั้น การเรียนรู้จากการปฏิบัตินี้ เกิดจากการเรียนรู้จา ก
ประสบการณ์ (Experiential Learning) การแก้ปัญหาอย่างสร้างสรรค์ (The Creative Solving) การ
แสวงหาความรู้ต่างๆที่เกี่ยวข้อง (Acquisition of Relevant Knowledge) และกลุ่มสนับสนุนการเรียนรู้
ร่วมกัน  (The Co-learner Support Group) 
 1. ขั้นตอนการร่วมกันเรียนรู้ถึงปัญหาที่แท้จริง เช่น ปัญหาในงาน คุณภาพงาน คุณภาพ
ผลผลิต หรือการแข่งขันทางการตลาด ฯลฯ ว่าเกิดจากสาเหตุอะไร  
 2. สมาชิกทุกคนร่วมกันแก้ไขปัญหานั้นอย่างจริงจัง เพื่อให้ได้ผลปฏิบัติจริง และบรรลุ
วิสัยทัศน์ขององค์กร 
 3. ร่วมกันเรียนรู้ในประสบการณ์ที่ได้ลงมือปฏิบัติอย่างจริงจัง 
 นอกเหนือจากวิธีการทั้ง 5 ที่กล่าวมา การเรียนรู้นร่วมกันเป็นทีมจะประสบความส าเร็จ
จ าเป็นต้องอาศัยพื้นฐานแห่งความส าเร็จ 2 ประการ คือ  
 1. การศึกษาสภาพท่ีแท้จริงขององค์กรในปัจจุบัน 
 การศึกษาสภาพที่แท้จริงขององค์กรในปัจจุบัน ทีมงานที่เรียนรู้จ าเป็นต้องมีการเรียนรู้
สภาพความเป็นไปในปัจจุบันขององค์การเสมอ (Current Reality) โดยการส ารวจหรือตรวจสอบการ
ท างาน และภารกิจของทีมงานว่า งานที่ท าไปนั้นได้ผลดีผลเสียมากน้อยเพียงใด และทบทวนสาเหตุ
ของปัญหาท่ีเกิดขึ้นในการท างานของสมาชิก เป็นการเรียนรู้ที่จะตรวจสอบตนเองว่าอยู่ในสภาวะหรอื
สถานการณ์แบบใด โดยตระหนัก ยอมรับความจริง และเข้าใจในสภาพความเป็นจริงของตนเอง และ
ขององค์การโดยเราจะต้องรู้จักตัวของเรา ทีมของเรา และองค์กรณ์ของเราว่ารู้อะไร ไม่รู้อะไร มี
จุดอ่อน จุดบกพร่องตรงไหน มีความเก่งหรือจุดแข็งตรงไหน เพราะถ้าเราตระหนักรู้ได้อย่างถ่องแท้
แล้วเราก็จะได้ใช้กลยุทธ์มุ่งไปอย่างมีทิศทาง 
 2. มีความสามารถในการเรียนรู้ “วิธีการเรียนรู้” 
 กระบวนการในการเรียนรู้เป็นทีม เป็นการกระท าที่ต่อเนื่องกันระหว่างการฝึกฝนปฏิบัติ
และการกระท าจริงสลับกันไปมา สมาชิกในทีมต้องมีการฝึกปฏิบัติร่วมกัน (Practice Fields) เพื่อ
พัฒนาทักษะการเรียนรู้ร่วมกัน เป็นการน าทฤษฎีหรือแนวคิดตามที่ได้เรียนรู้ มาทดลองปฏิบัติเพื่อให้
เกิดความสามารถในการท างาน และความมั่นใจเมื่อต้องการเผชิญกับความยุ่งยากในการปฏิบัติงานที่
อาจเกิดขึ้นในอนาคต ซ่ึงจะช่วยส่งเสริมความส าเร็จในการท างานจริง อาทิ การฝึกสนทนา การฝึก
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ปฏิบัติตามกลยุทธ์ที่วางไว้หรือการมอบหมายให้ปฏิบัติงาน เป็นต้น ซ่ึงการเรียนรู้มีหลากหลาย
รูปแบบไม่ว่าจะเป็นการสัมมนา การประชุมเชิงปฏิบัติการ การประชุม การฝึกอบรมในงาน การ
สนทนา การอภิปราย การระดมสมอง การใช้ห้องสมุด เว็บไซต์ และอ่ืนๆอีกมากมายที่ตัวเราหรือ
ทีมงานของเราจะต้องรู้ว่าจะเรียนรู้อย่างไร เพื่อให้บรรลุเป้าหมายขององค์การ    

จากการศึกษางานวิจัยที่เกี่ยวข้องสามารถสรุปวิธีการสร้างการเรียนรู้เป็นทีมได้ดังนี้ คือ  
1.  การสนทนา จะต้องมีการจัดกิจกรรมให้สมาชิกพูดคุยร่วมกันในทีม โดยสมาชิกสามารถ

แสดงความรู้สึกหรือความคิดเห็นในเรื่องต่างๆ ได้อย่างอิสระ รับฟังถึงส่ิงที่อยู่ในใจและร่วมคิด
ด้วยกันอย่างจริงใจ ทุกคนในทีมจะพูดคุยด้วยความเคารพต่อความคิดเห็นของกันและกัน  
 2.  การอภิปราย จะต้องมีการจัดกิจกรรมให้สมาชิกได้วิเคราะห์และแสดงเหตุผลเพื่อให้
สมาชิกในทีมยอมรับแนวคิดมุมมองท่ีน าเสนอ เพื่อใช้เป็นแนวทางการปฏิบัติของทีมร่วมกัน 
 3.  การเรียนรู้จากการปฏิบัติ จะต้องมีการจัดกิจกรรมให้ให้สมาชิกได้ปฏิบัติงานร่วมกัน ได้
เรียนรู้ด้วยตนเองจากการแก้ปัญหาในงาน 
 

2.2.5  การเลือกสมาชิกทีม (team – member selection)  
หลักการเลือกสมาชิกเข้ามาท างานในทีม ควรใช้วิธีการเลือกที่เป็นระบบในการที่จะเลือก

คนให้เหมาะกับงานภายในทีมของเรา โดยควรมีหลักในการเลือก คือ ใช้วิธีการคัดเลือกอย่างเป็น
ระบบ (systematic selection methods) เพื่อ 

1.  พิจารณาดูความรู้ ความสามารถและทักษะอ่ืน ๆ ในการท างาน ซ่ึงเรื่องนี้มีการศึกษาวิจัย
เป็นหลักฐานอ้างอิงได้ว่า การคัดเลือกสมาชิกทีมที่มีความรู้ความสามารถและทักษะการท างานส่วน
บุคคลสูง ร่วมกับการคัดเลือกคนที่มีแรงจูงใจในการท างานสูง จะพบว่าผลการท างานของทีมที่มี
สมาชิกซ่ึงมีลักษณะดังกล่าว จะท างานได้ผลงานของกลุ่มดี จะมีปัจจัยที่เกี่ยวข้องดังนี้ 

ก) ความสามารถเฉพาะบุคคล (individual abilities) 
ข) ระดับของการจูงใจ (motivation levels) 

2.  การคัดเลือกอย่างเป็นระบบท่ีจะน าสมาชิกเข้าทีมงานนั้น จะช่วยปรับปรุงผลการท างาน
เป็นทีม เพราะการที่มีสมาชิกที่มีความแตกต่างกันมาก (heterogeneity of team member)จะช่วยเพิ่ม
ความแตกต่างและความห่างไกลของสมรรถนะ (competencies) ของสมาชิกภายในกลุ่ม  กล่าวคือ 
สมาชิกภายในกลุ่ม จะมีความรู้ความสามารถที่มีความแตกต่างกัน และน าความแตกต่างนี้มาใช้
ประโยชน์สูงสุดในการท างานร่วมกัน 
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3.  การคัดเลือกสมาชิกทีม ยังมีประโยชน์ในแง่ท่ีว่า สามารถเพิ่มประสิทธิผลของทีม (team 
performance) โดยการแยกแยะ วิเคราะห์หาบุคคลที่มีความรู้ ความสามารถและมีความพร้อมระดับ
หนึ่ง ที่จะเข้ามาร่วมท างานในทีม ภายใต้บรรยากาศของทีมงานได้อย่างเหมาะสมซ่ึงการประเมิน
วิเคราะห์ความรู้ความสามารถ โดยพิจารณาดูจาก ภาระหน้าที่ท่ีเป็นการงานพิเศษที่มีความเชื่อมโยงตวั
บุคคล และเชื่อมโยงกับงานที่ท าด้วย โดยมีหลักการพิจารณาคนดังนี้ 

ก) ความสามารถในการช่วยเหลือผู้อ่ืน 
ข) ความสามารถในการท างานร่วมกับบุคคลอ่ืน 
ค) การตอบรับการมอบหมายงานในทีม 
ง) มีความรู้ในการท างานภายในทีม 
จ) มีทัศนคติที่ดีเกี่ยวกับงาน และปัจจัยสนับสนุนอ่ืน ๆ 

คุณลักษณะของสมาชิกในทีมที่ท าให้เกิดการเรียนรู้เป็นทีม 
 คุณลักษณะของสมาชิกในทีมท่ีท าให้เกิดการเรียนรู้เป็นทีมตามแนวคิด Peter M. Senge มี
ดังนี้ 
 1. สมาชิกต้องมีแนวคิด แนวปฏิบัติที่สอดคล้องกันและมีจุดมุ่งหมายในการท างานให้
บรรลุผลส าเร็จที่ตั้งใจ เป็นไปในแนวทางเดียวกัน 
 2. สมาชิกต้องได้รับการเพิ่มอ านาจในการท างาน ซ่ึงเป็นการกระจายอ านาจ ความ
รับผิดชอบและความอิสระในการตัดสินใจปฏิบัติงาน 
 3. สมาชิกต้องมีการประสานพลังร่วมกันภายในทีมโดยน าความรู้ความสามารถและความ
เชี่ยวชาญของแต่ละคนในทีมออกมาใช้ให้เกิดประโยชน์ 
 4. สมาชิกต้องสามารถสร้างสรรค์ส่ิงใหม่ๆ ให้เกิดขึ้น และประสานงานกับผู้อ่ืนได้โดย
ร่วมมือกันคิดเปล่ียนแปลงส่ิงใหม่ๆ ให้เกิดขึ้น 
 5. สมาชิกต้องส่งเสริมสนับสนุนและกระตุ้นการเรียนรู้ของสมาชิกแต่ละคนในทีมให้มีการ
เรียนรู้ร่วมกันและถ่ายทอดการปฏิบัติงานและทักษะความรู้ไปยังส่วนรวม 
 6. สมาชิกต้องสามารถวิเคราะห์ปัญหาท่ีซับซ้อนได้ อย่างลึกซ้ึงเพื่อให้เข้าใจการท างานการ
ท างานและปัญหาท่ีเกิดขึ้น 
 7. สมาชิกทุกคนต้องมีความไว้วางใจในการปฏิบัติงาน มีความเชื่อมั่นระหว่างกันและเข้าใจ
ในการท างานของแต่ละคน 
 8. สมาชิกในทีมต้องเผชิญหน้ากับความเส่ียงหรือต้องตัดสินใจในการท างานด้วยตนเอง 
 9. สมาชิกควรแสดงพฤติกรรมที่สุภาพให้เกียรติกันในการท างาน 



46 
 

 10. สมาชิกควรรับฟังผู้อ่ืนอย่างตั้งใจและละความคิดของตนเองเอาไว้เม่ือฟังผู้อ่ืนพูด 
 11. สมาชกิควรมีจิตส านึกว่าตนเองมีความส าคัญในฐานะที่เป็นส่วนหนึ่งของทีม 

  12. สมาชิกสอบถามและสะท้อนความคิดเห็นของสมาชิกท่านอ่ืนๆ 
จากการศึกษางานวิจัยที่เกี่ยวข้องสามารถสรุปวิธีการเลือกสมาชิกทีมได้ดังนี้ คือ จะต้องมี

การคัดเลือกสมาชิกภายในทีม โดยพิจารณาจากความรู้ ความสามารถและทักษะอ่ืน ๆ ในการท างาน 
สมาชิกควรมีความสามารถที่แตกต่างกันจะช่วยส่งผลให้เกิดประโยชน์สูงสุดในการท างานร่วมกัน 

 
2.2.6  ขั้นตอนการจัดการเรียนรู้เป็นทีม 

 การเรียนรู้ เป็นทีมนั้นเปรียบเสมือนเป็นเครื่องมือในการทบทวนและก่อให้เกิดการ
เปล่ียนแปลงความสามารถขององค์การได้ซ่ึงการเรียนรู้เป็นทีมต้องอาศัยเวลาในการพิจารณาและการ
ฝึกฝนในลักษณะการเรียนรู้เชิงปฏิบัติ (action learning) ซ่ึงการเรียนรู้เชิงปฏิบัติ (action learning) มี
องค์ประกอบดังนี้  (Marquardt , 1996) 
 1. ควรจะมีสมาชิกประมาณ 4-8 คน เนื่องมาจากว่าถ้าน้อยกว่า 4 คน จะไม่ค่อยมีความ
หลากหลายไม่ว่าจะเป็นทางความคิด พฤติกรรม ทัศนคติ ประสบการณ์ ฯ แต่ถ้ามากกว่า 8 คน จะท า
ให้ทีมมีความซับซ้อนมากเกินไปท าให้ทุกคนในทีมไม่มีเวลาในการร่วมแสดงความคิดเห็นเพียงพอ 
 2. สมาชิกในทีมควรมาจากคนละสายงานหรือคนละแผนก เพื่อให้เกิดความหลากหลายใน
การเรียนรู้ร่วมกัน 
 3. ในกลุ่มของทีมเรียนรู้ร่วมกันควรมีผู้มีอ านาจในการส่ังการเป็นสมาชิกในทีมด้วย เพื่อจะ
ได้สามารถน าข้อเสนอแนะของกลุ่มไปปฏิบัติได้ โดยบุคคลคนนั้นจะต้องเป็นคนที่ใส่ใจและรู้ปัญหา
ด้านนั้น ๆ พอสมควร 
 วรรณภรณ์ วีระพงษ์ (2551) กล่าวถึง หลักส าคัญในการเรียนแบบทีม (Team  base  
Learning) ไว้ดังนี้ 
 1. ต้องมีการจัดตั้งและจัดการกลุ่มอย่างถูกต้อง   โดย 
 1.1 ลดความเกาะกลุ่มกันเองโดยใช้เหตุผล  เช่น  คู่รัก   พี่น้อง  สัญชาติ  วัฒนธรรมเพื่อให้
เกิดกลุ่มท่ีผสมผสานกัน 
 1.2 การแบ่งกระจายคุณสมบัติของสมาชิกที่ เป็นประโยชน์  เช่น  ความเป็นผู้น า  ความ
สนใจ   ความขยัน  เจตคติ  ความช านาญเฉพาะด้าน  อ่ืนๆ  ควรกระจายอย่างท่ัวถึง  เพื่อให้การท างาน
แบบทีมมีประสิทธิภาพมากที่สุด 
 1.3 มีขนาดของทีมท่ีเหมาะสม   ประมาณ 5-7 คน 
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 1.4 ควรเป็นกลุ่มถาวร  เพราะหากมีการจัดตังกลุ่มใหม่สมาชิกก็จะยึดผู้มีความสามารถ
มาก  ท าให้การพัฒนาทีมต่อไปน้อยลง  หากสมาชิกเป็นกลุ่มเดิม   การส่ือสารจะเปิดกว้าง  มีทั้งการ
เป็นผู้ให้และผู้รับ 
 ขั้นตอน 
 เมื่อท าการพิจารณาขนาดของกลุ่มแล้ว ครูสามารถเริ่มต้นกระจายคุณสมบัติส่วนตัวของ
สมาชิกให้แก่ทุกกลุ่ม ให้ท าการจัดตั้งกลุ่มในห้องเรียนต่อหน้านักศึกษา  กระบวนการจัดตั้งกลุ่มจะมี
ลักษณะเริ่มต้นด้วยการที่ครูและผู้เรียนร่วมกันก าหนดปัจจัยส าคัญที่มีผลต่อความส าเร็จของกลุ่ม ใน
การจัดการในห้องเรียน ค าถามที่ถาม เช่น “มีนักศึกษากี่คนที่เคยมีประสบการณ์เป็นหัวหน้ากลุ่มใน
การท างาน” “มีนักศึกษากี่คนที่มีศิลปะในการวาดภาพ” “เป็นคนจังหวัดไหน” “ใครที่คิดว่าพออ่าน
ภาษาอังกฤษได้”เป็นต้น ให้นักศึกษาตอบค าถามปากเปล่าหรือยกมือขึ้น หลังจากนั้นให้นักศึกษาเข้า
แถวเรียงคิวตามคุณสมบัติส่วนตัว หลังจากที่นักศึกษาเข้าแถวแล้วครูจะท าการตัดแถวให้ส้ันลง 
ศักยภาพการจัดตั้งกลุ่มโดยการให้นักศึกษาขานรับตัวเลข ผู้ท่ีขานรับ 1 จะเป็นสมาชิกในกลุ่มท่ี 1 และ
ผู้ท่ีขานรับ 2 จะเป็นสมาชิกในกลุ่มท่ี 2 ด้วยวิธีการง่ายๆ เช่นนี้ จะมีการกระจายคุณ สมบัติรายบุคคล
ของสมาชิกออกไปท่ัวทุกกลุ่ม 
 2.  ผู้เรียนต้องรับผิดชอบในงานของตนเองและงานกลุ่ม 
 ในการเรียนแบบเดิม  ผู้เรียนมักรับผิดชอบแต่งานของตนเอง  แต่ในการเรียนแบบทีม  
จะต้องมีการวัดผลและให้คะแนนเกี่ยวกับการเตรียมตัวเพื่องานกลุ่ม   การอุทิศเวลาและความพยายาม   
การมีปฏิสัมพันธ์กับผู้อ่ืน ความรับผิดชอบท่ีผู้เรียนต้องมี  
 2.1 ความรับผิดชอบล่วงหน้าก่อนเรียนจริง    
 ใช้กระบวนการรับประกันความพร้อมของผู้เรียนที่เรียกว่า Readiness  Assurance  Process 
เครื่องมือที่ใช้เรียกว่า Readiness  Assurance  Test ( RAT)  ซ่ึงเป็นแบบทดสอบปรนัยมีข้อค าถาม
จ านวนไม่เกิน 20  ข้อ  โดยให้ผู้เรียนแต่ละคนรับไปท าล่วงหน้าก่อนเข้าเรียนเป็นการรับประกัน
ความรู้ของผู้เรียนเป็นรายบุคคล ( Individual Readiness  Assurance  Test ) แล้วให้ส่งกระดาษค าตอบ
ที่ท าหลังจากนั้นผู้สอนจะแจกข้อสอบชุดเดิมและกระดาษค าตอบใหม่  และให้ผู้เรียนตอบต าตอบที่
เป็นความคิดเห็นรวมของทีม( Group Readiness  Assurance  Test )ซ่ึงสมาชิกในกลุ่มแต่ละคนจะต้อง
มีการอภิปราย  ซักถาม  และตอบค าถามแก่สมาชิกเพื่อป้องกันความคิดเห็นของตนในทุกข้อค าถาม   
ผลที่ได้รับนอกจากผู้เรียนจะมีความรับผิดชอบท่ีชัดเจนต่อตนเอง  ต่อกลุ่ม  แล้วยังสามารถอธิบายถึง
แนวคิด  ความรู้ที่ตนเองมีให้แก่เพื่อนได้     ผู้สอนจะต้องมีการให้คะแนนและตอบสนองต่อค าตอบ
จากแบบฝึกหัดอย่างทันทีทันใด (Immediate Feedback  Technique)  ซ่ึงวิธีการนี้จะช่วยส่งเสริมความ
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รับผิดชอบท้ังผู้สอนและผู้เรียน  คะแนนที่น ามาพิจารณาเป็นคะแนนจากผลงานส่วนบุคคลและผลงาน
ของทีม 
 2.2 ความรับผิดชอบในการท างานให้แก่ทีม   
 เมื่อผู้เรียนได้มีการเตรียมตัวล่วงหน้าก่อนเข้าช้ันเรียน  จะท าให้เกิดความมั่นใจว่าตนเอง 
สามารถน าความรู้ที่ศึกษามาพัฒนาทีมให้ประสบความส าเร็จได้  เครื่องมือที่ใช้ในการประเมินก็ได้แก่ 
Peer Assesment  (แบบประเมินเพื่อน)  โดยสมาชิกจะประเมินความช่วยเหลือ  การสนับสนุนที่ให้แก่
ทีม  เช่น  การเตรียมตนเองก่อนเข้ากลุ่ม  ความสนใจ   การให้ข้อมูลที่เป็นประโยชน์  เป็นต้น 
 นอกจากนี้ผู้สอนจะต้องพัฒนาระบบการประเมินผลทั้งพฤติกรรมที่สนับสนุนการเรียนใน
กลุ่มและปฏิสัมพันธ์  คะแนนที่ให้ได้แก่คะแนนการเตรียมตนเอง  คะแนนการสนับสนุนของ
นักศึกษาท่ีให้แก่กลุ่ม  คุณภาพของงานกลุ่ม 
 3.  แบบฝึกหัดหรือข้อสอบ  ต้องส่งเสริมและช่วยพัฒนาทีมให้บรรลุเป้าหมาย 
 ในการออกแบบแบบฝึกหัดหรืองานที่ให้ผู้เรียน   แบบฝึกหัดหรืองาน  ต้องส่งเสริม
ปฏิสัมพันธ์กลุ่ม  กระบวนการตัดสินใจ  และบันทึกในแบบฟอร์มท่ีง่ายและไม่ยุ่งยาก  การให้งานแก่
ผู้เรียนในลักษณะที่เป็นรายงานมากๆหรือยาวๆ   จะท าให้ผู้เรียนแบ่งงานกันท า  ท าให้จ ากัด
ปฏิสัมพันธ์ในกลุ่ม 
 4.  ผู้เรียนต้องได้รับการตอบโต้กลับ (feedback) ในระยะเวลาที่เหมาะสม 
 ผู้เรียนจ าเป็นต้องได้รับการตอบกลับเกี่ยวกับกิจกรรมที่ท าในกลุ่มอย่างเป็นประจ าและใน
เวลาท่ีเหมาะสม  ส่ิงท่ีตอบกลับได้แก่ 
 Individual Readiness  Assurance  Test  การประกาศคะแนนอย่างเปิดเผยจะช่วยบอกให้
ผู้เรียนทราบว่าตนเองได้เตรียมความพร้อมมากน้อยแค่ไหน  ในขณะเดียวกันผู้เรียนจะเกิดความรับรู้
ต่อสถานการณ์ในกลุ่มว่ากลุ่มจะประสบความส าเร็จตามเป้าหมายหรือไม่  ท าให้เกิดแรงกระตุ้นเพื่อ
แก้ไขสถานการณ์ 
 Group Readiness  Assurance  Test  การให้ทราบคะแนนที่รวดเร็วจะเป็นส่ิงส าคัญในการ
พัฒนาทีม  อย่างไรก็ตามความส าคัญของกิจกรรมนี้อยู่ที่ผลงานที่ถูกต้องของทีม 
   การน า Team  base  Learning ลงสู่การปฏิบัติ (วรรณภรณ์ วีระพงษ์ , ออนไลน์ , 2551) 
 ประโยชน์ที่ส าคัญที่สุดของการเรียนแบบทีมนั้นอยู่ที่ ผู้สอนไม่ใช่ผู้รับผิดชอบหลักในการ
สอนเนื้อหารายวิชาให้ครอบคลุม  แต่เป็นผู้เรียนที่ต้องรับผิดชอบภายใต้กระบวนการที่เป็นตัวกระตุ้น
วิธีการนี้จึงเหมาะกับห้องเรียนที่มีจ านวนผู้เรียนกลุ่มใหญ่ เช่น มากกว่า 150 คน และใช้ผู้สอนเพียง  
1 คน  ความยุ่งยากของการจัดการเรียนการสอนแบบนี้อยู่ที่ต้องออกแบบรายวิชาใหม่ตั้งแต่ต้นจนจบ 
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การออกแบบ 
 ก่อนเปิดเรียน 
 1.จัดเนื้อหาสาระของรายวิชาเข้าเป็นหน่วยการเรียนขนาดใหญ่  การจัดขึ้นอยู่กับแนวคิด
หลักของวิชาอาจจัดเป็น 4- 7 หน่วยการเรียน  ซ่ึงต้องก าหนดเป้าหมายและวัตถุประสงค์ในแต่ละ
หน่วยการเรียน  แบบฝึกหัด  การให้คะแนน  เวลาท่ีใช้ 
 2.ระบุเป้าหมายและวัตถุประสงค์ของการเรียนรู้  ที่ส าคัญได้แก่การมีความรู้ความเข้าใจใน
แนวคิดและการน าไปประยุกต์ใช้ 
 3.ออกแบบระบบการวัดประเมินผล  การให้คะแนนค านึงถึงสัดส่วน 3 ด้านขึ้นอยู่กับ ผล 
การท างานของรายบุคคล   ผลการท างานของทีม  การสนับสนุนของสมาชิกเพื่อช่วยเหลือการท างาน
ของทีม 
 ชั่วโมงแรก 
 ผู้สอนต้องชี้แจงวิธีการเรียนแบบทีม   การจัดตั้งกลุ่มต้องมีการกระจายคุณสมบัติที่เป็น
ประโยชน์เพื่อหลีกเล่ียงการท างานเป็นกลุ่มย่อย  โดยทั้งผู้สอนและผู้เรียนร่วมกันตกลงพิจารณา
คุณสมบัติของสมาชิกในกลุ่มท่ีเป็นปัจจัยต่อความส าเร็จของทีมและผู้สอนควรมีข้อมูล    เมื่อจัดคนลง
ตามคุณสมบัติแล้วน ามาจัดกลุ่มอีกครั้ง   ซ่ึงการจัดกลุ่มควรท าหน้าชั้นเรียน 
 ขั้นตอน Team  base  Learning 
 1. ระบุเป้าหมายและวัตถุประสงค์ของรายวิชา  เช่น  ภายหลังการเรียนวิชานี้ผู้เรียนต้องมี 
ความสามารถอะไร  ผู้เรียนต้องมีความรู้เรื่องอะไร  ผู้เรียนจะน าความรู้ที่ได้ไปท าอะไร 
 2. จัดเนื้อหาสาระของรายวิชาเข้าเป็นหน่วยการเรียนขนาดใหญ่  การจัดขึ้นอยู่กับแนวคิด
หลักของวิชาอาจจัดเป็น 4- 7 หน่วยการเรียน  ซ่ึงต้องก าหนดเป้าหมายและวัตถุประสงค์ในแต่ละ
หน่วยการเรียน  แบบฝึกหัด  การให้คะแนน  เวลาท่ีใช้ 
 3. สร้างคู่มือส าหรับผู้เรียนในแต่ละหน่วยการเรียน  เป็นแนวคิดหลักที่ส าคัญของแต่ละ 
หน่วยการเรียน  ซ่ึงจะช่วยให้ผู้เรียนได้เตรียมตัวก่อน เรียน  รวมทั้งแจ้งรายชื่อเอกสาร  ต ารา   
ผลงานวิจัย  ข้อมูลจากอินเทอร์เน็ต  ที่ช่วยท าให้การเรียนมีประสิทธิภาพ 
 4. สร้างแบบทดสอบเพื่อรับประกันความพร้อมของผู้เรียน(Readiness Assurance Test) 
เป็นข้อสอบแบบตัวเลือกจ านวน 15 -20 ข้อ  ซ่ึงเป็นการทดสอบความรู้ของผู้เรียนจากการอ่านก่อนเข้า
ชั้นเรียน  ข้อสอบควรเน้นที่แนวคิดไม่เน้นที่รายละเอียดของเนื้อหา  เพื่อประเมินระดับของความ
พร้อมและความรู้ความเข้าใจของผู้เรียน 
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 5. สร้างแบบฝึกหัดที่เน้นการประยุกต์ใช้    ผลของการเรียนแบบทีมจะช่วยให้ผู้เรียนมี
ความรู้ความเข้าใจในเนื้อหาวิชามากขึ้น   กิจกรรมกลุ่มจะท าให้ผู้เรียนแสดงความคิดเห็นและตดัสินใจ
โดยใช้ดุลยพินิจ  เป้าหมายของแบบฝึกหัดนี้เพื่อสร้างโอกาสแก่ผู้เรียนได้เลือกค าตอบที่ถูกต้องและ
แตกต่างกันในแต่ละกลุ่มภายใต้เหตุผลที่บนพื้นฐานของแนวคิดของรายวิชา   นอกจากนี้ยังช่วย
ส่งเสริมประสิทธิภาพของการท างานเป็นทีม  หลีกเล่ียงการท างานแบบแบ่งกันท าเป็นตอนๆ 
(ตัวอย่างเช่นรายงานที่ยาวๆ) แทนที่จะเน้นการเขียนรายงานกลุ่ม 
 6. สร้างแผนการประเมิน  ซ่ึงได้แก่การประเมินผู้เรียนรายบุคคล  การประเมินผลการ
ท างานกลุ่ม  และการประเมินโดยสมาชิกกลุ่ม   

เอกชัย  กี่สุขพันธ์ (2538) กล่าวว่า  ในการท างานเป็นทีม สมาชิกทุกคนภายในทีม
จ าเป็นต้องเรียนรู้และท าความเข้าใจดังขั้นตอนการท างานเป็นทีม ซ่ึงมีทั้งหมด 7 ขั้นตอน ได้แก่  

1. การก าหนดภารกิจหรืองานที่จะท า หมายถึง ผู้บริหารหรือผู้บังคับบัญชาจะต้องมีการ
ก าหนดภารกิจหรืองานที่จะท าให้วัตถุประสงค์ของการท างานนั้น หน้าที่ความรับผิดชอบของสมาชิก
แต่ละคนก่อนที่จะมีการประชุมชี้แจงให้สมาชิกทราบ โดยพร้อมจะเปล่ียนแปลงได้ถ้าสมาชิกมี
ข้อเสนอแนะที่ดี หรือมีความจ าเป็นจะต้องเปล่ียน 

2. สร้างความเข้าใจกับสมาชิก เป็นการเปิดโอกาสให้สมาชิกได้มีส่วนร่วมในการเสนอแนะ
ข้อคิดเห็นและการตัดสินใจในเรื่องต่าง ๆ เช่น วัตถุประสงค์ในการท างานคืออะไรท าไมต้องท างานนี้ 
มาตรฐานในการท างานมีอะไร เป็นต้น ผลจากการสร้างความเข้าใจกับสมาชิกโดยให้มีส่วนร่วมนี้จะ
ท าให้สมาชิกเกิดความผูกพันกันทีมงานอย่างมากทีเดียว 

3. ระดมความคิด เมื่อผู้บริหารกับทีมงานเข้าใจวัตถุประสงค์ในการท างานส่ิงท่ีต้องการจาก
การท างาน ตลอดจนเรื่องอ่ืน ๆ ที่เกี่ยวข้องกับงานที่จะท าแล้ว ในขั้นนี้เป็นการระดมความคิดของ
สมาชิกทุกคนของทีมในเรื่องเกี่ยวกับวิธีปฏิบัติงานต่าง ๆ ทักษะการท างานที่จะเป็นข้อมูลข่าวสารที่
ต้องการ อัตราการเส่ียงกับผลประโยชน์ที่จะได้รับทรัพยากรในการท างานที่มีอยู่และข้อจ ากัดต่าง  ๆ 
ในการท างานส าหรับวิ ธีการระดมความคิดให้ได้ผลนั้น  ควรใช้ เทคนิคการระดมสมอง 
(brainstorming) 

4. การคัดเลือกความคิด เป็นการพิจารณาความคิดต่าง ๆ ที่ได้จากการระดมสมอง
โดยเฉพาะวิธีการปฏิบัติงาน ขั้นตอนต่าง ๆ ในการท างานซ่ึงผู้บริหารและทีมงานเห็นว่าดีที่สุด เพื่อ
น าไปก าหนดเป็นแผนการปฏิบัติงาน 

5. ก าหนดแผนปฏิบัติงาน หมายถึง การวางแผนการปฏิบัติงานเพื่อให้บรรลุวัตถุประสงค์ที่
ต้องการ และเพื่อให้สมาชิกของทีมทุกคนรับทราบแผนงานตรงกันว่า ใครมีหน้าที่ท าอะไรบ้าง ท าที่
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ไหนและเมื่อใด ผู้บริหารจะต้องแน่ใจว่าสมาชิกของทีมงานทุกคนเข้าใจตรงกันว่าแต่ละคนมีหน้าที่
รับผิดชอบอะไรบ้างในการปฏิบัติงานต่าง ๆ ตามแผน 

6. การปฏิบัติตามแผน เป็นการน าแผนไปสู่การปฏิบัติซ่ึงผู้บริหารจะต้องมีการก ากับและ
ตรวจสอบผลการปฏิบัติงานอยู่เสมอ ในขั้นการปฏิบัติตามแผนนี้ผู้บริหารอาจจะไม่ต้องลงมือปฏิบัติ
เองแต่ต้องคอยส่งเสริมสนับสนุน ส่ังการ ให้ค าแนะน าและกระตุ้นให้ก าลังใจแก่ลูกทีม 

7. การประเมินผล เป็นการสรุปผลการด าเนินงานในด้านต่าง ๆ ไม่ว่าจะป็นความก้าวหน้า
ของการท างาน คุณภาพของผลงาน ปัญหาและอุปสรรคที่เกิดขึ้น วิธีการด าเนินงานที่ได้ผลซ่ึงควรจะ
ปฏิบัติต่อไปตลอดจนประสบการณ์ที่ได้รับจากการปฏิบัติงาน เป็นต้น 

จากการศึกษางานวิจัยที่เกี่ยวข้องสามารถสรุปขั้นตอนการจัดการเรียนรู้เป็นทีมได้ดังนี้ คือ 
ขั้นที่ 1 ต้องมีการจัดตั้งทีมส าหรับการเรียนรู้   
การจัดตั้งทีมส าหรับการเรียนรู้ควรมีสมาชิก 4-8 คน  สมาชิกควรมีความหลากหลายและ

ควรเป็นทีมเดียวกันตลอดการเรียน 
ขั้นที่ 2 ระบุวัตถุประสงค์และเป้าหมายของรายวิชา 

 ควรมีการแจ้งวัตถุประสงค์ในการเรียนเพื่อให้นักเรียนทราบว่าเม่ือเรียนแล้วนักเรียนต้องมี
ความรู้เรื่องอะไร ความสามารถอะไร และจะน าความรู้ที่ได้ไปท าอะไร 

ขั้นที่ 3 จัดเนื้อหาสาระของรายวิชาเข้าเป็นหน่วยการเรียนรู้ 
ขั้นที่ 4 สร้างคู่มือส าหรับผู้เรียนในแต่ละหน่วย  
คู่มือส าหรับผู้เรียนอาจได้แก่ เอกสารประกอบการเรียน หรือส่ือการเรียนรู้ต่างๆ เพื่อใช้ใน

การจัดการเรียนรู้ 
ขั้นที่ 5 สร้างแบบฝึกหัด/กิจกรรมที่ส่งเสริมการท างานเป็นทีม  
แบบฝึกหัด/กิจกรรมจะต้องส่งเสริมและพัฒนาทีมให้บรรลุเป้าหมาย โดยต้องมีการส่งเสริม

ให้มีปฏิสัมพันธ์กันในทีม และผู้เรียนต้องได้รับการตอบกลับเกี่ยวกับกิจกรรมที่ท าในทีมอย่างเป็น
ประจ าและในเวลาท่ีเหมาะสม 

ขั้นที่ 6 สร้างแบบทดสอบ   
การสร้างแบบทดสอบควรมีท้ังก่อนเรียนและหลังเรียนเพื่อดูความพร้อมของผู้เรียนและผล

การเรียนรู้หลังการจัดการเรียนรู้ 
ขั้นที่ 7 สร้างแบบประเมิน  
การประเมิน ได้แก่ การประเมนิรายบุคคล การประเมินการท างานเป็นทีม และการประเมนิ

โดยสมาชิกในทีม  
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2.2.7  ประโยชน์ของการเรียนรู้เป็นทีม 
 ศ. สุรศักดิ์ นานานุกูล  (2539) กล่าวว่า การน าแนวคิดการเรียนรู้เป็นทีมมาใช้ในการพัฒนา
พนักงาน มีความส าคัญมากส าหรับองค์การที่ทันสมัยในปัจจุบัน ดังนี้  
 1. การเรียนรู้เป็นทีมเป็นวิธีการแก้ปัญหาท่ีดีที่สุด เป็นการดึงเอาสมองและข้อมูลที่ทุกคนมี
อยู่มาร่วมคิดร่วมท าเป็นข้อสรุปเดียวเพื่อที่จะแก้ปัญหาใหญ่ๆที่ซับซ้อนได้ หลักส าคัญก็คือ ผู้บริหาร
ต้องฝึกให้คุ้นเคยกับการระดมสมอง เพื่อจะได้ข้อมูลที่สมบูรณ์  การปรับความคิดเห็นให้ไปแนวทาง
เดียวกันตลอดจนการฝึกเรื่องวิธีคุยกันของผู้บริหารซ่ึงก็คือวิธีการฟังและวิธีการพูดอย่างถูกวิธีเพือ่ทีจ่ะ
ดึงความเห็นออกมาแล้วก็จะได้ข้อมูลความเห็นจากทุกคน 
 2. การท างานเป็นทีมจะช่วยส่งเสริมความร่วมมือและการสร้างการแข่งขัน การสร้างพลัง
ร่วม (Synergy) เครือข่ายทรัพยากรต่างๆ ทั้งภายในทีมและระหว่างทีมกับบุคคลภายนอกทีมสร้าง
พันธมิตรในการด าเนินธุรกิจให้เป็นไปอย่างรวดเร็ว ยืดหยุ่นขึ้น 
 3. การร่วมกันท ากิจกรรมการเรียนรู้จะท าให้พนักงานมีวิสัยทัศน์ร่วมกันซ่ึงจะเป็น
แรงผลักดันให้การปฏิบัติงานมุ่งเข้าสู่เป้าหมายอย่างมีเจตจ านง อย่างผูกพันบนพื้นฐานของค่านิยม 
ปรัชญา ความคิด ความเชื่อที่คล้ายคลึงกัน ส่งผลให้พนักงานไปสู่จุดหมายเดียวกัน 
 4. พนักงานมีความคิดอย่างเป็นระบบและวิพากษ์วิจารณ์ให้พนักงานในทีมได้รู้จักคิดวิธี
ใหม่ๆ เปน็การตรวจสอบความคิด ความเชื่อ ค่านิยมของตน 

จากการศึกษางานวิจัยที่เกี่ยวข้องสามารถสรุปประโยชน์ของการจัดการเรียนรู้เป็นทีมได้
ดังนี้ คือ เป็นการน าความรู้ความสามารถที่มีอยู่ในตัวของแต่ละบุคคลออกมาแสดงร่วมกันกลายเป็น
ผลงานหรือความคิดเดียวกันที่มีประสิทธิภาพ ช่วยส่งเสริมความร่วมมือและสร้างแรงผลักดันให้การ
ท างานไปสู่เป้าหมายได้ส าเร็จ 
 
2.3  ความสามัคคี 
 2.3.1  ความหมายของความสามัคคี 

พจนานุกรมฉบับราชบัณฑิตยสถาน พ.ศ. 2542 ได้ให้ความหมายค าว่า “ความสามัคคี” ว่า
“สามัคคี หมายถึง ความพร้อมเพรียงกัน ความกลมเกลียวเป็นน้ าหนึ่งใจเดียวกัน ไม่ทะเลาะเบาะแว้ง 
วิวาทบาดหมางกันและกัน”  

พระบาทสมเด็จพระเจ้าอยู่หัวพระราชทานความหมายค าว่า“สามัคคี” ที่ลึกซ้ึงกว่า ว่า “…
ความสามัคคีควรจะมีความหมายที่ลึกซ้ึงกว่านั้นอีกด้วย เช่น ควรจะหมายถึงความพร้อมเพรียงของทุก
ฝ่ายทุกคนที่มีความส านึกแน่ชัดในความรับผิดชอบท่ีจะพึงใช้ความรู้ความคิด ความสามารถ ตลอดจน



53 
 

คุณสมบัติทุก ๆ ประการของตน ให้ประกอบพร้อมเข้าด้วยกัน และให้เกื้อกูลส่งเสริมกัน เพื่อ
สร้างสรรค์ส่ิงท่ีเป็นสาระแก่นสารและที่เป็นประโยชน์เป็นความเจริญต่อส่วนรวมและเพื่อนมนุษย์...”  

(จันทรา ด่านคงรักษ์) 
สามัคคีก็คือ การเห็นแก่บ้านเมืองและช่วยกันทุกวิถีทาง เพื่อที่จะสร้างบ้านเมืองอยู่ได้  

      สามัคคีนี้ก็คือ การเห็นแก่บ้านเมือง และช่วยกันทุกวิถีทาง เพื่อที่จะสร้างบ้านเมืองให้
เข้มแข็ง ด้วยการเห็นอกเห็นใจซ่ึงกันและกัน และไม่ท าลายงานของกันและกัน และท างานด้วยความ
ซ่ือสัตย์สุจริต ต้องส่งเสริมงานของกันและกัน และไม่ท าลายงานของกันและกัน มีเรื่องอะไรให้ได้พูด
ปรองดองกัน อย่าเรื่องใครเรื่องมัน และงานก็ท างานอย่างตรงไปตรงมา นึกถึงประโยชน์ส่วนรวม...” 
(พระราชด ารัสของพระบาทสมเด็จพระเจ้าอยู่หัว พระราชทานในพิธีประดับยศนายต ารวจชั้นนายพล 
ณ พระต าหนักจิตรลดารโหฐาน วันพฤหัสบดีที่ 15 มกราคม 2519) 

กรมวิชาการ (2523 ก : 27) ได้ให้ความหมายของความสามัคคีไว่ว่า ความสามัคคี หมายถึง 
การแสดงออกซ่ึงการร่วมแรงร่วมใจกันเพื่อปฏิบัติงานให้ส าเร็จลุล่วงอย่างมีประสิทธิภาพ ความ
สามัคคีต้องอาศัยความอดทน เสียสละ ความเห็นอกเห็นใจซ่ึงกันและกันและตระหนักในปัญหา
ร่วมกัน ทั้งนี้ต้องมีการท างานร่วมกันบ่อยๆ จนเป็นผลดีของการร่วมมือมากกว่าการแยกท าอะไรอยู่
เพียงคนเดียว ความสามัคคีจะก่อให้เกิดความรักใคร่กลมเกลียวกันและก็สามารถปฏิบัติงานทุกอย่าง
ได้ส าเร็จ 

กรมวิชาการ (2535 ข : 27) กล่าวว่า ความสามัคคี หมายถึง การแสดงออกซ่ึงการร่วมแรง
ร่วมใจกันเพื่อปฏิบัติงานให้ส าเร็จลุล่วงอย่างมีประสิทธิภาพ ความสามัคคีต้องอาศัยความอดทน 
เสียสละ ความเห็นอกเห็นใจซ่ึงกันและกันและตระหนักในปัญหาร่วมกัน ทั้งนี้ต้องมีการท างาน
ร่วมกันบ่อยๆ จนเป็นผลดีของการร่วมมือมากกว่าการแยกท าอะไรอยู่เพียงคนเดียว ความสามัคคีจะ
ก่อให้เกิดความรักใคร่กลมเกลียวกันและสามารถปฏิบัติงานทุกอย่างส าเร็จ  

พระราชสุธี (โสภณ โสภณจิตฺโต ป.ธ.9) กล่าวว่า  ความสามัคคี หมายถึง ความพร้อมเพรียง
กัน ความกลมเกลียวเป็นน้ าหนึ่งใจเดียวกัน ไม่ทะเลาะเบาะแว้ง วิวาทบาดหมางกัน  ความสามัคคี มี
ด้วยกัน 2 ประการ คือ 1. ความสามัคคีทางกาย ได้แก่ การร่วมแรงร่วมใจกันในการท างาน 2. ความ
สามัคคีทางใจ ได้แก่ การร่วมประชุมปรึกษาหารือกันในเมื่อเกิดปัญหาขึ้น ความสามัคคีดังที่ว่านี้ จะ
เกิดมีขึ้นได้ ต้องอาศัยเหตุที่เรียกกันว่า สาราณียธรรม ธรรมเป็นเหตุให้ระลึกถึงกัน กระท าซ่ึงความ
เคารพระหว่างกัน อยู่ร่วมกันในสังคมด้วยดี มีความสุข ความสงบ ไม่ทะเลาะเบาะแว้ง ท าร้ายท าลาย
กัน มี 6 ประการ คือ  
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1.  ท าต่อกันด้วยเมตตา คือ แสดงไมตรีและความหวังดีต่อเพื่อนร่วมงาน ร่วมกิจการ ร่วม
ชุมชน ด้วยการช่วยเหลือธุระต่างๆ โดยเต็มใจ แสดงอาการกิริยาสุภาพ เคารพนับถือกัน ทั้งต่อหน้า
และลับหลัง 

2.  พูดต่อกันด้วยเมตตา คือ ช่วยบอกส่ิงที่เป็นประโยชน์ ส่ังสอนหรือแนะน าตักเตือนกัน
ด้วยความหวังดี กล่าววาจาสุภาพ แสดงความเคารพนับถือกัน ทั้งต่อหน้าและลับหลัง 

3.  คิดต่อกันด้วยเมตตา คือ ตั้งจิตปรารถนาดี คิดท าแต่ส่ิงท่ีเป็นประโยชน์แก่กัน มองกันใน
แง่ดี มีหน้าตายิ้มแย้มแจ่มใสต่อกัน 

4.  ได้มาแบ่งกันกินใช้ คือ แบ่งปันลาภผลที่ได้มาโดยชอบธรรม แม้เป็นของเล็กน้อย ก็
แจกจ่ายให้ได้มีส่วนร่วมใช้สอยบริโภคทั่วกัน 

5.  ประพฤติให้ดีเหมือนเขา คือ มีความประพฤติสุจริต ดีงาม รักษาระเบียบวินัยของ
ส่วนรวม ไม่ท าตนให้เป็นที่น่ารังเกียจ หรือท าความเส่ือมเสียแก่หมู่คณะ 

6.  ปรับความเห็นเข้ากันได้ คือ เคารพรับฟังความคิดเห็นกัน มีความเห็นชอบร่วมกัน ตกลง
กันได้ในหลักการส าคัญ ยึดถืออุดมคติหลักแห่งความดีงาม หรือจุดหมายอันเดียวกัน 

ส านักงานเลขาธิการสภาการศึกษา กระทรวงศึกษาธิการ (2550)  ได้ให้ความหมายของค า
ว่าสามัคคี ซ่ึงเป็นคุณธรรมพื้นฐานข้อที่ 7 จากทั้งหมด 8 ข้อ ว่า ความสามัคคี คือ การพร้อมเพรียงกัน  
กลมเกลียว ปรองดองกัน ร่วมใจกันปฏิบัติงานเพื่อบรรลุผลส าเร็จตามที่ต้องการ เกิดงานอย่าง
สร้างสรรค์ โดยปราศจากการทะเลาะ ไม่เอารัดเอาเปรียบกัน  เป็นการยอมรับความมีเหตุผลยอมรับ
ความแตกต่าง  ความหลากหลายทางความคิด ความหลากหลายทางเชื้อชาติ 
 นันทกา  จิรานันท์  (2551)  กล่าวว่า ความสามัคคี หมายถึง การยอมรับในความแตกต่าง
ของกันและกัน ท างานร่วมกันด้วยความยินดีเป็นสุขและคงไว้ซ่ึงความเป็นมิตรต่อกัน  โดยแสดง
พฤติกรรม คือ ช่วยเหลือกันท างาน ไม่ทะเลาะวิวาทกันและยอมรับฟังความคิดเห็นของผู้อ่ืน 

จากการศึกษาเอกสาร งานวิจัยที่เกี่ยวข้องสามารถสรุปความหมายของความสามัคคี  
หมายถึง  การแสดงออกถึงความพร้อมเพรียงปรองดองกัน รับฟังความคิดเห็นของผู้อ่ืน รู้บทบาทของ
ตนทั้งในฐานะผู้น าและผู้ตามที่ดี  แสดงออกโดยรวมเป็นอันหนึ่งอันเดียวกัน  ทั้งก าลังกายก าลัง
ความคิด  ก าลังความรู้  ในการท างานหรือประกอบภารกิจอย่างใดอย่างหนึ่ง  ให้ส าเร็จตามจุดประสงค์
ของกลุ่ม  เป็นหนึ่งเดียวกัน  โดยไม่เอาเปรียบกัน  ไม่ยุยงให้เกิดความแตกแยก  ไม่ก่อการทะเลาะ
วิวาท  และร่วมมือกันท างานเพื่อประโยชน์ของหมู่คณะ 
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2.3.2  ลักษณะพฤตกิรรมที่แสดงถงึการมีความสามัคค ี
ส านักงานเลขาธิการสภาการศึกษา กระทรวงศึกษาธิการ (2550)  ได้อธิบายไว้ว่า ผู้ท่ีมีความ

สามัคคี คือ ผู้ที่เปิดใจกว้าง รับฟังความคิดเห็นของผู้อ่ืน รู้บทบาทหน้าที่ของตนทั้งในฐานะผู้น าและผู้
ตามท่ีดี มีความมุ่งมั่นต่อการรวมพลังช่วยเหลือเกื้อกูล เพื่อให้งานส าเร็จลุล่วง สามารถแก้ปัญหาและ
ขจัดความขัดแย้งได้ เป็นผู้มีเหตุผลยอมรับความแตกต่าง ความหลากหลายทางวัฒนธรรม  ความคิด
และความเชื่อ พร้อมท่ีจะปรับตัวเพื่อที่จะอยู่ร่วมกันอย่างสันติและสมานฉันท์ และยังได้พัฒนาตัวชี้วัด
พฤติกรรมคุณธรรมด้านความสามัคคีไว้ ซ่ึงพอที่จะเกี่ยวข้องกับการท างาน คือ  มองโลกในแง่ดี 
ยอมรับความคิดเห็นของผู้อ่ืนเป็นทั้งผู้น าและผู้ตามในขณะเดียวกัน  ปฏิบัติตามข้อตกลงของกลุ่มโดย
ไม่มีบิดพล้ิว ไม่มีปัญหาทะเลาะวิวาท มีความสุขกับการท างานเป็นทีม  ยินดีให้ความช่วยเหลือกันและ
ท างานที่ได้รับมอบหมายให้ส าเร็จ 

กรมวิชาการ (2535 ข : 27) กล่าวว่า พฤตกิรรมที่แสดงออกซ่ึงความสามัคคี มดีังนี้ 
 1.  ปรับตนเองให้เข้ากับผู้อ่ืนไดด้ ี
 2.  รับผิดชอบต่อส่วนรวมมากกว่าส่วนตัว 
 3.  เข้ามีส่วนร่วมอย่างแข็งขันในกิจการของส่วนรวม 
 4.  เป็นผู้มีประสานความสามัคคใีนหมู่คณะ 
 5.  ไม่แบ่งแยกเป็นพวกเขาพวกเรา 
 6.  รักหมู่คณะ มีใจหวังดี และช่วยเหลือเกื้อกูลในทางไม่ผิดศีลธรรม 
 7.  มองคนอ่ืนในแง่ดีเสมอ 

รุจิร์ ภู่สาระ และคณะ (2535 : 26)  กล่าวว่า สมาชกิในกลุ่มต้องมีพฤติกรรมความสามัคคี 
ดังนี ้
 1.  ช่วยเหลืองานในหมู่คณะดว้ยความเต็มใจ 
 2.  สละความสุขส่วนตวัเพื่อประโยชน์ส่วนรวม 
 3.  ยอมรับฟังความคิดเห็นของผู้อ่ืน 
 4.  รู้จักการแบ่งหน้าทีใ่นกลุ่ม 
 5.  มีความเอ้ือเฟื้อซ่ึงกันและกัน 

Cox (2002)  กล่าวว่า ความสามัคคใีนทีมมีความสัมพันธ์อย่างสูงกับความสามารถของทีม 
ในทีมท่ีมีความสามัคคีภายในทีมสูงจะส่งผลให้ความสามารถของทีมสูงขึ้นและส่งผลให้ทีมประสบ
ผลส าเร็จ 
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 จากการศึกษาเอกสาร งานวิจัยที่เกี่ยวข้องสามารถสรุปลักษณะพฤติกรรมที่แสดงถึงการมี
ความสามัคคีได้ดังนี้  คือ  การปรับตนเองให้เข้ากับผู้อ่ืน  ยอมรับฟังความคิดเห็นของผู้อ่ืน  รู้บทบาท
ของตน ทั้งในฐานะผู้น าและผู้ตามที่ดี รักหมู่คณะ เป็นหนึ่งเดียวกัน  ไม่แตกแยก ไม่ทะเลาะวิวาท   
มีความเอ้ือเฟื้อซ่ึงกันและกัน ร่วมมือกันท างานเพื่อประโยชน์ของหมู่คณะ และ มีความสุขกับการ
ท างานเป็นทีม 
 
 2.3.3  ประโยชน์ของความสามัคคี 
 นภา  กัลยาณสุต (2520)  ได้กล่าวถึงประโยชน์ของความสามัคคีไว้ว่า หากความสามัคคีมี
ขึ้นในหมู่คนกลุ่มใดก็จะท าให้คนกลุ่มนั้นมีความสุข ความเจริญ  เช่น ในบ้านหรือในห้องเรียนถ้าทุก
คนรักใคร่กันดี มีงานอะไรก็ช่วยกันท า ทุกคนจะอยู่กันอย่างมีความสุข การงานก็จะเสร็จเร็ว ทุกคนจึง
ควรรักษาความสามัคคีไว้เพื่อความเจริญก้าวหน้าของตนเอง 
 

2.3.4  การเสริมสร้างความสามัคค ี 
 นันทกา  จิรานันท์ (2551)  กล่าวว่า หลักธรรมในการเสริมสร้างความสามัคคีให้เกิดขึ้นใน
สังคมหรือในหมู่คณะ มี 6 ประการด้วยกัน คือ สาราณียธรรม 6  ซ่ึงความหมายว่า หลักธรรมอันเป็น
ที่ตั้งแห่งความระลึกถึงเป็นหลักธรรมที่จะเสริมสร้างความรู้สึกที่ดีให้เกิดขึ้นต่อกันและกันอยู่เสมอ ซ่ึง
ถือเป็นเครื่องมืออย่างหนึ่งในการเสริมสร้างความสามัคคี มีน้ าหนึ่งใจเดียวกันให้เกิดขึ้นด้วย ซ่ึงหาก
สังคมใดหรือหมู่คณะใดต้องการที่จะเสริมสร้างความสามัคคีและความเป็นปึกแผ่นให้เกิดขึ้นก็ควร
น าเอาหลักธรรมทั้ง 6 ประการนี้ไปใช้ ดังนี้ 
 1.  เมตตามโนกรรม  หมายถึง  การคิดดี  การมองกันในแง่ดี  มีความหวังดีและปรารถนาดี
ต่อกัน  รักและเมตตาต่อกัน คิดแต่ในส่ิงท่ีสร้างสรรค์ต่อกัน  ไม่อิจฉาริษยา  ไม่คิดอคติ  ไม่พยาบาท  
ไม่โกรธแค้นกัน  รู้จักให้โอกาสและให้อภัยกันและกันเสมอ   
 2.  เมตตาวจีกรรม  หมายถึง  การพูดแต่ส่ิงที่ดีงาม  พูดกันด้วยความรักความปรารถนาดี 
รู้จักการพูดให้ก าลังใจกันในยามที่มีใครเศร้าหมองหรือผิดหวัง ไม่พูดซ้ าเติมกัน ไม่นินทาว่าร้ายท้ังต่อ
หน้าและลับหลัง  พูดแนะน ากันในส่ิงท่ีมีประโยชน์ ไม่โกหก 
 3.  เมตตากายกรรม  หมายถึง  การกระท าความดีต่อกัน  สนับสนุนช่วยเหลือกันทางด้าน
ก าลังกาย มีความอ่อนน้อมถ่อมตน ไม่เบียดเบียนรังแกกัน  ไม่ท าร้ายกัน 
 4.  สาธารณโกคี หมายถึง การรู้จักแบ่งปันผลประโยชน์ที่ได้มาอย่างยุติธรรมไม่เอาเปรียบ
กัน 
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 5. สีลสามัญญตา หมายถึง การปฎิบัติตนตามกฎระเบียบข้อบังคับอย่างเดียวกัน ไม่ก้าวก่าย
หน้าที่กัน ไม่อ้างอ านาจบาตรใหญ่ ไม่ถืออภิสิทธ์ิใดๆ 

6. ทิฎฐิสามัญญติ หมายถึง ความคิดเห็นเป็นอย่างเดียวกัน คิดในส่ิงที่ตรงกัน ปรับมุมมอง
ให้ตรงกัน ไม่ยึดถือความคิดของตนเป็นใหญ่ รู้จักยอมรับฟังความคิดเห็นของคนอ่ืน 
 จากการศึกษาเอกสาร งานวิจัยที่เกี่ยวข้องสามารถสรุปลักษณะพฤติกรรมที่แสดงถึงการมี
ความสามัคคีได้ดังตาราง 
ตารางท่ี 2.2  แสดงการวิเคราะห์ทฤษฎีเกี่ยวกับความสามัคคีเพื่อสร้างแบบประเมินความสามัคคี 
 

ทฤษฎีเกี่ยวกับความสามัคค ี

รายชื่อนักวจิัย/เอกสารงานวจิัย 
กรม 

วิชาการ 
(2535) 

ส านักงานเลขา- 
ธิการสภาการ- 
ศึกษา (2550) 

รุจิร์   
ภู่าระ 
(2535) 

นันทกา 
จิรานันท ์
(2551) 

- เปิดใจกว้างรับฟังความคิดเห็นของผู้อ่ืน     

- รู้บทบาทหน้าที่ของตนเองในฐานะผู้น าผู้ตามที่ดี     
- ช่วยเหลือเกื้อกูลกัน ไม่เอาเปรียบกัน     

- แก้ปัญหาและขจัดความขัดแย้ง     

- มีเหตุผล ยอมรับความแตกต่าง     
- ปรับตัวเพื่ออยู่ร่วมกัน     

- ร่วมกันท างานอย่างเต็มใจ     
- ปฏิบัติตามข้อตกลง     

- มีความสุขกับการท างาน     
- รับผิดชอบต่อส่วนรวมมากกว่าส่วนตัว     
- ไม่แบ่งแยกเป็นพวกเขาพวกเรา     
- รักหมู่คณะ     

- รู้จักแบ่งหน้าที่ในกลุ่ม     
- รู้จักให้โอกาสและให้อภัยกันและกันเสมอ       

- ไม่พูดซ้ าเติมกัน ไม่นินทาว่าร้ายท้ังต่อหน้า 
และลับหลัง 

    

- รู้จักให้โอกาสและให้อภัยกันและกันเสมอ       
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 จากตารางเป็นการวิเคราะห์หาลักษณะของพฤติกรรมที่แสดงถึงความสามัคคี  ซ่ึงจะ
แนวทางในการน าไปสร้างเป็นเครื่องมือเพื่อใช้ในการประเมินความสามัคคีของนักเรียน 
 
2.4  ตัวชี้วัดและสาระการเรียนรู้แกนกลาง 
 กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยีเป็นกลุ่มสาระที่ช่วยพัฒนาให้ผู้เรียน                      
มีความรู้  ความเข้าใจ   มีทักษะพื้นฐานที่จ าเป็นต่อการด ารงชีวิต    และรู้เท่าทันการเปล่ียนแปลง     
สามารถน าความรู้เกี่ยวกับการด ารงชีวิต   การอาชีพ  และเทคโนโลยี  มาใช้ประโยชน์ในการท างาน
อย่างมีความคิดสร้างสรรค์ และแข่งขันในสังคมไทยและสากล   เห็นแนวทางในการประกอบอาชีพ   
รักการท างาน  และมีเจตคติที่ดีต่อการท างาน   สามารถด ารงชีวิตอยู่ในสังคมได้อย่างพอเพียง                 
และมีความสุข  ดังนั้นการจัดการเรียนการสอนในรายวิชาการน าเสนอส่ือประสม ง 30243 นั้น จึง
สอดคล้องกับสาระที่  1  และ 3 ของระดับช้ัน ม.4-6 รายละเอียดดังนี้  

2.4.1  สาระการเรียนรู้  
สาระที่ 1 การด ารงชวีิตและครอบครัว 
สาระที่ 3 เทคโนโลยีสารสนเทศและการส่ือสาร 

2.4.2  มาตรฐานการเรียนรู้/ตัวชี้วัด 
มาตรฐาน ง  1.1       

เข้าใจการท างาน  มีความคิดสร้างสรรค์   มีทักษะกระบวนการท างาน  ทักษะ   
การจัดการ ทักษะกระบวนการแก้ปัญหา  ทักษะการท างานร่วมกัน  และทักษะ  การแสวงหาความรู้    
มีคุณธรรม และลักษณะนิสัยในการท างาน   มีจิตส านึก  ในการใช้พลังงาน ทรัพยากร และ
ส่ิงแวดล้อม  เพื่อการด ารงชีวิตและครอบครัว 

ตัวชี้วัดที่ 2   
สร้างผลงานอย่างมีความคิดสร้างสรรค์   และมีทักษะการท างานร่วมกัน   

มาตรฐาน ง 3.1 
เข้าใจ เห็นคุณค่า และใช้กระบวนการเทคโนโลยีสารสนเทศในการสืบค้นข้อมูล 

การเรียนรู้ การส่ือสาร  การแก้ปัญหา การท างาน  และอาชีพอย่างมีประสิทธิภาพ ประสิทธิผล  มีคุณธรรม 
ตัวชี้วัดที่ 12  

ใช้คอมพิวเตอร์ช่วยสร้างชิ้นงานหรือโครงงานอย่างมีจิตส านึกและความ
รับผิดชอบ 
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2.5  งานวิจัยที่เกี่ยวข้อง 
2.5.1 งานวิจัยที่เกี่ยวข้องกับการเรียนบนเว็บ 
นัฏพันธ์ุ นันทวาศ  (2551) ได้ท าการวิจัยเรื่อง การสร้างบทเรียนอิเล็กทรอนิกส์บนเครือข่าย

เรื่องการเขียนแบบวิศวกรรมส าหรับนักศึกษาคณะวิศวกรรมศาสตร์  มหาวิทยาลัยเชียงใหม่ ซ่ึง
การศึกษาครั้งนี้มีวัตถุประสงค์เพื่อสร้างบทเรียนอิเล็กทรอนิกส์บนเครือข่ายเรื่องการเขียนแบบ
วิศวกรรม ส าหรับนักศึกษาคณะวิศวกรรมศาสตร์ มหาวิทยาลัยเชียงใหม่ กลุ่มตัวอย่างที่ใช้ศึกษา คือ 
นักศึกษาระดับปริญญาตรี คณะวิศวกรรมศาสตร์ มหาวิทยาลัยเชียงใหม่ ที่ลงทะเบียนเรียนกระบวน
วิชา 259104 การเขียนแบบวิศวกรรม ในภาคเรียนที่ 2 ปีการศึกษา 2550 จ านวน 30คน เครื่องมือที่ใช้
ในการศึกษาได้แก่ บทเรียนอิเล็กทรอนิกส์บนเครือข่ายเรื่องการเขียนแบบวิศวกรรมและแบบสอบถาม 
ซ่ึงเก็บรวบรวมข้อมูลโดยให้กลุ่มตัวอย่างทดสอบการใช้งานบทเรียนอิเล็กทรอนิกส์บนเครือข่ายเรื่อง
การเขียนแบบวิศวกรรม จากนั้นให้ตอบแบบสอบถามการใช้งานแล้วน าข้อมูลที่ได้มาวิเคราะห์หาค่า
ร้อยละผลการศึกษาท้ัง 4 ด้าน คือ ด้านการน าเสนอเนื้อหา ด้านการออกแบบหน้าจอ ด้านการท่องไป
ในบทเรียน ด้านการใช้งาน โดยในด้านการน าเสนอเนื้อหากลุ่มตัวอย่างเห็นด้วยร้อยละ 98 เพราะมี
การน าเสนอจากง่ายไปหายาก มีค าอธิบายประกอบชัดเจน เข้าใจง่าย ส่วนเนื้อหาของภาพ3D มีการ
น าเสนอเนื้อหาในมุมมองท่ีน่าสนใจบทเรียนมีเนื้อหาครบถ้วนตามกระบวนวิชาในหลักสูตรที่เรียน 
รวมท้ังผู้เรียนสามารถน าเนื้อหาของบทเรียนไปทบทวนซ้ าได้อีก ส าหรับการด้านการออกแบบหน้าจอ 
นักศกึษาเห็นด้วยร้อยละ 91 โดยเฉพาะเรื่องของภาพวีดิทัศน์ ขนาดของภาพขนาดตัวอักษรและชนิด
ของตัวอักษรมีความเหมาะสม ชัดเจน อ่านง่ายและเข้าใจ การออกแบบการวางหน้าจอท าให้เห็นภาพ 
วีดิทัศน์และภาพ 3D ที่แสดงลักษณะมุมมองต่างๆ ได้อย่างชัดเจนรวมทั้งการจัดวางองค์ประกอบใน
ส่วนของ กระดานสนทนา คุยออนไลน์ ผู้เรียนและผู้สอนสามารถเข้าถึงได้ง่าย ในด้านการท่องไปใน
บทเรียน กลุ่มศึกษาเห็นด้วยคิดเป็นร้อยละ 99 ทั้งในเรื่องของการเชื่อมโยงเมนูและบทเรียน เชื่อมโยง
ได้อย่างถูกต้อง วีดีทัศน์บรรยายและภาพ 3D ส่ือความหมายเห็นแล้วเข้าใจได้ง่ายชัดเจน และด้านการ
ใช้งาน กลุ่มศึกษาเห็นด้วยคิดเป็นร้อยละ 98 เพราะการเข้าไปศึกษาบทเรียนอิเล็กทรอนิกส์บน
เครือข่ายสามารถเข้าไปได้อย่างสะดวกและรวดเร็ว นอกจากนี้กลุ่มตัวอย่างได้ข้อเสนอแนะว่า ในการ
เข้าถึงบทเรียนอิเล็กทรอนิกส์บนเครือข่ายพร้อมกันหลายคนควรมีการเปิด Bandwidth ให้เหมาะสม
กับการใช้งานแบบ Video Streaming 

ฉลอง  มีเนียม  (2549)  ศึกษาผลการเรียนรู้จากการเรียนแบบรายบุคคลและแบบกลุ่ม
ร่วมมือ โดยใช้บทเรียนบนเครือข่าย เรื่อง ระบบเครือข่ายคอมพิวเตอร์ส าหรับผู้ เรียนระดับชั้น
มัธยมศึกษาปีที 5 เครื่องมือที่ใช้ในการวิจัยประกอบด้วย บทเรียนบนเครือข่าย แบ่งออกเป็น 2 
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บทเรียน คือ ส าหรับการเรียนแบบรายบุคคล กับการเรียนแบบกลุ่มร่วมมือ แบบทดสอบวัดผลสัมฤทธ์ิ
ทางการเรียน และแบบสอบถามความพึงพอใจของผู้เรียน ผลการวิจัย พบว่า 1) ประสิทธิภาพของ
บทเรียนบนเครือข่าย รายวิชาเทคโนโลยีสารสนเทศของผู้เรียนที่เรียนแบบรายบุคคลและแบบกลุ่ม
ร่วมมือมีประสิทธิภาพผ่านเกณฑ์  2) ผลสัมฤทธ์ิทางการเรียนของผู้เรียนที่เรียนแบบกลุ่มร่วมมือ มี
คะแนนเฉล่ียสูงกว่าผู้เรียนที่เรียนแบบรายบุคคล อย่างมีนัยส าคัญทางสถิติที่ระดับ .01  3) ผู้เรียนที่
เรียนด้วยบทเรียนบนเครือข่ายรายวิชาเทคโนโลยีสารสนเทศ ท่ีเรียนแบบรายบุคคล แบบกลุ่มร่วมมือ 
และโดยรวมมีความพึงพอใจต่อบทเรียนอยู่ในระดับมาก  4) ความคงทนในการเรียนรู้ของผู้เรียนที่
เรียนแบบกลุ่มร่วมมือ มีคะแนนเฉล่ียของความคงทนในการเรียนรู้สูงกว่าผู้เรียนที่เรียนแบบรายบุคคล 

ณัฐพงศ์ สมปินตา (2549) ได้ท าการวิจัยเรื่อง การผลิตบทเรียนอิเล็กทรอนิกส์บนเครือข่าย
เรื่องส่ือการสอน พบว่า ด้านการน าเสนอเนื้อหา ด้านการท่องไปในบทเรียน และด้านการใช้งาน มี
กลุ่มศึกษาเห็นด้วยด้วยกันตรงจ านวน 28 คน คิดเป็นร้อยละ 93.33 โดยทั้งนี้เห็นว่าบทเรียนมีการ
น าเสนอเนื้อหาจากง่าย มีความชัดเจน เข้าใจง่าย การเชื่อมโยงภายในบทเรียนนั้นถูกต้อง จุดเชื่อมโยง
สามารถส่ือความหมายเข้าใจได้อย่างชัดเจน และง่ายในการศึกษาเนื้อหาบทเรียน ทั้ง 3 ด้าน ที่ได้
ออกแบบและพัฒนานั้นมีความเหมาะสม ส่วนด้านการออกแบบหน้าจอ มีกลุ่มศึกษาเห็นด้วยจ านวน 
26 คน คิดเป็นร้อยละ 86.67 เห็นว่าปริมาณของข้อความและขนาดของภาพที่น าเสนอมีความเหมาะสม 
ชนิดตัวอักษรที่น าเสนอในบทเรียนอ่านง่ายและมีความกลมกลืนในทุกหน้าของบทเรียน ส่วนการจัด
วางต าแหน่งของหัวเรื่อง การวางเนื้อหา การจัดวางปุ่ม ล้วนอยู่ในต าแหน่งที่เหมาะสม นอกจากนี้ กลุ่ม
ศึกษาได้ให้ข้อเสนอแนะเกี่ยวกับบทเรียนอิเล็กทรอนิกส์บนเครือข่ายไว้ว่าส าหรับเนื้อหาที่มีเสียง
บรรยายประกอบ ควรจะมีปุ่มท่ีให้ผู้เรียนสามารถจะท าการฟังซ้ าได้อีกครั้ง 
 ธ ารงค์  พานิชเจริญ  (2549) ได้ท าการวิจัย เรื่อง การพัฒนาบทเรียนบนเครือข่ายอินทราเน็ต 
เรื่องความรู้เบ้ืองต้นเกี่ยวเกี่ยวกับคอมพิวเตอร์และอินเทอร์เน็ต ส าหรับนักเรียนชั้นประถมศึกษาปีที่ 5 
โรงเรียนอนุบาลราชบุรี ผลการวิจัยพบว่า  1) การพัฒนาบทเรียนบนเครือข่ายอินทราเน็ต เรื่องความรู้
เบื้องต้นเกี่ยวเกี่ยวกับคอมพิวเตอร์และอินเทอร์เน็ต ส าหรับนักเรียนชั้นปรถมศึกษาปีที่  5 โรงเรียน
อนุบาลราชบุรี เป็นบทเรียนที่สามารถสร้างองค์ความรู้ที่เหมาะสมและสามารถพัฒนาผลสัมฤทธ์ิของ
ผู้เรียนได้เป็นอย่างดี  2)  ประสิทธิภาพของบทเรียนบนเครือข่ายอินทราเน็ต มีค่า E1/E2 = 81.11/83.34   
3)  ผลสัมฤทธ์ิทางการเรียนของนักเรียนที่เรียนด้วยบทเรียนบนเครือข่ายอินทราเน็ตหลังเรียนสูงกว่า
ก่อนเรียน   
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มณเฑียร รัตนศิริวงศ์วุฒิ  (2546)  ได้ท าการวิจัยเรื่อง การพัฒนาและหาประสิทธิภาพระบบ
การจัดการเรียนการสอนและบทเรียนคอมพิวเตอร์ผ่านส่ืออิเล็กทรอนิกส์บนเครือข่ายอินเทอร์เน็ต 
กรณีศึกษา วิชาการพัฒนาระบบสารสนเทศตามหลักสูตรวิทยาศาสตร์มหาบัณฑิต พบว่า บทเรียนมี
ประสิทธิภาพ 86.22/85.60 ซ่ึงสูงกว่าเกณฑ์ที่ก าหนดไว้ คือ 80/80 และเมื่อน าคะแนนผลสัมฤทธ์ิ
ทางการเรียนมาวิเคราะห์เปรียบเทียบพบว่ากลุ่มทดลองเรียนมีผลสัมฤทธ์ิทางการเรียนไม่แตกต่างกับ
กลุ่มเรียนในแบบปกติอย่างมีนัยส าคัญทางสถิติที่ .05 นอกจากนี้แล้วการประเมินความคิดเห็นของ 
ความเชี่ยวชาญด้านเนื้อหา มีคะแนนเฉล่ียเท่ากับ 4.61 แสดงว่าความคิดเห็นของผู้เชี่ยวชาญอยู่ใน
เกณฑ์ดี และการประเมินความคิดเห็นของผู้เชี่ยวชาญด้านระบบ มีค่าเฉล่ียเท่ากับ 4.22 แสดงว่าระดับ
ความคิดเห็นของผู้เชี่ยวชาญเกี่ยวกับระบบอยู่ในเกณฑ์ดี ระบบสามารถน าไปประยุกต์ใช้งานจริงได้
เป็นอย่างดี 

 
2.5.2  งานวิจัยที่เกี่ยวข้องกับการเรียนแบบทีม 
ปัญญฎา ประดิษฐบาทุกา (2546)  ได้ท าการวิจัยเรื่อง ผลของการเรียนรู้แบบทีมแข่งขันที่มี

ต่อความคิสร้างสรรค์ทางคณิตศาสตร์ของนักเรียนชั้นประถมศึกษาปีที่ 6 โรงเรียนทรงวิทยา จังหวัด
สมุทรปราการ พบว่า นักเรียนมีความคิดสร้างสรรค์ทางคณิตศาสตร์มากขึ้น หลังจากได้รับการเรียนรู้
แบบทีมแข่งขัน อย่างมีนัยส าคัญทางสถิติที่ระดับ .01  

อวยชัย  โชคบุญสิทธ์ิ (2525) ได้ท าการวิจัยเรื่อง การศึกษาผลสัมฤทธ์ิและทัศนคติต่อวิชา
สังคมศึกษาเรื่อง “การพัฒนาประเทศ” ชั้นมัธยมศึกษาปีที่ 3 โดยการเรียนเป็นทีม พบว่า นักเรียนที่
เรียนจากการเรียนเป็นทีมมีผลสัมฤทธ์ิทางการเรียนสูงกว่านักเรียนที่เรียนในกลุ่มควบคุม อย่างมี
นัยส าคัญทางสถิติที่ระดับ .05 นักเรียนที่เรียนจากการเรียนเป็นทีมมีผลสัมฤทธ์ิทางการเรียนสูงขึ้น
อย่างมีนัยส าคัญทางสถิติที่ระดับ .05 และนักเรียนที่เรียนจากการเรียนเป็นทีม มีทัศนคติต่อวิชาสังคม
ศึกษาไม่แตกต่างกับนักเรียนในกลุ่มควบคุม อย่างมีนัยส าคัญทางสถิติที่ระดับ .05 

 
2.5.3  งานวิจัยที่เกี่ยวข้องกับการเรียนบนเว็บแบบทีม 

 วัลยา พุ่มต้นวงศ์ (2552) ได้ท าการวิจัยเรื่อง การศึกษาผลการเรียนอีเลิร์นนิงแบบร่วมมือที่มี
ต่อทักษะการท างานกลุ่มของนักศึกษาระดับปริญญาตรี มหาวิทยาลัยศิลปากร พบว่า 1) ผลการเรียนรู้
หลังเรียนของการเรียนอีเลิร์นนิงแบบร่วมมือกับการเรียนอีเลิร์นนิงไม่แตกต่างกัน  2) ผลการเรียนรู้
ก่อนและหลังการเรียนอีเลิร์นนิงแบบร่วมมือและการเรียนอีเลิร์นนิงแตกต่างกันอย่างมีนัยส าคัญทาง
สถิติที่ระดับ .05 โดยคะแนนที่ได้หลังเรียนสูงกว่าก่อนเรียน 3) ทักษะการท างานกลุ่มของนักศึกษาที่
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เรียนด้วยการเรียนอีเลิร์นนิงแบบร่วมมือมีคะแนนรวมเฉล่ียอยู่ในระดับมาก 4) ผลงานจากการเรียน
ด้วยส่ือประกอบการเรียนอีเลิร์นนิงแบบร่วมมือ มีคะแนนรวมเฉล่ียอยู่ในระดับดี 5) นักศึกษามีความ
คิดเห็นต่อวิธีการจัดการเรียนอีเลิร์นนิงแบบร่วมมือมีค่าเฉล่ียอยู่ในระดับมาก   
  ณัฏฐ์สิตา ศิริรัตน์  (2551) ได้ท าการวิจัยเรื่อง รูปแบบการแลกเปล่ียนเรียนรู้บนเครือข่าย
ตามแนวคิดการเรียนรู้แบบชี้น าตนเองเพื่อสร้างการเรียนรู้ร่วมกันเป็นทีมส าหรับบุคลากรทาง
การศึกษาพบว่า  องค์ประกอบของรูปแบบการแลกเปล่ียนเรียนรู้บนเครือข่าย ตามแนวคิดการเรียนรู้
แบบชี้น าตนเอง ประกอบด้วย 5 องค์ประกอบ คือ 1) ฐานข้อมูลความรู้บนเครือข่าย 2) ทีมเรียนรู้บน
เครือข่าย 3) เครื่องมือในการแลกเปล่ียนเรียนรู้บนเครือข่าย 4) ผู้เชี่ยวชาญบนเครือข่าย และ 5) 
เทคโนโลยีที่สนับสนุนการท างานร่วมกันบนเครือข่าย  ขั้นตอนการเรียนรู้ของรูปแบบการแลกเปล่ียน
เรียนรู้บนเครือข่าย ตามแนวคิดการเรียนรู้แบบช้ีน าตนเอง มี 7 ขั้น คือ 1) ขั้นการวางแผนและก าหนด
ทิศทางการเรียนรู้ 2) ขั้นการสร้างแรงจูงใจในการเรียนรู้ 3) ขั้นการสนับสนุนแหล่งข้อมูลและแหล่ง
วิทยากร 4) ขั้นการจัดเก็บรวบรวมข้อมูลและน าผลจากข้อมูลที่ค้นพบไปใช้ 5) ขั้นการฝึกทักษะใน
การสืบสวนสอบสวน และการลองผิดลองถูก 6) ขั้นการทบทวนผลการเรียนรู้และการปรับปรุงแก้ไข 
และ 7) ขั้นการประเมินผลการเรียนรู้ และกลุ่มตัวอย่างมีคะแนนการประเมินตนเองด้านการเรียนรู้
ร่วมกันเป็นทีมหลังการท ากิจกรรมการแลกเปล่ียนเรียนรู้สูงกว่าก่อนท ากิจรรมอย่างมีนัยส าคัญทาง
สถิติที่ระดับ .05 กลุ่มตัวอย่างมีความคิดเห็นว่า รูปแบบการแลกเปล่ียนเรียนรู้บนเครือข่าย ตาม
แนวคิดการเรียนรู้แบบชี้น าตนเอง ส าหรับบุคลากรทางการศึกษาเพื่อสร้างการเรียนรู้ร่วมกันเป็น
ทีม มีความเหมาะสมในระดับมาก 

ลัดดาวัลย์ สวัสดิ์หลง  (2550)  ได้ท าการวิจัยเรื่อง การพัฒนาบทเรียนคอมพิวเตอร์ช่วยสอน
บนเว็บด้วยการเรียนรู้แบบโครงงานเพื่อการเรียนรู้เป็นทีมของนักศึกษาระดับปริญญาโท มหาวิทยาลัย
เทคโนโลยีพระจอมเกล้าพระนครเหนือ พบว่า บทเรียนคอมพิวเตอร์ช่วยสอนบนเว็บด้วยการเรียนรู้
แบบโครงงานเพื่อการเรียนรู้เป็นทีมที่ผู้วิจัยพัฒนาขึ้น มีประสิทธิภาพ 83.16/80.19 สูงกว่าเกณฑ์ 
80/80 ที่ตั้งไว้ ส่วนผู้เรียนมีความพึงพอใจต่อบทเรียนคอมพิวเตอร์ช่วยสอนบนเว็บด้วยการเรียนรู้แบบ
โครงงานเพื่อการเรียนรู้เป็นทีมท่ีผู้วิจัยพัฒนาขึ้นในระดับมาก 

นิษฐา  พุฒิมานรดีกุล  (2548)  ได้ท าการวิจัย เรื่อง การน าเสนอรูปแบบการฝึกอบรมบนเว็บ
เพื่อพฒันาทักษะการเรียนรู้เป็นทีม ส าหรับนักเทคโนโลยีการศึกษา พบว่า ผลการศึกษาความคิดเห็น
ของผู้เชี่ยวชาญเกี่ยวกับรูปแบบการฝึกอบรมบนเว็บเพื่อพัฒนาทักษะการเรียนรู้เป็นทีมส าหรับนัก
เทคโนโลยีการศึกษาพบว่า ผู้เชี่ยวชาญโดยส่วนใหญ่มีความเห็นว่าองค์ประกอบของการฝึกอบรม 
และขั้นตอนการฝึกอบรมมีความเหมาะสมโดยการปฐมนิเทศและปัจฉิมนิเทศการฝึกอบรมควรจัด
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ภายในห้องฝึกอบรม และควรให้ผู้เข้าฝึกอบรมได้พบกันแบบเผชิญหน้าอย่างน้อย 3 ครั้ง ในช่วงเวลา
การฝึกอบรม ผลการทดลองใช้รูปแบบการฝึกอบรม พบว่า กลุ่มตัวอย่างมีคะแนนทักษะการเรียนรู้
เป็นทีมและประสิทธิภาพในการท างานเป็นทีมสูงกว่าก่อนการฝึกอบรมอย่างมีนัยส าคัญทางสถิติที่
ระดับ .05 และกลุ่มตัวอย่างร่วมมือกันท างานเป็นทีมในระดับมาก ส่วนรูปแบบการฝึกอบรมบนเว็บ
เพื่อพัฒนาทักษะการเรียนรู้เป็นทีมส าหรับนักเทคโนโลยีการศึกษา ประกอบด้วย 3 ส่วน คือ  
1. องค์ประกอบการฝึกอบรม 10 องค์ประกอบ ได้แก่ เป้าหมายของการฝึกอบรม ชนิดของการเรียนรู้
ในการฝึกอบรม หลักสูตรการฝึกอบรม บทบาทผู้เข้ารับการฝึกอบรม บทบาทของผู้ด าเนินการ
ฝึกอบรม บทบาทผู้เชี่ยวชาญและผู้สนับสนุนการฝึกอบรม วิธีการปฏิสัมพัน์ผ่านเว็บ เทคโนโลยี
คอมพิวเตอร์และระบบเครือข่าย ปัจจัยสนับสนุนการฝึกอบรมผ่านเว็บ การประเมินการฝึกอบรม 2. 
ขั้นตอนการฝึกอบรม ประกอบด้วย ขั้นตอนก่อนการฝึกอบรมได้แก่ ลงทะเบียนบนเว็บฝึกอบรมและ
ปฐมนิเทศ ขั้นด าเนินการฝึกอบรมตามการเรียนรู้แบบโครงการ 6 ขั้นตอน ได้แก่ ค้นหาปัญหาหรือ
ก าหนดภารกิจงาน รวบรวมและวิเคราะห์ข้อมูล วางแผนการด าเนินงาน ด าเนินงาน สรุปผลการ
ด าเนินงาน และน าเสนอผลการด าเนินงาน ขั้นตอนการประเมินผลการฝึกอบรมได้แก่ การประเมิน
ทักษะการเรียนรู้เป็นทีม ประสิทธิภาพในการท างานเป็นทีม และการมีส่วนร่วมในการท างานเป็นทีม
บนเว็บ 3. กิจกรรมการฝึกอบรมบนเว็บได้แก่ ไปรษณีย์อิเล็กทรอนิกส์  กระดานข่าว ห้องสนทนา การ
ค้นหาบนเครือข่าย และการถ่ายโอนแฟ้มข้อมูล และกิจกรรมในห้องฝึกอบรม ได้แก่ การปฐมนิเทศ
การฝึกอบรม การวางแผนด าเนินการโครงการ และการปัจฉิมนิเทศการฝึกอบรม 
 

2.5.4  งานวิจัยที่เกี่ยวข้องกับความสามัคคี 
อดิศักดิ์  ดวงศรี (2553)  ได้ท าการวิจัยเรื่อง  การจัดการเรียนรู้พลศึกษาโดยใช้กจิกรรม

ฟุตบอลตามแนวคิดของคารร์อล เพื่อพัฒนาความสามัคคีของนักเรียนมัธยมศึกษาตอนต้น ผลการวิจัย
พบว่า 1) ค่าเฉล่ียของคะแนนความสามัคคีหลังการทดลองของนักเรียนกลุ่มทดลองสูงกว่าก่อนการ
ทดลองอย่างมีนัยส าคัญทางสถิติที่ระดับ .05 และค่าเฉล่ียของคะแนนความสามัคคกี่อนและหลังการ
ทดลองของนักเรียนกลุ่มควบคุมไม่แตกต่างกันอย่างมีนยัส าคัญทางสถิติที่ระดับ .05  2) ค่าเฉล่ียของ
คะแนนความสามัคคีหลังการทดลองของนกัเรียนกลุ่มทดลองสูงกว่านักเรยีนกลุ่มควบคุมอย่างมี
นัยส าคัญทางสถิติที่ระดับ .05 

นันทกา  จิรานันท์ (2551)  ได้ท าการวิจัย เรื่อง ผลของการใช้โปรแกรมพัฒนาคุณลักษณะ
ด้านความสามัคคี  ความรับผิดชอบ  ความมีน้ าใจและความกล้าแสดงออก  ที่มีต่อความส าเร็จในการ
ท ากิจกรรมกลุ่ม  ของนักเรียนประถมศึกษาปีที่ 4 ผลการวิจัยพบว่า  1) หลังการเข้าร่วมโปรแกรม
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นักเรียนมีคะแนนความส าเร็จของงานจากการท ากิจกรรมร่วมกันสูงกว่าก่อนการเข้าร่วมโปรแกรม
อย่างมีนัยส าคัญทางสถิติที่ระดับ .05  2)  หลังการเข้าร่วมโปรแกรมนักเรียนมีพฤติกรรมการท างาน
กลุ่มด้านความสามัคคี ความรับผิดชอบ ความมีน้ าใจและความกล้าแสดงออกสูงกว่าก่อนการเข้าร่วม
โปรแกรม  อย่างมีนัยส าคัญทางสถิติที่ระดับ .05  3) หลังการเข้าร่วมโปรแกรมนักเรียนมีพฤติกรรม
การท างานกลุ่มด้านความสามัคคี ความรับผิดชอบ ความมีน้ าใจและความกล้าแสดงสูงกว่าเกณฑ์การ
ประเมินโปรแกรม คือ 75%  อย่างมีนัยส าคัญทางสถิติที่ระดับ .05  4)  จ านวนนักเรียนที่ผ่านเกณฑ์การ
ประเมินของแต่ละกิจกรรมการเรียนรู้ มีจ านวนร้อยละ 80 ขึ้นไปในทุกกิจกรรม 
 
 จากการศึกษางานวิจัยที่เกี่ยวข้องสรุปได้ว่า การเรียนการสอนบนเว็บท าให้ผู้เรียนสามารถ
เรียนที่ไหน เม่ือไร ด้วยเนื้อหามากน้อยเท่าใดก็ได้ ตามที่ผู้เรียนต้องการซ่ึงสอดคล้องกับแนวคิดที่ให้
ผู้เรียนเป็นศูนย์กลางการเรียนรู้ ซ่ึงผู้เรียนสามารถเรียนรู้เนื้อหาต่างๆ ตามกิจกรรมที่ผู้สอนจัดไว้ให้
และสามารถสืบค้นข้อมูลเพิ่มเติมได้จากแหล่งการเรียนรู้บนเครือข่ายท่ีมากมายมหาศาล อีกทั้งผู้เรียน
สามารถติดต่อส่ือสารกับผู้สอนหรือผู้เรียนด้วยกันเองได้ผ่านทางกระดานสนทนาหรือห้องสนทนา
ออนไลน์ ได้  ซ่ึงการติดต่อส่ือสารถือเป็นทักษะที่ส าคัญในการท าให้การท างานเป็นทีมประสบ
ความส าเร็จ สอดคล้องกับลัดดาวัลย์  สวัสดิ์หลง (2550) กล่าวว่า การเรียนรู้เป็นทีมเป็นกระบวนการที่
ช่วยเพิ่ม ส่งเสริมให้ผลสัมฤทธ์ิดีขึ้น และยังมีอิทธพลในเชิงสนับสนุนเรื่องของความภาคภูมิใจใน
ตนเอง รวมท้ังส่งเสริมความสามารถในการท างานร่วมกับผู้อ่ืนด้วย ซ่ึงเหมาะกับทุกรายวิชาที่จะน า
รูปแบบการสอนแบบนี้ไปใช้จัดการเรียนการสอนต่อไป  
  
  
 



 
 

บทที่ 3 
 

วิธีด ำเนินกำรวิจัย 
  
 การวิจัยครั้งนี้เป็นการวิจัยกึ่งการทดลองแบบ The One-Group Pretest-Postest Design 
(Shadish ,W.R. ; Cook , T.D. and Campbell , D.T. , 2002) มีวัตถุประสงค์เพื่อพัฒนาบทเรียนบนเว็บ
ช่วยสอนแบบการเรียนรู้เป็นทีม หาประสิทธิภาพของเว็บช่วยสอนแบบการเรียนรู้เป็นทีม ประเมิน 
ผลงานนักเรียน  เปรียบเทียบผลการเรียนของนักเรียนก่อนเรียนและหลังเรียน  ประเมินความสามัคคี
ของนักเรียนหลังจากเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมและศึกษาความพึงพอใจของ
นักเรียนในการใช้เว็บช่วยสอนแบบการเรียนรู้เป็นทีม ของนักเรียนชั้นมัธยมศึกษาปีที่ 5 โดยมีการ
ด าเนินการตามขั้นตอน ดังนี้ 
 3.1  แบบแผนการทดลอง 
 3.2  ประชากรและกลุ่มตวัอย่าง 
 3.3  เครื่องมือในการวิจยั 
 3.4  การเก็บรวบรวมข้อมูล 
 3.5  การวิเคราะห์ข้อมูล 
 
3.1   แบบแผนกำรทดลอง 
 ในการวจิัยครั้งนี้ใช้แบบแผนการทดลองแบบ The One-Group Pretest-Posttest Design 
(Shadish ,W.R. ; Cook , T.D. and Campbell , D.T. , 2002) 

                     
 ความหมาย 
  O1 หมายถึง การทดสอบก่อนเรียน 

  X หมายถึง การเรียนด้วยเว็บช่วยสอนแบบการเรยีนรู้เป็นทีม 

  O2 หมายถึง การทดสอบหลังเรียน 
 
3.2  ประชำกรและกลุ่มตัวอยำ่ง 
 ประชากร หมายถึง นักเรียนชั้นมัธยมศึกษาปีที่ 5 โรงเรียนสวนกุหลาบวิทยาลัย รังสิต 
จังหวัดปทุมธานี จ านวน 526 คน ภาคเรียนที่ 2 ปีการศึกษา 2555 
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 กลุ่มตัวอย่าง หมายถึง นักเรียนระดับชั้นมัธยมศึกษาปีที่ 5  ที่ก าลังเรียนในภาคเรียนที่ 2  
ปีการศึกษา 2555 โรงเรียนสวนกุหลาบวิทยาลัย รังสิต จังหวัดปทุมธานี จ านวน 33 คน ได้มาโดยการ
สุ่มอย่างง่าย (Simple Random Sampling)  ด้วยวิธีการจับฉลาก 1 ห้องเรียน  
 
3.3  เคร่ืองมอืในกำรวิจัย 
 ในการวจิัยครั้งนี้ ผู้วิจัยได้ใช้เครื่องมือในการวิจัย ดังนี้ 
 3.3.1  บทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
 3.3.2  แบบทดสอบผลการเรียนรู ้
 3.3.3  แบบประเมินผลงานนักเรียน 
 3.3.4  แบบประเมินความสามัคค ี
 3.3.5  แบบประเมินความพึงพอใจ 
 3.3.1  เว็บช่วยสอนแบบกำรเรียนรู้เป็นทีม 
 ในการพัฒนาเว็บช่วยสอนแบบการเรียนรู้เป็นทีม เพื่อใช้ในการวิจัยครั้งนี้ มีขั้นตอนการ
พัฒนาเว็บช่วยสอนแบบการเรียนรู้เป็นทีม ดังนี้ 
 1. ศีกษา ทฤษฎี หลักการ เอกสาร หนังสือ งานวิจัยที่เกี่ยวข้องกับเว็บช่วยสอนและ
การจัดการเรียนการสอนแบบการเรียนรู้เป็นทีม  
 2. ศึกษาหลักสูตรแกนกลางปี 2551 ของกลุ่มสาระการงานอาชีพและเทคโนโลยี 
ระดับช้ันมัธยมศึกษาปีที่ 4-6 ซ่ึงมีรายละเอียดดังนี้ 

สาระที่ 1 การด ารงชีวิตและครอบครัว 
มาตรฐาน ง  1.1  เข้าใจการท างาน  มีความคิดสร้างสรรค์   มีทักษะกระบวนการ

ท างาน  ทักษะ   การจัดการ ทักษะกระบวนการแก้ปัญหา  ทักษะการท างานร่วมกัน  และทักษะ  การ
แสวงหาความรู้     มีคุณธรรม และลักษณะนิสัยในการท างาน   มีจิตส านึก  ในการใช้พลังงาน 
ทรัพยากร และส่ิงแวดล้อม  เพื่อการด ารงชีวิตและครอบครัว 

ตัวชี้วัดที่ 2  สร้างผลงานอย่างมีความคิดสร้างสรรค์   และมีทักษะการท างานร่วมกัน   
สาระที่  3   เทคโนโลยีสารสนเทศและการส่ือสาร 
มาตรฐาน ง 3.1  เข้าใจ เห็นคุณค่า และใช้กระบวนการเทคโนโลยีสารสนเทศในการ

สืบค้นข้อมูล  การเรียนรู้   การส่ือสาร   การแก้ปัญหา การท างาน  และอาชีพอย่างมีประสิทธิภาพ 
ประสิทธิผล  มีคุณธรรม 
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ตัวชี้วัดที่ 12 ใช้คอมพิวเตอร์ช่วยสร้างชิ้นงานหรือโครงงานอย่างมีจิตส านึกและ
ความรับผิดชอบ 
   3. ก าหนดวัตถุประสงค์การเรียนการสอนและผลการเรียนรู้ 
 4. รวบรวมเนื้อหาส าหรับสร้างเว็บช่วยสอนแบบการเรียนรู้เป็นทีม ซ่ึงมีรายละเอียด
ดังนี้ 
        4.1  การใช้งานโปรแกรมเบื้องต้น 

4.2  การแทรกข้อความและรูปภาพ 
4.3  การแทรกมัลติมีเดีย 
4.4  การสร้างปฏิสัมพันธ์กับส่ือ 
4.5  การน าเสนอชิ้นงาน 

 5. น าวัตถุประสงค์และเนื้อหา ไปให้ผู้เชี่ยวชาญด้านเนื้อหา จ านวน 3 ท่าน โดยมี
เกณฑ์ก าหนดผู้เชี่ยวชาญ ดังนี้ 
 5.1 ผู้มีคุณวุฒิระดับปริญญาโทหรือปริญญาเอก สาขาเทคโนโลยีทาง
การศึกษาหรือเทคโนโลยีและส่ือสารการศึกษา และส าเร็จการศึกษามาไม่น้อยกว่า 3 ปี  
 5.2 เป็นอาจารย์ที่มีประสบการณ์สอนในรายวิชาที่เกี่ยวข้องกับเทคโนโลยี
สารสนเทศมาไม่น้อยกว่า 10 ปี หรือ มีต าแหน่งวิทยฐานะช านาญการพิเศษ (คศ.3) 
 6. ให้ผู้เชี่ยวชาญพิจารณาความตรงเชิงเนื้อหา (Content Validity) เพื่อตรวจสอบ
ความถูกต้องของเนื้อหาและพิจารณาความสอดคล้องของเนื้อหากับวัตถุประสงค์ (IOC)   และน าผล
มาวิเคราะห์ข้อมูลให้มีค่า 0.5 ขึ้นไป  
 7. ปรับปรุงและแก้ไขวัตถุประสงค์และเนื้อหา 
 8. ออกแบบโครงสร้างเว็บช่วยสอนโดยท าเป็น Storyboard จากนั้นน าไปให้
ผู้เชี่ยวชาญด้านการออกแบบเว็บไซต์จ านวน 3  ท่าน พิจารณาความตรงเชิงเนื้อหา (Content Validity) 
เพื่อตรวจสอบแล้วน ามาปรับปรุงแก้ไขตามค าแนะน าของผู้เชี่ยวชาญ โดยมีเกณฑ์ก าหนดผู้เชี่ยวชาญ 
ดังนี้ 
 8.1 ผู้มีคุณวุฒิระดับปริญญาโทหรือปริญญาเอก สาขาเทคโนโลยีทาง
การศึกษาหรือเทคโนโลยีและส่ือสารการศึกษา และส าเร็จการศึกษามาไม่น้อยกว่า 3 ปี  
 9. สร้างเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
 10. ให้ผู้เชี่ยวชาญประเมินเว็บช่วยสอนแบบการเรียนรู้เป็นทีม โดยเป็นผู้เชี่ยวชาญ
ด้านเนื้อหา 3 ท่าน และผู้เชี่ยวชาญด้านส่ือและเทคโนโลยี 3 ท่าน ด้วยแบบประเมินการใช้เว็บช่วย
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สอนแบบการเรียนรู้เป็นทีมด้านเนื้อหา  ด้านส่ือและเทคโนโลยีตามล าดับ ซ่ึงเป็นมาตราส่วนประมาณ
ค่า (Rating Scale) 4 ระดับ ได้แก่ มากที่สุด มาก น้อย และน้อยที่สุด (รังสรค์ โฉมยา , 2549) 
  โดยก าหนดระดับการประเมิน ดังนี ้
   4  หมายถึง  มากที่สุด 
   3  หมายถึง  มาก 
   2  หมายถึง  น้อย 
   1  หมายถึง  น้อยที่สุด 
  และมีเกณฑ์ความหมายของแต่ละระดับ ดังนี ้
   4.00 – 3.50  หมายถึง ระดับมากที่สุด 
   3.49 – 2.50  หมายถึง ระดับมาก 
   2.49 – 1.50  หมายถึง ระดับน้อย 
   1.49 – 1.00  หมายถึง ระดับน้อยที่สุด 
  โดยให้ได้ค่าตั้งแต่ 2.50 ขึ้นไป 
 11. น าแบบประเมินมาวิเคราะห์ข้อมูล ผลการประเมินเว็บช่วยสอนแบบการเรียนรู้
เป็นทีมครั้งนี้ ผู้เชี่ยวชาญเห็นว่าเว็บไซต์มีความเหมาะสมระดับมากที่สุด (   = 3.83 , S.D. = .05) 
รายละเอียดแสดงในตารางภาคผนวกที่ 17 ภาคผนวก ค   
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ดังแสดงไว้ในแผนภูมิที่ 1 :  แสดงขั้นตอนการสร้างและพฒันาเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   
  
 
  
ภำพที่  3.1  แสดงขั้นตอนการพฒันาเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 

 
 
 
 

ศึกษาทฤษฎี หลักการ เอกสาร งานวิจัยที่เกี่ยวข้อง  หลักสูตรแกนกลางปี 2551 

ก าหนดวัตถุประสงค์การเรียนและผลการเรียนรู้ 

รวบรวมเนื้อหา 

น าวัตถุประสงค์และเนื้อหาไปให้ผู้เช่ียวชาญวิเคราะห์หาค่า IOC 

พิจารณา 

ออกแบบโครงสร้างเว็บช่วยสอนแล้วน าไปให้ผู้เช่ียวชาญด้านสื่อและเนื้อหาตรวจ 

สร้างเว็บช่วยสอนแล้วน าไปให้ผู้เช่ียวชาญตรวจ 

น าผลการประเมินจากผู้เช่ียวชาญมาปรับปรุงเว็บช่วยสอนแบการเรยีนรู้เป็นทีม 

ปรับปรุง 

ปรับปรุง 

ปรับปรุง 

ผ่าน 

ผ่าน 

ผ่าน 

ไม่ผ่าน 

ไม่ผ่าน 

ไม่ผ่าน 

พิจารณา 

พิจารณา 
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กำรหำประสิทธิภำพของบทเรียน 
 ในการวิจัยครั้งนี้ได้ด าเนินการหาประสิทธิภาพของเว็บช่วยสอนแบบการเรียนรู้เป็นทีม มี 3 
ขั้นตอน ดังนี้ 
 1. การหาประสิทธิภาพแบบเดี่ยวหรือแบบหนึ่งต่อหนึ่ง จ านวน 3 คน ได้แก่ นักเรียนที่มี
คะแนนเฉล่ียสูง กลาง ต่ า อย่างละ 1 คน ให้ผู้เรียนเรียนจากเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
หลังจากนั้นให้ผู้เรียนท าแบบทดสอบหลังเรียน แล้วน าผลคะแนนระหว่างเรียนและหลังเรียนไปหาค่า 
E1/E2 ตามเกณฑ์ 80/80  พบว่า ประสิทธิภาพ E1/E2 มีค่าเท่ากับ 85.00/83.33 
 2. การหาประสิทธิภาพแบบกลุ่มเล็ก จ านวน 6 คน ได้แก่ นักเรียนที่มีคะแนนเฉล่ียสูง กลาง 
ต่ า อย่างละ 2 คน ให้ผู้เรียนเรียนจากเว็บช่วยสอนแบบการเรียนรู้เป็นทีม หลังจากนั้นให้ผู้เรียนท า
แบบทดสอบหลังเรียน แล้วน าผลคะแนนระหว่างเรียนและหลังเรียนไปหาค่า E1/E2 ตามเกณฑ์ 80/80 
พบว่า ประสิทธิภาพ E1/E2 มีค่าเท่ากับ 84.58/84.44 
 3. การหาประสิทธิภาพแบบกลุ่มใหญ่ จ านวน 30 คน ได้แก่ นักเรียนที่มีคะแนนเฉล่ียสะสม
สูง กลาง ต่ า คละกัน ให้ผู้เรียนเรียนจากเว็บช่วยแบบการเรียนรู้เป็นทีม หลังจากนั้นให้ผู้เรียนท า
แบบทดสอบหลังเรียน แล้วน าผลคะแนนระหว่างเรียนและหลังเรียนไปหาค่า E1/E2 ตามเกณฑ์ 80/80 
พบว่า ประสิทธิภาพ E1/E2 มีค่าเท่ากับ 88.29/84.33 
 
 3.3.2  แบบทดสอบผลกำรเรียนรู้ 
 ในการพัฒนาแบบทดสอบผลการเรียนรู้รายวิชาการน าเสนอส่ือประสม  เรื่องการน าเสนอ
ส่ือประสมเบื้องต้น  ได้ด าเนินการตามขั้นตอน ดังต่อไปนี้ 
 1. ก าหนดวัตถุประสงค์ของการทดสอบ 
 2. สร้างแบบทดสอบผลการเรียนรู้ โดยมีรายละเอียดดังนี้ 

-  ก าหนดชนิดของแบบทดสอบเป็นแบบเป็นแบบปรนัย 4 ตัวเลือก 
  -  ก าหนดโครงสร้างของแบบทดสอบผลการเรียนรู้ 
  -  ก าหนดตารางน้ าหนักคะแนนและจ านวนข้อสอบจ านวน 30 ข้อ 
  -  สร้างข้อสอบให้ได้จ านวน 40 ข้อ เพื่อใช้ในการคัดเลือกข้อสอบ 
 3. น าไปให้ผู้เชี่ยวชาญด้านเนื้อหา จ านวน 3 ท่าน ประเมินความสอดคล้องของข้อสอบกับ
วัตถุประสงค์  โดยมีเกณฑ์ในการให้คะแนน ดังนี้ 
  -  ถ้าแน่ใจว่าข้อค าถามตรงตามวัตถุประสงค์ให้ตอบ +1 
  -  ถ้าไม่แน่ใจว่าข้อค าถามตรงตามวัตถุประสงค์ให้ตอบ 0 
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  -  ถ้าแน่ใจว่าข้อค าถามไม่ตรงตามวัตถุประสงค์ให้ตอบ -1 
และมีเกณฑ์ก าหนดผู้เชี่ยวชาญ ดังนี้ 
  - ผู้มีคุณวุฒิระดับปริญญาโทหรือปริญญาเอก สาขาเทคโนโลยีทางการศึกษา
หรือเทคโนโลยีและส่ือสารการศึกษา และส าเร็จการศึกษามาไม่น้อยกว่า 3 ปี  
  -  เป็นอาจารย์ที่มีประสบการณ์สอนในรายวิชาที่เกี่ยวข้องกับเทคโนโลยีมาไม่
น้อยกว่า 10 ปี หรือ มีต าแหน่งวิทยฐานะช านาญการพิเศษ (คศ.3) 
  โดยผลการประเมินความสอดคล้องของผู้เชี่ยวชาญด้านเนื้อหามีค่าเท่ากับ 1.00 
 4. น าไปให้ผู้เชี่ยวชาญด้านการวัดและประเมินผล จ านวน 3 ท่าน ประเมินความสอดคล้อง
ของข้อสอบกับวัตถุประสงค์ (IOC) โดยจะต้องมีค่า IOC ตั้งแต่ 0.5 ขึ้นไป โดยมีเกณฑ์ก าหนด
ผู้เชี่ยวชาญ ดังนี้ 
  4.1 ผู้มีคุณวุฒิระดับปริญญาโทหรือปริญญาเอก สาขาการวัดและประเมินผล 
และส าเร็จการศึกษามาไม่น้อยกว่า 3 ปี 
  โดยผลการประเมินความสอดคล้องของผู้เชี่ยวชาญด้านการวัดและประเมินผลมี
ค่าเท่ากับ 1.00 
 5. น าแบบทดสอบผลการเรียนรู้จ านวน 40 ข้อ ไปทดลองใช้กับตัวแทนกลุ่มตัวอย่างที่มี
ความรู้เรื่องนี้ แล้วน าค่าผลการทดสอบมาหาค่าความยากง่าย (p) แบบ Spit half  ให้ได้ค่าอยู่ระหว่าง 
0.20 – 0.80 และหาค่าอ านาจจ าแนก (r) โดยมีค่าระหว่าง 0.2 – 1.0 ซ่ึงแบบทดสอบผลการเรียนรู้ครั้งนี้ 
มีค่าความยากง่ายระหว่าง 0.33 – 0.63  และค่าอ านาจจ าแนกระหว่าง 0.33 – 0.63   
 6. น าไปหาค่าความเชื่อมั่น  โดยคัดเลือกข้อสอบให้เหลือ 30 ข้อ จากค่าความยากง่าย   
0.20 – 0.80  โดยเลือกข้อที่มีค่าใกล้ 0.5 ซ่ึงแบบทดสอบครั้งนี้มีค่าความยากง่ายระหว่าง 0.33 – 0.63 
แล้วน ามาหาค่าความเชื่อมั่นด้วยสูตร KR-20 โดยมีค่าความเชื่อมั่น 0.8 ขึ้นไป ซ่ึงค่าความเชื่อมั่นของ
แบบทดสอบครั้งนี้มีค่าเท่ากับ 0.86 
 7. น าแบบทดสอบมาปรับปรุง 
 8. น าแบบทดสอบไปใช้กับกลุ่มเป้าหมาย  

 
ดังแสดงไว้ใน แผนภูมิท่ี 2 : แสดงขั้นตอนการสร้างและพัฒนาแบบทดสอบผลการเรียนรู้จาก

การใช้เว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
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ภำพที่  3.2  แสดงขั้นตอนการสร้างและพัฒนาแบบทดสอบผลการเรียนรู้จากการใช้เว็บช่วยสอนแบบ  
    การเรียนรู้เป็นทีม   
 
 
 
 

พิจารณา 

ก าหนดวัตถุประสงค์ของแบบทดสอบ 

สร้างแบบทดสอบผลการเรียนรู้ 

น าแบบทดสอบไปให้ผู้เช่ียวชาญด้านเนื้อหาตรวจสอบความถูกต้องเหมาะสมของเนื้อหา 
 

น าแบบทดสอบไปให้ผู้เช่ียวชาญด้านการวัดและประเมินผล หาค่า IOC 

น าแบบทดสอบผลการเรียนรู้ไปปรับปรุง 

น าแบบทดสอบผลการเรียนรู้ไปใช้กับกลุ่มเป้าหมาย 

ปรับปรุง 

ปรับปรุง 

ผ่าน 

ผ่าน 

ไม่ผ่าน 

ไม่ผ่าน 

น าแบบทดสอบผลการเรียนรู้ไปทดลองใช้กับตัวแทนกลุ่มตัวอย่าง แล้วน ามาหาค่า p และ r 

คัดเลือกข้อสอบข้อ จากค่าความยากง่าย  0.20 – 0.80 และค่าความเช่ือม่ัน  0.8 ขึ้นไป 
 

พิจารณา 
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3.3.3  แบบประเมินผลงำนนักเรียนจำกกำรเรียนด้วยเว็บช่วยสอนแบบกำรเรียนรู้เป็นทีม 
ผู้วิจัยใช้เกณฑ์การประเมินค่า (rubric score) ก าหนดแนวทางการให้คะแนน มีขั้นตอน ดังนี้ 
1.  ศึกษาวิธีก าหนดคะแนนประเมินค่า (rubric score) และเอกสารงานวิจัยที่เกี่ยวข้อง 
2.  สร้างแบบประเมินผลงาน  โดยก าหนดเกณฑ์การประเมินเป็น 4, 3, 2 และ 1 ประเด็นที่

จะประเมิน 5 ด้าน คือ ความสมบูรณ์ของชิ้นงาน  ความเหมาะสมของเนื้อหาที่น าเสนอ  การจัดวาง
ข้อความและรูปภาพเหมาะสม  มีการเชื่อมโยงอย่างเหมาะสม  การแทรกเทคนิคพิเศษอย่างเหมาะสม 

3.  น าไปให้ผู้เชี่ยวชาญด้านเนื้อหา จ านวน 3 ท่าน ตรวจสอบความความถูกต้อง การ
ครอบคลุมของเนื้อหาและน ามาปรับปรุงแก้ไข  โดยมีเกณฑ์ก าหนดผู้เชี่ยวชาญ ดังนี้ 
  - ผู้มีคุณวุฒิระดับปริญญาโทหรือปริญญาเอก สาขาเทคโนโลยีทางการศึกษา
หรือเทคโนโลยีและส่ือสารการศึกษา และส าเร็จการศึกษามาไม่น้อยกว่า 3 ปี  
  -  เป็นอาจารย์ที่มีประสบการณ์สอนในรายวิชาที่เกี่ยวข้องกับเทคโนโลยีมาไม่
น้อยกว่า 10 ปี หรือ มีต าแหน่งวิทยฐานะช านาญการพิเศษ (คศ.3) 
  โดยผลการประเมินความสอดคล้องของผู้เชี่ยวชาญด้านเนื้อหามีค่าเท่ากับ 1.00 
 4.  น าไปให้ผู้เชี่ยวชาญด้านการวัดและประเมินผล จ านวน 3 ท่าน ตรวจสอบความ
สอดคล้องของข้อค าถามกับวัตถุประสงค์ (IOC) โดยจะต้องมีค่า IOC ตั้งแต่ 0.5 ขึ้นไป โดยมีเกณฑ์
ก าหนดผู้เชี่ยวชาญ ดังนี้ 

 4.1 ผู้มีคุณวุฒิระดับปริญญาโทหรือปริญญาเอก สาขาการวัดและประเมินผล 
และส าเร็จการศึกษามาไม่น้อยกว่า 3 ปี  
  โดยผลการประเมินความสอดคล้องของผู้เชี่ยวชาญด้านการวัดและประเมินผลมี
ค่าเท่ากับ 1.00 
 5.  น าแบบประเมินผลงานนักเรียนมาปรับปรุงตามข้อเสนอแนะของผู้เชี่ยวชาญ 

6.  น าแบบวัดความสามัคคีไปทดลองใช้กับกลุ่มตัวอย่าง จ านวน 30 คน 
 7.  น าแบบประเมินผลงานนักเรียนที่สร้างไปใช้กับกลุ่มเป้าหมาย  
 

ดังแสดงไว้ใน แผนภูมิท่ี 3 : แสดงขั้นตอนการสร้างและพัฒนาแบบวัดความสามัคคีจากการ
ใช้เว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
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ภำพที่  3.3  แสดงขั้นตอนการสร้างและพัฒนาแบบวัดความสามัคคีจากการใช้เว็บช่วยสอนแบบการ
   เรียนรู้เป็นทีม 
 

3.3.4  แบบประเมินควำมสำมัคค ี
 ในการพัฒนาแบบประเมินความสามัคคีได้ด าเนินการพัฒนาและสร้างแบบประเมินความ
สามัคคีออกเป็น 2 ส่วน คือ แบบประเมินความสามัคคีส าหรับนักเรียนประเมินตนเอง และส าหรับครู
ประเมินนักเรียน ซ่ึงมีขั้นตอน ดังต่อไปนี้ 

1. ศึกษาทฤษฎี หลักการ เอกสารและงานวิจัยที่เกี่ยวข้องกับการพัฒนาเว็บช่วยสอนแบบ
การเรียนรู้เป็นทีมและก าหนดวัตถุประสงค์ของแบบวัดความสามัคคี 
 2. สร้างแบบประเมินความสามัคคี โดยมีรายละเอียดดังนี้ 

ศึกษาทฤษฎี หลักการ เอกสาร งานวิจัยที่เกี่ยวข้อง   

สร้างแบบประเมินผลงานนักเรียน 

น าไปให้ผู้เช่ียวชาญด้านเนื้อหาตรวจสอบความถูกต้องเหมาะสมของเนื้อหา 
 

น าไปให้ผู้เช่ียวชาญด้านการวัดและประเมินผลและด้านจิตวิทยา หาค่า IOC 

น าแบบประเมินผลงานนักเรียนไปใช้กับกลุ่มเป้าหมาย 

ปรับปรุง 

ปรับปรุง 

ผ่าน 

ผ่าน 

ไม่ผ่าน 

ไม่ผ่าน 
พิจารณา 

พิจารณา 

น าแบบวัดความสามัคคีไปทดลองใช้กับกลุ่มตัวอย่าง จ านวน 30 คน  
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 2.1 ก าหนดชนิดของแบบสอบถามเป็นแบบมาตราส่วนประมาณค่า 4 ระดับ 
ได้แก่ มากที่สุด มาก น้อย และน้อยที่สุด โดยก าหนดระดับคะแนน ดังนี้ 
   4  หมายถึง  มากที่สุด 
   3  หมายถึง  มาก 
   2  หมายถึง  น้อย 
   1  หมายถึง  น้อยที่สุด 
 2.2  ก าหนดโครงสร้างของแบบวดัความสามัคค ี
 2.3  ก าหนดจ านวนข้อค าถามแบบประเมินความสามัคคีส าหรับนักเรียน
ประเมินตนเอง จ านวน 23 ข้อ  และส าหรับครูประเมินนกัเรียน จ านวน 13 ข้อ 
 3. น าไปให้ผู้เชี่ยวชาญด้านจิตวิทยา จ านวน 3 ท่าน ตรวจสอบความสอดคล้องของข้อ
ค าถามกับวัตถุประสงค์ (IOC) จะต้องมีค่า IOC ตั้งแต่ 0.5 ขึ้นไป โดยมีเกณฑ์ก าหนดผู้เชี่ยวชาญ ดังนี้ 
 3.1  ผู้มีคุณวุฒิระดับปริญญาโทหรือปริญญาเอก สาขาจิตวิทยา และส าเร็จ
การศึกษามาไม่น้อยกว่า 3 ปี 
 3.2  เป็นอาจารย์ที่มีประสบการณ์สอนในรายวิชาที่เกี่ยวข้องกับการสอนของ
กลุ่มสาระสังคมศึกษา ศาสนาและวัฒนธรรม มาไม่น้อยกว่า 10 ปี หรือ มีต าแหน่งวิทยฐานะช านาญ
การพิเศษ (คศ.3)  หรือ เชี่ยวชาญ (คศ.4) 
 4. น าไปให้ผู้เชี่ยวชาญด้านการวัดและประเมินผล จ านวน 3 ท่าน ตรวจสอบความ
สอดคล้องของข้อค าถามกับวัตถุประสงค์ (IOC) โดยจะต้องมีค่า IOC ตั้งแต่ 0.5 ขึ้นไป โดยมีเกณฑ์
ก าหนดผู้เชี่ยวชาญ ดังนี้ 
 4.1 ผู้มีคุณวุฒิระดับปริญญาโทหรือปริญญาเอก สาขาการวัดและประเมินผล 
และส าเร็จการศึกษามาไม่น้อยกว่า 3 ปี  
  โดยผลการประเมินความสอดคล้องของผู้ เชี่ยวชาญทั้งสองด้านของแบบ
ประเมนิความสามัคคีส าหรับนักเรียนประเมินตนเอง มีค่าเท่ากับ 0.96  และแบบประเมินความสามัคคี
ส าหรับครูประเมินนักเรียน มีค่าเท่ากับ 0.92 

5. น าแบบประเมินความสามัคคีมาปรับปรุงตามข้อเสนอแนะของผู้เชี่ยวชาญ 
 6. น าแบบประเมินความสามัคคีไปทดลองใช้กับกลุ่มตัวอย่าง จ านวน 30 คน 
 7. น าแบบประเมินความสามัคคีที่สร้างไปใช้กับกลุ่มเป้าหมาย  
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ดังแสดงไว้ใน แผนภูมิท่ี 3 : แสดงขั้นตอนการสร้างและพฒันาแบบวัดความสามัคคีจากการ
ใช้เว็บช่วยสอนแบบการเรียนรู้เป็นทีม 

 
 

 
 
 
 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
ภำพที่  3.4  ขั้นตอนการสร้างและพัฒนาแบบวัดความสามัคคีจากการใช้เว็บช่วยสอนแบบการเรียนรู้ 

  เป็นทีม 
 
 
 

ศึกษาทฤษฎี หลักการ เอกสาร งานวิจัยที่เกี่ยวข้อง   

ก าหนดวัตถุประสงค์ของแบบวัดความสามัคคี 

สร้างแบบวัดความสามัคคี 

น าไปให้ผู้เช่ียวชาญด้านเนื้อหาตรวจสอบความถูกต้องเหมาะสมของเนื้อหา 
 

น าไปให้ผู้เช่ียวชาญด้านการวัดและประเมินผล และด้านจิตวิทยา หาค่า IOC  

น าแบบวัดความสามัคคีไปทดลองใช้กับกลุ่มตัวอย่าง จ านวน 30 คน  

น าแบบวัดความสามัคคีไปใช้กับกลุ่มเป้าหมาย 

ปรับปรุง 

ปรับปรุง 

ผ่าน 

ผ่าน 

ไม่ผ่าน 

ไม่ผ่าน 
พิจารณา 

พิจารณา 
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3.3.5  แบบสอบถำมควำมพงึพอใจในกำรใชเ้ว็บช่วยสอนแบบกำรเรียนรู้เป็นทีม 
  ในการวิจัยครั้งนี้ได้พัฒนาแบบสอบถามความพึงพอใจในการใช้เว็บช่วยสอน
แบบการเรียนรู้เป็นทีม โดยมีขั้นตอนดังนี้ 

1. ศึกษาทฤษฎี หลักการ เอกสารและงานวิจัยที่เกี่ยวข้องกับการพัฒนาเว็บช่วยสอน
แบบการเรียนรู้เป็นทีมและก าหนดวัตถุประสงค์ของแบบสอบถาม 

2. สร้างแบบสอบถามฉบับร่าง โดยมีรายละเอียดดังนี้ 
 2.1 ก าหนดชนิดของแบบสอบถามเป็นแบบมาตราส่วนประมาณค่า 4 ระดับ 
ได้แก่ มากที่สุด มาก น้อย และน้อยที่สุด โดยก าหนดระดับคะแนน ดังนี้ 
   4  หมายถึง  มากที่สุด 
   3  หมายถึง  มาก 
   2  หมายถึง  น้อย 
   1  หมายถึง  น้อยที่สุด 
 และมีเกณฑ์ความหมายของแต่ละระดับ ดังนี ้
   4.00 – 3.50  หมายถึง ระดับมากที่สุด 
   3.49 – 2.50  หมายถึง ระดับมาก 
   2.49 – 1.50  หมายถึง ระดับน้อย 
   1.49 – 1.00  หมายถึง ระดับน้อยที่สุด 
 2.2 ก าหนดโครงสร้างของแบบสอบถามเป็น 3 ส่วน ดังนี ้
   3.1 ข้อมูลพื้นฐาน 
   3.2 ข้อค าถามในการประเมนิ 
   3.3 ข้อเสนอแนะ 
  3. น าแบบทดสอบฉบับร่างเสนอต่ออาจารย์ที่ปรึกษาวิทยานิพนธ์เพื่อตรวจสอบ 
เนื้อหา ตลอดจนความเหมาะสมของแบบสอบถาม จากนั้นท าการปรับปรุงแก้ไขตามค าแนะน า 
  4. สร้างแบบสอบถาม 
  5. น าไปให้ผู้เชี่ยวชาญด้านการวัดและประเมินผล จ านวน 3 ท่าน และด้าน
เนื้อหาและเทคโนโลยี จ านวน 3 ท่าน ตรวจสอบความเหมาะสมของข้อค าถามและหาค่าดัชนีความ
สอดคล้อง (IOC : Index for Item Objective Congruence) ด้วยแบบประเมิน โดยมีเกณฑ์ในการให้
คะแนน ดังนี้ 
   -  ถ้าแน่ใจว่าข้อค าถามตรงตามวัตถุประสงค์ให้ตอบ +1 
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   -  ถ้าไม่แน่ใจว่าข้อค าถามตรงตามวตัถุประสงค์ให้ตอบ 0 
   -  ถ้าแน่ใจว่าข้อค าถามไม่ตรงตามวตัถุประสงค์ให้ตอบ -1 
ซ่ึงค่า IOC ที่ได้ควรมีค่าตั้งแต่ 0.5 ขึ้นไป จึงถือว่าข้อค าถามนั้นตรงตามวัตถุประสงค์ของการวิจัย และ
มีเกณฑ์ก าหนดผู้เชี่ยวชาญ ดังนี้ 
   -  เป็นผู้มีคุณวุฒิระดับปริญญาโทหรือปริญญาเอก สาขาการวัดและ
ประเมินผล และส าเร็จการศึกษามาไม่น้อยกว่า 3 ปี 
   -  ผู้มีคุณวุฒิระดับปริญญาโทหรือปริญญาเอก สาขาการเทคโนโลยี
ทางการศึกษา หรือเทคโนโลยีและส่ือสารการศึกษา และส าเร็จการศึกษามาไม่น้อยกว่า 3 ปี  
  โดยผลการประเมินความสอดคล้องของผู้เชี่ยวชาญด้านการวัดและประเมินผล 
และด้านเนื้อหาและเทคโนโลยี มีค่าเท่ากับ 1.00 
  6. น าแบบสอบถามมาปรับปรุงตามข้อเสนอแนะของผู้เชี่ยวชาญ 
  7. น าแบบสอบถามไปทดลองใช้กับกลุ่มตัวอย่าง จ านวน 30 คน 
  8. น าแบบสอบถามที่สร้างไปใช้กับกลุ่มเป้าหมาย 

 
ดังแสดงไว้ใน แผนภูมิท่ี 4 : แสดงขั้นตอนการสร้างและพฒันาแบบสอบถามความพึงพอใจ

ในการใช้เว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
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ภำพที่  3.5  ขั้นตอนการสร้างและพัฒนาแบบสอบถามความพึงพอใจในการใช้เว็บช่วยสอนแบบการ 

  เรียนรู้เป็นทีม 
 
 
 
 
 

ศึกษาทฤษฎี หลักการ เอกสาร งานวิจัยที่เกี่ยวข้อง   

ก าหนดวัตถุประสงค์ของแบบสอบถาม 

สร้างแบบสอบถามฉบับร่าง 

น าเสนอต่ออาจารย์ที่ปรึกษาวิทยานิพนธ์เพื่อตรวจสอบเนื้อหาและความเหมาะสม 

สร้างแบบสอบถามแล้วน าไปให้ผู้เช่ียวชาญด้านการวัดและประเมินผล  
และด้านเนื้อหาและเทคโนโลยี หาคา่ IOC 

น าแบบสอบถามไปทดลองใช้กับกลุ่มตัวอย่าง จ านวน 30 คน แล้วน ามาหาค่าสัมประสิทธิ์อัลฟา 

น าแบบสอบถามไปใช้กับกลุ่มเป้าหมาย 

ปรับปรุง 

ปรับปรุง 

ผ่าน 

ผ่าน 

ไม่ผ่าน 

ไม่ผ่าน 

พิจารณา 

พิจารณา 
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3.4  กำรเกบ็รวบรวมข้อมลู 
 ในการวิจัยครั้งนี้ได้ด าเนินการเก็บรวบรวมข้อมูลโดยการทดลองตามแบบแผนการทดลอง
ที่ก าหนดไว้ดังนี้  โดยขั้นตอนในการทดสอบเว็บช่วยสอนแบบการเรียนรู้เป็นทีม มีดังนี้ 
 1. แนะน าขั้นตอนวิธีการใช้งาน 
 2. ให้นักเรียนท าแบบทดสอบก่อนเรียน โดยให้เวลาในการท าแบบทดสอบ 20 นาที แล้วน า
ผลคะแนนที่ได้ไปวิเคราะห์ข้อมูล 
 3. ให้นักเรียนใช้เว็บช่วยสอนแบบการเรียนรู้เป็นทีม โดยให้นักเรียนสมัครสมาชิกของ
เว็บไซต์และรายวิชา โดยแบ่งการเรียนเป็น 5 สัปดาห์ เรียนสัปดาห์ละ 100 นาที    
 4. ให้นักเรียนท าแบบทดสอบหลังเรียน โดยให้เวลาในการท าแบบทดสอบ 20 นาที แล้วน า
ผลคะแนนที่ได้ไปวิเคราะห์ข้อมูล 
 5.  ครูสังเกตพฤติกรรมการเรียนของผู้เรียนจากเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
 6.  ให้นักเรียนท าแบบประเมินความสามัคคีจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้
เป็นทีม โดยให้เวลาในการแบบประเมิน 20 นาที แล้วน าผลคะแนนที่ได้ไปเตรียมการวิเคราะห์ข้อมูล 

7.  ให้นักเรียนท าแบบประเมินความพึงพอใจต่อเว็บช่วยสอนแบบการเรียนรู้เป็นทีม โดย
ให้เวลาในการแบบประเมิน 20 นาที แล้วน าผลคะแนนที่ได้ไปเตรียมการวิเคราะห์ข้อมูล 
 

3.5  กำรวิเครำะห์ข้อมลู 
 ในการวิจัยครั้งนี้ได้ท าการวิเคราะห์ข้อมูลดังต่อไปนี้ 
 1.  การหาประสิทธิภาพของเว็บช่วยสอนแบบการเรียนรู้เป็นทีมโดยใช้เกณฑ์มาตรฐาน 
80/80 

2.  การศึกษาผลการเรียนรู้ ได้เปรียบเทียบหาความแตกต่างของคะแนนเฉล่ียหลังเรียนกับ
ก่อนเรียนด้วยการทดสอบค่าที่ (t-test) แบบ Dependent 

3.  การประเมินผลงานนักเรียน ท าการวิเคราะห์ข้อมูลด้วยค่าเฉล่ีย (  ) 
 4.  การศึกษาหาค่าความสามัคคี ท าการวิเคราะห์ข้อมูลด้วยค่าเฉล่ีย (  ) และค่าส่วน
เบี่ยงเบนมาตรฐาน (S.D.) 
 5. การศึกษาความพึงพอใจต่อเว็บช่วยสอนแบบการเรียนรู้เป็นทีม ท าการวิเคราะห์ข้อมูล
ด้วยค่าเฉล่ีย (  ) และค่าส่วนเบ่ียงเบนมาตรฐาน (S.D.) 
 



บทที่ 4 
 

ผลการวิเคราะห์ข้อมูล 
 

การวิจัยคร้ังนี้เป็นการพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมของนักเรียน
ช้ันมัธยมศึกษาปีที่ 5 โดยมีวัตถุประสงค์ดังนี้ 

1.  เพื่อพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
 2.  เพื่อหาประสิทธิภาพบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม ตามเกณฑ์ 80/80 

3.  เพื่อประเมินผลงานจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
 4.  เพื่อเปรียบเทียบผลการเรียนของนักเรียนก่อนเรียนและหลังเรียนบนเว็บช่วยสอนแบบ
การเรียนรู้เป็นทีม 
 5.  เพื่อวัดความสามัคคีของนักเรียนจากบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
 6.  เพื่อศึกษาความพึงพอใจของนักเรียนในการใช้บทเรียนบนเว็บช่วยสอนแบบการเรียนรู้
เป็นทีม 

ในการรายงานผลการวิเคระห์ข้อมูลนั้นผู้วิจัยขอน าเสนอผลการวิเคราะห์ข้อมูล  ดังนี้ 
 4.1  ผลการหาประสิทธิภาพบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมตามเกณฑ์ 

80/80 

 4.2  ผลการเปรียบเทียบผลการเรียนของนักเรียนก่อนเรียนและหลังเรียนบนเว็บช่วยสอน
แบบการเรียนรู้เป็นทีม 
 4.3  ผลการประเมินผลงานจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
 4.4  ผลการประเมินความสามัคคีของนักเรียนจากบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้
เป็นทีม 
 4.5  ผลการประเมินความพึงพอใจของนักเรียนในการใช้บทเรียนบนเว็บช่วยสอนแบบการ
เรียนรู้เป็นทีม 
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4.1   การหาประสิทธิภาพของบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมตามเกณฑ์ 80/80 
 ผลการวิเคราะห์หาประสิทธิภาพบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม ผู้วิจัยได้
จัดให้มีการน าเสนอผลโดยแบ่งเป็น  3 กลุ่มการทดลองประกอบไปด้วย 
 กลุ่มเดี่ยว  จ านวน 3  คน  ประกอบไปด้วย นักเรียนที่มีผลการเรียนเฉลี่ยสูง ปานกลาง และ
ต่ า อย่างละ 1 คน  
 กลุ่มกลาง  จ านวน 6  คน ประกอบไปด้วย  นักเรียนที่มีผลการเรียนเฉลี่ยสูง ปานกลาง และ
ต่ า อย่างละ 2 คน 
 กลุ่มใหญ่   จ านวน 30  คน  ประกอบไปด้วย  นักเรียนที่มีผลการเรียนเฉลี่ยสูง ปานกลาง และต่ า 
อย่างละ 10 คน 
 สามารถน าเสนอผลการวิเคราะห์การหาประสิทธิภาพของบทเรียนบนเว็บช่วยสอนแบบ
การเรียนรู้เป็นทีม ได้ดังนี้ 
 
การหาประสิทธิภาพ 80/80 ของบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม กลุ่มเดี่ยว จ านวน 3  คน   
ตารางที่ 4.1  แสดงการหาประสิทธิภาพจากคะแนนร้อยละของการท ากิจกรรมระหว่างเรียน และค่าคะแนนร้อย

ละของแบบทดสอบหลังเรียน  E1/E2 ของกลุ่มเดี่ยว   จ านวน 3  คน 
 

คนที่ คะแนนร้อยละ คะแนนร้อยละ 
  คะแนนระหว่างเรียน E1  คะแนนแบบทดสอบหลังเรียน  E2 

1 97.50 93.33 
2 83.75 86.67 
3 73.75 70.00 

E1/E2 E1= 85.00 E2=83.33 
  

  จากตารางที่  4.1  แสดงการหาประสิทธิภาพจากคะแนนร้อยละของการท ากิจกรรมระหว่าง
เรียน และค่าคะแนนร้อยละของแบบทดสอบหลังเรียน  E1/E2 ของกลุ่มเดี่ยว  จ านวน 3  คน พบว่า 
บทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมมีประสิทธิภาพเท่ากับ 85.00/83.33 เป็นไปตาม
สมมติฐานที่ตั้งไว้ 80/80 โดยมีค่าระดับคะแนนร้อยละของการท ากิจกรรมระหว่างเรียน (E1) เท่ากับ 
85.00  และมีค่าระดับคะแนนร้อยละของการท าแบบทดสอบหลังเรียน (E2) เท่ากับ 83.33   
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การหาประสิทธิภาพ 80/80 ของบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม กลุ่มกลางจ านวน 6 คน   
ตารางที่ 4.2   แสดงการหาประสิทธิภาพจากคะแนนร้อยละของการท ากิจกรรมระหว่างเรียนและค่าคะแนน

ร้อยละของแบบทดสอบหลังเรียน  E1/E2 ของกลุ่มกลาง จ านวน 6  คน 
 

คนที่ คะแนนร้อยละ คะแนนร้อยละ 
  คะแนนระหว่างเรียน E1 คะแนนแบบทดสอบหลังเรียน  E2 

1 97.50 96.67 
2 93.75 90.00 
3 82.50 86.67 
4 81.25 83.33 
5 78.75 76.67 
6 73.75 73.33 

E1/E2                 E1 = 84.58                        E2 = 84.44 
  
  จากตารางที่ 4.2  แสดงการหาประสิทธิภาพจากคะแนนร้อยละของการท ากิจกรรมระหว่าง
เรียนและค่าคะแนนร้อยละของแบบทดสอบหลังเรียน  E1/E2 ของกลุ่มกลาง  จ านวน 6  คน ได้ว่า  
บทเรียนบนเว็บแบบการเรียนรู้เป็นทีมมีประสิทธิภาพเท่ากับ 84.58/84.44 ซึ่งเป็นไปตามสมมติฐาน
ที่ตั้งไว้ที่เกณฑ์ 80/80 โดยมีค่าระดับคะแนนร้อยละของการท ากิจกรรมระหว่างเรียน (E1) เท่ากับ 
84.58  และมีค่าระดับคะแนนร้อยละของการท าแบบทดสอบหลังเรียน (E2)  เท่ากับ 84.44   
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การหาประสิทธิภาพ 80/80 ของบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม กลุ่มใหญ่จ านวน 30 คน   
ตารางที่ 4.3  แสดงการหาประสิทธิภาพจากคะแนนร้อยละของการท ากิจกรรมระหว่างเรียนและค่าคะแนน

ร้อยละของแบบทดสอบหลังเรียน E1/E2 ของกลุ่มใหญ่ จ านวน 30  คน 
 

คนที่ คะแนนร้อยละ คะแนนร้อยละ 
  คะแนนระหว่างเรียน E1 คะแนนแบบทดสอบหลังเรียน  E2 

1 100.00 100.00 
2 100.00 100.00 
3 98.75 96.67 
4 97.50 96.67 
5 97.50 96.67 
6 97.50 96.67 
7 96.25 93.33 
8 96.25 93.33 
9 95.00 93.33 

10 95.00 93.33 
11 93.75 90.00 
12 93.75 86.67 
13 92.50 90.00 
14 92.50 86.67 
15 91.25 86.67 
16 91.25 86.67 
17 90.00 83.33 
18 88.75 83.33 
19 88.75 83.33 
20 87.50 83.33 
21 86.25 80.00 
22 88.75 80.00 
23 87.50 80.00 
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คนที่ คะแนนร้อยละ คะแนนร้อยละ 
  คะแนนระหว่างเรียน E1 คะแนนแบบทดสอบหลังเรียน  E2 

24 75.00 76.67 
25 71.25 73.33 
26 71.25 70.00 
27 71.25 66.67 
28 71.25 63.33 
29 71.25 60.00 
30 71.25 60.00 

E1/E2         E1  =  88.29             E2  =  84.33 
  
  ตารางที่ 4.3  แสดงการหาประสิทธิภาพจากคะแนนร้อยละของการท ากิจกรรมระหว่าง
เรียน และค่าคะแนนร้อยละของแบบทดสอบหลังเรียน E1/E2 ของกลุ่มใหญ่  จ านวน 30  คน  ได้ว่า  
บทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมมีประสิทธิภาพเท่ากับ 88.29/84.33 ซึ่งเป็นไปตาม
สมมติฐานที่ตั้งไว้ 80/80 โดยมีค่าระดับคะแนนร้อยละของการท ากิจกรรมระหว่างเรียน (E1)  เท่ากับ 
88.29  และมีค่าระดับคะแนนร้อยละของการท าแบบทดสอบหลังเรียน (E2) เท่ากับ 84.33  
 
4.2  การเปรียบเทียบผลการเรียนของนักเรียนก่อนเรียนและหลังเรียนจากเว็บช่วยสอนแบบการเรียนรู้ 
เป็นทีม 
 การเปรียบเทียบผลการเรียนรู้ด้วยแบบทดสอบก่อนเรียนและหลังเรียน  ด้วยบทเรียนบน
เว็บช่วยสอนแบบการเรียนรู้เป็นทีม ส าหรับนักเรียนระดับช้ันมัธยมศึกษาปีที่ 5 เร่ืองการน าเสนอสื่อ
ประสม  สามารถน าเสนอผลการวิเคราะห์การเปรียบเทียบผลการเรียนก่อนเรียนและหลังเรียนได้ดังนี้ 
ตารางที่  4.4     แสดงการเปรียบเทียบผลการเรียนก่อนเรียนและหลังเรียนด้วยบทเรียนบนเว็บช่วยสอนแบบการ

เรียนรู้เป็นทีม ส าหรับนักเรียนระดับชั้นมัธยมศึกษาปีที่ 5 
 

           คะแนน   n คะแนนเต็ม   S.D. t p 
การทดสอบก่อนเรียน 33 30 10.55 4.10 23.86 .00 
การทดสอบหลังเรียน 33 30 27.76 1.82     
*p<.05 
 

 

 

    

X
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 จากตารางที่ 4.4 ผลการวิเคราะห์ข้อมูลพบว่าคะแนนผลการเรียนเฉลี่ยก่อนเรียนด้วยบทเรียน
บนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม ส าหรับนักเรียนระดับช้ันมัธยมศึกษาปีที่ 5 เร่ืองการน าเสนอ
สื่อประสม มีค่าเฉลี่ยเท่ากับ 10.55 ส่วนเบี่ยงเบนมาตรฐานเท่ากับ 4.10 และหลังเรียนมีค่าเฉลี่ยเท่ากับ 
27.76 ส่วนเบี่ยงเบนมาตรฐานเท่ากับ 1.82  ผลการทดสอบความแตกต่างของคะแนนผลการเรียนรู้
พบว่าผู้เรียนมีผลการเรียนหลังเรียนจากบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมสูงกว่าก่อน
เรียนอย่างมีนัยส าคัญทางสถิติที่ระดับ .05  
 

4.3  ผลการประเมินผลงานจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
ตารางที่  4.5  ผลการประเมินผลงานจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม ใช้เกณฑ์

การประเมินค่า (Rubric Score) 
 

กลุ่มที ่

รายการประเมิน 

สรุประดับ
คุณภาพ 

คว
าม
สม
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กเท
คน

ิค
พิเ
ศษ

อย่
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เห
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ม 

คะ
แน

นเ
ฉล

ี่ย 
                  

1 4.00 4.00 3.38 3.63 4.00 3.80 ดีมาก 
2 3.63 3.88 3.25 4.00 3.63 3.68 ดีมาก 

3 3.63 3.63 3.50 3.38 3.75 3.58 ดีมาก 

4 3.75 3.75 3.75 3.75 3.50 3.70 ดีมาก 

5 3.63 3.75 3.50 3.75 3.50 3.63 ดีมาก 

6 3.38 3.50 3.13 3.63 3.13 3.35 ดี 
7 3.50 3.50 3.25 3.75 3.38 3.48 ดี 
8 2.88 3.00 3.00 3.38 3.25 3.10 ดี 

เฉลี่ย 3.55 3.63 3.34 3.66 3.52 3.54 ดีมาก 
  

จากตารางที่  4.5  ผลการวิเคราะห์ข้อมูลพบว่าคะแนนเฉลี่ยผลงานจากทักษะการท างานการ
เรียนรู้เป็นทีมของนักเรียนที่เรียนด้วยบทเรียนบนเว็บแบบการเรียนรู้เป็นทีม เร่ืองการน าเสนอสื่อ
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ประสม โดยมีนักเรียนทั้งหมดจ านวน 8 ทีม แบ่งเป็นทีมละ 4  คน จ านวน 7 ทีม และ ทีมละ 5 คน 
จ านวน 1 ทีม โดยใช้เกณฑ์การประเมินค่า (Rubric Score) พบว่า ผลการท างานเป็นทีมส่งผลให้
ผลงานโดยรวมมีค่าเฉลี่ยอยู่ในระดับดีมาก  (   = 3.54) โดยเรียงล าดับตามเกณฑ์คะแนนจากมากไปหา
น้อย ได้แก่ อันดับที่ 1 มีการเช่ือมโยงอย่างเหมาะสม มีค่าเฉลี่ยอยู่ในระดับดีมาก  (   = 3.66) อันดับที่ 
2 ความเหมาะสมของเนื้อหาที่น าเสนอมีค่าเฉลี่ยอยู่ในระดับดีมาก  (   = 3.63)  อันดับที่ 3 ความ
สมบูรณ์ของช้ินงาน มีค่าเฉลี่ยอยู่ในระดับดีมาก  (   = 3.55)  อันดับที่  4  การแทรกเทคนิคพิเศษอย่าง
เหมาะสม  มีค่าเฉลี่ยอยู่ในระดับมากที่สุด (   = 3.52)  และอันดับที่ 5  การจัดวางข้อความ รูปภาพ
เหมาะสม มีค่าเฉลี่ยอยู่ในระดับดี  
(   = 3.34) 
  
4.4  ผลการประเมินความสามัคคีของนักเรียนจากบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
ตารางที่  4.6  แสดงผลการประเมินความสามัคคีส าหรับนักเรียนประเมินตนเอง 

รายการประเมิน    S.D. แปลผล 
1.  เข้าใจบทบาทหน้าที่ในทีม    
 1.1 นักเรียนเข้าใจบทบาทของตนเองในฐานะผู้น าและ
ผู้ตามที่ดี 

3.58 .50 มากที่สุด 

 1.2 นักเรียนปฏิบัติตามข้อตกลงของการเป็นสมาชิกใน
ทีม 

3.55 .51 มากที่สุด 

 1.3 นักเรียนประชุม ปรึกษาหารือกันในกิจกรรมที่
ได้รับมอบหมาย 

3.24 .50 มาก 

 1.4 นักเรียนมีอัธยาศัยที่ดีในการติดต่อสื่อสารกับเพื่อน 3.42 .61 มาก 
 1.5 นักเรียนปรึกษาหารือกันเพื่อแก้ไขข้อผิดพลาด
ภายหลังการท างาน 

3.39 .66 มาก 

เฉลี่ยด้านเข้าใจบทบาทหน้าที่ในทีม 3.44 .39 มาก 
2.  การยอมรับฟังความคิดเห็น    
 2.1 นักเรียนยอมรับฟังความคิดเห็นที่แตกต่างของเพื่อน
ในทีม 

3.82 .39 มากที่สุด 

 2.2 นักเรียนมีเหตุผลเพียงพอในการตัดสินใจ 3.45 .56 มาก 
 2.3 นักเรียนยอมรับเสียงส่วนใหญ่ (ผลสรุป) ของทีม 3.58 .56 มากที่สุด 
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รายการประเมิน    S.D. แปลผล 
 2.4 นักเรียนยอมรับผลงานของสมาชิกในทีม 3.55 .62 มากที่สุด 
 2.5 นักเรียนพร้อมที่จะปรับตัวเพื่อให้สามารถอยู่ร่วม
ในทีมได ้

3.67 .60 มากที่สุด 

เฉลี่ยด้านการยอมรับฟังความคิดเห็น 3.61 .36 มากที่สุด 
3.  การท างานร่วมกัน    
 3.1. นักเรียนช่วยเหลือเพื่อนในทีมให้ท างานส าเร็จด้วย
ความเต็มใจ 

3.58 .50 มากที่สุด 

     3.2 นักเรียนมีความรักใคร่กลมเกลียวและช่วยเหลือ
สมาชิกในทีมเสมอ 

3.64 .49 มากที่สุด 

     3.3 นักเรียนเข้าร่วมท ากิจกรรมต่างๆ กับเพื่อนในทีม
เป็นประจ า 

3.30 .59 มาก 

 3.4 นักเรียนมีการพัฒนาทักษะของตัวเองเพื่อเพิ่ม
ความสามารถของทีม 

3.42 .66 มาก 

 3.5 นักเรียนตรงต่อเวลาในการท างานร่วมกันเป็นทีม 3.21 .65 มาก 
 3.6 นักเรียนท างานที่ได้รับมอบหมายอย่างเต็ม
ความสามารถ 

3.58 .56 มากที่สุด 

เฉลี่ยด้านการท างานร่วมกัน 3.45 .39 มาก 
4.  ผลการท างานเป็นทีม    
 4.1 งานเสร็จทันในเวลาที่ก าหนด 3.15 .71 มาก 
 4.2 นักเรียนมีความสัมพันธ์ที่ดีกับสมาชิกในทีม 3.58 .56 มากที่สุด 
 4.3 เกิดการพัฒนาทักษะในการท างานป็นทมี 3.52 .51 มากที่สุด 
 4.4 เกิดการเรียนรู้ในงานที่ท าร่วมกัน 3.64 .55 มากที่สุด 
 4.5 สามารถแก้ปัญหาได้เมือ่เกิดความขัดแย้งภายในทีม 3.64 .55 มากที่สุด 
 4.6 เกิดความสามัคคีภายในทีม 3.55 .51 มากที่สุด 

เฉลี่ยด้านผลการท างานเป็นทีม 3.51 .33 มากที่สุด 
เฉลี่ยรวมทุกด้าน 3.50 .30 มากที่สุด 
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 จากตารางที่  4.6  ผลการวิเคราะห์ข้อมูลแบบประเมินความสามัคคีจากการประเมินตนเอง
พบว่านักเรียนมีความสามัคคีโดยรวมมีค่าเฉลี่ยอยู่ในระดับมากที่สุด (   = 3.34 , S.D. = .30) โดย
เรียงล าดับจากมากไปหาน้อยได้แก่ ล าดับที่ 1 การยอมรับฟังความคิดเห็นมีค่าเฉลี่ยอยู่ในระดับมาก
ที่สุด (   = 3.61 , S.D. = .36)  ล าดับที่ 2  ผลการท างานเป็นทีมมีค่าเฉลี่ยอยู่ในระดับมากที่สุด (   = 3.51 
, S.D. = .33)  ล าดับที่ 3  การท างานร่วมกันมีค่าเฉลี่ยอยู่ในระดับมาก (   = 3.45 , S.D. = .39)  และ
ล าดับที่ 4 เข้าใจบทบาทหน้าที่ในทีมมีค่าเฉลี่ยอยู่ในระดับมาก (   = 3.44 , S.D. = .39) 
 ล าดับที่ 1  การยอมรับฟังความคิดเห็น  เมื่อพิจารณาเป็นรายข้อโดยเรียงล าดับจากมากไป
หาน้อย  ได้แก่  นักเรียนยอมรับฟังความคิดเห็นที่แตกต่างของเพื่อนในทีม มีค่าเฉลี่ยอยู่ในระดับมาก
ที่สุด (   = 3.82 , S.D. = .39)  นักเรียนพร้อมที่จะปรับตัวเพื่อให้สามารถอยู่ร่วมในทีมได้  มีค่าเฉลี่ยอยู่
ในระดับมากที่สุด  (   = 3.67 , S.D. = .60)  นักเรียนยอมรับเสียงส่วนใหญ่ (ผลสรุป) ของทีม มีค่าเฉลี่ย
อยู่ในระดับมากที่สุด  (   = 3.58 , S.D. = .56)  นักเรียนยอมรับผลงานของสมาชิกในทีม  มีค่าเฉลี่ยอยู่
ในระดับมากที่สุด (   = 3.55 , S.D. = .62)  และนักเรียนมีเหตุผลเพียงพอในการตัดสินใจ  มีค่าเฉลี่ยอยู่
ในระดับมาก (   = 3.45 , S.D. = .56) 
 ล าดับที่ 2  ผลการท างานเป็นทีม  เมื่อพิจารณาเป็นรายข้อโดยเรียงล าดับจากมากไปหาน้อย  
ได้แก่  เกิดการเรียนรู้ในงานที่ท าร่วมกันและสามารถแก้ปัญหาได้เมื่อเกิดความขัดแย้งภายในทีม   มี
ค่าเฉลี่ยอยู่ในระดับมากที่สุด  (   = 3.64 , S.D. = .55)  นักเรียนมีความสัมพันธ์ที่ดีกับสมาชิกในทีม  มี
ค่าเฉลี่ยอยู่ในระดับมากที่สุด  (   = 3.58 , S.D. = .56)  เกิดความสามัคคีภายในทีม  มีค่าเฉลี่ยอยู่ใน
ระดับมากที่สุด  (   = 3.55 , S.D. = .51)  เกิดการพัฒนาทักษะในการท างานป็นทีม มีค่าเฉลี่ยอยู่ใน
ระดับมากที่สุด (   = 3.52 , S.D. = .51)  และงานเสร็จทันในเวลาที่ก าหนด  มีค่าเฉลี่ยอยู่ในระดับมาก  
(   = 3.15 , S.D. = .71) 

ล าดับที่ 3  การท างานร่วมกัน  เมื่อพิจารณาเป็นรายข้อโดยเรียงล าดับจากมากไปหาน้อย  
ได้แก่  นักเรียนมีความรักใคร่กลมเกลียวและช่วยเหลือสมาชิกในทีมเสมอ  มีค่าเฉลี่ยอยู่ในระดับมาก
ที่สุด (   = 3.64 , S.D. = .49)  นักเรียนช่วยเหลือเพื่อนในทีมให้ท างานส าเร็จด้วยความเต็มใจ มีค่าเฉลี่ย
อยู่ในระดับมากที่สุด  (   = 3.58 , S.D. = .56)  นักเรียนท างานที่ได้รับมอบหมายอย่างเต็ม
ความสามารถ  มีค่าเฉลี่ยอยู่ในระดับมากที่สุด  (   = 3.58 , S.D. = .56)  นักเรียนมีการพัฒนาทักษะของ
ตัวเองเพื่อเพิ่มความสามารถของทีม มีค่าเฉลี่ยอยู่ในระดับมาก (   = 3.42 , S.D. = .66)  นักเรียนเข้าร่วม
ท ากิจกรรมต่างๆ กับเพื่อนในทีมเป็นประจ า  มีค่าเฉลี่ยอยู่ในระดับมาก (   = 3.30 , S.D. = .59)  และ
นักเรียนตรงต่อเวลาในการท างานร่วมกันเป็นทีม  มีค่าเฉลี่ยอยู่ในระดับมาก  (   = 3.21 , S.D. = .65) 
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ล าดับที่ 4  เข้าใจบทบาทหน้าที่ในทีม  เมื่อพิจารณาเป็นรายข้อโดยเรียงล าดับจากมากไปหา
น้อย  ได้แก่  นักเรียนเข้าใจบทบาทของตนเองในฐานะผู้น าและผู้ตามที่ดี   มีค่าเฉลี่ยอยู่ในระดับมาก
ที่สุด (   = 3.58 , S.D. = .50)  นักเรียนปฏิบัติตามข้อตกลงของการเป็นสมาชิกในทีม  มีค่าเฉลี่ยอยู่ใน
ระดับมากที่สุด  (   = 3.55 , S.D. = .51)  นักเรียนมีอัธยาศัยที่ดีในการติดต่อสื่อสารกับเพื่อน  มีค่าเฉลี่ย
อยู่ในระดับมาก (   = 3.42 , S.D. = .50)  นักเรียนปรึกษาหารือกันเพื่อแก้ไขข้อผิดพลาดภายหลังการ
ท างาน  มีค่าเฉลี่ยอยู่ในระดับมาก (   = 3.39 , S.D. = .66)  และนักเรียนประชุม ปรึกษาหารือกันใน
กิจกรรมที่ได้รับมอบหมาย  มีค่าเฉลี่ยอยู่ในระดับมาก  (   = 3.24 , S.D. = .50) 
 
ตารางที่  4.7  แสดงผลการประเมินความสามัคคสี าหรับครูประเมินนักเรียน 

รายการประเมิน    S.D. แปลผล 
1. สมาชิกในทีมมีการจัดสรรหน้าที่ความรับผิดชอบอย่าง
เหมาะสม 

3.63 .52 มากที่สุด 

2. สมาชิกในทีมมีความตรงต่อเวลา 3.63 .52 มากที่สุด 

3. สมาชิกในทีมเข้าใจบทบาทของตนเองในการเป็นผู้น า
หรือผู้ตามที่ดี 

3.75 .46 มากที่สุด 

4. สมาชิกในทีมมีความกระตือรือร้นและมุ่งมัน่ท ากิจกรรม
ที่ได้รับมอบหมาย 

3.50 .54 มากที่สุด 

5. สมาชิกในทีมมีการปรึกษาหารือเพื่อวางแผนในการ
ท างาน 

3.88 .35 มากที่สุด 

6. งานที่ได้รับมอบหมายส่งทันในเวลาที่ก าหนด 3.50 .54 มากที่สุด 

7. สมาชิกในทีมเข้าร่วมท ากิจกรรมต่างๆ กับเพื่อนในทีม
เป็นประจ า 

3.63 .52 มากที่สุด 

8. สมาชิกทุกคนร่วมกันรับผิดชอบในผลงานของทีม 3.63 .52 มากที่สุด 

9. สมาชิกในทีมรู้จักและมีความสัมพันธ์ที่ดีต่อกนั 4.00 .00 มากที่สุด 

10. สมาชิกในทีมมีการรับฟังความคิดเห็นของผู้อื่นและ
เคารพในสิทธิของผู้อื่น 

3.63 .52 มากที่สุด 

11. สมาชิกในทีมร่วมกันปรับปรุงผลงาน 3.50 .54 มากที่สุด 

เฉลี่ยรวม 3.66 .36 มากที่สุด 
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 จากตารางที่  4.7  ผลการวิเคราะห์ข้อมูลแบบประเมินความสามัคคีส าหรับครูประเมิน
นักเรียน พบว่า นักเรียนมีความสามัคคีค่าเฉลี่ยรวมทุกข้ออยู่ในระดับมากที่สุด (   = 3.66 , S.D. = .36)  
โดยเรียงล าดับจากมากไปหาน้อยดังนี้ มากที่สุดได้แก่ สมาชิกในทีมรู้จักและมีความสัมพันธ์ที่ดีต่อกัน
อยู่ในระดับมากที่สุด  (   = 4.00 , S.D. = .00)  รองลงมาคือ สมาชิกในทีมมีการปรึกษาหารือเพื่อ
วางแผนในการท างานอยู่ในระดับมากที่สุด  (   = 3.88 , S.D. = .35)  และน้อยที่สุดคือ สมาชิกในทีมมี
ความกระตือรือร้นและมุ่งมั่นท ากิจกรรมที่ได้รับมอบหมาย  งานที่ได้รับมอบหมายส่งทันในเวลาที่
ก าหนด  สมาชิกในทีมร่วมกันปรับปรุงผลงานอยู่ในระดับมากที่สุด  (   = 3.50 , S.D. = .54)  
 
4.5  ผลการประเมินความพึงพอใจของนักเรียนในการใช้บทเรียนบนเว็บช่วยสอนแบบการเรียนรู้ 
เป็นทีม 
ตารางที่  4.8  แสดงความพึงพอใจของนักเรียนต่อการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 

รายการประเมิน    S.D. แปลผล 
1.  ด้านเนื้อหา     
1.1  ตรงตามวัตถุประสงค์ของบทเรียน 3.70 .47 มากที่สุด 
1.2 การใช้ภาษา ง่ายต่อการท าความเข้าใจ 3.70 .47 มากที่สุด 

1.3 การจัดล าดับเนื้อหาแต่ละเร่ืองมีความเหมาะสม 3.70 .53 มากที่สุด 

1.4 เนื้อหามีความยากง่ายเหมาะสมกับผู้เรียน 3.58 .56 มากที่สุด 

1.5 เนื้อหาที่น าเสนอให้เป็นความรู้ที่มีประโยชน์ 3.52 .62 มากที่สุด 

1.6  เนื้อหาตรงกับสิ่งที่สนใจ 3.18 .73 มาก 

เฉลี่ยรวมด้านเนื้อหา 3.56 .42 มากที่สุด 

2.  ด้านการออกแบบ    
   2.1  หน้าจอสวยงาม ดึงดูด น่าสนใจ 3.15 .57 มาก 

2.2  สีของตัวอักษร อ่านง่าย สบายตา ชัดเจน 3.30 .53 มาก 
2.3  รูปแบบของตัวอักษรอ่านง่าย 3.48 .57 มาก 
2.4  ขนาดของตัวอักษรมีความชัดเจน 3.61 .56 มากที่สุด 
2.5  ภาพที่ใช้ประกอบเหมาะสมชัดเจน 3.48 .57 มาก 
2.6  มีการเช่ือมโยงเนื้อหาภายในเว็บเพจและกับเว็บไซต์

อื่น 
3.18 .77 มาก 

เฉลี่ยรวมด้านการออกแบบ 3.37 .33 มาก 
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รายการประเมิน    S.D. แปลผล 
3. รูปแบบการน าเสนอ    
    3.1  การน าเสนอมีความนา่สนใจ 3.33 .60 มาก 

3.2  น าเสนอบทเรียนได้อย่างชัดเจนและเข้าใจง่าย 3.55 .51 มากที่สุด 
3.3  การออกแบบเว็บไซต์ดึงดูดความสนใจ 2.94 .56 มาก 
3.4  เปิดโอกาสให้มีส่วนร่วมและท ากิจกรรมในบทเรียน 3.55 .62 มากที่สุด 
 3.5  สามารถเลือกเรียนได้ตามความต้องการ 3.00 .66 มาก 
3.6  ทราบผลทางการเรียนได้ในทันที 3.61 .56 มากที่สุด 

เฉลี่ยรวมด้านรูปแบบการน าเสนอ 3.33 .32 มาก 
4.  การเรียนรู้ร่วมกันเป็นทีม    

4.1  ผู้เรียนเข้ามาเรียนรู้บทเรียนได้ทุกที่ทุกเวลา 3.73 .52 มากที่สุด 
4.2  ผู้เรียนที่อยู่ต่างพื้นที่กันสามารถเรียนรู้ร่วมกันได้ 3.45 .67 มาก 
4.3  ท างานตามที่ได้รับมอบหมายในทีม 3.55 .62 มากที่สุด 
4.4  ผู้เรียนแต่ละทีมสามารถติดต่อสื่อสารกับเพื่อนในทีม

ในบทเรียนได้ 
3.42 .66 มาก 

4.5  ผู้เรียนสามารถติดต่อสื่อสารกับเพื่อนต่างในทีมใน
บทเรียนได้ 

3.36 .65 มาก 

4.6  ผู้เรียนสามารถแสดงความคิดเห็นเกี่ยวกับช้ินงานที่
ท าในทีมและเพื่อนต่างทีมในบทเรียนได้ 

3.42 .50 มาก 

เฉลี่ยรวมด้านการเรียนรู้ร่วมกันเป็นทีม 3.49 .42 มาก 
เฉลี่ยรวมทุกด้าน 3.44 .27 มาก 

 
 จากตารางที่  4.8  ผลการวิเคราะห์ข้อมูลความพึงพอใจของนักเรียนต่อการเรียนด้วยเว็บช่วย
สอนแบบการเรียนรู้เป็นทีม พบว่า นักเรียนมีความพึงพอใจโดยรวมมีค่าเฉลี่ยอยู่ในระดับมาก  
(   = 3.44 , S.D. = .27) โดยเรียงล าดับจากมากไปหาน้อย ได้แก่ ล าดับที่ 1 ด้านเนื้อหา  มีค่าเฉลี่ยอยู่ใน
ระดับมากที่สุด (   = 3.56 , S.D. = .42)  ล าดับที่ 2  การเรียนรู้ร่วมกันเป็นทีม  มีค่าเฉลี่ยอยู่ในระดับ
มาก (   = 3.49 , S.D. = .42)  ล าดับที่ 3  ด้านการออกแบบ  มีค่าเฉลี่ยอยู่ในระดับมาก (   = 3.37 ,  
S.D. = .33)  และล าดับที่ 4  รูปแบบการน าเสนอ  มีค่าเฉลี่ยอยู่ในระดับมาก (   = 3.33 , S.D. = .32) 
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 ล าดับที่ 1  ด้านเนื้อหา  เมื่อพิจารณาเป็นรายข้อโดยเรียงล าดับจากมากไปหาน้อย  ได้แก่  
ตรงตามวัตถุประสงค์ของบทเรียน  และการใช้ภาษา ง่ายต่อการท าความเข้าใจ   มีค่าเฉลี่ยอยู่ในระดับ
มากที่สุด  (   = 3.70 , S.D. = .47)  การจัดล าดับเนื้อหาแต่ละเร่ืองมีความเหมาะสม  มีค่าเฉลี่ยอยู่ใน
ระดับมากที่สุด  (   = 3.70 , S.D. = .53)  เนื้อหามีความยากง่ายเหมาะสมกับผู้เรียน  มีค่าเฉลี่ยอยู่ใน
ระดับมากที่สุด (   = 3.58 , S.D. = .56)  เนื้อหาที่น าเสนอให้เป็นความรู้ที่มีประโยชน์  มีค่าเฉลี่ยอยู่ใน
ระดับมากที่สุด (   = 3.52 , S.D. = .62)  และเนื้อหาตรงกับสิ่งที่สนใจ  มีค่าเฉลี่ยอยู่ในระดับมาก  
(   = 3.18 , S.D. = .73) 

ล าดับที่ 2  การเรียนรู้ร่วมกันเป็นทีม  เมื่อพิจารณาเป็นรายข้อโดยเรียงล าดับจากมากไปหา
น้อย  ได้แก่  ผู้เรียนเข้ามาเรียนรู้บทเรียนได้ทุกที่ทุกเวลา  มีค่าเฉลี่ยอยู่ในระดับมากที่สุด  (   = 3.73 , 
S.D. = .52)  ท างานตามที่ได้รับมอบหมายในทีม  มีค่าเฉลี่ยอยู่ในระดับมากที่สุด  (   = 3.55 ,  
S.D. = .62)  ผู้เรียนที่อยู่ต่างพื้นที่กันสามารถเรียนรู้ร่วมกันได้  มีค่าเฉลี่ยอยู่ในระดับมาก  (   = 3.45 , 
S.D. = .67)  ผู้เรียนแต่ละทีมสามารถติดต่อสื่อสารกับเพื่อนในทีมในบทเรียนได้มีค่าเฉลี่ยอยู่ในระดับ
มาก (   = 3.42 , S.D.= .66)  ผู้เรียนสามารถแสดงความคิดเห็นเกี่ยวกับช้ินงานที่ท าในทีมและเพื่อน
ต่างทีมในบทเรียนได้ มีค่าเฉลี่ยอยู่ในระดับมาก  (   = 3.42 , S.D. = .50)  และผู้เรียนสามารถ
ติดต่อสื่อสารกับเพื่อนต่างในทีมในบทเรียนได้  มีค่าเฉลี่ยอยู่ในระดับมาก  (   = 3.36 , S.D. = .65) 

ล าดับที่ 3  ด้านการออกแบบ  เมื่อพิจารณาเป็นรายข้อโดยเรียงล าดับจากมากไปหาน้อย  
ได้แก่  ขนาดของตัวอักษรมีความชัดเจน  มีค่าเฉลี่ยอยู่ในระดับมากที่สุด   (   = 3.61 , S.D. = .56)  
รูปแบบของตัวอักษรอ่านง่ายและภาพที่ใช้ประกอบเหมาะสมชัดเจนมีค่าเฉลี่ยอยู่ในระดับมาก  
(   = 3.48 , S.D. = .57) สีของตัวอักษร อ่านง่าย สบายตา ชัดเจน  มีค่าเฉลี่ยอยู่ในระดับมาก (   = 3.30 , 
S.D. = .53)  มีการเช่ือมโยงเนื้อหาภายในเว็บเพจและกับเว็บไซต์อื่น  มีค่าเฉลี่ยอยู่ในระดับมาก  
(   = 3.18 , S.D.= .77)  และหน้าจอสวยงาม ดึงดูด น่าสนใจ  มีค่าเฉลี่ยอยู่ในระดับมาก  (   = 3.15 , 
S.D. = .57)   

ล าดับที่ 4  รูปแบบการน าเสนอ  เมื่อพิจารณาเป็นรายข้อโดยเรียงล าดับจากมากไปหาน้อย  
ได้แก่  ทราบผลทางการเรียนได้ในทันที  มีค่าเฉลี่ยอยู่ในระดับมากที่สุด  (   = 3.61 , S.D. = .56)  
น าเสนอบทเรียนได้อย่างชัดเจนและเข้าใจง่าย  มีค่าเฉลี่ยอยู่ในระดับมากที่สุด  (   = 3.55 , S.D. = .51)  
เปิดโอกาสให้มีส่วนร่วมและท ากิจกรรมในบทเรียน  มีค่าเฉลี่ยอยู่ในระดับมากที่สุด  (   = 3.55 ,  
S.D. = .62) การน าเสนอมีความน่าสนใจ  มีค่าเฉลี่ยอยู่ในระดับมากที่สุด  (   = 3.33 , S.D. = .60)  
สามารถเลือกเรียนได้ตามความต้องการ  มีค่าเฉลี่ยอยู่ในระดับมาก  (   = 3.00 , S.D. = .66)  และการ
ออกแบบเว็บไซต์ดึงดูดความสนใจ   มีค่าเฉลี่ยอยู่ในระดับมาก  (   = 2.94 , S.D. = .56)   



บทที่ 5 
 

สรุปผลการวิจัย  อภิปรายผล  และข้อเสนอแนะ 
 
 การสร้างและพัฒนาบทเรียนบนเว็บแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความสามัคคี 
ส าหรับนักเรียนช้ันมัธยมศึกษาปีที่ 5  ผู้วิจัยขอสรุปผลการวิจัย  การอภิปรายผล  และข้อเสนอแนะไว้
ดังนี้ 
 
5.1  วัตถุประสงค์การวิจัย 
 5.1.1  เพื่อพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
 5.1.2  เพื่อหาประสิทธิภาพบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม ตามเกณฑ์ 
80/80 

5.1.3  เพื่อประเมินผลงานจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
 5.1.4  เพื่อเปรียบเทียบผลการเรียนของนักเรียนก่อนเรียนและหลังเรียนบนเว็บช่วยสอน
แบบการเรียนรู้เป็นทีม 
 5.1.5  เพื่อประเมินความสามัคคีของนักเรียนจากบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้
เป็นทีม 
 5.1.6  เพื่อศึกษาความพึงพอใจของนักเรียนในการใช้บทเรียนบนเว็บช่วยสอนแบบการ
เรียนรู้เป็นทีม 

 
5.2  สมมติฐานการวิจัย 
 5.2.1  บทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม มีประสิทธิภาพตามเกณฑ์ 80/80 
 5.2.2  นักเรียนเรียนจากบทเรียนบนเว็บแบบการเรียนรู้เป็นทีมมีผลการเรียนหลังเรียนสูง
กว่าก่อนเรียนอย่างมีนัยส าคัญทางสถิต ิ
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5.3 ประชากรและกลุม่ตัวอย่าง 
ในการวิจัยในคร้ังนี้  ผู้วิจัยได้ก าหนดประชากรและกลุม่ตัวอย่างที่ใช้ในการวิจัย  ไว้ดังนี้ 

5.3.1   ประชากร 
 นักเรียนชั้นมัธยมศึกษาปีที่ 5 โรงเรียนสวนกุหลาบวิทยาลัย รังสิต จังหวัดปทุมธานี จ านวน 
526 คน ภาคเรียนที่ 2 ปีการศึกษา 2555 
 5.3.2.  กลุ่มตัวอย่าง 

นักเรียนชั้นมัธยมศึกษาปีที่ 5  ภาคเรียนที่ 2 ปีการศึกษา 2555 โรงเรียนสวนกุหลาบวิทยาลัย 
รังสิต จังหวัดปทุมธานี จ านวน 33คน โดยการสุ่มอย่างง่าย (Simple Random Sampling) ด้วยวิธีการจับ
ฉลากเลือก 1 ห้องเรียน จาก จ านวน 14 ห้อง  

 
5.4 ตัวแปรที่ศึกษา 
 5.4.1   ตัวแปรต้น  คือ  บทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
 5.4.2   ตัวแปรตาม คือ 

 5.4.2.1  ประสิทธิภาพของบทเรียน 
 5.4.2.2  ผลการเรียนรู้ 
 5.4.2.3  ผลงานนักเรียน 
 5.4.2.4  ความสามัคคี 
 5.4.2.5  ความพึงพอใจในการใช้บทเรียน 

 

5.5 เครื่องมือที่ใช้ในการวิจัย 

 เครื่องมือที่ใช้ในการวิจัยในคร้ังนี้ประกอบด้วย 
 5.5.1  เว็บช่วยสอนแบบการเรียนรู้เป็นทีม เร่ือง  การน าเสนอสื่อประสม  โดยแบ่งเนื้อหา
ออกเป็น 5 ส่วน ดังนี้ ส่วนที่ 1  การใช้งานโปรแกรมเบื้องต้น ส่วนที่ 2 การเพิ่มวัตถุต่างๆในสไลด์ 
ส่วนที่ 3 การแทรกมัลติมีเดีย ส่วนที่ 4 การสร้างปฏิสัมพันธ์กับสื่อ และส่วนที่ 5 การน าเสนอผลงาน 
 5.5.2  แผนการเรียนการสอนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมใช้เวลาในการทดลอง 
5 สัปดาห์ สัปดาห์ละ 1 คร้ัง ใช้เวลา 100 นาที ผู้วิจัยจึงสร้างแผนการจัดการเรียนรู้ทั้งหมด 5 แผน แต่
ละแผนประกอบด้วย จุดประสงค์การเรียนรู้  เนื้อหาสาระการเรียนรู้  กิจกรรมการเรียนการสอน  สื่อ
และแหล่งการเรียนรู้  และการวัดและประเมินผล 
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 5.5.3   แบบทดสอบวัดผลการเรียนรู้ในรายวิชาการน าเสนอสื่อประสม  เร่ือง  การน าเสนอสื่อ
ประสมเบื้องต้น เป็นแบบปรนัยชนิดเลือกตอบ 4 ตัวเลือก  จ านวน 30 ข้อ  ที่ได้ผ่านการวิเคราะห์เนื้อหาจาก
ผู้เช่ียวชาญด้านการวัดผลและประประเมินผล 3 ท่าน และผู้เช่ียวชาญด้านสื่อและเทคโนโลยี 3 ท่าน แล้วน า
แบบทดสอบไปทดลองใช้กับนักเรียนระดับช้ันมัธยมศึกษาปีที่ 5 ที่เคยเรียนเร่ืองการน าเสนอสื่อประสม
มาแล้ว  จ านวน 30 คน 
 5.5.4  แบบประเมินความสามัคคี โดยใช้มาตราส่วนประมาณค่า 4 ระดับ  ซึ่งแบ่งเป็น 2 ส่วน ดังนี้ 
 5.5.4.1  แบบประเมินความสามัคคีส าหรับนักเรียนประเมินตนเอง  มีเกณฑ์การประเมิน
ทั้งหมด 4  ด้าน ดังนี้ ด้านที่ 1   เข้าใจบทบาทหน้าที่ในทีม จ านวน 5 ข้อ ด้านที่ 2  การยอมรับฟังความคิดเห็น 
จ านวน 6 ข้อ  ด้านที่ 3  การท างานร่วมกัน จ านวน 6 ข้อ  และด้านที่ 4  ผลการท างานเป็นทีม จ านวน 6 ข้อ   

5.5.4.2  แบบประเมินความสามัคคีส าหรับครูประเมินนักเรียน จ านวน 11 ข้อ   
 5.5.5  แบบประเมินผลงานนักเรียนจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 

โดยใช้เกณฑ์การประเมินแบบรูบิค (Rubric Score)  ซึ่งมีเกณฑ์การประเมินทั้งหมด  5  ด้าน โดยประเมินเป็น

รายข้อๆ ละ 4 คะแนน  ประกอบด้วยด้านต่าง  ๆดังนี้  ด้านที่ 1 ความสมบูรณ์ของช้ินงาน  ด้านที่ 2  ความ

เหมาะสมของเนื้อหาที่น าเสนอ  ด้านที่ 3  การจัดวางข้อความและรูปภาพอย่างเหมาะสม  ด้านที่ 4  มีการ

เช่ือมโยงอย่างเหมาะสม  และด้านที่ 5  มีการแทรกเทคนิคพิเศษอย่างเหมาะสม 

 5.5.6  แบบประเมินความพึงพอใจต่อเว็บช่วยสอนแบบการเรียนรู้เป็นทีม  โดยใช้มาตราส่วน

ประมาณค่า 4 ระดับ  ซึ่งมีเกณฑ์การประเมินทั้งหมด  4  ด้าน ด้านละ 6 ข้อ ดังนี้  ด้านที่ 1 ด้านเนื้อหา  ด้านที่ 2  

ด้านการออกแบบ  ด้านที่ 3  รูปแบบการน าเสนอ และด้านที่  4  การเรียนรู้ร่วมกันเป็นทีม  

 

5.6  วิธีด าเนินการวิจัย 
 การวิจัยเร่ืองการพัฒนาบทเรียนเว็บแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความสามัคคีของ
นักเรียนชั้นมัธยมศึกษาปีที่ 5  มีขั้นตอนวิธีการด าเนินการวิจัย  แบ่งได้ดังนี้ 
 ขั้นการสร้าง 
 ในขั้นตอนนี้ผู้วิจัยได้ด าเนินการศึกษางานวิจัยที่เกี่ยวข้องในส่วนของบทเรียนออนไลน์ 
ความสามัคคี  จากนั้นท าการวิเคราะห์  สังเคราะห์  แล้วออกแบบเนื้อหาให้สอดคล้องกับวัตถุประสงค์
ที่ต้องการวัดผล  โดยก าหนดให้บทเรียนบนเว็บที่ใช้ในการวิจัย  ประกอบไปด้วย จุดประสงค์การ
เรียนรู้  ใบความรู้ วิดีโอประกอบการเรียน ใบงาน  แบบทดสอบ แบบประเมินความสามัคคี และแบบ
ประเมินความพึงพอใจ  
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 ขั้นการพัฒนา 
 ในขั้นตอนนี้ผู้วิจัยได้น าโครงสร้างการเรียน แผนการเรียนรู้  เว็บช่วยสอน แบบประเมิน
ความสามัคคี แบบประเมินผลงงานนักเรียน  แบบประเมินความพึงพอใจ ซึ่งผู้วิจัยได้สร้างขึ้น  ไปให้
ผู้เช่ียวชาญด้านการวัดและประเมินผล  ช่วยประเมินความเที่ยงตรงเชิงเนื้อหา  แล้วปรับปรุง  จากนั้น
น าไปให้ผู้เช่ียวชาญด้านเนื้อหาและเทคโนโลยีช่วยประเมินความคิดเห็นความเหมาะสมด้านเนื้อหา  
โดยใช้สถิติค่าเฉลี่ยและส่วนเบี่ยงเบน  แล้วปรับปรุงอีกคร้ัง  จนมีผลเป็นที่น่าพอใจแล้ว  จึงน า
แบบทดสอบก่อนและหลัง  ไปหาค่าอ านาจจ าแนกและวิเคราะห์หาความเช่ือมั่นด้วย Model Scale 
Alpha () โดย Kuder-Richardson(KR 20)กับกลุ่มตัวอย่างที่มีความใกล้เคียงกับกลุ่มตัวอย่างจริง  
จ านวน 30 คน เพื่อวิเคราะห์หาความเช่ือมั่นของแบบทดสอบทั้งฉบับ  ส่วนแบบประเมินความสามัคคี
น าไปให้ผู้เช่ียวชาญด้านจิตวิทยาประเมินความเที่ยงตรงเชิงเนื้อหา  แล้วปรับปรุงแล้วน าไปใช้ต่อไป   
 ขั้นการหาประสิทธิภาพ 
 น าเว็บช่วยสอนที่ได้ไปหาประสิทธิภาพโดยน าไปทดลองกับนักเรียน จ านวน  3 คน (สูง 1 
คน ปานกลาง 1 คน และ ต่ า 1 คน)  แล้วบันทึกผลพร้อมปรับปรุงข้อบกพร่องก่อนน าไปหา
ประสิทธิภาพอีกครั้งแบบกลุ่ม  จ านวน 6 คน (สูง 2 คน ปานกลาง 2 คน และ ต่ า 2 คน) บันทึกผลและ
ปรับปรุงแก้ไข แล้วจึงน าไปทดลองแบบภาคสนาม  จ านวน 30  คน (สูง 10 คน  ปานกลาง10 คน และ
ต่ า10 คน) บันทึกผลและปรับปรุงก่อนที่จะน าไปใช้กับกลุ่มตัวอย่างจริง  
 ขั้นการน าไปใช้ 

ผู้วิจัยน าเว็บช่วยสอนที่ผ่านการหาประสิทธิภาพมาแล้ว  มาด าเนินการทดลองตามแผนการ
การทดลองกับกลุ่มตัวอย่างจริง จ านวน 33  คน โดยการสุ่มอย่างง่าย (Simple Random Sampling) ด้วย
วิธีการจับฉลากเลือก 1 ห้องเรียนจากนั้นน าผลที่ได้ไปทดสอบตามสมมุติฐานที่ตั้งไว้ด้วยกระบวนการ
ทางสถิติ 
 ขั้นการวิเคราะห์ข้อมูล 
 การวิเคราะห์ข้อมูลทางการวิจัย  ผู้วิจัยเลือกใช้โปรแกรมช่วยการวิเคราะห์งานวิจัย  ทาง
การศึกษามาช่วยในการวิเคราะห์ผล ดังต่อไปนี้  
 ด าเนินการตรวจสอบความเที่ยงตรงด้านเนื้อหา ด้วยผู้เช่ียวชาญ โดยใช้ค่าดัชนีความ
สอดคล้องในการวิเคราะห์ความสอดคล้อง (IOC) 
 ด าเนินการวิเคราะห์ความคิดเห็นด้านความชัดเจนความเหมาะสมในเนื้อหาด้วยผู้เช่ียวชาญ  
โดยใช้ค่าเฉลี่ย  และส่วนเบี่ยงเบนมาตรฐานในการวิเคราะห์ 
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 ด าเนินการหาค่าอ านาจจ าแนกและความเช่ือมั่นของแบบทดสอบด้วยวิธีของคูเดอร์-ริชาร์ด
สัน (KR-20)  
 ด าเนินการหาประสิทธิภาพของบทเรียนบนเว็บช่วยสอน โดยหาความสัมพันธ์ของคะแนน
ร้อยละที่ได้ระหว่างการเรียน  กิจกรรม(ใบงาน) กับคะแนนร้อยละที่ได้จากการท าแบบทดสอบหลัง
เรียน  มาหาประสิทธิภาพตามเกณฑ์  80/80 
 ด าเนินการเปรียบเทียบผลการเรียนก่อนเรียนและหลังเรียน ด้วยแบบทดสอบก่อนและหลัง      
ด้วยสถิติ  t-test Dependent   
 ด าเนินการหาผลการประเมินผลงานจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
โดยใช้ค่าเฉลี่ยในการวิเคราะห์ 
 ด าเนินการหาผลการประเมินความสามัคคีจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้
เป็นทีม โดยใช้ค่าเฉลี่ย  และส่วนเบี่ยงเบนมาตรฐานในการวิเคราะห์ 
 ด าเนินการหาผลความพึงใจต่อบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม โดยใช้
ค่าเฉลี่ย  และส่วนเบี่ยงเบนมาตรฐานในการวิเคราะห์ 
 
5.7  สรุปผลการวิจัย 
 ในการสร้างและพัฒนาบทเรียนบนเว็บแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความสามัคคี 
ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 5  สามารถสรุปได้ดังนี้ 
 5.7.1  ผลจากการสร้างและพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อ
ส่งเสริมความสามัคคี ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 5 ให้มีประสิทธิภาพตามเกณฑ์ 80/80   พบว่า 
คะแนนร้อยละของกิจกรรมระหว่างการเรียนเท่ากับ 88.29 (E1) และมีคะแนนจากแบบทดสอบหลัง
การเรียน เท่ากับ 84.33 (E2)  ซึ่งสูงกว่าเกณฑ์ที่ตั้งไว้ที่ 80/80    
 5.7.2  ผลการเปรียบเทียบผลการเรียนก่อนเรียนและหลังเรียนบนเว็บช่วยสอนแบบการ
เรียนรู้เป็นทีมเพื่อส่งเสริมความสามัคคี ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 5 ได้ว่าผลการทดสอบหลัง
การเรียนสูงกว่าก่อนเรียนอย่างมีนัยส าคัญทางสถิติที่ระดับ .05 
 5.7.3  ผลงานจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความ
สามัคคีมีคะแนนรวมเฉลี่ยอยู่ในระดับดีมาก (   = 3.54) 
 5.7.4  ความสามัคคีของนักเรียนต่อการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีมโดย
นักเรียนประเมินตนเองมีคะแนนรวมเฉลี่ยอยู่ในระดับมากที่สุด (   = 3.50 , S.D. = .30) ส่วนครู
ประเมินนักเรียนมีคะแนนรวมเฉลี่ยอยู่ในระดับมากที่สุด (   = 3.66 , S.D. = .36) 
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 5.7.5  ความพึงพอใจของนักเรียนต่อการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อ
ส่งเสริมความสามัคคีของนักเรียนระดับชั้นมัธยมศึกษาปีที่ 5 มีคะแนนรวมเฉลี่ยอยู่ในระดับมาก  
(   = 3.44 , S.D. = .27) 
 
5.8  การอภิปรายผล 
 ผลการวิจัยมีประเด็นที่น่าสนใจมาอภิปรายได้ดังนี้ 
 5.8.1  ผลจากการสร้างและพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อ
ส่งเสริมความสามัคคี ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 5 ให้มีประสิทธิภาพตามเกณฑ์ 80/80   พบว่า 
คะแนนร้อยละของกิจกรรมระหว่างการเรียนเท่ากับ 88.29 (E1) และมีคะแนนจากแบบทดสอบหลัง
การเรียน เท่ากับ 84.33 (E2)  ซึ่งเป็นไปตามเกณฑ์ที่ตั้งไว้ในสมมติฐาน คือ 80/80  เนื่องจากบทเรียนที่
สร้างขึ้นนั้นผู้วิจัยได้ผ่านการตรวจสอบเนื้อหาจากผู้เช่ียวชาญ น าเสนอเนื้อหาเป็นล าดับขั้นตอน มีทั้ง
วิดีโอ ภาพเคลื่อนไหว ข้อความที่กระตุ้นให้ผู้เรียนเกิดความต้องการที่จะเรียนรู้ และสามารถเลือก
เรียนได้ตามต้องการ นอกจากนั้นยังมีการปฏิสัมพันธ์ระหว่างบทเรียน ระหว่างผู้เรียนกับผู้เรียนให้
สมาชิกในกลุ่มได้ช่วยเหลือและให้ค าแนะน าแก่กัน รวมถึงผู้เรียนกับผู้สอน ซึ่งผลการวิจัยสอดคล้อง
กับงานวิจัยของลัดดาวัลย์ สวัสดิ์หลง (2550)  เร่ือง การพัฒนาบทเรียนคอมพิวเตอร์ช่วยสอนบนเว็บ
ด้วยการเรียนรู้แบบโครงงานเพื่อการเรียนรู้เป็นทีมของนักศึกษาระดับปริญญาโท มหาวิทยาลัย
เทคโนโลยีพระจอมเกล้าพระนครเหนือ ซึ่งผลการวิจัยพบว่าบทเรียนคอมพิวเตอร์ช่วยสอนบนเว็บ
ด้วยการเรียนรู้แบบโครงงานเพื่อการเรียนรู้เป็นทีมที่ผู้วิจัยพัฒนาขึ้น มีประสิทธิภาพ 83.16/80.19 สูง
กว่าเกณฑ์ 80/80 ที่ตั้งไว้ และสอดคล้องกับ มณเฑียร รัตนศิริวงศ์วุฒิ (2546) ได้ท าการวิจัยเร่ือง การ
พัฒนาและหาประสิทธิภาพระบบการจัดการเรียนการสอนและบทเรียนคอมพิวเตอร์ผ่านสื่อ
อิเล็กทรอนิกส์บนเครือข่ายอินเทอร์เน็ต กรณีศึกษา วิชาการพัฒนาระบบสารสนเทศตามหลักสูตร
วิทยาศาสตร์มหาบัณฑิต พบว่า บทเรียนมีประสิทธิภาพ 86.22/85.60 ซึ่งเป็นไปตามเกณฑ์ที่ก าหนดไว้ 
คือ 80/80  
 5.8.2  ผลการเปรียบเทียบผลการเรียนก่อนเรียนและหลังเรียนบนเว็บช่วยสอนแบบการ
เรียนรู้เป็นทีมเพื่อส่งเสริมความสามัคคี ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 5 ได้ว่าผลการทดสอบหลัง
การเรียนสูงกว่าก่อนเรียนอย่างมีนัยส าคัญทางสถิติที่ระดับ .05 เนื่องจากกระบวนการจัดการเรียนรู้
ด้วยบทเรียนบนเว็บแบบการเรียนรู้เป็นทีมท าให้นักเรียนสามารถทบทวนเนื้อหา บทเรียนได้
ตลอดเวลา เป็นผลท าให้ ผลการทดสอบหลังการเรียนสูงกว่าก่อนเรียน  สอดคล้องกับ ปัญญฎา 
ประดิษฐบาทุกา  (2546) ได้ท าการวิจัยเร่ือง ผลของการเรียนรู้แบบทีมแข่งขันที่มีต่อความคิด
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สร้างสรรค์ทางคณิตศาสตร์ของนักเรียนช้ันประถมศึกษาปีที่ 6 โรงเรียนทรงวิทยา จังหวัด
สมุทรปราการ พบว่า นักเรียนมีความคิดสร้างสรรค์ทางคณิตศาสตร์มากขึ้น หลังจากได้รับการเรียนรู้
แบบทีมแข่งขัน อย่างมีนัยส าคัญทางสถิติที่ระดับ .01 และยังสอดคล้องกับ นิษฐา  พุฒิมานรดีกุล 
(2548) ได้ท าการวิจัย เร่ือง การน าเสนอรูปแบบการฝึกอบรมบนเว็บเพื่อพัฒนาทักษะการเรียนรู้เป็น
ทีม ส าหรับนักเทคโนโลยีการศึกษา พบว่า ผลการทดลองใช้รูปแบบการฝึกอบรม พบว่า กลุ่มตัวอย่าง
มีคะแนนทักษะการเรียนรู้เป็นทีมและประสิทธิภาพในการท างานเป็นทีมสูงกว่าก่อนการฝึกอบรม
อย่างมีนัยส าคัญทางสถิติที่ระดับ .05 และกลุ่มตัวอย่างร่วมมือกันท างานเป็นทีมในระดับมาก 

5.8.3  ผลงานจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความ
สามัคคีมีคะแนนรวมเฉลี่ยอยู่ในระดับดีมาก (   = 3.54) ซึ่งโดยรวมพบว่านักเรียนแต่ละทีมมีการ
ปรึกษาหารือร่วมกัน  วางแผนการท างานผ่านระบบกระดานสนทนาและห้องสนทนเพื่อแบ่งหน้าที่
ความรับผิดชอบและช่วยกันสืบค้นข้อมูลเพื่อจัดท างานที่ได้รับมอบหมายร่วมกัน ซึ่งสอดคล้องกับ  
วัลยา พุ่มต้นวงศ์ (2552) ได้ท าการวิจัยเร่ือง การศึกษาผลการเรียนอีเลิร์นนิ่งแบบร่วมมือที่มีต่อทักษะ
การท างานกลุ่มของนักศึกษาระดับปริญญาตรี มหาวิทยาลัยศิลปากร พบว่า ผลงานจากการเรียนด้วย
สื่อประกอบการเรียนอีเลิร์นนิ่งแบบร่วมมือ มีคะแนนรวมเฉลี่ยอยู่ในระดับดี และสอดคล้องกับ Cox 
(2002)  กล่าวว่า ความสามัคคีในทีมมีความสัมพันธ์อย่างสูงกับความสามารถของทีม ซึ่งทีมที่มีความ
สามัคคีภายในทีมสูงจะส่งผลให้ความสามารถของทีมสูงขึ้นและส่งผลให้ทีมประสบผลส าเร็จ 

5.8.4  ความสามัคคีของนักเรียนต่อการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีมโดย
นักเรียนประเมินตนเองมีคะแนนรวมเฉลี่ยอยู่ในระดับมากที่สุด (   = 3.50 , S.D. = .30) ส่วนครู
ประเมินนักเรียนมีคะแนนรวมเฉลี่ยอยู่ในระดับมากที่สุด (   = 3.66 , S.D. = .36) โดยแบบประเมินที่
สร้างขึ้นนั้นสอดคล้องตามหลักธรรม สาธาณียธรรม 6 ซึ่งเป็นหลักธรรมที่ใช้ในการเสริมสร้างความ
สามัคคีและความเป็นปึกแผ่น และยังสอดคล้องกับ อดิศักดิ์  ดวงศรี (2553)  ได้ท าการวิจัยเร่ืองการ
จัดการเรียนรู้พลศึกษาโดยใช้กิจกรรมฟุตบอลตามแนวคิดของคาร์รอล เพื่อพัฒนาความสามัคคีของ
นักเรียนมัธยมศึกษาตอนต้น ผลการวิจัยพบว่า 1) ค่าเฉลี่ยของคะแนนความสามัคคีหลังการทดลอง
ของนักเรียนกลุ่มทดลองสูงกว่าก่อนการทดลองอย่างมีนัยส าคัญทางสถิติที่ระดับ .05 และค่าเฉลี่ยของ
คะแนนความสามัคคีก่อนและหลังการทดลองของนักเรียนกลุ่มควบคุมไม่แตกต่างกันอย่างมีนัยส าคัญ
ทางสถิติที่ระดับ .05  2) ค่าเฉลี่ยของคะแนนความสามัคคีหลังการทดลองของนักเรียนกลุ่มทดลองสูง
กว่านักเรียนกลุ่มควบคุมอย่างมีนัยส าคัญทางสถิติที่ระดับ .05   
 5.8.5  ความพึงพอใจของนักเรียนต่อการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อ
ส่งเสริมความสามัคคีของนักเรียนระดับชั้นมัธยมศึกษาปีที่ 5 มีคะแนนรวมเฉลี่ยอยู่ในระดับมาก  
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(   = 3.44 , S.D. = .27 สอดคล้องกับงานวิจัยของ ลัดดาวัลย์ สวัสดิ์หลง (2550)  เร่ือง การพัฒนา
บทเรียนคอมพิวเตอร์ช่วยสอนบนเว็บด้วยการเรียนรู้แบบโครงงานเพื่อการเรียนรู้เป็นทีมของนักศึกษา
ระดับปริญญาโท มหาวิทยาลัยเทคโนโลยีพระจอมเกล้าพระนครเหนือ ซึ่งผลการวิจัยพบว่าผู้เรียนมี
ความพึงพอใจต่อบทเรียนคอมพิวเตอร์ช่วยสอนบนเว็บด้วยการเรียนรู้แบบโครงงานเพื่ อการเรียนรู้
เป็นทีมที่ผู้วิจัยพัฒนาขึ้นในระดับมาก   
 
5.9  ข้อเสนอแนะในการน าผลไปใช้ 
 5.9.1  การเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความสามัคคีของ
นักเรียน จะเห็นได้ว่าให้ผลทางการเรียนรู้เพิ่มขึ้นเนื่องจากนักเรียนสามารถเข้าไปใช้บทเรียนได้ทุกที่
ทุกเวลา และในบทเรียนก็มีทั้งเอกสารและวิดีโอประกอบการเรียน อีกทั้งยังสามารถท างานตามใบงาน
และปรึกษาหารือร่วมกันได้ทั้งระหว่างนักเรียนด้วยกันหรือระหว่างครูกับนักเรียนก็ได้ ดังนั้นการ
จัดการเรียนการสอนแบบนี้จึงสามารถที่จะน าไปใช้ในการจัดการเรียนการสอนในรายวิชาอื่นๆ  ได้
เช่นเดียวกัน 
 5.9.2  รูปแบบการเรียนรู้เป็นทีมที่พัฒนาขึ้นสามารถน าไปใช้กับรายวิชาใดก็ได้  โดยเฉพาะ
อย่างย่ิงรายวิชาที่ต้องมีการปฏิบัติหรือสร้างช้ินงานหรือการเรียนแบบโครงงานก็ได้ 
 
5.10  ข้อเสนอแนะในการท าวิจัยครั้งต่อไป 
 5.10.1  ควรมีการวิจัยการใช้เว็บช่วยสอนแบบการเรียนรู้เป็นทีม มาประยุกต์ใช้กับการเรียน
แบบสังคมออนไลน์ (social network) เช่น facebook , myspace , webblog เพื่อให้เกิดรูปแบบการ
เรียนรู้ที่หลากหลายตามลักษณะการเรียนรู้ของผู้เรียนและทันสมัย 
 5.10.2  ควรน ารูปแบบการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีมไปทดลองใช้เพื่อ
ศึกษาถึงผลของกิจกรรมที่ส่งผลกับตัวแปรอื่นตามคุณลักษณะอันพึงประสงค์ 8 ข้อ ตามหลักสูตร
แกนกลางการศึกษาขั้นพื้นฐาน  พุทธศักราช  2551 ได้แก่ รักชาติ ศาสน์ กษัตริย์  ซื่อสัตย์สุจริต  มีวินัย  
ใฝ่เรียนรู้  อยู่อย่างพอเพียง  มุ่งมั่นในการท างาน  รักความเป็นไทย และมีจิตสาธารณะ  
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รายชื่อผู้เชี่ยวชาญตรวจสอบเครื่องมือทีใ่ช้ในงานวิจัย 

 

ผู้เช่ียวชาญด้านวัดและประเมนิผล 
1. ดร.ราชันย์  บุญธิมา  
อาจารย์ประจ าส านักทดสอบทางการศึกษาและจิตวิทยา  มหาวิทยาลัยศรีนครินทรวิโรฒ  

2. ผู้ช่วยศาตราจารย์ ดร.ฉัตรศิริ ปิยะพิมลสิทธ์ิ    
ประธานสาขาวิชาการวิจัยและประเมินทางการศึกษา  ภาควิชาการศึกษา คณะ
ศึกษาศาสตร์  มหาวิทยาลัยเกษตรศาสตร์ 

  3. ดร.มารุต พัฒผล  
อาจารย์ประจ าสาขาการวิจัยและพัฒนาหลักสูตร  บัณฑิตวิทยาลัย   
มหาวิทยาลัยศรีนครินทรวิโรฒ 

ผู้เช่ียวชาญด้านสื่อและเนือ้หา 
 1. รองศาสตราจารย์ ดร.ปรัชญนันท์ นิลสุข 

อาจารย์ประจ าภาควิชาครุศาสตร์เทคโนโลยี คณะครุศาสตร์อุตสาหกรรม 
มหาวิทยาลัยเทคโนโลยีพระจอมเกล้าพระนครเหนือ 

 2. ผู้ช่วยศาสตราจารย์ ดร.ฐาปนีย์ ธรรมเมธา 
อาจารย์ประจ าภาควิชาภาควิชาเทคโนโลยีการศึกษา คณะศึกษาศาสตร์  
มหาวิทยาลัยศิลปากร 

 3. รองศาสตราจารย์ ดร.สาโรช โศภีรักข์ 
ภาควิชาเทคโนโลยีการศึกษา คณะศึกษาศาสตร์ มหาวิทยาลัยเกษตรศาสตร์ 

ผู้เช่ียวชาญด้านจิตวิทยา 
 1. รองศาสตราจารย์ ดร. รุ่งแสง  อรุณไพโรจน์ 

อาจารย์ประจ าภาควิชาจิตวิทยาการศึกษาและการแนะแนว  มหาวิทยาลัยเกษตรศาสตร์ 
 2. ผู้ช่วยศาสตราจารย์ ดร. มนัสนันท์  หัตถศักดิ์ 

รองหัวหน้าภาควิชาจิตวิทยาการศึกษาและการแนะแนว มหาวิทยาลัยเกษตรศาสตร์ 
 3. นางสาววิชุดา  จินดา (ครูเช่ียวชาญ) 

ครกูลุ่มสาระการเรียนรู้สังคมศึกษา ศาสนา และวัฒนธรรม  
โรงเรียนสวนกุหลาบวิทยาลัย รังสิต 
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 31  กรกฎาคม   2555 

เรื่อง   ขอเรียนเชิญเป็นผู้เช่ียวชาญในการตรวจสอบเครื่องมือวิจัย 
เรียน   ดร.ราชันย์  บุญธิมา 

  เนื่องด้วย  นางสาววาสนา  แสงศรี  นักศึกษาหลักสูตรศึกษาศาสตรมหาบัณฑิต   สาขาวิชา
เทคโนโลยีและสื่อสารการศึกษา คณะครุศาสตร์อุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี ก าลัง
จัดท าวิทยานิพนธ์  เร่ืองการพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความ
สามัคคี ส าหรับนักเรียนช้ันมัธยมศึกษาปีที่ 5 โดยมี รองศาสตราจารย์  ดร. เกียรติศักดิ์  พันธ์ล าเจียก  เป็น
อาจารย์ ที่ปรึกษาวิทยานิพนธ์    
   ในการนี้  คณะกรรมการบริหารหลักสูตรฯ  พิจารณาเห็นว่า  ท่านเป็นผู้เช่ียวชาญที่มีความรู้
ความสามารถอย่างดีย่ิง  จึงขอเรียนเชิญเป็นผู้เช่ียวชาญตรวจสอบเคร่ืองมือวิจัยในการจัดท าวิทยานิพนธ์ 
ดังกล่าวให้แก่  นางสาววาสนา  แสงศรี  เพื่อประโยชน์ทางการศึกษาต่อไป 

 
 จึงเรียนมาเพื่อโปรดพิจารณาให้ความอนุเคราะห์  จะเป็นพระคุณย่ิง 
 

ขอแสดงความนับถอื 
                                      
 
(  ดร.ทศพร  แสงสว่าง  ) 

                                       ผู้ช่วยคณบดีฝ่ายบัณฑิตศึกษา  
                   ปฏิบัติราชการแทน คณบดีคณะครุศาสตร์อุตสาหกรรม 
 

 

 

คณะครุศาสตร์อุตสาหกรรม 
มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี  
ต.คลองหก  อ.ธัญบุรี จ.ปทุมธานี 12110 
 

ที่ ศธ 0578.02/0536.3 

งานบัณฑิตศึกษา 
โทรศัพท์  02 549 3210 
โทรสาร  02 577 5020 
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 31  กรกฎาคม   2555 

เรื่อง   ขอเรียนเชิญเป็นผู้เช่ียวชาญในการตรวจสอบเครื่องมือวิจัย 
เรียน   ผู้ช่วยศาสตราจารย์  ดร.ฉัตรศิริ  ปิยะพิมลสิทธ์ิ 

  เนื่องด้วย  นางสาววาสนา  แสงศรี  นักศึกษาหลักสูตรศึกษาศาสตรมหาบัณฑิต   สาขาวิชา
เทคโนโลยีและสื่อสารการศึกษา คณะครุศาสตร์อุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี ก าลัง
จัดท าวิทยานิพนธ์  เร่ืองการพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความ
สามัคคี ส าหรับนักเรียนช้ันมัธยมศึกษาปีที่ 5 โดยมี รองศาสตราจารย์  ดร. เกียรติศักดิ์  พันธ์ล าเจียก  เป็น
อาจารย์ ที่ปรึกษาวิทยานิพนธ์    
   ในการนี้  คณะกรรมการบริหารหลักสูตรฯ  พิจารณาเห็นว่า  ท่านเป็นผู้เช่ียวชาญที่มีความรู้
ความสามารถอย่างดีย่ิง  จึงขอเรียนเชิญเป็นผู้เช่ียวชาญตรวจสอบเคร่ืองมือวิจัยในการจัดท าวิทยานิพนธ์ 
ดังกล่าวให้แก่  นางสาววาสนา  แสงศรี  เพื่อประโยชน์ทางการศึกษาต่อไป 

 
 จึงเรียนมาเพื่อโปรดพิจารณาให้ความอนุเคราะห์  จะเป็นพระคุณย่ิง 
 

ขอแสดงความนับถอื 
                                      
 
(  ดร.ทศพร  แสงสว่าง  ) 

                                       ผู้ช่วยคณบดีฝ่ายบัณฑิตศึกษา  
                   ปฏิบัติราชการแทน คณบดีคณะครุศาสตร์อุตสาหกรรม 
                                
          
 
 
 

คณะครุศาสตร์อุตสาหกรรม 
มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี  
ต.คลองหก  อ.ธัญบุรี จ.ปทุมธานี 12110 
 

ที่ ศธ 0578.02/0536.4 

งานบัณฑิตศึกษา 
โทรศัพท์  02 549 3210 
โทรสาร  02 577 5020 
 



114 
 

 

 

         
 
 
       

 31  กรกฎาคม   2555 

เรื่อง   ขอเรียนเชิญเป็นผู้เช่ียวชาญในการตรวจสอบเครื่องมือวิจัย 
เรียน   ดร.มารุต  พัฒผล 

  เนื่องด้วย  นางสาววาสนา  แสงศรี  นักศึกษาหลักสูตรศึกษาศาสตรมหาบัณฑิต   สาขาวิชา
เทคโนโลยีและสื่อสารการศึกษา คณะครุศาสตร์อุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี ก าลัง
จัดท าวิทยานิพนธ์  เร่ืองการพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความ
สามัคคี ส าหรับนักเรียนช้ันมัธยมศึกษาปีที่ 5 โดยมี รองศาสตราจารย์  ดร. เกียรติศักดิ์  พันธ์ล าเจียก  เป็น
อาจารย์ ที่ปรึกษาวิทยานิพนธ์    
   ในการนี้  คณะกรรมการบริหารหลักสูตรฯ  พิจารณาเห็นว่า  ท่านเป็นผู้เช่ียวชาญที่มีความรู้
ความสามารถอย่างดีย่ิง  จึงขอเรียนเชิญเป็นผู้เช่ียวชาญตรวจสอบเคร่ืองมือวิจัยในการจัดท าวิทยานิพนธ์ 
ดังกล่าวให้แก่  นางสาววาสนา  แสงศรี  เพื่อประโยชน์ทางการศึกษาต่อไป 

 
 จึงเรียนมาเพื่อโปรดพิจารณาให้ความอนุเคราะห์  จะเป็นพระคุณย่ิง 
 

ขอแสดงความนับถอื 
                                      
 
(  ดร.ทศพร  แสงสว่าง  ) 

                                       ผู้ช่วยคณบดีฝ่ายบัณฑิตศึกษา  
                   ปฏิบัติราชการแทน คณบดีคณะครุศาสตร์อุตสาหกรรม 
 
 
                 
 
            

คณะครุศาสตร์อุตสาหกรรม 
มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี  
ต.คลองหก  อ.ธัญบุรี จ.ปทุมธานี 12110 
 

ที่ ศธ 0578.02/0536.5 

งานบัณฑิตศึกษา 
โทรศัพท์  02 549 3210 
โทรสาร  02 577 5020 
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 31  กรกฎาคม   2555 

เรื่อง   ขอเรียนเชิญเป็นผู้เช่ียวชาญในการตรวจสอบเครื่องมือวิจัย 
เรียน   รองศาสตราจารย์  ดร.ปรัชญนันท์  นิลสุข 

  เนื่องด้วย  นางสาววาสนา  แสงศรี  นักศึกษาหลักสูตรศึกษาศาสตรมหาบัณฑิต   สาขาวิชา
เทคโนโลยีและสื่อสารการศึกษา คณะครุศาสตร์อุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี ก าลัง
จัดท าวิทยานิพนธ์  เร่ืองการพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความ
สามัคคี ส าหรับนักเรียนช้ันมัธยมศึกษาปีที่ 5 โดยมี รองศาสตราจารย์  ดร. เกียรติศักดิ์  พันธ์ล าเจียก  เป็น
อาจารย์ ที่ปรึกษาวิทยานิพนธ์    
   ในการนี้  คณะกรรมการบริหารหลักสูตรฯ  พิจารณาเห็นว่า  ท่านเป็นผู้เช่ียวชาญที่มีความรู้
ความสามารถอย่างดีย่ิง  จึงขอเรียนเชิญเป็นผู้เช่ียวชาญตรวจสอบเคร่ืองมือวิจัยในการจัดท าวิทยานิพนธ์ 
ดังกล่าวให้แก่  นางสาววาสนา  แสงศรี  เพื่อประโยชน์ทางการศึกษาต่อไป 

 
 จึงเรียนมาเพื่อโปรดพิจารณาให้ความอนุเคราะห์  จะเป็นพระคุณย่ิง 
 

ขอแสดงความนับถอื 
                                      
 
(  ดร.ทศพร  แสงสว่าง  ) 

                                       ผู้ช่วยคณบดีฝ่ายบัณฑิตศึกษา  
                   ปฏิบัติราชการแทน คณบดีคณะครุศาสตร์อุตสาหกรรม 
                        
 
    

 

คณะครุศาสตร์อุตสาหกรรม 
มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี  
ต.คลองหก  อ.ธัญบุรี จ.ปทุมธานี 12110 
 

ที่ ศธ 0578.02/0536.6 

งานบัณฑิตศึกษา 
โทรศัพท์  02 549 3210 
โทรสาร  02 577 5020 
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 31  กรกฎาคม   2555 

เรื่อง   ขอเรียนเชิญเป็นผู้เช่ียวชาญในการตรวจสอบเครื่องมือวิจัย 
เรียน   ผู้ช่วยศาสตราจารย์  ดร.ฐาปนีย์  ธรรมเมธา 

  เนื่องด้วย  นางสาววาสนา  แสงศรี  นักศึกษาหลักสูตรศึกษาศาสตรมหาบัณฑิต   สาขาวิชา
เทคโนโลยีและสื่อสารการศึกษา คณะครุศาสตร์อุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี ก าลัง
จัดท าวิทยานิพนธ์  เร่ืองการพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความ
สามัคคี ส าหรับนักเรียนช้ันมัธยมศึกษาปีที่ 5 โดยมี รองศาสตราจารย์  ดร. เกียรติศักดิ์  พันธ์ล าเจียก  เป็น
อาจารย์ ที่ปรึกษาวิทยานิพนธ์    
   ในการนี้  คณะกรรมการบริหารหลักสูตรฯ  พิจารณาเห็นว่า  ท่านเป็นผู้เช่ียวชาญที่มีความรู้
ความสามารถอย่างดีย่ิง  จึงขอเรียนเชิญเป็นผู้เช่ียวชาญตรวจสอบเคร่ืองมือวิจัยในการจัดท าวิทยานิพนธ์ 
ดังกล่าวให้แก่  นางสาววาสนา  แสงศรี  เพื่อประโยชน์ทางการศึกษาต่อไป 

 
 จึงเรียนมาเพื่อโปรดพิจารณาให้ความอนุเคราะห์  จะเป็นพระคุณย่ิง 
 

ขอแสดงความนับถอื 
                                      
 
(  ดร.ทศพร  แสงสว่าง  ) 

                                       ผู้ช่วยคณบดีฝ่ายบัณฑิตศึกษา  
                   ปฏิบัติราชการแทน คณบดีคณะครุศาสตร์อุตสาหกรรม 
                   
 
 
      
 

คณะครุศาสตร์อุตสาหกรรม 
มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี  
ต.คลองหก  อ.ธัญบุรี จ.ปทุมธานี 12110 
 

ที่ ศธ 0578.02/0536.7 

งานบัณฑิตศึกษา 
โทรศัพท์  02 549 3210 
โทรสาร  02 577 5020 
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 31  กรกฎาคม   2555 

เรื่อง   ขอเรียนเชิญเป็นผู้เช่ียวชาญในการตรวจสอบเครื่องมือวิจัย 
เรียน   รองศาสตราจารย์  ดร.สาโรช  โศภีรักข์ 

  เนื่องด้วย  นางสาววาสนา  แสงศรี  นักศึกษาหลักสูตรศึกษาศาสตรมหาบัณฑิต   สาขาวิชา
เทคโนโลยีและสื่อสารการศึกษา คณะครุศาสตร์อุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี ก าลัง
จัดท าวิทยานิพนธ์  เร่ืองการพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความ
สามัคคี ส าหรับนักเรียนช้ันมัธยมศึกษาปีที่ 5 โดยมี รองศาสตราจารย์  ดร. เกียรติศักดิ์  พันธ์ล าเจียก  เป็น
อาจารย์ ที่ปรึกษาวิทยานิพนธ์    
   ในการนี้  คณะกรรมการบริหารหลักสูตรฯ  พิจารณาเห็นว่า  ท่านเป็นผู้เช่ียวชาญที่มีความรู้
ความสามารถอย่างดีย่ิง  จึงขอเรียนเชิญเป็นผู้เช่ียวชาญตรวจสอบเคร่ืองมือวิจัยในการจัดท าวิทยานิพนธ์ 
ดังกล่าวให้แก่  นางสาววาสนา  แสงศรี  เพื่อประโยชน์ทางการศึกษาต่อไป 

 
 จึงเรียนมาเพื่อโปรดพิจารณาให้ความอนุเคราะห์  จะเป็นพระคุณย่ิง 
 

ขอแสดงความนับถอื 
                                      
 
(  ดร.ทศพร  แสงสว่าง  ) 

                                       ผู้ช่วยคณบดีฝ่ายบัณฑิตศึกษา  
                   ปฏิบัติราชการแทน คณบดีคณะครุศาสตร์อุตสาหกรรม 
                            
 
 
 
 

คณะครุศาสตร์อุตสาหกรรม 
มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี  
ต.คลองหก  อ.ธัญบุรี จ.ปทุมธานี 12110 
 

ที่ ศธ 0578.02/0536.8 

งานบัณฑิตศึกษา 
โทรศัพท์  02 549 3210 
โทรสาร  02 577 5020 
 



118 
 

 

 

 

 
 
       

 31  กรกฎาคม   2555 

เรื่อง   ขอเรียนเชิญเป็นผู้เช่ียวชาญในการตรวจสอบเครื่องมือวิจัย 
เรียน   รองศาสตราจารย์  ดร.รุ่งแสง  อรุณไพโรจน์ 

  เนื่องด้วย  นางสาววาสนา  แสงศรี  นักศึกษาหลักสูตรศึกษาศาสตรมหาบัณฑิต   สาขาวิชา
เทคโนโลยีและสื่อสารการศึกษา คณะครุศาสตร์อุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี ก าลัง
จัดท าวิทยานิพนธ์  เร่ืองการพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความ
สามัคคี ส าหรับนักเรียนช้ันมัธยมศึกษาปีที่ 5 โดยมี รองศาสตราจารย์  ดร. เกียรติศักดิ์  พันธ์ล าเจียก  เป็น
อาจารย์ ที่ปรึกษาวิทยานิพนธ์    
   ในการนี้  คณะกรรมการบริหารหลักสูตรฯ  พิจารณาเห็นว่า  ท่านเป็นผู้เช่ียวชาญที่มีความรู้
ความสามารถอย่างดีย่ิง  จึงขอเรียนเชิญเป็นผู้เช่ียวชาญตรวจสอบเคร่ืองมือวิจัยในการจัดท าวิทยานิพนธ์ 
ดังกล่าวให้แก่  นางสาววาสนา  แสงศรี  เพื่อประโยชน์ทางการศึกษาต่อไป 

 
 จึงเรียนมาเพื่อโปรดพิจารณาให้ความอนุเคราะห์  จะเป็นพระคุณย่ิง 
 

ขอแสดงความนับถอื 
                                      
 
(  ดร.ทศพร  แสงสว่าง  ) 

                                       ผู้ช่วยคณบดีฝ่ายบัณฑิตศึกษา  
                   ปฏิบัติราชการแทน คณบดีคณะครุศาสตร์อุตสาหกรรม 
                          
 
 
 
 

คณะครุศาสตร์อุตสาหกรรม 
มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี  
ต.คลองหก  อ.ธัญบุรี จ.ปทุมธานี 12110 
 

ที่ ศธ 0578.02/0536.9 

งานบัณฑิตศึกษา 
โทรศัพท์  02 549 3210 
โทรสาร  02 577 5020 
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 31  กรกฎาคม   2555 

เรื่อง   ขอเรียนเชิญเป็นผู้เช่ียวชาญในการตรวจสอบเครื่องมือวิจัย 
เรียน   ผู้ช่วยศาสตราจารย์  ดร.มนัสนันท์  หัตถศักดิ์ 

  เนื่องด้วย  นางสาววาสนา  แสงศรี  นักศึกษาหลักสูตรศึกษาศาสตรมหาบัณฑิต   สาขาวิชา
เทคโนโลยีและสื่อสารการศึกษา คณะครุศาสตร์อุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี ก าลัง
จัดท าวิทยานิพนธ์  เร่ืองการพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความ
สามัคคี ส าหรับนักเรียนช้ันมัธยมศึกษาปีที่ 5 โดยมี รองศาสตราจารย์  ดร. เกียรติศักดิ์  พันธ์ล าเจียก  เป็น
อาจารย์ ที่ปรึกษาวิทยานิพนธ์    
   ในการนี้  คณะกรรมการบริหารหลักสูตรฯ  พิจารณาเห็นว่า  ท่านเป็นผู้เช่ียวชาญที่มีความรู้
ความสามารถอย่างดีย่ิง  จึงขอเรียนเชิญเป็นผู้เช่ียวชาญตรวจสอบเคร่ืองมือวิจัยในการจัดท าวิทยานิพนธ์ 
ดังกล่าวให้แก่  นางสาววาสนา  แสงศรี  เพื่อประโยชน์ทางการศึกษาต่อไป 

 
 จึงเรียนมาเพื่อโปรดพิจารณาให้ความอนุเคราะห์  จะเป็นพระคุณย่ิง 
 

ขอแสดงความนับถอื 
                                      
 
(  ดร.ทศพร  แสงสว่าง  ) 

                                       ผู้ช่วยคณบดีฝ่ายบัณฑิตศึกษา  
                   ปฏิบัติราชการแทน คณบดีคณะครุศาสตร์อุตสาหกรรม 
                            
 
 
 
 

คณะครุศาสตร์อุตสาหกรรม 
มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี  
ต.คลองหก  อ.ธัญบุรี จ.ปทุมธานี 12110 
 

ที่ ศธ 0578.02/0536.10 

งานบัณฑิตศึกษา 
โทรศัพท์  02 549 3210 
โทรสาร  02 577 5020 
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 31  กรกฎาคม   2555 

เรื่อง   ขอเรียนเชิญเป็นผู้เช่ียวชาญในการตรวจสอบเครื่องมือวิจัย 
เรียน   อาจารย์วิชุดา  จินดา 

  เนื่องด้วย  นางสาววาสนา  แสงศรี  นักศึกษาหลักสูตรศึกษาศาสตรมหาบัณฑิต   สาขาวิชา
เทคโนโลยีและสื่อสารการศึกษา คณะครุศาสตร์อุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี ก าลัง
จัดท าวิทยานิพนธ์  เร่ืองการพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความ
สามัคคี ส าหรับนักเรียนช้ันมัธยมศึกษาปีที่ 5 โดยมี รองศาสตราจารย์  ดร. เกียรติศักดิ์  พันธ์ล าเจียก  เป็น
อาจารย์ ที่ปรึกษาวิทยานิพนธ์    
   ในการนี้  คณะกรรมการบริหารหลักสูตรฯ  พิจารณาเห็นว่า  ท่านเป็นผู้เช่ียวชาญที่มีความรู้
ความสามารถอย่างดีย่ิง  จึงขอเรียนเชิญเป็นผู้เช่ียวชาญตรวจสอบเคร่ืองมือวิจัยในการจัดท าวิทยานิพนธ์ 
ดังกล่าวให้แก่  นางสาววาสนา  แสงศรี  เพื่อประโยชน์ทางการศึกษาต่อไป 

 
 จึงเรียนมาเพื่อโปรดพิจารณาให้ความอนุเคราะห์  จะเป็นพระคุณย่ิง 
 

ขอแสดงความนับถอื 
                                      
 
(  ดร.ทศพร  แสงสว่าง  ) 

                                       ผู้ช่วยคณบดีฝ่ายบัณฑิตศึกษา  
                   ปฏิบัติราชการแทน คณบดีคณะครุศาสตร์อุตสาหกรรม 
 

 

 

คณะครุศาสตร์อุตสาหกรรม 
มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี  
ต.คลองหก  อ.ธัญบุรี จ.ปทุมธานี 12110 
 

ที่ ศธ 0578.02/0536.5 

งานบัณฑิตศึกษา 
โทรศัพท์  02 549 3210 
โทรสาร  02 577 5020 
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 31  กรกฎาคม   2555 

เรื่อง   ขอความอนุเคราะห์ให้นักศึกษาปริญญาโทเข้าเก็บข้อมูล 
เรียน   ผู้อ านวยการโรงเรียนสวนกุหลาบวิทยาลัย รังสิต 

  เนื่องด้วย  นางสาววาสนา  แสงศรี  นักศึกษาหลักสูตรศึกษาศาสตรมหาบัณฑิต   สาขาวิชา
เทคโนโลยีและสื่อสารการศึกษา คณะครุศาสตร์อุตสาหกรรม มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี ก าลัง
จัดท าวิทยานิพนธ์  เร่ืองการพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความ
สามัคคี ส าหรับนักเรียนช้ันมัธยมศึกษาปีที่ 5 โดยมี รองศาสตราจารย์  ดร. เกียรติศักดิ์  พันธ์ล าเจียก  เป็น
อาจารย์ ที่ปรึกษาวิทยานิพนธ์    
   ในการนี้  คณะฯ จึงขอความอนุเคราะห์จากท่านให้ นางสาววาสนา  แสงศรี  เข้าท าการเก็บ
ข้อมูลจากบุคลากรในสถานศึกษาของท่าน เพื่อน าผลไปใช้ในการจัดท าวิทยานิพนธ์ต่อไป 

 
 จึงเรียนมาเพือ่โปรดพิจารณาให้ความอนุเคราะห์ด้วย  จะเป็นพระคุณย่ิง 
 

ขอแสดงความนับถอื 
                                      
 
(  ดร.ทศพร  แสงสว่าง  ) 

                                       ผู้ช่วยคณบดีฝ่ายบัณฑิตศึกษา  
                   ปฏิบัติราชการแทน คณบดีคณะครุศาสตร์อุตสาหกรรม 
 

 

คณะครุศาสตร์อุตสาหกรรม 
มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี  
ต.คลองหก  อ.ธัญบุรี จ.ปทุมธานี 12110 
 

ที่ ศธ 0578.02/0538 

งานบัณฑิตศึกษา 
โทรศัพท์  02 549 3210 
โทรสาร  02 577 5020 
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ภาคผนวก  ข 
เครื่องมือท่ีใช้ในการวิจัย 

-  โครงสร้างบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
-  แผนการเรียนการสอนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
-  แบบประเมินเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
-  แบบประเมินความพึงพอใจในการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
-  แบบประเมินความสามัคคีจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีมส าหรับ 

        นักเรียนประเมินตนเอง 
-  แบบประเมินความสามัคคีจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีมส าหรับ    
    ครูประเมินนักเรียน 
-  แบบประเมินผลงานนักเรียนจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
-  ใบงาน 
-  แบบทดสอบ 
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  โครงสร้างบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม เรือ่ง การน าเสนอสือ่ประสม (แบบ WBI)

รหัสวิชา ง 30243              ชั้นมัธยมศึกษาปีที่ 5          เวลา  10  ชั่วโมง 

                        
สัปดาห ์ เรื่อง จุดประสงค์การเรยีนรู ้ กิจกรรม/เครื่องมือ 

1 การใช้งานโปรแกรมเบื้องต้น 
  -  ส่วนประกอบของโปรแกรม 
Adobe Captivate 5.5 
  -  การเพิ่ม Slide 
  -  การลบ Slide 
  -  การแทรกข้อความ(Text Caption) 
  -  การใส่ Transition , Effect 
  -  การบันทึกช้ินงาน 
  -  การดูตัวอย่างช้ินงาน (Preview) 
  -  การส่งออกช้ินงาน (Publish)  
 

- นักเรียนรู้จักและบอกหน้าที่การ
ท างานของเครื่องมือตา่งๆได ้
- นักเรียนมีทักษะในการ เพิ่ม ลบ 
และแทรกข้อความในสไลด์ได ้
- นักเรียนสามารถบันทึก ดู
ตัวอย่างผลงานและส่งออกผลงาน
เป็นไฟล์ต่างๆ ได ้
- นักเรียนสามารถก าหนด 
Transition และ Effect ให้กับวัตถุ
และสไลดไ์ด ้

- แบบทดสอบก่อน
เรียน 
- กระดานสนทนา 
(แบ่งทีมการเรียน) 
- ห้องสนทนา 
- การบ้าน 
- แบบฝึกหัด 

2 การเพิ่มวัตถุต่างๆในสไลด์ 
- การแทรกข้อความเคลือ่นไหว 
(Text Animation) 
- การแทรกภาพเคลื่อนไหว 
(Animation) 
- การแทรกรูปภาพ (Image) 
- การท า Rollover 
 

- นักเรียนสามารถแทรกข้อความ
เคลื่อนไหว รูปภาพและ
ภาพเคลื่อนไหวได ้
- นักเรียนสามารถท า Rollover 
แบบต่างๆได้ 

- กระดานสนทนา 
- ห้องสนทนา 
- การบ้าน 
- แบบฝึกหัด 

3 การแทรกมัลติมีเดีย 
- การแทรกปุ่ม (Button) 
- การแทรกเสียง (Sound) 
- การแทรกวิดีโอ (Video) 
 

- นักเรียนแทรกปุ่มในสไลด์แบบ
ต่างๆและท าการเช่ือมโยงได้ 
- นักเรียนแทรกเสียงในสไลด์ได้ 
- นักเรียนแทรกวิดีโอในสไลด์ได้ 

- กระดานสนทนา 
- ห้องสนทนา 
- การบ้าน 
- แบบฝึกหัด 
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สัปดาห ์ เรื่อง จุดประสงค์การเรยีนรู ้ กิจกรรม/เครื่องมือ 
4 การสร้างปฏิสัมพันธ์กับสื่อ 

- การท า Text Entry 
- การท า Click Box 
 
 

- นักเรียนสามารถสร้างค าถามด้วย 
Text Entry ได้ 
- นักเรียนสามารถสร้างค าถามด้วย 
Click Boxได ้

- กระดานสนทนา 
- ห้องสนทนา 
- การบ้าน 
- แบบฝึกหัด 

5 การสร้างและน าเสนอช้ินงาน - นักเรียนรู้จักแบ่งหน้าที่และ
ท างานร่วมกันในทีมได ้
- นักเรียนแต่ละทีมช่วยกันท างาน
และสร้างช้ินงานร่วมกันได ้
- นักเรียนแต่ละทีมสามารถ
น าเสนอช้ินงานได ้
- นักเรียนแต่ละทีมมีความ
เอื้อเฟื้อเผ่ือแผ่ และมีความสามคัคี
ในทีม 
 

- กระดานสนทนา 
- ห้องสนทนา 
- น าเสนองาน 
- แบบประเมินผล
งาน 
- แบบทดสอบหลัง
เรียน 
- แบบประเมิน
ความพึงพอใจ 
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แผนการเรียนการสอนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพ่ือส่งเสริมความสามัคคี 

 
 
 
 

ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 5 
 
 
 
 

โดย นางสาววาสนา  แสงศรี 
ระดับปริญญาโท  สาขาวิชาเทคโนโลยีและสื่อสารการศึกษา 

คณะครุศาสตร์อุตสาหกรรม  มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี 
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แผนการเรียนการสอนด้วยบทเรยีนบนเว็บช่วยสอนแบบการเรียนรู้เปน็ทีม  เร่ือง  การสร้างสื่อประสม  ระดับช้ันมัธยมศึกษาปีที่ 5 
สาระการเรียนรู้  การงานอาชีพและเทคโนโลยี        10  คาบ     เวลา  10 ช่ัวโมง 
วิชา  การน าเสนอสื่อประสม          นางสาววาสนา  แสงศรี 
สาระการเรียนรู้ :  
สาระที่ 1 การด ารงชีวิตและครอบครัว 

มาตรฐาน ง  1.1       
เข้าใจการท างาน  มีความคิดสร้างสรรค์   มีทักษะกระบวนการท างาน  ทักษะ   การจัดการ ทักษะกระบวนการแก้ปัญหา  
ทักษะการท างานร่วมกัน  และทกัษะ  การแสวงหาความรู้    มีคุณธรรม และลักษณะนิสัยในการท างาน   มีจิตส านึก  ในการ
ใช้พลังงาน ทรัพยากร และสิ่งแวดล้อม  เพื่อการด ารงชีวิตและครอบครัว 

ตัวช้ีวัดช่วงช้ัน 
2. สร้างผลงานอย่างมีความคิดสร้างสรรค์   และมีทักษะการท างานร่วมกนั   

สาระที่  3   เทคโนโลยีสารสนเทศและการส่ือสาร 
มาตรฐาน ง 3.1    

เข้าใจ เห็นคุณค่า และใช้กระบวนการเทคโนโลยีสารสนเทศในการสืบค้นข้อมูล  การเรียนรู้   การสื่อสาร   การแก้ปัญหา การ
ท างาน  และอาชีพอย่างมีประสิทธิภาพ ประสิทธิผล  มีคุณธรรม 

ตัวช้ีวัดช่วงช้ัน 
12. ใช้คอมพิวเตอร์ช่วยสร้างช้ินงานหรือโครงงานอย่างมีจิตส านึกและความรับผิดชอบ 

 

 

 126 



127 
 

สปัดาห์
ท่ี 

เวลา 
(นาที) 

วัตถุประสงค์เชิง
พฤติกรรม 

กิจกรรมการเรียนรู ้ สื่อการเรียนรู ้
การวัดและประเมินผลการเรียนรู้ 

หมายเหตุ 
การวัด การประเมินผล 

1 5 เม่ือเรียนจบคาบนี้
แล้วนักเรียน
สามารถ 
 

1. ครูแนะน าบทเรียนในรูปแบบการเรียนการ
สอนแบบทีมบนเว็บ พร้อมท้ังอธิบายวิธีการ
การใช้เครื่องมือต่างๆ ในการเรียนการสอนบน
เว็บ 

- ตัวอย่างหน้าจอ
บนเว็บ 

- ความสนใจ 
- การซักถาม 

-  

 5 1. บอก 
วัตุประสงค์ 
ในการเรียน 

2. ครูบอกวัตถุประสงค์ในการเรียนการสอน
แบบทีมบนเว็บแก่นักเรียน และเม่ือนักเรียนเริ่ม
บทเรียนบนเว็บก็ให้ศึกษาวัตถุประสงค์ของ
บทเรียนบนเว็บอีกครั้ง 

- Web Page   ขั้นท่ี 2 ระบุ
วัตถุประสงค์และ
เป้าหมายของ
รายวิชา 

 5 2. ปฏิบัติกิจกรรม
ท่ีได้รับมอบหมาย
ได้อย่างถูกต้อง 

3. ครูชี้แจงกิจกรรมการเรียนและข้อตกลงใน
การเรียนเป็นทีมบนเว็บ ดังน้ี  
   - ผู้เรียนทุกคนต้องรับผิดชอบท่ีจะศึกษา
กิจกรรมต่างๆ ด้วยตนเองและร่วมมือช่วยเหลอื
กันกับเพ่ือนท่ีจะท ากิจกรรมให้ส าเร็จและเข้าใจ
กันดีกับทุกคนในทีม 
  - ผู้เรียนจะต้องติดต่อสื่อสารระหว่างกันในทีม
โดยใช้เครื่องมือบนเว็บเพ่ือแลกเปลี่ยน
ข้อคิดเห็นต่างๆในการเรียนและท างานเป็นทีม
ตามท่ีได้รับมอบหมาย 

- ห้องสนทนา 
- กระดานสนทนา 

   

 10 3. สมัครสมาชิก
ของเว็บไซต์ได้ 

4. ครูสาธิตวิธกีารสมัครสมาชิกบนเว็บและให้
นักเรียนสมัครสมาชิกไปพร้อมกับครู 
 

- Web Page - การสมัคร 
สมาชิก Webได ้

- นร. สมัคร
สมาชิกได ้
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สปัดาห์
ท่ี 

เวลา 
(นาที) 

วัตถุประสงค์เชิง
พฤติกรรม 

กิจกรรมการเรียนรู ้ สื่อการเรียนรู ้
การวัดและประเมินผลการเรียนรู้ หมายเหตุ 

การวัด การประเมินผล 
1 (ต่อ) 10 4. สร้างทีมบนเว็บ

การเรียนรู้ได ้
5. นักเรียนสร้างทีมส าหรับการเรียนรู้และการ
ท างานร่วมกันโดยให้แต่ละทีมมีสมาชิก 4-5 
คน จากนั้นให้นักเรียนพูดคุยแบ่งหน้าท่ีและ
คัดเลือกหัวหน้าทีม จากนั้นให้แต่ละกลุ่มตั้ง
กระทู้เพ่ือแสดงรายช่ือสมาชิกในทีม 

- ห้องสนทนา 
- กระดานสนทนา 

- การสร้างทีม
ได้ส าเร็จ 

- นร. สร้างทีม
ได้สร็จภายใน 
10 นาที 

ขั้นท่ี 1 ต้องมีการ
จัดตั้งทีมส าหรับ
การเรียนรู้   
 

 15 5. ท าแบบทดสอบ 
ก่อนการเรียนรู้ 
เรื่อง การสร้างสื่อ
ประสมได้ 

6. นักเรียนแต่ละคนท าแบบทดสอบก่อนเรียน
เพ่ือวัดความรู้พ้ืนฐาน จ านวน 30 ข้อ 

- แบบ 
ทดสอบก่อนเรียน 

- ท า
แบบทดสอบ
ก่อนเรียน 

- คะแนนในการ
ท าแบบทดสอบ
ก่อนเรียน 

 

 25 6. บอกหน้าท่ีการ
ท างานของ
เครื่องมือต่างๆ ได ้
7. มีทักษะในการ
เพ่ิม ลบ สไลด์ 
แทรกข้อความ 
พ้ืนหลังและเอฟ
เฟคได้ 
8. สามารถบันทึก 
และส่งผลงาน
ออก(Publish)ได ้
 

7. นักเรียนแต่ละคนศึกษาเนื้อหาและปฏิบัติ
กิจกรรมตามบทเรียนบนเว็บในสัปดาห์ท่ี 1 
จากใบความรู้และวิดีโอประกอบการเรียน 
ได้แก่  
   - ส่วนประกอบของโปรแกรม Adobe 
Captivate 5.5 
   - การใช้งาน Blank Project 
     การเพ่ิม ลบสไลด์ , การแทรกข้อความ , การ
ใส่พ้ืนหลังและ effect , การบันทึกช้ินงาน , การ
ดูตัวอย่างช้ินงานและการส่งออกช้ินงาน 

- ใบความรู้ท่ี 1 
- VDO 

- - ขั้นท่ี 3 จัดเนื้อหา
สาระของรายวิชา
เข้าเป็นหน่วยการ
เรียนรู ้
ขั้นท่ี 4 สร้างคู่มือ
ส าหรับผู้เรียนใน
แต่ละหน่วย 
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สปัดาห์
ท่ี 

เวลา 
(นาที) 

วัตถุประสงค์เชิง
พฤติกรรม 

กิจกรรมการเรียนรู ้ สื่อการเรียนรู ้
การวัดและประเมินผลการเรียนรู้ 

หมายเหตุ 
การวัด การประเมินผล 

1 (ต่อ) 20 9. สามารถท างาน
ร่วมกันเป็นทีมได้ 

8. นักเรียนท าใบงานท่ี 1 ร่วมกันสนทนา 
อภิปรายเกี่ยวกับเรื่องท่ีนักเรียนต้องท างาน
ร่วมกันเป็นทีม 

- ใบงานท่ี 1 - ท าใบงานท่ี 1 - คะแนนจาก
กระทู้ 

ขั้นท่ี 5 สร้าง
แบบฝึกหัด/
กิจกรรมท่ีส่งเสริม
การท างานเป็นทีม  

 5  9. นักเรียนท าแบบทดสอบ 10 ข้อ - แบบฝึกหัด - ท าแบบฝึกหัด  ขั้นท่ี 6 สร้าง
แบบทดสอบ 

2 3  1. นักเรียนอ่านจุดประสงค์การเรียนรู้ราย
สัปดาห์ท่ี 2 จากเว็บ 

- Web Page - - ขั้นท่ี 2 ระบุ
วัตถุประสงค์และ
ป้าหมายของ
รายวิชา 

 7  2. นักเรียนทบทวนความรู้โดยท าแบบทดสอบ
ความรู้ครั้งท่ี 1 

- แบบทดสอบ - ท าแบบทดสอบ - คะแนน 
 

 

 40 1. นักเรียนสามารถ
แทรกข้อความและ
ภาพเคลื่อนไหวได ้
2. นักเรียนสามารถ
ท า Rollover 
Caption ได ้
 

3. นักเรียนศึกษาเนื้อหาในสัปดาห์ท่ี 2 จากใบ
ความรู้และ VDO แล้วปฏิบัติตาม ดังน้ี 
   - การแทรก Text Animation , Animation 
และ Image 
   - การแทรก Rollover Caption , Image และ 
Slidelet 
   - ขั้นตอนการอัพโหลดงานขึ้น YouTube 
 

- ใบความรู้ท่ี 2  
- VDO สาธิตการ
ใช้งาน 
- เว็บไซต์อื่นๆ 

- - ขั้นท่ี 3 จัดเนื้อหา
สาระของรายวิชา
เข้าเป็นหน่วยการ
เรียนรู ้
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สปัดาห์
ท่ี 

เวลา 
(นาที) 

วัตถุประสงค์เชิง
พฤติกรรม 

กิจกรรมการเรียนรู ้ สื่อการเรียนรู ้
การวัดและประเมินผลการเรียนรู้ 

หมายเหตุ 
การวัด การประเมินผล 

2 (ต่อ)  3. นักเรียน
สามารถท า Image 
Caption ได ้
4. นักเรียนสามารถ
ท า Rollover 
Slidelet ได ้

    ขั้นท่ี 4 สร้างคู่มือ
ส าหรับผู้เรียนใน
แต่ละหน่วย 

 45 5. นักเรียน
สามารถแบ่ง
หน้าท่ีและท างาน
ร่วมกันเป็นทีมได้ 

4. นักเรียนท าใบงานท่ี 2  - ใบงานท่ี 2 
- Chat Room 
- Webboard 

- ท าใบงานท่ี 2 - คะแนน 
- แบบประเมิน
การท างานเป็น
ทีม 

ขั้นท่ี 5 สร้าง
แบบฝึกหัด/
กิจกรรมท่ีส่งเสริม
การท างานเป็นทีม 

 5  5. นักเรียนท าแบบทดสอบ 10 ข้อ เพ่ือทดสอบ
ความเข้าใจในบทเรียน 

- แบบฝึกหัด - ท าแบบฝึกหัด - คะแนน ขั้นท่ี 6 สร้าง
แบบทดสอบ 

3 3  1. นักเรียนอ่านจุดประสงค์การเรียนรู้ราย
สัปดาห์ท่ี 3 จากเว็บ 

- Web Page - - ขั้นท่ี 2 ระบุ
วัตถุประสงค์และ
เป้าหมายของ
รายวิชา 

 7  2. นักเรียนทบทวนความรู้โดยท าแบบทดสอบ
ความรู้ครั้งท่ี 2 

- แบบทดสอบ - ท า
แบบทดสอบ 

- คะแนน  
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สปัดาห์
ท่ี 

เวลา 
(นาที) 

วัตถุประสงค์เชิง
พฤติกรรม 

กิจกรรมการเรียนรู ้ สื่อการเรียนรู ้
การวัดและประเมินผลการเรียนรู้ 

หมายเหตุ 
การวัด การประเมินผล 

3 (ต่อ) 40 1. นักเรียน
สามารถแทรก 
Button และสร้าง
การเช่ือมโยงได้ 
2. นักเรียนสามารถ
การแทรก Sound 
และ Video ได ้
3. นักเรียน
สามารถเผยแพร่
ผลงานได้ 

3. นักเรียนศึกษาเนื้อหาในสัปดาห์ท่ี 3 จากใบ
ความรู้และ VDO แล้วปฏิบัติตาม ดังน้ี 
   - การแทรก Button เพ่ือสร้างการเช่ือมโยง 
   - การแทรกเสียง 
   - การแทรก Video 
    

- ใบความรู้ท่ี 3 
- VDO สาธิตการ
ใช้งาน 
- เว็บไซต์อื่นๆ 

- - ขั้นท่ี 3 จัดเนื้อหา
สาระของรายวิชา
เข้าเป็นหน่วยการ
เรียนรู ้
ขั้นท่ี 4 สร้างคู่มือ
ส าหรับผู้เรียนใน
แต่ละหน่วย 

 45 5. นักเรียน
สามารถแบ่ง
หน้าท่ีและท างาน
ร่วมกันเป็นทีมได้ 

4. นักเรียนท าใบงานท่ี 3  - ใบงานท่ี 3 
- Chat Room 
- Webboard 

- ท าใบงานท่ี 3 - คะแนน 
- แบบประเมิน
การท างานเป็น
ทีม 

ขั้นท่ี 5 สร้าง
แบบฝึกหัด/กิจกรรม
ท่ีส่งเสริมการท างาน
เป็น 
ทีม 

 5  5. นักเรียนท าแบบทดสอบ 10 ข้อ เพ่ือทดสอบ
ความเข้าใจในบทเรียน 
 

- แบบฝึกหัด - ท าแบบฝึกหัด - คะแนน ขั้นท่ี 6 สร้าง
แบบทดสอบ 
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สปัดาห์
ท่ี 

เวลา 
(นาที) 

วัตถุประสงค์เชิง
พฤติกรรม 

กิจกรรมการเรียนรู ้ สื่อการเรียนรู ้
การวัดและประเมินผลการเรียนรู้ 

หมายเหตุ 
การวัด การประเมินผล 

4 3  1. นักเรียนอ่านจุดประสงค์การเรียนรู้ราย
สัปดาห์ท่ี 4จากเว็บ 

- Web Page - - ขั้นท่ี 2 ระบุ
วัตถุประสงค์และ
เป้าหมายของ
รายวิชา 

 7  2. นักเรียนทบทวนความรู้โดยท าแบบทดสอบ
ความรู้ครั้งท่ี 3 

- แบบทดสอบ - ท า
แบบทดสอบ 

- คะแนน  
 

 

 40 1. นักเรียน
สามารถท า Text 
Entry ได ้
2. นักเรียน
สามารถท า ท า 
Click Box ได ้
 

3. นักเรียนศึกษาเนื้อหาในสัปดาห์ท่ี 4 จากใบ
ความรู้และ VDO แล้วปฏิบัติตาม ดังน้ี 
   - การท า Text Entry 
   - การท า Click Box 
 

- ใบความรู้ท่ี 4  
- VDO สาธิตการ
ใช้งาน 
- เว็บไซต์อื่นๆ 

- - ขั้นท่ี 3 จัดเนื้อหา
สาระของรายวิชา
เข้าเป็นหน่วยการ
เรียนรู ้
ขั้นท่ี 4 สร้างคู่มือ
ส าหรับผู้เรียนใน
แต่ละหน่วย 

 45 3. นักเรียน
สามารถแบ่ง
หน้าท่ีและท างาน
ร่วมกันเป็นทีมได้ 

4. นักเรียนท าใบงานท่ี 4 - ใบงานท่ี 4 
- Chat Room 
- Webboard 

- ท าใบงานท่ี 4 - คะแนน 
- แบบประเมิน
การท างานเป็น
ทีม 

ขั้นท่ี 5 สร้าง
แบบฝึกหัด/กิจกรรม
ท่ีส่งเสริมการท างาน
เป็นทีม 
 

 5  5. นักเรียนท าแบบฝึกหัด 10 ข้อ เพ่ือทดสอบ
ความเข้าใจในบทเรียน 
 

- แบบฝึกหัด - ท าแบบฝึกหัด - คะแนน ขั้นท่ี 6 สร้าง
แบบทดสอบ 
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สปัดาห์
ท่ี 

เวลา 
(นาที) 

วัตถุประสงค์เชิง
พฤติกรรม 

กิจกรรมการเรียนรู ้ สื่อการเรียนรู ้
การวัดและประเมินผลการเรียนรู้ 

หมายเหตุ 
การวัด การประเมินผล 

5 5  1. นักเรียนอ่านจุดประสงค์การเรียนรู้ราย
สัปดาห์ท่ี 5จากเว็บ 

- Web Page - - ขั้นท่ี 2 ระบุ
วัตถุประสงค์และ
เป้าหมายของ
รายวิชา 

 30 - นักเรียนรู้จักแบ่ง
หน้าท่ีและท างาน
ร่วมกันในทีมได้ 
- นักเรียนแต่ละ
ทีมช่วยกันท างาน
และสร้างช้ินงาน
ร่วมกันได้ 

2. นักเรียนร่วมกันท าใบงานท่ี 5 
 

- ใบงานท่ี 5 
- Chat Room 
- Webboard 

- ท าใบงานท่ี 5 - คะแนน 
- แบบประเมิน
การท างานเป็น
ทีม 

ขั้นท่ี 5 สร้าง
แบบฝึกหัด/
กิจกรรมท่ี
ส่งเสริมการ
ท างานเป็นทีม 

 25 - นักเรียนแต่ละ
ทีมสามารถ
น าเสนอช้ินงาน
ผ่านเว็บได้ 

3. นักเรียนน าเสนอผลงานและเพ่ือนแต่ละทีม
ประเมินผลงานซึ่งกันและกัน 
 

- Chat Room 
- Webboard 

- ท าแบบ
ประเมินช้ินงาน 
 

- แบบประเมิน
ช้ินงาน 
 

ขั้นท่ี 7 สร้างแบบ
ประเมิน 

 20 - นักเรียนท าแบบ 
ทดสอบหลังเรียน 

4. นักเรียนท าแบบทดสอบหลังเรียน 30 ข้อ  - แบบทดสอบ - ท าแบบฝึกหัด - คะแนนจาก
แบบทดสอบ 

ขั้นท่ี 6 สร้าง
แบบทดสอบ 

 10 - นักเรียนท าแบบ
ประเมินความ
สามัคคี 
 

5. นักเรียนท าแบบประเมินความสามัคคี - แบบประเมิน - ท าแบบ
ประเมิน 

- คะแนนจาก
แบบประเมิน 
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สปัดาห์
ท่ี 

เวลา 
(นาที) 

วัตถุประสงค์เชิง
พฤติกรรม 

กิจกรรมการเรียนรู ้ สื่อการเรียนรู ้
การวัดและประเมินผลการเรียนรู้ 

หมายเหตุ 
การวัด การประเมินผล 

5 (ต่อ) 10 - นักเรียนท าแบบ
ประเมินความพึง
พอใจในการใช้
บทเรียนบนเว็บ
ช่วยสอน 

6. นักเรียนท าแบบประเมินความพึงพอใจใน
การใช้บทเรียนบนเว็บช่วยสอน 

- แบบประเมิน - ท าแบบประเมิน - คะแนนจาก
แบบประเมิน 
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แบบประเมินค่าดัชนีความสอดคล้องเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 

ส าหรับผู้เช่ียวชาญในการตรวจเครื่องมือวิจัย 

วัตถุประสงค์   

แบบประเมินค่าดัชนีความสอดคล้องเว็บช่วยสอนแบบการเรียนรู้เป็นทีมฉบับนี้จัดท าเพื่อใช้ใน

การส ารวจความคิดเห็นเกี่ยวกับข้อค าถามของแบบประเมินเว็บช่วยสอนแบบการเรียนรู้เป็นทีม จัดท าขึ้น

โดย นักศึกษาปริญญาโท คณะครุศาสตร์อุตสาหกรรม สาขาเทคโนโลยีและสื่อสารการศึกษา  เพื่อใช้

ประกอบการศึกษาและพัฒนาสื่อการเรียนรู้ในการพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม

เพื่อส่งเสริมความสามัคคีส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 5 

ข้อคิดเห็นและข้อเสนอแนะของท่าน มีความส าคัญอย่างย่ิงต่อการประเมินสื่อการเรียนรู้ในคร้ังนี้ 

จึงใคร่ขอความร่วมมือตอบแบบประเมินฉบับนี้ ให้ครบทุกข้อเพื่อน ามาปรับปรุงรูปแบบของแบบ

ประเมินเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความสามัคคีต่อไป 

 
ค าชี้แจง  โปรดพิจารณาว่าแบบประเมินเว็บช่วยสอนแบบการเรียนรู้เป็นทีม ในด้านการออกแบบเว็บและ
เนื้อหามีความสอดคล้อง ตามทีก่ าหนดให้หรือไม่  แล้วเขียนผลการพิจารณาของท่าน โดยท าเครื่องหมาย / 
ลงในช่อง “คะแนนการพิจารณา” ตามความคิดเห็นของท่านดังนี ้
  + 1   ถ้าแน่ใจว่ามีความสอดคลอ้ง 
       0   ถ้าไม่แน่ใจว่ามีความสอดคลอ้ง 
   -  1   ถ้าแน่ใจว่าไม่มีความสอดคลอ้ง 
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รายการประเมิน 
คะแนนการพิจารณา 

+1 0 -1 ข้อเสนอแนะ 
1.  เนื้อหา     

1.1  ความสอดคล้องของเนื้อหากับจุดประสงค์     
1.2  เนื้อหาชัดเจนครบถ้วนสมบูรณ์     
1.3  ความเหมาะสมกับระดับผู้เรียน     
1.4  การจัดล าดับหัวข้อ     
1.5  ความเหมาะสมของปริมาณเนือ้หา     
1.6  ความถูกต้องของเนื้อหา     
1.7  ความชัดเจนในการอธิบายเนื้อหา     
1.8  ความยากง่ายของเนื้อหา     
1.9  ความต่อเนื่องของเนื้อหา     
1.10 ความถูกต้องของภาษาที่ใช้     
1.11 ความเหมาะสมของการสรุปเนื้อหา     

2.  การจัดวางรูปแบบเว็บเพจ     
    2.1  การน าเสนอมีความน่าสนใจ     
    2.2  น าเสนอบทเรียนได้อย่างชัดเจนและเข้าใจง่าย     
    2.3  ผู้เรียนมีปฏิสัมพันธ์กับบทเรียน     
    2.4  สีที่ใช้มีความเหมาะสม สวยงาม     
3.  ภาษา/ตัวอักษร     

3.1  ขนาดตัวอักษรมีความเหมาะสม      
3.2   ลักษณะสีของตัวอักษรมีความเหมาะสม     
3.3   ลักษณะของตัวอักษรมีความเหมาะสม     
3.4   การวางต าแหน่งของตัวอักษร     
3.5   ความถูกต้องของภาษาที่น ามาใช้     
3.6   ความชัดเจนของตัวอักษร     
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รายการประเมิน 
คะแนนการพิจารณา 

+1 0 -1 ข้อเสนอแนะ 
4.  รูปภาพประกอบ     

4.1  รูปภาพสอดคล้องกับเนื้อหา     
4.2  ความคมชัดของรูปภาพประกอบและพื้นหลัง     
4.3  การวางต าแหน่งของรูปภาพ     
4.4  ความถูกต้องของภาพที่น ามาใช้     

5.  การเชื่อมโยง     
5.1 การเช่ือมโยงเนื้อหาแต่ละบท     
5.2 การเช่ือโยงภายในเว็บเพจ     

    5.3 การเช่ือมโยงกับเว็บไซต์อื่นๆ     
 

ข้อเสนอแนะเพื่อการพัฒนาและปรับปรุง 

……………………………………………………………………………………………………………

……………………………………………………………………………………………………… 

  

 

 
 
 
 
 
 
 

ลงช่ือ.....................................................ผู้ประเมิน 
        (.....................................................) 
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แบบประเมินเว็บช่วยสอนแบบการเรียนรู้เป็นทมี 

วัตถุประสงค์   

แบบประเมินฉบับนี้จัดท าเพ่ือใช้ในการส ารวจความคิดเห็นเกี่ยวกับรูปแบบของส่ือการเรียนรู้
และเนื้อหาของเว็บช่วยสอนแบบการเรียนรู้เป็นทีม จัดท าขึ้นโดย นักศึกษาปริญญาโท สาขาเทคโนโลยี
และสื่อสารการศึกษา คณะครุศาสตร์อุตสาหกรรม เพื่อใช้ประกอบการพัฒนาเว็บช่วยสอนแบบการเรียนรู้
เป็นทีม 

ข้อคิดเห็นและข้อเสนอแนะของท่าน มีความส าคญัอย่างย่ิงต่อการประเมินสื่อการเรียนรู้ในคร้ัง
นี้ จึงใคร่ขอความร่วมมือตอบแบบประเมินฉบับนี้ ให้ครบทุกข้อเพื่อน ามาปรับปรุงรูปแบบเว็บช่วยสอน
แบบการเรียนรู้เป็นทีม ต่อไป 
 
ค าชี้แจง  โปรดแสดงความคิดเห็นของท่านเกี่ยวกับรูปแบบเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 

และท าเครื่องหมาย √ ลงในช่อง   ที่ตรงกับความคิดเห็นของท่านมากที่สุด โดยมีเกณฑ์การให้
คะแนนดังนี ้
  ระดับคะแนน 4  หมายถึง  มีความเหมาะสมมากที่สุด       
  ระดับคะแนน 3  หมายถึง  มีความเหมาะสมมาก        
  ระดับคะแนน 2  หมายถึง  มีความเหมาะสมน้อย        
  ระดับคะแนน 1  หมายถึง  มีความเหมาะสมน้อยที่สุด 
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รายการประเมิน 
ระดับคะแนน 

4 3 2 1 

1.  เนื้อหา     
1.1  ความสอดคล้องของเนื้อหากับจุดประสงค์     
1.2  เนื้อหาชัดเจนครบถ้วนสมบูรณ์     
1.3  ความเหมาะสมกับระดับผู้เรียน     
1.4  การจัดล าดับหัวข้อ     
1.5  ความเหมาะสมของปริมาณเนือ้หา     
1.6  ความถูกต้องของเนื้อหา     
1.7  ความชัดเจนในการอธิบายเนื้อหา     
1.8  ความยากง่ายของเนื้อหา     
1.9  ความต่อเนื่องของเนื้อหา     
1.10 ความถูกต้องของภาษาที่ใช้     
1.11 ความเหมาะสมของการสรุปเนื้อหา     

2.  การจัดวางรูปแบบเว็บเพจ     
    2.1  การน าเสนอมีความน่าสนใจ     

2.2  น าเสนอบทเรียนได้อย่างชัดเจนและเข้าใจง่าย     
2.3  ผู้เรียนมีปฏิสัมพันธ์กับบทเรียน     
2.4 สีที่ใช้มีความเหมาะสม สวยงาม     

3.  ภาษา/ตัวอักษร     
3.1  ขนาดตัวอักษรมีความเหมาะสม      
3.2   ลักษณะสีของตัวอักษรมีความเหมาะสม     
3.3   ลักษณะของตัวอักษรมีความเหมาะสม     
3.4   การวางต าแหน่งของตัวอักษร     
3.5   ความถูกต้องของภาษาที่น ามาใช้     
3.6   ความชัดเจนของตัวอักษร     
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รายการประเมิน 
ระดับคะแนน 

4 3 2 1 

4.  รูปภาพประกอบ     

4.1  รูปภาพสอดคล้องกับเนื้อหา     
4.2  ความคมชัดของรูปภาพประกอบและพื้นหลงั     
4.3  การวางต าแหน่งของรูปภาพ     

4.4  ความถูกต้องของภาพที่น ามาใช้     

5.  การเชื่อมโยง     
5.1 การเช่ือมโยงเนื้อหาแต่ละบท     
5.2 การเช่ือโยงภายในเว็บเพจ     

5.3 การเช่ือมโยงกับเว็บไซต์อื่นๆ     
 

ข้อเสนอแนะเพื่อการพัฒนาและปรับปรุง 

.......................................................................................................................................................................

....................................................................................................................................................................... 

  

     ลงช่ือ…………………….………………..ผู้ประเมิน 

            (………………………………………..) 
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แบบประเมินค่าดัชนีความสอดคล้องความพึงพอใจในการเรียนด้วยเว็บช่วยสอน 
แบบการเรียนรู้เป็นทมี ส าหรับผู้เช่ียวชาญตรวจเครื่องมือวิจัย 

 
วัตถุประสงค์   

แบบประเมินความพึงใจฉบับนี้จัดท าเพื่อใช้ในการส ารวจความคิดเห็นเกี่ยวกับข้อค าถามของ
แบบประเมินความพึงใจจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม  จัดท าขึ้นโดย นักศึกษา
ปริญญาโท คณะครุศาสตร์อุตสาหกรรม สาขาเทคโนโลยีและสื่อสารการศึกษา  เพื่อใช้ประกอบการศึกษา
และพัฒนาสื่อการเรียนรู้ในการพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความ
สามัคคีส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 5 

ข้อคิดเห็นและข้อเสนอแนะของท่าน มีความส าคัญอย่างย่ิงต่อการประเมินเคร่ืองมือวิจัยในการ
เรียนรู้ในคร้ังนี้ จึงใคร่ขอความร่วมมือตอบแบบประเมินฉบับนี้ ให้ครบทุกข้อเพื่อน ามาปรับปรุงรูปแบบ
ของแบบประเมินความพึงพอใจต่อการใช้บทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อส่งเสริม
ความสามัคคีต่อไป 
 
ค าชี้แจง  โปรดพิจารณาว่าแบบประเมินความพึงใจจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
นี้มีความสอดคล้อง ในด้านต่าง ๆ ตามทีก่ าหนดให้หรือไม่  แล้วเขียนผลการพิจารณาของท่าน โดยท า
เครื่องหมาย / ลงในช่อง “คะแนนการพิจารณา” ตามความคิดเห็นของท่านดังนี ้
  + 1   ถ้าแน่ใจว่ามีความสอดคลอ้ง 
       0   ถ้าไม่แน่ใจว่ามีความสอดคลอ้ง 
   -  1   ถ้าแน่ใจว่าไม่มีความสอดคลอ้ง 
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รายการประเมิน 
คะแนนการพิจารณา 

+1 0 -1 ข้อเสนอแนะ 
1.  ด้านเนื้อหา  
 1.1  ตรงตามวัตถุประสงค์ของบทเรียน 

    

 1.2  การใช้ภาษา ง่ายต่อการท าความเข้าใจ     

 1.3  การจัดล าดับเนื้อหาแต่ละเร่ืองมีความเหมาะสม     

 1.4  เนื้อหามีความยากง่ายเหมาะสมกับผู้เรียน     

 1.5  เนื้อหาที่น าเสนอให้เป็นความรู้ที่มีประโยชน์     

 1.6  เนื้อหาตรงกับสิ่งที่สนใจ     

2.  ด้านการออกแบบ 
     2.1  หน้าจอสวยงาม ดึงดูด น่าสนใจ 

    

 2.2  สีของตัวอักษร อ่านง่าย สบายตา ชัดเจน     
 2.3  รูปแบบของตัวอักษรอ่านง่าย     
 2.4  ขนาดของตัวอักษรมีความชัดเจน     
 2.5  ภาพที่ใช้ประกอบเหมาะสมชัดเจน     
 2.6  มีการเช่ือมโยงเนื้อหาภายในเว็บเพจและกับเว็บไซต์
อื่น 

    

3. รูปแบบการน าเสนอ 
 3.1  การน าเสนอมีความน่าสนใจ 

    

 3.2  น าเสนอบทเรียนได้อย่างชัดเจนและเข้าใจง่าย     
 3.3  การออกแบบเว็บไซต์ดึงดูดความสนใจ     
 3.4  เปิดโอกาสให้มีส่วนร่วมและท ากิจกรรมในบทเรียน     
  3.5  สามารถเลือกเรียนได้ตามความตอ้งการ     

 3.6  ทราบผลทางการเรียนได้ในทันที     
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รายการประเมิน 
คะแนนการพิจารณา 

+1 0 -1 ข้อเสนอแนะ 
4.  การเรียนรู้ร่วมกันเป็นทีม     

 4.1  ผู้เรียนเข้ามาเรียนรู้บทเรียนได้ทุกที่ทุกเวลา     

 4.2  ผู้เรียนที่อยู่ต่างพื้นที่กันสามารถเรียนรู้ร่วมกันได ้     

 4.3  ท างานตามที่ได้รับมอบหมายในทีม     

 4.4  ผู้เรียนแต่ละทีมสามารถติดต่อสื่อสารกับเพือ่นในทีม
ในบทเรียนได้ 

    

 4.5  ผู้เรียนสามารถติดต่อสื่อสารกับเพื่อนต่างในทีมใน
บทเรียนได้ 

    

 4.6  ผู้เรียนสามารถแสดงความคิดเห็นเกี่ยวกับช้ินงานที่ท า
ในทีมและเพื่อนต่างทีมในบทเรียนได้ 

    

  
ข้อเสนอแนะเพื่อการพัฒนาและปรับปรุง 
.......................................................................................................................................................................
.......................................................................................................................................................................
....................................................................................................................................................................... 
 
                 ลงช่ือ…………………….………………..ผู้ประเมิน 
                        (………………………………………..) 
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แบบประเมินความพึงพอใจในการเรยีนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
 
ค าชี้แจง  โปรดแสดงความคิดเห็นของท่านเกี่ยวกับความพึงพอใจในการใช้บทเรียนบนเว็บช่วยสอนแบบ

การเรียนรู้เป็นทีมและท าเครื่องหมาย √ ลงในช่อง   ที่ตรงกับความคิดเห็นของท่านมากที่สุด โดยมี
เกณฑ์การให้คะแนนดังนี้ 
  ระดับคะแนน 4  หมายถึง  มีความพึงพอใจมากทีสุ่ด       
  ระดับคะแนน 3  หมายถึง  มีความพึงพอใจมาก        
  ระดับคะแนน 2  หมายถึง  มีความพึงพอใจน้อย        
  ระดับคะแนน 1  หมายถึง  มีความพึงพอใจน้อยที่สุด 
 

รายการประเมิน 
ระดับความพึงพอใจ 

4 3 2 1 
1.  ด้านเนื้อหา  
 1.1  ตรงตามวัตถุประสงค์ของบทเรียน 

    

 1.2  การใช้ภาษา ง่ายต่อการท าความเข้าใจ     

 1.3  การจัดล าดับเนื้อหาแต่ละเร่ืองมีความเหมาะสม     

 1.4  เนื้อหามีความยากง่ายเหมาะสมกับผู้เรียน     

 1.5  เนื้อหาที่น าเสนอให้เป็นความรู้ที่มีประโยชน์     

 1.6  เนื้อหาตรงกับสิ่งที่สนใจ     

2.  ด้านการออกแบบ 
    2.1  หน้าจอสวยงาม ดึงดูด น่าสนใจ 

    

 2.2  สีของตัวอักษร อ่านง่าย สบายตา ชัดเจน     
 2.3  รูปแบบของตัวอักษรอ่านง่าย     
 2.4  ขนาดของตัวอักษรมีความชัดเจน     
 2.5  ภาพที่ใช้ประกอบเหมาะสมชัดเจน     

 



145 
 

รายการประเมิน 
ระดับความพึงพอใจ 

4 3 2 1 
 2.6  มีการเช่ือมโยงเนื้อหาภายในเว็บเพจและกับเว็บไซต์
อื่น 

    

3. รูปแบบการน าเสนอ 
 3.1  การน าเสนอมีความน่าสนใจ 

    

 3.2  น าเสนอบทเรียนได้อย่างชัดเจนและเข้าใจง่าย     
 3.3  การออกแบบเว็บไซต์ดึงดูดความสนใจ     
 3.4  เปิดโอกาสให้มีส่วนร่วมและท ากิจกรรมในบทเรียน     
  3.5  สามารถเลือกเรียนได้ตามความตอ้งการ     

 3.6  ทราบผลทางการเรียนได้ในทันที     

4.  การเรียนรู้ร่วมกันเป็นทีม     

 4.1  ผู้เรียนเข้ามาเรียนรู้บทเรียนได้ทุกที่ทุกเวลา     

 4.2  ผู้เรียนที่อยู่ต่างพื้นที่กันสามารถเรียนรู้ร่วมกันได ้     

 4.3  ท างานตามที่ได้รับมอบหมายในทีม     

 4.4  ผู้เรียนแต่ละทีมสามารถติดต่อสื่อสารกับเพือ่นในทีม
ในบทเรียนได้ 

    

 4.5  ผู้เรียนสามารถติดต่อสื่อสารกับเพื่อนต่างในทีมใน
บทเรียนได้ 

    

 4.6  ผู้เรียนสามารถแสดงความคิดเห็นเกี่ยวกับช้ินงานที่ท า
ในทีมและเพื่อนต่างทีมในบทเรียนได้ 

    

  
ข้อเสนอแนะเพื่อการพัฒนาและปรับปรุง 
.......................................................................................................................................................................
........................................................................................................................................................... 
 

ลงช่ือ.....................................................ผู้ประเมิน 
        (.....................................................) 



146 
 

แบบประเมินดัชนีความสอดคลอ้งของแบบประเมินความสามัคคี 
จากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เปน็ทีมส าหรับนกัเรียนประเมินตนเอง 

ส าหรับผู้เช่ียวชาญในการตรวจเครื่องมือในการวจัิย 
 
วัตถุประสงค์   

แบบประเมินฉบับนี้จัดท าเพ่ือใช้ในการส ารวจความคิดเห็นเกี่ยวกับข้อค าถามของแบบประเมิน
ความสามัคคีจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม จัดท าขึ้นโดย นักศึกษาปริญญาโท 
คณะครุศาสตร์อุตสาหกรรม สาขาเทคโนโลยีและสื่อสารการศึกษา  เพื่อใช้ประกอบการศึกษาและพัฒนา
สื่อการเรียนรู้ในการพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความสามัคคี
ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 5 

ข้อคิดเห็นและข้อเสนอแนะของท่าน มีความส าคัญอย่างย่ิงต่อการประเมินสื่อการเรียนรู้ในคร้ัง
นี้ จึงใคร่ขอความร่วมมือตอบแบบประเมินฉบับนี้  ให้ครบทุกข้อเพื่อน ามาปรับปรุงรูปแบบของแบบ
ประเมินความสามัคคีของส่ือการเรียนรู้ต่อไป 
 
ค าชี้แจง  โปรดพิจารณาว่าแบบประเมินความสามัคคีจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
นี้มีความสอดคล้อง ในด้านต่าง ๆ ตามที่ก าหนดให้หรือไม่  แล้วเขียนผลการพิจารณาของท่าน โดยท า
เครื่องหมาย / ลงในช่อง “คะแนนการพิจารณา” ตามความคิดเห็นของท่านดังนี้ 
  + 1   ถ้าแน่ใจว่ามีความสอดคล้อง 
       0   ถ้าไม่แน่ใจว่ามีความสอดคล้อง 
   -  1   ถ้าแน่ใจว่าไม่มีความสอดคล้อง 
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รายการขอ้ค าถามแบบประเมินความสามัคคี 
คะแนนการพิจารณา 

+1 0 -1 ข้อเสนอแนะ 

1.  เข้าใจบทบาทหน้าที่ในทีม     

1.1 นักเรียนเข้าใจบทบาทของตนเองในฐานะผู้น าและผู้ตามที่ด ี     

 1.2 นักเรียนปฏิบัติตามข้อตกลงของการเป็นสมาชิกในทีม     
 1.3 นักเรียนมีการประชุม ปรึกษาหารือกันในกิจกรรมที่ได้รับ
มอบหมาย 

    

 1.4 นักเรียนมีอัธยาศัยที่ดีในการติดต่อสื่อสารกับเพื่อน     
 1.5 นักเรียนมีการปรึกษาหารือกันเพื่อแก้ไขขอ้ผิดพลาดภายหลัง
การท างาน 

    

2.  การยอมรับฟังความคิดเห็น     
 2.1 นักเรียนยอมรับฟังความคิดเห็นที่แตกต่างของเพื่อนในทีม     
 2.2 นักเรียนมีเหตุผลเพียงพอในการตัดสินใจ     

 2.3 นักเรียนยอมรับเสียงส่วนใหญ่ (ผลสรุป) ของทีม     
 2.4 นักเรียนยอมรับผลงานของสมาชิกในทีม     
 2.5 นักเรียนพร้อมที่จะปรับตัวเพื่อให้สามารถอยู่ร่วมในทีมได้     

 2.6 นักเรียนให้อภัยเพื่อนที่ท างานผิดพลาด     

3.  การท างานร่วมกัน     
 3.1. นักเรียนช่วยเหลือเพื่อนในทีมให้ท างานส าเร็จด้วย 
ความเต็มใจ 

    

 3.2 นักเรียนมีความรักใคร่กลมเกลียวและช่วยเหลือสมาชิกในทีม
เสมอ 

    

 3.3 นักเรียนเข้าร่วมท ากิจกรรมต่างๆ กับเพื่อนในทีมเป็นประจ า     

 3.4 นักเรียนมีการพัฒนาทักษะของตัวเองเพื่อเพิ่มความสามารถ
ของทีม 

    

 3.5 นักเรียนตรงต่อเวลาในการท างานร่วมกันเป็นทีม     
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รายการขอ้ค าถามแบบประเมินความสามัคคี 
คะแนนการพิจารณา 

+1 0 -1 ข้อเสนอแนะ 
     3.6 นักเรียนท างานที่ได้รับมอบหมายอย่างเต็มความสามารถ     

4.  ผลการท างานเป็นทีม     
 4.1 งานเสร็จทันในเวลาที่ก าหนด     
 4.2 นักเรียนมีความสัมพันธ์ที่ดีกับสมาชิกในทีม     
 4.3 เกิดการพัฒนาทักษะในการท างานป็นทมี     
 4.4 เกิดการเรียนรู้ในงานที่ท าร่วมกัน     
 4.5 สามารถแก้ปัญหาได้เมือ่เกิดความขัดแย้งภายในทีม     
 4.6 เกิดความสามัคคีภายในทีม     
 

ข้อเสนอแนะเพื่อการพัฒนาและปรับปรุงแบบประเมิน…………………………..…………………… 
……………………………………………………………………………………………………………
……………………………………………………………………………………………………… 
………………………………………………………………………………………………………… 
 

ลงช่ือ…………………….………………..ผู้ประเมิน 

        (………………………………………..) 
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แบบประเมินความสามัคคีจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม  

ส าหรับนักเรยีนประเมินตนเอง 

ค าชี้แจง  โปรดแสดงความคิดเห็นของท่านจากการใช้บทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมและ

ท าเครื่องหมาย √ ลงในช่อง   ที่ตรงกับความคิดเห็นของท่านมากที่สุด โดยมีเกณฑ์การให้คะแนน
ดังนี้ 
  ระดับคะแนน 4  หมายถึง  มีความพึงพอใจมากทีสุ่ด       
  ระดับคะแนน 3  หมายถึง  มีความพึงพอใจมาก        
  ระดับคะแนน 2  หมายถึง  มีความพึงพอใจน้อย        
  ระดับคะแนน 1  หมายถึง  มีความพึงพอใจน้อยที่สุด 
 

รายการประเมิน 
ระดับคะแนน 

4 3 2 1 

1.  เข้าใจบทบาทหน้าที่ในทีม     

 1.1 นักเรียนเข้าใจบทบาทของตนเองในฐานะผู้น าและผู้ตามที่ดี     

 1.2 นักเรียนปฏิบัติตามข้อตกลงของการเป็นสมาชิกในทีม     
 1.3 นักเรียนมีการประชุม ปรึกษาหารือกันในกิจกรรมที่ได้รับ
มอบหมาย 

    

 1.4 นักเรียนมีอัธยาศัยที่ดีในการติดต่อสื่อสารกับเพื่อน     
 1.5 นักเรียนมีการปรึกษาหารือกันเพื่อแก้ไขขอ้ผิดพลาดภายหลัง
การท างาน 

    

2.  การยอมรับฟังความคิดเห็น     
 2.1 นักเรียนยอมรับฟังความคิดเห็นที่แตกต่างของเพื่อนในทีม     
 2.2 นักเรียนมีเหตุผลเพียงพอในการตัดสินใจ     

 2.3 นักเรียนยอมรับเสียงส่วนใหญ่ (ผลสรุป) ของทีม     
 2.4 นักเรียนยอมรับผลงานของสมาชิกในทีม     
 2.5 นักเรียนพร้อมที่จะปรับตัวเพื่อให้สามารถอยู่ร่วมในทีมได้     
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รายการประเมิน 
ระดับคะแนน 

4 3 2 1 

3.  การท างานร่วมกัน     

 3.1. นักเรียนช่วยเหลือเพื่อนในทีมให้ท างานส าเร็จด้วยความ 
เต็มใจ 

    

 3.2 นักเรียนมีความรักใคร่กลมเกลียวและช่วยเหลือสมาชิกในทีม
เสมอ 

    

 3.3 นักเรียนเข้าร่วมท ากิจกรรมต่างๆ กับเพื่อนในทีมเป็นประจ า     
 3.4 นักเรียนมีการพัฒนาทักษะของตัวเองเพื่อเพิ่มความสามารถ
ของทีม 

    

 3.5 นักเรียนตรงต่อเวลาในการท างานร่วมกันเป็นทีม     
 3.6 นักเรียนท างานที่ได้รับมอบหมายอย่างเต็มความสามารถ     
4.  ผลการท างานเป็นทีม     
 4.1 งานเสร็จทันในเวลาที่ก าหนด     
 4.2 นักเรียนมีความสัมพันธ์ที่ดีกับสมาชิกในทีม     
 4.3 เกิดการพัฒนาทักษะในการท างานป็นทมี     
 4.4 เกิดการเรียนรู้ในงานที่ท าร่วมกัน     
 4.5 สามารถแก้ปัญหาได้เมือ่เกิดความขัดแย้งภายในทีม     
 4.6 เกิดความสามัคคีภายในทีม     
 

ข้อเสนอแนะ………………………………………….…………………………..…………………… 
…………………………………………………………………………………………………………. 
 

     ลงช่ือ…………………….………………..ผู้ประเมิน 

            (………………………………………..) 
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แบบประเมินดัชนีความสอดคลอ้งของแบบประเมินความสามัคคี 

จากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เปน็ทีมส าหรับครูประเมินนักเรียน 

ส าหรับผู้เช่ียวชาญในการตรวจเครื่องมือวิจัย 

วัตถุประสงค์  

แบบประเมินฉบับนี้จัดท าเพ่ือใช้ในการส ารวจความคิดเห็นเกี่ยวกับข้อค าถามของแบบประเมิน

ความสามัคคีจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม จัดท าขึ้นโดย นักศึกษาปริญญาโท 

คณะครุศาสตร์อุตสาหกรรม สาขาเทคโนโลยีและสื่อสารการศึกษา  เพื่อใช้ประกอบการศึกษาและพัฒนา

สื่อการเรียนรู้ในการพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความสามัคคี

ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 5 

ข้อคิดเห็นและข้อเสนอแนะของท่าน มีความส าคัญอย่างย่ิงต่อการประเมินสื่อการเรียนรู้ในคร้ัง

นี้ จึงใคร่ขอความร่วมมือตอบแบบประเมินฉบับนี้ ให้ครบทุกข้อเพื่อน ามาปรับปรุงรูปแบบของแบบ

ประเมินความสามัคคีของส่ือการเรียนรู้ต่อไป 

ค าชี้แจง  โปรดพิจารณาว่าแบบประเมินความสามัคคีจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
นี้มีความสอดคล้อง ในด้านต่าง ๆ ตามทีก่ าหนดให้หรือไม่  แล้วเขียนผลการพิจารณาของท่าน โดยท า
เครื่องหมาย / ลงในช่อง “คะแนนการพิจารณา” ตามความคิดเห็นของท่านดังนี ้
  + 1   ถ้าแน่ใจว่ามีความสอดคลอ้ง 
       0   ถ้าไม่แน่ใจว่ามีความสอดคลอ้ง 
   -  1   ถ้าแน่ใจว่าไม่มีความสอดคลอ้ง 
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รายการประเมิน 
คะแนนการพิจารณา 

+1 0 -1 ข้อเสนอแนะ 
1. สมาชิกในทีมมีการจัดสรรหน้าที่ความรับผิดชอบอย่างเหมาะสม     
2. สมาชิกในทีมมีความตรงต่อเวลา     
3. สมาชิกในทีมเข้าใจบทบาทของตนเองในการเป็นผู้น าหรือผู้
ตามที่ด ี

    

4. สมาชิกในทีมมีความกระตือรือร้นและมุ่งมัน่ท ากิจกรรมที่ได้รับ
มอบหมาย 

    

5. สมาชิกในทีมมีการปรึกษาหารือเพื่อวางแผนในการท างาน     
6. งานที่ได้รับมอบหมายส่งทันในเวลาที่ก าหนด     
7. สมาชิกในทีมเข้าร่วมท ากิจกรรมต่างๆ กับเพื่อนในทีมเป็น
ประจ า 

    

8. สมาชิกทุกคนร่วมกันรับผิดชอบในผลงานของทีม     
9. สมาชิกในทีมรู้จักและมีความสัมพันธ์ที่ดีต่อกนั     
10. สมาชิกในทีมมีการรับฟังความคิดเห็นของผู้อื่นและเคารพใน
สิทธิของผู้อื่น 

    

11. สมาชิกในทีมยอมรับในความคล้ายคลึงและความแตกต่างของ
ตนเองและผู้อื่น  

    

12. สมาชิกในทีมมีการแสดงความคิดเห็นซึ่งกันและกัน      
13. สมาชิกในทีมร่วมกันปรับปรุงผลงาน     

 

ข้อเสนอแนะเพื่อการพัฒนาและปรับปรุงแบบประเมิน…………………………………………………. 

…………………………………………………………………………………………………………… 

     ลงช่ือ…………………….………………..ผู้ประเมิน 

            (………………………………………..) 
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แบบประเมินความสามัคคีจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
ส าหรับครูประเมินนกัเรียน 

ช่ือกลุ่มที่รับการประเมิน......................................................................................................................... 

ค าชี้แจง  โปรดแสดงท าเครื่องหมาย √ ลงในช่อง   ที่ตรงกับความคิดเห็นของท่านมากที่สุด โดย 
เกณฑ์การให้คะแนนดังนี้ 
  ระดับคะแนน 4  หมายถึง  มีความพึงพอใจมากทีสุ่ด  
  ระดับคะแนน 3  หมายถึง  มีความพึงพอใจมาก      
  ระดับคะแนน 2  หมายถึง  มีความพึงพอใจน้อย    
  ระดับคะแนน 1  หมายถึง  มีความพึงพอใจน้อยที่สุด 
 

รายการประเมิน 
ระดับคะแนน 

4 3 2 1 
1. สมาชิกในทีมมีการจัดสรรหน้าที่ความรับผิดชอบอย่างเหมาะสม     
2. สมาชิกในทีมมีความตรงต่อเวลา     
3. สมาชิกในทีมเข้าใจบทบาทของตนเองในการเป็นผู้น าหรือผู้ตามที่ดี     
4. สมาชิกในทีมมีความกระตือรือร้นและมุ่งมัน่ท ากิจกรรมที่ได้รับมอบหมาย     
5. สมาชิกในทีมมีการปรึกษาหารือเพื่อวางแผนในการท างาน     
6. งานที่ได้รับมอบหมายส่งทันในเวลาที่ก าหนด     
7. สมาชิกในทีมเข้าร่วมท ากิจกรรมต่างๆ กับเพื่อนในทีมเป็นประจ า     
8. สมาชิกทุกคนร่วมกันรับผิดชอบในผลงานของทีม     
9. สมาชิกในทีมรู้จักและมีความสัมพันธ์ที่ดีต่อกนั     
10. สมาชิกในทีมมีการรับฟังความคิดเห็นของผู้อื่นและเคารพในสิทธิของผู้อื่น     
11. สมาชิกในทีมร่วมกันปรับปรุงผลงาน     

 

ข้อเสนอแนะเพื่อการพัฒนาและปรับปรุงแบบประเมิน……………………………………………….… 
…………………………………………………………………………………………………………… 

         

 

ลงช่ือ…………………….………………..ผู้ประเมิน 

       (………………………………………)           

          

(………………………………………..) 
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แบบประเมินดัชนีความสอดคลอ้งเกณฑ์การให้คะแนนผลงานนักเรยีน 

จากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เปน็ทีม 

ส าหรับผู้เช่ียวชาญในการตรวจเครื่องมือวิจัย  

วัตถุประสงค์    

แบบประเมินฉบับนี้จัดท าเพ่ือใช้ในการส ารวจความคิดเห็นเกี่ยวกับเกณฑ์การให้คะแนนผลงาน

นักเรียนจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม ส าหรับนักเรียนช้ันมัธยมศึกษาปีที่ 5  จัดท า

ขึ้นโดย นักศึกษาปริญญาโท คณะครุศาสตร์อุตสาหกรรม สาขาเทคโนโลยีและสื่อสารการศึกษา  เพื่อใช้

ประกอบการศึกษาและพัฒนาสื่อการเรียนรู้ในการพัฒนาบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม

เพื่อส่งเสริมความสามัคคีส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 5  

ข้อคิดเห็นและข้อเสนอแนะของท่าน มีความส าคัญอย่างย่ิงต่อการประเมินสื่อการเรียนรู้ในคร้ังนี้ 

จึงใคร่ขอความร่วมมือตอบแบบประเมินฉบับนี้ ให้ครบทุกข้อเพื่อน ามาปรับปรุงรูปแบบของเกณฑ์การ

ประเมินผลงานนักเรียนต่อไป 

ค าชี้แจง  โปรดพิจารณาข้อค าถามในแบบประเมินผลงานนักเรียนจากการเรียนด้วยเว็บช่วยสอนแบบการ

เรียนรู้เป็นทีม นี้มีความเหมาะสม ในด้านต่าง ๆ ตามที่ก าหนดให้หรือไม่  แล้วเขียนผลการพิจารณาของ

ท่าน โดยท าเครื่องหมาย / ลงในช่อง “คะแนนการพิจารณา” ตามความคิดเห็นของท่านดังนี้ 

  + 1   ถ้าแน่ใจว่ามีความเหมาะสม 
       0   ถ้าไม่แน่ใจว่ามีความเหมาะสม 
   -  1   ถ้าแน่ใจว่าไม่มีความเหมาะสม 
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รายการประเมิน 
คะแนนการพิจารณา 

+1 0 -1 ข้อเสนอแนะ 
1. ความสมบูรณ์ของช้ินงาน 
    มีการก าหนดวัตถุประสงค์ชัดเจน มีรายละเอียดเนื้อหาครบถ้วน 
มีการจัดองค์ประกอบและออกแบบได้สวยงาม 

    

2. ความเหมาะสมของเนื้อหาที่น าเสนอ 
    เนื้อหาสาระสัมพันธ์กับช่ือเร่ืองที่ก าหนด เป็นประโยชน์และ
ทันสมัยมีข้อมลูสนับสนุนและแหล่งอ้างอิงชัดเจน 

    

3. การจัดวางข้อความ รูปภาพและใส่เอ็ฟเฟ็คอย่างเหมาะสม 
    มีการใช้ขนาดตัวอักษรที่อ่านง่าย ชัดเจน จัดวางข้อความ รูปภาพ 
ภาพเคลื่อนไหวมาใช้ประกอบกนัและใส่เอ็ฟเฟ็คอย่างเหมาะสม 

    

4. มีการเช่ือมโยงอย่างเหมาะสม 
   มีการใส่ปุ่มเพ่ือควบคุมการท างานในสไลด์ และสามารถ
เช่ือมโยงข้อมูลกันไดอ้ย่างเหมาะสม 

    

5. การแทรกเทคนิคพิเศษอย่างเหมาะสม 
   มีการแทรกเสียงและวิดีโออย่างเหมาะสมรวมทั้งมีการใช้ Text 
Entry และ Click Box เพื่อเพิ่มปฏิสัมพันธ์ระหว่างผู้ใช้กับสื่อได้
อย่างเหมาะสม 

    

 
ข้อเสนอแนะเพื่อการพัฒนาและปรับปรุงแบบประเมิน……………………………………………… 

……………………………………………………………………………………………………………

……………………………………………………………………………………………………… 

 

     ลงช่ือ…………………….………………..ผู้ประเมิน 

            (………………………………………..) 
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เกณฑ์การให้คะแนนการจัดท าสื่อประสม คะแนนเต็ม 20 คะแนน มีรายละเอียดดังนี ้

รายการ 
ระดับคะแนน 

1 2 3 4 

1. ความ
สมบูรณ์ของ
ช้ินงาน 

มีการก าหนด
วัตถุประสงค์ไม่
ชัดเจน มี
รายละเอียดเนื้อหา
ไม่ครบถ้วน จัด
องค์ประกอบไม่
เหมาะสมและไม่
สวยงาม 

มีการก าหนด
วัตถุประสงค์ชัดเจน 
มีรายละเอียดเนือ้หา
ไม่ครบถ้วน จัด
องค์ประกอบไม่
เหมาะสม และ
ออกแบบสวยงาม 

มีการก าหนด
วัตถุประสงค์ชัดเจน 
มีรายละเอียดเนือ้หา
ครบถว้น จัด
องค์ประกอบไม่
เหมาะสม การ
ออกแบบสวยงาม 

มีการก าหนด
วัตถุประสงค์ชัดเจน 
มีรายละเอียดเนือ้หา
ครบถว้น มกีารจัด
องค์ประกอบและ
ออกแบบได้สวยงาม
มาก 

2. ความ
เหมาะสมของ
เนื้อหาที่
น าเสนอ 
 

เนื้อหาทีเ่ขียน
สอดคล้องกับเนือ้
เรื่องแต่ไม่มกีาร
ล าดับเรื่องให้
ชัดเจนไม่มีการ
สอดแทรกสาระ
ต่างๆไม่ทนัสมัยไม่
มีแหล่งอ้างอิง 

เนื้อหาทีเ่ขียน
สอดคล้องกับเนือ้
เรื่องและล าดับเรื่อง
ได้ชัดเจน แต่ไมม่ี
การสอดแทรกสาระ
ต่างๆไม่ทนัสมัยไม่
มีแหล่งอ้างอิง 

เนื้อหาทีเ่ขียน
สอดคล้องกับเนือ้
เรื่องและล าดับเรื่อง
ได้ชัดเจน แต่ไมม่ี
การสอดแทรกสาระ
ต่างๆมีความ
ทันสมยัและแหล่ง
อ้างอิงน่าเช่ือถอื 

เนื้อหาทีเ่ขียน
สอดคล้องกับเนือ้
เรื่องและล าดับเรื่อง
ได้ชัดเจน 
สอดแทรกสาระ
บางอย่าง มีความ
ทันสมยัและแหล่ง
อ้างอิงน่าเช่ือถอื 

3. การจัดวาง
ข้อความ 
รูปภาพและใส่
เอ็ฟเฟ็คอย่าง
เหมาะสม 
 

ตัวอักษรอ่านง่าย
รูปแบบไม่
เหมาะสม จัดวาง
ข้อความและ 
รูปภาพ ประกอบ
ไม่เข้ากนั และใส่
เอ็ฟเฟ็คนอ้ยหรอื
มากจนเกนิไป 
 

ตัวอักษรอ่านง่าย
รูปแบบเหมาะสม  
จัดวางข้อความและ 
รูปภาพ ประกอบ
ไม่เข้ากนั และใส่
เอ็ฟเฟ็คนอ้ยหรอื
มากจนเกนิไป 

ตัวอักษรอ่านง่าย
รูปแบบเหมาะสม  
จัดวางข้อความและ 
รูปภาพ ประกอบ
เข้ากัน และใส่เอ็ฟ
เฟ็คได้พอเหมาะ 

มีการใช้ขนาด
ตัวอักษรที่อ่านง่าย 
ชัดเจน จัดวาง
ข้อความ รปูภาพ 
ภาพเคลื่อนไหวมา
ใช้ประกอบกันและ
ใส่เอ็ฟเฟ็คอย่าง
เหมาะสม 
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รายการ 
ระดับคะแนน 

1 2 3 4 
4. มีการ
เช่ือมโยงอย่าง
เหมาะสม 
 

มีการใส่ปุ่มเพ่ือ
ควบคุมการท างาน
เฉพาะหน้าหลัก
เท่านั้น 

มีการใส่ปุ่มเพ่ือ
ควบคุมการท างาน
ที่หน้าหลักและส
ไสด์อื่น การ
เช่ือมโยงกันยังไม่
สมบูรณ์  ปุ่มขาด
ความสวยงาม 

มีการใส่ปุ่มเพ่ือ
ควบคุมการท างาน
ที่หน้าหลักและส
ไสด์อื่น การ
เช่ือมโยงกันยัง
สมบูรณ์  ปุ่มกด
ออกแบบได้
สวยงาม 

มีการใส่ปุ่มเพ่ือ
ควบคุมการท างาน
ในสสไลด์ และ
สามารถเช่ือมโยง
ข้อมูลกันไดอ้ย่าง
เหมาะสม ปุ่มกด
ออกแบบได้
สวยงามดึงดูดใจ 

5. การแทรก
เทคนิคพิเศษ
อย่างเหมาะสม 
 

มีการแทรกเสียง
บางสไลด์แต่ไม่
เหมาะสม ขาด
วิดีโอประกอบ 
มีการใช้ Text 
Entry หรือ Click 
Box อย่างใดอย่าง
หนึ่งแต่ยังไม่
เหมาะสมกับ
เนื้อหา 

มีการแทรกเสียง
บางและวิดีโอ
ประกอบ
เหมาะสมในบาง
สไลด ์
ใช้ Text Entry 
และ Click Box แต่
ยังไม่เหมาะสมกับ
เนื้อหา 

มีการแทรกเสียง
และวิดีโอ
ประกอบ
เหมาะสม ใช้ Text 
Entry  และ Click 
Box อย่างใดอย่าง
หนึ่งเหมาะสมกับ
เนื้อหา 
(อีกอย่างมีแต่ไม่
เหมาะสม) 

มีการแทรกเสียง
และวิดีโออย่าง
เหมาะสมรวมทั้งมี
การใช้ Text Entry 
และ Click Box 
เพื่อเพิ่ม
ปฏิสัมพันธ์
ระหว่างผู้ใช้กับสื่อ
ได้อย่างเหมาะสม
เข้าใจง่าย 

เกณฑ์การตัดสินระดับคุณภาพ 

 คะแนน   ระดับคุณภาพ 

   0 - 7   ปรับปรุง 

   8 - 12   พอใช้ 

  13 - 17   ดี 

  18 - 20   ดีมาก 
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แบบประเมินผลงานนักเรยีนจากการเรียนด้วยเวบ็ช่วยสอนแบบการเรียนรู้เป็นทีม 

เรื่อง การน าเสนอสื่อประสมเบ้ืองต้น 

ค าชี้แจง  โปรดใส่ระดับคะแนนลงในช่อง   ที่ตรงกับความคิดเห็นของท่านมากที่สุด โดยมีเกณฑ์ 

การให้คะแนน  4 ระดับ รายละเอียดดังตารางด้านล่าง 
 

กลุ่มที ่

ระดับคะแนน 

รวม
คะแนน 

ระดับ
คุณภาพ 

คว
าม
สม

บูร
ณ์ข

อง
ชิ้น

งา
น 

 คว
าม
เห
มา
ะส

มข
อง

เน
ื้อห

าท
ี่น า
เส
นอ

 
 กา
รจั
ดว
าง
ข้อ

คว
าม
 

รูป
ภา
พแ

ละ
ใส
่เอ็ฟ

เฟ
็คอ

ย่า
งเห

มา
ะส

ม 

กา
รเชื่

อม
โย
งอ
ย่า
ง

เห
มา
ะส

ม 

กา
รแ
ทร

กเท
คน

ิค
พิเ
ศษ

อย่
าง
เห
มา
ะส

ม 

กลุ่มที่ 1        
กลุ่มที ่2        
กลุ่มที ่3        
กลุ่มที ่4        
กลุ่มที ่5        
กลุ่มที ่6        
กลุ่มที ่7        
กลุ่มที ่8        
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เกณฑ์การให้คะแนนการจัดท าสื่อประสม คะแนนเต็ม 20 คะแนน มีรายละเอียดดังนี ้

รายการ 
ระดับคะแนน 

1 2 3 4 

1. ความ
สมบูรณ์ของ
ช้ินงาน 

มีการก าหนด
วัตถุประสงค์ไม่
ชัดเจน มี
รายละเอียดเนื้อหา
ไม่ครบถ้วน จัด
องค์ประกอบไม่
เหมาะสมและไม่
สวยงาม 

มีการก าหนด
วัตถุประสงค์
ชัดเจน มี
รายละเอียดเนื้อหา
ไม่ครบถ้วน จัด
องค์ประกอบไม่
เหมาะสม และ
ออกแบบสวยงาม 

มีการก าหนด
วัตถุประสงค์
ชัดเจน มี
รายละเอียดเนื้อหา
ครบถ้วน จัด
องค์ประกอบไม่
เหมาะสม การ
ออกแบบสวยงาม 

มีการก าหนด
วัตถุประสงค์
ชัดเจน มี
รายละเอียดเนื้อหา
ครบถ้วน มีการจัด
องค์ประกอบและ
ออกแบบได้
สวยงามมาก 

2. ความ
เหมาะสมของ
เนื้อหาที่
น าเสนอ 
 

เนื้อหาที่เขียน
สอดคล้องกับเนือ้
เร่ืองแต่ไม่มีการ
ล าดับเร่ืองให้
ชัดเจนไม่มีการ
สอดแทรกสาระ
ต่างๆไม่ทันสมัย
ไม่มีแหล่งอา้งอิง 

เนื้อหาที่เขียน
สอดคล้องกับเนือ้
เร่ืองและล าดับ
เร่ืองได้ชัดเจน แต่
ไม่มกีารสอดแทรก
สาระต่างๆไม่
ทันสมัยไม่มีแหล่ง
อ้างอิง 

เนื้อหาที่เขียน
สอดคล้องกับเนือ้
เร่ืองและล าดับ
เร่ืองได้ชัดเจน แต่
ไม่มกีารสอดแทรก
สาระต่างๆมีความ
ทันสมัยและแหล่ง
อ้างอิงน่าเช่ือถอื 

เนื้อหาที่เขียน
สอดคล้องกับเนือ้
เร่ืองและล าดับเร่ือง
ได้ชัดเจน 
สอดแทรกสาระ
บางอย่าง มีความ
ทันสมัยและแหล่ง
อ้างอิงน่าเช่ือถอื 

3. การจัดวาง
ข้อความ 
รูปภาพและใส่
เอ็ฟเฟ็คอย่าง
เหมาะสม 
 

ตัวอักษรอ่านง่าย
รูปแบบไม่
เหมาะสม จัดวาง
ข้อความและ 
รูปภาพ ประกอบไม่
เข้ากัน และใส่เอ็ฟ
เฟ็คนอ้ยหรอืมาก
จนเกินไป 

ตัวอักษรอ่านง่าย
รูปแบบเหมาะสม  
จัดวางข้อความและ 
รูปภาพ ประกอบไม่
เข้ากัน และใส่เอ็ฟ
เฟ็คนอ้ยหรอืมาก
จนเกินไป 

ตัวอักษรอ่านง่าย
รูปแบบเหมาะสม  
จัดวางข้อความและ 
รูปภาพ ประกอบเข้า
กัน และใส่เอ็ฟเฟค็
ได้พอเหมาะ 

มีการใช้ขนาด
ตัวอักษรที่อ่านง่าย 
ชัดเจน จัดวาง
ข้อความ รปูภาพ 
ภาพเคลื่อนไหวมา
ใช้ประกอบกันและ
ใส่เอ็ฟเฟ็คอย่าง
เหมาะสม 
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รายการ 
ระดับคะแนน 

1 2 3 4 
4. มีการ
เช่ือมโยงอย่าง
เหมาะสม 
 

มีการใส่ปุ่มเพ่ือ
ควบคุมการท างาน
เฉพาะหน้าหลัก
เท่านั้น 

มีการใส่ปุ่มเพ่ือ
ควบคุมการท างาน
ที่หน้าหลักและส
ไสด์อื่น การ
เช่ือมโยงกันยังไม่
สมบูรณ์  ปุ่มขาด
ความสวยงาม 

มีการใส่ปุ่มเพ่ือ
ควบคุมการท างาน
ที่หน้าหลักและ 
สไสด์อื่น การ
เช่ือมโยงกันยังไม่
สมบูรณ์  ปุ่มกด
ออกแบบได้
สวยงาม 

มีการใส่ปุ่มเพ่ือ
ควบคุมการท างาน
ในสไลด์ และ
สามารถเช่ือมโยง
ข้อมูลกันไดอ้ย่าง
เหมาะสม ปุ่มกด
ออกแบบได้
สวยงามดึงดูดใจ 

5. การแทรก
เทคนิคพิเศษ
อย่างเหมาะสม 
 

มีการแทรกเสียง
บางสไลด์แต่ไม่
เหมาะสม ขาด
วิดีโอประกอบ 
มีการใช้ Text Entry 
หรือ Click Box 
อย่างใดอย่างหนึ่งแต่
ยังไม่เหมาะสมกับ
เนื้อหา 

มีการแทรกเสียง
บางและวิดีโอ
ประกอบเหมาะสม
ในบางสไลด์ 
ใช้ Text Entry และ 
Click Box แต่ยัง
ไม่เหมาะสมกับ
เนื้อหา 

มีการแทรกเสียง
และวิดีโอประกอบ
เหมาะสม ใช้ Text 
Entry  และ Click 
Box อย่างใดอย่าง
หนึ่งเหมาะสมกับ
เนื้อหา 
(อีกอย่างมีแต่ไม่
เหมาะสม) 

มีการแทรกเสียง
และวิดีโออย่าง
เหมาะสมรวมทั้งมี
การใช้ Text Entry 
และ Click Box 
เพื่อเพิ่มปฏิสัมพันธ์
ระหว่างผู้ใช้กับสื่อ
ได้อย่างเหมาะสม
เข้าใจง่าย 

เกณฑ์การตัดสินระดับคุณภาพ 

 คะแนน   ระดับคุณภาพ 

   0 - 7   ปรับปรุง 

   8 - 12   พอใช้ 

  13 - 17   ดี 

  18 - 20   ดีมาก 
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ใบงานที่ 1 
เรื่อง การใช้งานโปรแกรมเบ้ืองต้น  

รหัสวิชา ง30243   รายวิชา การน าเสนอสือ่ประสม    ช้ัน มัธยมศึกษาปีที่ 5  
------------------------------------------------------------------------------------------------------------- 

ค าชี้แจง 
 1. ให้นักเรียนสมาชิกในทีมร่วมกันระดมสมองเพื่อก าหนดเร่ืองที่ต้องการน าเสนอ พร้อมกับหา
ข้อมูลเพื่อเตรียมพร้อมส าหรับการท าใบงานในสัปดาห์ต่อไป โดยให้นักเรียนก าหนดเร่ืองช่ือเร่ืองและแบ่ง
เนื้อออกเป็นส่วนๆและบอกแหล่งที่มาของขอ้มลูด้วย 
 2. น าข้อมูลทั้งหมดโพสบนกระดานสนทนาในสัปดาห์ที่ 1 
 3. สมาชิกในทีมร่วมออกแบบรูปแบบพ้ืนหลังของช้ินงานแล้วโพสผลงานผ่านกระดานสนทนาใน
สัปดาห์ที่ 1 
   
 

ใบงานที่ 2 
เรื่อง การเพิ่มวัตถุต่างๆ  ในสไลด์  

รหัสวิชา ง30243   รายวิชา การน าเสนอสือ่ประสม    ช้ัน มัธยมศึกษาปีที่ 5  
------------------------------------------------------------------------------------------------------------- 

ค าชี้แจง 
 1. ให้แต่ละทีมแบ่งงานกันท าโดยน าเนื้อหาจากสปัดาห์ที่แล้วมาใส่ลงในสไลด์  
 2. ในสไลด์จะต้องประกอบไปด้วย ข้อความ ขอ้ความเคลื่อนไหว รูปภาพ ภาพเคลื่อนไหวและ
และการใช้ค าสั่ง Rollover แบบใดก็ได้ แล้วตกแต่งและจัดวางตามความเหมาะสม  
 3. เมื่อนักเรียนท าเสร็จแล้วให้อัพโหลดขึ้นยูทูปแล้วน าลิงค์มาโพสไว้ที่กระดานสนทนาของทีม
ตนเอง ในสัปดาห์ที่ 2 
 4. ให้สมาชิกในทีมร่วมกันติชมผลงานของทีมตนเองเพื่อพัฒนาและปรับปรุงต่อไป 
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ใบงานที่ 3 
เรื่อง การแทรกมลัติมีเดีย  

รหัสวิชา ง30243   รายวิชา การน าเสนอสือ่ประสม    ช้ัน มัธยมศึกษาปีที่ 5  
------------------------------------------------------------------------------------------------------------- 

ค าชี้แจง 
 1. ให้แต่ละทีมน าผลงานจากสัปดาห์ที่ผ่านมาน ามาท าต่อ  
 2. ในสไลด์จะต้องประกอบไปด้วยเสียงประกอบ  วิดีโอ และมีการเช่ือมโยงภายในสไลด์ โดย
ตกแต่งและจัดวางตามความเหมาะสม  
 3. เมื่อนักเรียนท าเสร็จแล้วให้อัพโหลดขึ้นยูทูปแล้วน าลิงค์มาโพสไว้ที่กระดานสนทนาของทีม
ตนเอง ในสัปดาห์ที่ 3 
 4. ให้สมาชิกในทีมร่วมกันติชมผลงานของทีมตนเองเพื่อพัฒนาและปรับปรุงต่อไป 
 
 
 

ใบงานที่ 4 
เรื่อง การสร้างปฏสิัมพันธ์กับสื่อ  

รหัสวิชา ง30243   รายวิชา การน าเสนอสือ่ประสม    ช้ัน มัธยมศึกษาปีที่ 5  
------------------------------------------------------------------------------------------------------------- 

ค าชี้แจง 
1. ให้แต่ละทีมน าผลงานจากสัปดาห์ที่ผ่านมาน ามาพัฒนาตอ่  
2. ท าการออกแบบการน า Text Entry และ Click Box มาใช้งานโดยให้เหมาะสมกับเนื้อหาที่

น าเสนอ 
 3. เมื่อนักเรียนท าเสร็จแล้วให้อัพโหลดขึ้นยูทูปแล้วน าลิงค์มาโพสไว้ที่กระดานสนทนาของทีม
ตนเอง ในสัปดาห์ที่ 4 
 4. ให้สมาชิกในทีมร่วมกันติชมผลงานของทีมตนเองเพื่อพัฒนาและปรับปรุงต่อไป 
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ใบงานที่ 5 
เรื่อง การน าเสนอสื่อประสม  

รหัสวิชา ง30243   รายวิชา การน าเสนอสือ่ประสม    ช้ัน มัธยมศึกษาปีที่ 5  
------------------------------------------------------------------------------------------------------------- 

ค าชี้แจง 
 1. ให้นักเรียนแต่ละทีมน าผลงานของสมาชิกในทีมตนเองมารวมเป็นงานช้ินเดียวกัน จากนั้นจัด
องค์ประกอบต่างๆให้เหมาะสมและครอบคลมุเนื้อหาที่เรียนมา 
 2. น าเสนอผลงานและร่วมกันประเมินผลงานเพือ่นต่างทีม 
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แบบประเมินคุณภาพเพื่อหาค่า IOC ส าหรับผู้เช่ียวชาญ 
ที่มีต่อแบบทดสอบของบทเรียนบนเว็บช่วยสอนแบบการเรียนรู้เป็นทีมเพื่อส่งเสริมความสามัคคี 

 ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 5 
 

ค าชี้แจง    โปรดแสดงความคิดเห็นของท่านที่มีต่อแบบทดสอบของบทเรียนบนเว็บช่วยสอนแบบการ
เรียนรู้เป็นทีมเพื่อส่งเสริมความสามัคคี ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 5  โดยใส่เครื่องหมาย  ()  
ลงในช่องความคิดเห็นของท่านพร้อมเขียนข้อเสนอแนะที่เป็นประโยชน์ในการน าไปพิจารณาแกไ้ข
ปรับปรุงในล าดับต่อไป 

ข้อก าหนดของความคิดเห็น  ก าหนดให้ 
+1     หมายถึง    แน่ใจว่าสอดคล้องกับจุดประสงค์การเรียนรู้ 
0  หมายถึง    ไม่แน่ใจว่าสอดคล้องกับจุดประสงค์การเรียนรู้ 

-1      หมายถึง    ไม่สอดคล้องกับจุดประสงค์การเรียนรู้ 
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จุดประสงค์การ
เรียนรู้ 

รายการข้อสอบ 
ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

นักเรียนรู้จักและ
บอกหน้าท่ีการ
ท างานของ
เครื่องมือต่างๆได ้

 

1. ข้อใดกล่าวถูกตอ้ง 

 
1.  หมายเลข 1 คือ Panel Groups และ หมายเลข 2 คือ Toolbar 
2.  หมายเลข 3 คือ Document Window และ หมายเลข 4 คือ 
Toolbar 
3.  หมายเลข 5 คือ Menu Bar และ หมายเลข 6 คือ Properties  
4.  หมายเลข 7 คือ Slide และ หมายเลข 8 คือ Timeline 
ตอบข้อ 4 

    

นักเรียนรู้จักและ
บอกหน้าท่ีการ
ท างานของ
เครื่องมือต่างๆได ้

 

2. ข้อใดกล่าวถูกตอ้งท่ีสุดเกี่ยวกับหน้าท่ีการท างานของเครื่องมือ 
(Tools Bar) 
 
 
 
 
1. หมายเลข 2 ใช้ในการแทรกข้อความ หมายเลข 7 ใช้ในการ
แทรกข้อความเคลื่อนไหว  
2. หมายเลข 2 ใช้ในการท า Rollover Caption หมายเลข 6 ใช้ใน
การแทรกข้อความเคลือ่นไหว  
3. หมายเลข 1 ใช้ในการเคลื่อนย้ายวัตถุ หมายเลข 3 ใช้ในการ
แทรกข้อความ  
4. หมายเลข 4 ใช้ในการเคลื่อนย้ายวัตถุ หมายเลข 5 ใช้ในการ
สร้างปุ่ม 
ตอบข้อ 1 
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จุดประสงค์การ
เรียนรู้ 

รายการข้อสอบ 
ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

นักเรียนรู้จักและ
บอกหน้าท่ีการ
ท างานของ
เครื่องมือต่างๆได ้

 

3.  ข้อใดกล่าว ไม่ ถูกตอ้ง 
 1.  Timeline เป็นตัวก าหนดเวลาการแสดงของวัตถุแต่
ละตัวในแผ่น Slide นั้นๆ 
 2.  Properties เป็นแถบส าคัญท่ีก าหนดคุณลักษณะของ
วัตถุท่ีถูกเลอืกบนหน้าจอ 
 3.  Document Window เป็นหน้าจอแสดงผลของ
โปรแกรม โดยจะแสดง Slide ทีละแผ่น 
 4.  Menu Bar เป็นแถบแสดงเครื่องมือต่างๆของ
โปรแกรม 
ตอบข้อ 4 

    

นักเรียนรู้จักและ
บอกหน้าท่ีการ
ท างานของ
เครื่องมือต่างๆได ้

 

4.  FilmStrip Bar มีหน้าท่ีท าอะไร 
  1.  แสดงหน้าแผ่นสไลด์ท่ีมีท้ังหมด  
  2.  ใช้ส าหรับใส่ Film ภาพยนตร์  
  3.  เป็นเครื่องมือประเภทหนึ่งใน Tool bar  
  4.  เป็นลูกเล่นตัวหนึ่งของ Time line 
ตอบข้อ 1 

    

นักเรียนมีทักษะ
ในการ เพ่ิม ลบ 
และแทรก
ข้อความในสไลด์
ได ้

 

5.  หากต้องการใส่รูปเป็น background ของ Slide ท่ี 1 ต้องเลือก
ค าสั่งใดท่ี Properties  
  1.  Quality  
  2.  Transition  
  3.  Project Background  
  4.  Use Mater Slide Background 
ตอบข้อ 4 

    

นักเรียนมีทักษะ
ในการ เพ่ิม ลบ 
และแทรก
ข้อความในสไลด์
ได ้

 

6.  ถ้าต้องการแทรกข้อความลงในสไลด์มีขั้นตอนอย่างไร 
     1.  ไปท่ี Edit -> Text Caption 

  2.  ไปท่ี Edit -> Standard Objects -> Text Caption 
  3.  ไปท่ี Insert -> Text Caption  
  4.  ไปท่ี Insert->Standard Objects ->Text Caption   
ตอบข้อ 4 
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จุดประสงค์การ
เรียนรู้ 

รายการข้อสอบ 
ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

นักเรียนรู้จักและ
บอกหน้าท่ีการ
ท างานของ
เครื่องมือต่างๆได ้

 

7.  หากต้องการจัดอันดับการแสดงวัตถ ุ(Object) ให้แสดงก่อน
หรือหลังตอ้งกระท าท่ีใด 
  1.  TimeLine  
  2.  Display Time  
  3.  Quality  
  4.  Transition 
ตอบข้อ 1 
 

    

นักเรียนรู้จักและ
บอกหน้าท่ีการ
ท างานของ
เครื่องมือต่างๆได ้

 

8.  หากเครือ่งมือ Timeline หายไป ต้องท าขั้นตอนใด Timeline  
ถึงกลับมาเหมือนเดิม 
  1. ไปท่ีเมนู Window แล้วเลือก Timeline  
  2. ไปท่ีเมนู View แล้วเลือก Timeline  
  3. ไปท่ีเมนู Modify แล้วเลือก Timeline  
  4. ไปท่ีเมนู File แล้วเลือก Timeline 
ตอบข้อ 1 
 

    

นักเรียนสามารถ
บันทึก ดูตัวอย่าง
ผลงานและ
ส่งออกผลงาน
เป็นไฟล์ต่างๆได้ 
 
 

9.  การน าเสนองานท้ังโปรเจคและน าเสนอเฉพาะสไลดต์้องกด
ปุ่มลัดอะไรบ้าง 
 1.  F3 และ F4 
 2.  F3 และ F8 
 3.  F4 และ F8 
 4.  F4 และ F3 
ตอบข้อ 4 
 

    

- นักเรียน
สามารถบันทึก ดู
ตัวอย่างผลงาน
และส่งออก
ผลงานเป็นไฟล์
ต่างๆได้ 

10.  นักเรียนคิดว่าการส่งออก ( Publish ) งานแบบไหนดีท่ีสุด 
 1.  .swf 
 2.  .html 
 3.  .exe 
 4.  .cptx 
ตอบข้อ 3 
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จุดประสงค์การ
เรียนรู้ 

รายการข้อสอบ 
ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

นักเรียนสามารถ
แทรกข้อความ
เคลื่อนไหว 
รูปภาพและ
ภาพเคลื่อนไหว
ได ้

11.  ข้อใดคือขั้นตอนการใส่รูปภาพลง slide 
  1. File -> Image…  
  2. Insert -> Image…  
  3. File -> Picture…  
  4. Insert -> Picture… 
ตอบข้อ 2 

    

นักเรียนสามารถ
แทรกข้อความ
เคลื่อนไหว 
รูปภาพและ
ภาพเคลื่อนไหว
ได ้

12.  ข้อใดคือขั้นตอนการใส่รูปภาพเคลื่อนไหวลง slide 
  1. File -> Image…  
  2. Insert -> Animation…  
  3. File -> Picture…  
  4. Insert -> Picture… 
ตอบข้อ 2 

    

นักเรียนสามารถ
แทรกข้อความ
เคลื่อนไหว 
รูปภาพและ
ภาพเคลื่อนไหว
ได ้

 

13.  ถ้าต้องการแทรกข้อความเคลื่อนไหวลงในสไสลดต์้องใช้
ค าสั่งใด 
 1. File -> Image…  
  2. Insert -> Image…  
  3. File -> Picture…  
  4. Insert -> Picture… 
ตอบข้อ 2 

    

นักเรียนสามารถ
แทรกข้อความ
เคลื่อนไหว 
รูปภาพและ
ภาพเคลื่อนไหว
ได ้

 

14.  การใส่ Text Animation มักจะมีปัญหาเรื่องภาษาท่ีแสดง
ออกมาเป็นตัวสี่เหลี่ยม นักเรียนมีวิธีการแก้ปัญหานี้อย่างไร 
  1. ปรับ Size ให้เหมาะสมเพราะ ถ้าใหญ่หรือเล็กไป 
ภาษานั้นๆอาจไม่แสดงได้  
  2. ไม่สามารถแก้ไขได้เลยต้องลงโปรแกรมใหม่  
  3. เปลี่ยน Font ให้ Support กับภาษานั้นๆ  
  4. ปรับ Effect ของการแสดงให้ Support กับภาษา
นั้นๆ 
ตอบข้อ 3 
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จุดประสงค์การ
เรียนรู้ 

รายการข้อสอบ 
ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

นักเรียนสามารถ
ท า Rollover แบบ
ต่างๆได้ 

15.  Rollover Caption เป็นเครื่องมือท่ีท าหน้าท่ีอะไร 
  1.  ใช้สร้างข้อความ คล้ายๆกับ Text Caption  
  2.  ใช้แสดงข้อความเม่ือมีการน าเมาส์ผ่านบริเวณท่ี
ก าหนด  
  3.  ใช้สร้างข้อความโดยท่ีข้อความจะวิ่งมาจากทางซ้าย
ไปถึงท่ีก าหนด   
  4.  ถูกทุกข้อ 
ตอบข้อ 2 

    

นักเรียนสามารถ
ท า Rollover แบบ
ต่างๆได้ 

16.  การปรับพ้ืนท่ี Rollover Area ไม่ให้มีสีพ้ืนกระท าท่ีใด 
  1. Fill & Stroke ตั้งค่า Width = 0  
  2. Fill & Stroke ตั้งค่า fill = 0 %  
  3. Shadow -> Enable ตั้งค่า blur = 0  
  4. Shadow -> Enable ตั้งค่า Color = 0 
ตอบข้อ 2 

    

นักเรียนสามารถ
ท า Rollover แบบ
ต่างๆได้ 

17. เม่ือเอาเมาส์ไปช้ีหรือเลือ่นผ่านวัตถุบนสไลด์แล้วมีท้ังรูป
และข้อความแสดงขึ้นมาแสดงว่าใช้เครื่องมือใด 
 1.  Rollover Caption 
 2.  Rollover Image 
 3.  Rollover Slidelet 
 4.  ถูกทุกข้อ 
ตอบข้อ 3 

    

นักเรียนสามารถ
ท า Rollover แบบ
ต่างๆได้ 

18.  หากต้องการใหเ้มาส์ผ่านข้อความแล้วโชว์ภาพ ใช้เครื่องมือ
ใด 
  1.  Rollover Image and Text  
  2.  Rollover Picture  
  3.  Rollover Image  

 4.  Rollover Caption 
ตอบข้อ 3 
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จุดประสงค์การ
เรียนรู้ 

รายการข้อสอบ 
ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

นักเรียนสามารถ
ท า Rollover แบบ
ต่างๆได้ 

19.  การปรับพ้ืนท่ี Rollover  Area ไม่ให้มีเส้นขอบกระท าท่ีใด 
  1. Fill & Stroke ตั้งค่า fill 0 %  
  2. Shadow -> Enable ตั้งค่า Color = 0  
  3. Shadow -> Enable ตั้งค่า blur = 0  
  4. Fill & Stroke ตั้งค่า Width = 0 
ตอบข้อ 4 

    

นักเรียนสามารถ
ก าหนด 
Transition และ 
Effect ให้กับวัตถุ
และสไลด์ได้ 

 

20.  หากต้องการใส ่effect ให้กับวัตถุ มีขั้นตอนอย่างไร 
  1. ไปท่ี Edit -> effect -> Add effect..  
  2. ไปท่ี Modify -> effect -> Add effect..  
  3. ไปท่ี Window -> effect -> Add effect..  
  4. ไปท่ี Insert -> effect -> Add effect.. 
ตอบข้อ 3 

    

นักเรียนแทรกปุ่ม
ในสไลด์แบบ
ต่างๆและท าการ
เช่ือมโยงได้ 

 

21.  ข้อใดคือวิธกีารใส่ปุ่มเพ่ือสร้างการเช่ือมโยง (Link) 
  1. Insert -> Standard -> Button  
  2. Insert -> Slide Transitions -> Button  
  3. Insert -> Standard Object -> Button  
  4. Insert -> Button 
ตอบข้อ 3 

    

นักเรียนแทรกปุ่ม
ในสไลด์แบบ
ต่างๆและท าการ
เช่ือมโยงได้ 

 

22.  สิ่งใดท่ีเกิดขึ้นกับ Slide หลังจากการใส่ปุ่ม (Botton) 
  1. Slide เล่นตามปกติ  
  2. Slide นั้นๆท่ีใส่ปุ่มจะไม่โชว์  
  3. Slide ไม่เล่นต่อ แต่จะรอกดปุ่ม  
  4. ไม่มีข้อใดถูก 
ตอบข้อ 3 

    

นักเรียนแทรกปุ่ม
ในสไลด์แบบ
ต่างๆและท าการ
เช่ือมโยงได้ 

23.  ค าสั่งใดใช้สั่งให้ปุ่มนี้ท างาน ถอยหลังไป 1 สไลด ์
  1. Action -> On Success -> Go to the next slide  
  2. Action -> On Success -> Open Url or file 
  3. Action ->On Success -> Go to the previous slide 
   4. Action -> On Success -> jump to file 
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จุดประสงค์การ
เรียนรู้ 

รายการข้อสอบ 
ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

ข้อ 23 ตอ่ ตอบข้อ 3     
นักเรียนแทรกปุ่ม
ในสไลด์แบบ
ต่างๆและท าการ
เช่ือมโยงได้ 

 

24.  ถ้าอยู่ท่ีสไลด์ท่ี 2 แต่ต้องการกดปุ่มแล้วไปสไลด์ท่ี 15 ต้อง
ใช้ค าสั่งใดท่ีปุ่ม 
  1.  Action -> On Success -> Open Url or file  
  2.  Action -> On Success -> Go to the next slide 
  3.  Action -> On Success -> Go to the previous slide 
  4.  Action -> On Success -> Jump to Slide 

ตอบข้อ 4 
 

    

นักเรียนแทรกปุ่ม
ในสไลด์แบบ
ต่างๆและท าการ
เช่ือมโยงได้ 

 

25.  ค าสั่งใดใช้สั่งให้ปุ่มนี้ท างาน ไป Slide ต่อไป 
  1. Action -> On Success -> jump to file  
  2. Action -> On Success -> Go to the previous slide 
  3. Action -> On Success -> Open Url or file  
  4. Action -> On Success -> Go to the next slide 
ตอบข้อ 4 
 

    

นักเรียนแทรก
เสียงในสไลด์ได้ 

26.  การใส่เสียงเพลงครั้งเดียวทุกสไลด์ มีขั้นตอนอย่างไร 
 1.  Insert -> Sound… 
 2.  Insert -> Audio 
 3.  Audio -> Import to -> Background 
 4.  Audio -> Import to -> Slide 
ตอบข้อ 3 

    

นักเรียนแทรก
เสียงในสไลด์ได้ 

27.  ถ้านักเรียนต้องการแทรกเสียงเพลงให้กับสไลดเ์พียงสไลด์
เดียว มีขั้นตอนอย่างไร  

1.  Insert -> Sound… 
 2.  Insert -> Audio 
 3.  Audio -> Import to -> Background 
 4.  Audio -> Import to -> Slide 
ตอบข้อ 4 
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จุดประสงค์การ
เรียนรู้ 

รายการข้อสอบ 
ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

นักเรียนแทรก
วิดีโอในสไลด์ได้ 

28.  ถ้าต้องการแทรกวีดิโอในสไลด์มีขั้นตอนอย่างไร 
  ก.  Insert -> Slide Video… 
  ข.  Insert -> FLV OR F4v File… 
  ค.  Video -> Insert Slide Video… 
  ง.  Video -> Import to Slide… 
 1.  ก  ข และ ค 
 2.  ก ข และ ง 
 3.  ข ค และ ง 
 4.  ก ข ค และ ง 
ตอบข้อ 1 
 

    

นักเรียนแทรก
วิดีโอในสไลด์ได้ 

29.  ถ้าหากว่าในสไลด์งานของนักเรียนมีท้ังเพลงและวิดีโออยู่
ด้วยกัน นักเรียนมีวิธีในการท าให้เสียงเพลงหยุดแต่วิดีโอยังคง
เล่นอยู่หรอืไม่อย่างไร   
 1.  ไม่มี ต้องเลือกอย่างใดอย่างหนึ่งเท่านั้น 
 2.  ไม่มี เพราะโปรแกรมนี้มีความสามารถจ ากัด 
 3.  มี โดยการเลอืกท่ีสไลด์ จากนั้นก าหนดท่ี Properties 
-> Audio -> Stop Background Audio 
 4.  ไม่ข้อใดถูกต้อง 
ตอบข้อ 3 
 

    

นักเรียนแทรก
วิดีโอในสไลด์ได้ 

30. ไฟล์วิดีโอนามสกุลใดท่ีไม่สามารถแทรกเข้ามาในสไลด์ได้ 
 1.  FLV  
 2.  AVI  
 3.  MP4  
 4.  WMA 
ตอบข้อ 4 
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จุดประสงค์การ
เรียนรู้ 

รายการข้อสอบ 
ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

นักเรียนสามารถ
สร้างค าถามด้วย 
Text Entry ได ้

31.  ถ้าต้องการสรา้งแบบทดสอบย่อยๆ โดยให้เดิมค าตอบลงใน
สไลด์ แล้วมีข้อความตอบกลับมา นักเรียนคิดว่าจะใช้เครื่องมือ
อะไร 
 1.  Click Box 
 2.  Text Entry Box  
 3.  Rollover Slidelet 
 4.  ใช้ได้ทุกข้อ 
ตอบข้อ 2 

    

นักเรียนสามารถ
สร้างค าถามด้วย 
Text Entry ได ้

32. ข้อใดคือค าสั่งท่ีใช้ในการน า Text Entry Box มาใช้งาน 
 1.  Insert -> Text Entry Box 
 2.  Insert -> Standard Object -> Text Entry Box 
 3.  File -> Import -> Text Entry Box 
 4.  File -> Standard Object -> Text Entry Box 
ตอบข้อ 2 

    

นักเรียนสามารถ
สร้างค าถามด้วย 
Text Entry ได ้

33. จากรูป ถ้าต้องการป้อนค าตอบท่ีถูกต้องลงใน Text Entry 
Box นักเรียนต้องเลอืกท่ีส่วนใด 
 

 
  
 1.  Retain Text 
 2.  Show Text  Box  Frame 
 3.  Password Field 
 4.  Validate User Input 
ตอบข้อ 4 
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จุดประสงค์การ
เรียนรู้ 

รายการข้อสอบ 
ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

นักเรียนสามารถ
สร้างค าถามด้วย 
Text Entry ได ้

34. จากรูป ถ้าต้องการให้ปุ่ม “ถูกต้องค่ะ” หรือ “ผิดค่ะ” แสดง
ขึ้นมาต้องก าหนดค่าอย่างไร 

 
 1.  Library -> Action -> Captions -> Success/Failure  
 2.  Library -> Option -> Captions -> Success/Hint  
 3.  Properties -> Action -> Captions ->Failure/Hint 
 4.  Properties -> Option -> Captions -> Success/ 
Failure 
ตอบข้อ  4 

    

นักเรียนสามารถ
สร้างค าถามด้วย 
Text Entry ได ้

35.  จากภาพหากต้องการเพ่ิมค าตอบให้กับโจทย์ด้านล่างต้องท า
อย่างไร

 
 1.  คลิกท่ีปุ่ม Submit แล้วกรอกขอ้ความท่ีถูกต้องลงไป
ใน Text Box 
 2.  คลิกท่ีปุ่ม + แล้วกรอกข้อความท่ีถูกต้องลงไป 
 3.  คลิกท่ีปุ่ม - แล้วกรอกขอ้ความท่ีถูกต้องลงไป 
 4.  ดับเบ้ิลคลิกลงไปท่ีกล่อง Correct Entries 
ตอบข้อ 2 
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จุดประสงค์การ
เรียนรู้ 

รายการข้อสอบ 
ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

นักเรียนสามารถ
สร้างค าถามด้วย 
Click Boxได ้

36. การเอาเมาส์คลกิลงไปบนวัตถุแล้วมีปฏิสัมพันธ์โต้ตอบ
กลับมาท่ีผู้ใช้ นักเรียนต้องใช้เครื่องมือท่ีช่ือว่าอะไร 
 1.  Click Box 
 2.  Text Entry Box  
 3.  Rollover Slidelet 
 4.  Text Caption 
ตอบข้อ 1 

    

นักเรียนสามารถ
สร้างค าถามด้วย 
Click Boxได ้

37. ข้อใดคือค าสั่งท่ีใช้ในการน า Click Box มาใช้งาน 
 1.  File -> Import -> Click Box 
 2.  File -> Standard Object -> Click Box 
 3.  Insert -> Click Box 
 4.  Insert -> Standard Object -> Click Box 
ตอบข้อ 4 

    

นักเรียนสามารถ
สร้างค าถามด้วย 
Click Boxได ้

38. จากภาพ เม่ือนักเรียนใช้ Click Box แล้วต้องการใหก้าร
แสดงผลตอบกลับมีเสียงประกอบจะต้องท าอย่างไร 

 
 1.  ไปท่ี Insert -> Recording Slide… 
 2.  เลือกท่ีปุ่ม “ถูกต้องครับ” จากนั้นไปท่ี Insert -> 
Recording Slide… 
 3.  ไปท่ี Properties -> Audio -> Add Audio… 
 4.  เลือกท่ีปุ่ม “ถูกต้องครับ” จากนั้นไปท่ี Properties -> 
Audio -> Add Audio… 
ตอบข้อ 4 
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จุดประสงค์การ
เรียนรู้ 

รายการข้อสอบ 
ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

นักเรียนสามารถ
สร้างค าถามด้วย 
Click Boxได ้

39. ข้อใดกลา่วถูกตอ้งเกี่ยวกับเครื่องมือ Click Box 
 1.  ถ้าคลิกบน Click Box แสดงว่าพ้ืนท่ีนั้นคือต าตอบท่ี
ถูกต้อง 
 2.  ถ้าคลิกนอกเหนอืบริเวณ Click Box แสดงว่าพ้ืนท่ี
นั้นคือต าตอบท่ีถูกต้อง 
 3.  การแสดงผลตอบกลับจากการคลิกท่ี Click Box จะ
แสดงผลตอบกลับในกรณีท่ีถูกต้องเท่านั้น 
 4.  การแสดงผลตอบกลับแสดงผลเป็นข้อความและ
รูปภาพเท่านั้น 

ตอบข้อ 1 
 

    

นักเรียนสามารถ
สร้างค าถามด้วย 
Click Boxได ้

40. นักเรียนคิดว่าการน า Click Box มาใช้งานจะใช้ได้ในกรณีใด 
 1.  เป็นค าถามท่ีต้องพิมพ์ค าตอบลงไปในกล่อง
ข้อความ 
 2.  เป็นค าถามส าหรับจับคู่ 
 3.  เป็นค าถามท่ีให้เลือกหาค าตอบโดยเอาเมาส์ไปคลิก 
 4.  ถูกทุกข้อ 
ตอบข้อ 3 

 

    

 
ข้อเสนอแนะเพื่อการพัฒนาและปรับปรุง 
.......................................................................................................................................................................
.......................................................................................................................................................................
....................................................................................................................................................................... 
  
          ลงช่ือ………………………..ผู้ประเมิน 
                     (……………………………..) 



 
 
 
 
 
 
 
 
 
 
 

ภาคผนวก  ค 
ผลการตรวจสอบคุณภาพเครื่องมือ 
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ตารางภาคผนวกที่  1  ผลการวิเคราะห์ค่าดัชนีความสอดคลอ้ง (IOC)  ของการประเมินคุณภาพแบบ
ประเมินเว็บช่วยสอนแบบการเรียนรู้เป็นทีมส าหรับผู้เช่ียวชาญด้านวัดและประเมินผล 

รายการประเมิน 
ผู้เช่ียวชาญ 

IOC แปลผล คนที่ 
1 

คนที่ 
2 

คนที่ 
3 

1.  เนื้อหา      
1.1  ความสอดคล้องของเนื้อหากับ

จุดประสงค์ 
+1 +1 +1 1.00 น าไปใช้ได ้

1.2  เนื้อหาครบถ้วนสมบูรณ์ +1 +1 +1 1.00 น าไปใช้ได ้
1.3  ความเหมาะสมกับระดับผู้เรียน +1 +1 +1 1.00 น าไปใช้ได ้
1.4  การจัดล าดับหัวข้อ +1 +1 +1 1.00 น าไปใช้ได ้
1.5  ความเหมาะสมของปริมาณเนือ้หา +1 +1 +1 1.00 น าไปใช้ได ้
1.6  ความถูกต้องของเนื้อหา +1 +1 +1 1.00 น าไปใช้ได ้
1.7  ความชัดเจนในการอธิบายเนื้อหา +1 +1 +1 1.00 น าไปใช้ได ้
1.8  ความยากง่ายของเนื้อหา +1 +1 +1 1.00 น าไปใช้ได ้
1.9  ความต่อเนื่องของเนื้อหา +1 +1 +1 1.00 น าไปใช้ได ้
1.10 ความถูกต้องของภาษาที่ใช้ +1 +1 +1 1.00 น าไปใช้ได ้
1.11 ความเหมาะสมของการสรุปเนื้อหา +1 +1 +1 1.00 น าไปใช้ได ้

2.  การจัดวางรูปแบบเว็บเพจ      
    2.1  การน าเสนอมีความน่าสนใจ +1 +1 +1 1.00 น าไปใช้ได ้

2.2  น าเสนอบทเรียนเข้าใจง่าย +1 +1 +1 1.00 น าไปใช้ได ้
2.3  ผู้เรียนมีปฏิสัมพันธ์กับบทเรียน +1 +1 +1 1.00 น าไปใช้ได ้
2.4 สีที่ใช้มีความเหมาะสม สวยงาม +1 +1 +1 1.00 น าไปใช้ได ้
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รายการประเมิน 
ผู้เช่ียวชาญ 

IOC แปลผล คนที่ 
1 

คนที่ 
2 

คนที่ 
3 

3.  ภาษา/ตัวอักษร      
3.1  ขนาดตัวอักษรมีความเหมาะสม  +1 +1 +1 1.00 น าไปใช้ได ้
3.2   ลักษณะสีของตัวอักษรมีความ

เหมาะสม 
+1 +1 +1 1.00 น าไปใช้ได ้

3.3   ลักษณะของตัวอักษรมีความเหมาะสม +1 +1 +1 1.00 น าไปใช้ได ้
3.4   การวางต าแหน่งของตัวอักษร +1 +1 +1 1.00 น าไปใช้ได ้
3.5   ความถูกต้องของภาษาที่น ามาใช้ +1 +1 +1 1.00 น าไปใช้ได ้
3.6   ความชัดเจนของตัวอักษร +1 +1 +1 1.00 น าไปใช้ได ้

4.  รูปภาพประกอบ      
4.1  รูปภาพสอดคล้องกับเนื้อหา +1 +1 +1 1.00 น าไปใช้ได ้
4.2  ความคมชัดของรูปภาพประกอบและ

พื้นหลัง 
+1 +1 +1 1.00 น าไปใช้ได ้

4.3  การวางต าแหน่งของรูปภาพ +1 +1 +1 1.00 น าไปใช้ได ้
4.4  ความถูกต้องของภาพที่น ามาใช้ +1 +1 +1 1.00 น าไปใช้ได ้

5.  การเช่ือมโยง      
5.1 การเช่ือมโยงเนื้อหาแต่ละบท +1 +1 +1 1.00 น าไปใช้ได ้
5.2 การเช่ือโยงภายในเว็บเพจ +1 +1 +1 1.00 น าไปใช้ได ้
5.3 การเช่ือมโยงกับเว็บไซต์อื่นๆ +1 +1 +1 1.00 น าไปใช้ได ้

ค่าเฉลี่ย IOC 1.00  
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ตารางภาคผนวกที่  2  ผลการวิเคราะห์ค่าดัชนีความสอดคลอ้ง (IOC)  ของการประเมินคุณภาพแบบ
ประเมินเว็บช่วยสอนแบบการเรียนรู้เป็นทีม ส าหรับผู้เช่ียวชาญด้านสื่อและเนื้อหา 

รายการประเมิน 
ผู้เช่ียวชาญ 

IOC แปลผล คนที่ 
1 

คนที่ 
2 

คนที่ 
3 

1.  เนื้อหา      
1.1  ความสอดคล้องของเนื้อหากับ

จุดประสงค์ 
+1 +1 +1 1.00 น าไปใช้ได ้

1.2  เนื้อหาครบถ้วนสมบูรณ์ +1 +1 +1 1.00 น าไปใช้ได ้
1.3  ความเหมาะสมกับระดับผู้เรียน +1 +1 +1 1.00 น าไปใช้ได ้
1.4  การจัดล าดับหัวข้อ +1 +1 +1 1.00 น าไปใช้ได ้
1.5  ความเหมาะสมของปริมาณเนือ้หา +1 +1 +1 1.00 น าไปใช้ได ้
1.6  ความถูกต้องของเนื้อหา +1 +1 +1 1.00 น าไปใช้ได ้
1.7  ความชัดเจนในการอธิบายเนื้อหา +1 +1 +1 1.00 น าไปใช้ได ้
1.8  ความยากง่ายของเนื้อหา +1 +1 +1 1.00 น าไปใช้ได ้
1.9  ความต่อเนื่องของเนื้อหา +1 +1 +1 1.00 น าไปใช้ได ้
1.10 ความถูกต้องของภาษาที่ใช้ +1 +1 +1 1.00 น าไปใช้ได ้
1.11 ความเหมาะสมของการสรุปเนื้อหา +1 +1 +1 1.00 น าไปใช้ได ้

2.  การจัดวางรูปแบบเว็บเพจ      
    2.1  การน าเสนอมีความน่าสนใจ +1 +1 +1 1.00 น าไปใช้ได ้

2.2  น าเสนอบทเรียนเข้าใจง่าย 0 +1 +1 0.67 น าไปใช้ได ้
2.3  ผู้เรียนมีปฏิสัมพันธ์กับบทเรียน 0 +1 +1 0.67 น าไปใช้ได ้
2.4 สีที่ใช้มีความเหมาะสม สวยงาม +1 +1 +1 1.00 น าไปใช้ได ้
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รายการประเมิน 
ผู้เช่ียวชาญ 

IOC แปลผล คนที่ 
1 

คนที่ 
2 

คนที่ 
3 

3.  ภาษา/ตัวอักษร      
3.1  ขนาดตัวอักษรมีความเหมาะสม  +1 +1 +1 1.00 น าไปใช้ได ้
3.2   ลักษณะสีของตัวอักษรมีความ

เหมาะสม 
+1 +1 +1 1.00 น าไปใช้ได ้

3.3   ลักษณะของตัวอักษรมีความเหมาะสม +1 +1 +1 1.00 น าไปใช้ได ้
3.4   การวางต าแหน่งของตัวอักษร +1 +1 +1 1.00 น าไปใช้ได ้
3.5   ความถูกต้องของภาษาที่น ามาใช้ +1 +1 +1 1.00 น าไปใช้ได ้
3.6   ความชัดเจนของตัวอักษร +1 +1 +1 1.00 น าไปใช้ได ้

4.  รูปภาพประกอบ      
4.1  รูปภาพสอดคล้องกับเนื้อหา +1 +1 +1 1.00 น าไปใช้ได ้
4.2  ความคมชัดของรูปภาพประกอบและ

พื้นหลัง 
+1 +1 +1 1.00 น าไปใช้ได ้

4.3  การวางต าแหน่งของรูปภาพ +1 +1 +1 1.00 น าไปใช้ได ้
4.4  ความถูกต้องของภาพที่น ามาใช้ +1 +1 +1 1.00 น าไปใช้ได ้

5.  การเช่ือมโยง      
5.1 การเช่ือมโยงเนื้อหาแต่ละบท +1 +1 +1 1.00 น าไปใช้ได ้
5.2 การเช่ือโยงภายในเว็บเพจ +1 +1 +1 1.00 น าไปใช้ได ้
5.3 การเช่ือมโยงกับเว็บไซต์อื่นๆ +1 +1 +1 1.00 น าไปใช้ได ้

ค่าเฉลี่ย IOC 0.98  
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ตารางภาคผนวกที่  3  สรุปผลการวิเคราะห์ค่าดัชนีความสอดคล้อง (IOC)  ของการประเมินคุณภาพ
แบบประเมินเว็บช่วยสอนแบบการเรียนรู้เป็นทีม  

รายการ
ประเมิน
ข้อที ่

ผู้เช่ียวชาญ 
ด้านวัดและประเมินผล 

ผู้เช่ียวชาญ 
ด้านสื่อและเนือ้หา 

ค่า 
IOC 

สรุปผล 
คนที่ 1 คนที่ 2 คนที่ 3 คนที่ 1 คนที่ 2 คนที่ 3 

1         
1.1 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.2 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.3 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.4 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.5 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.6 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.7 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.8 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.9 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.10 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.11 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้

2         
2.1 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
2.2 +1 +1 +1 0 +1 +1 0.83 น าไปใช้ได ้

2.3 +1 +1 +1 0 +1 +1 0.83 น าไปใช้ได ้

2.4 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
3         

3.1 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
3.2 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
3.3 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
3.4 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
3.5 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
3.6 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
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รายการ
ประเมิน
ข้อที ่

ผู้เช่ียวชาญ 
ด้านวัดและประเมินผล 

ผู้เช่ียวชาญ 
ด้านสื่อและเนือ้หา 

ค่า 
IOC 

สรุปผล 
คนที่ 1 คนที่ 2 คนที่ 3 คนที่ 1 คนที่ 2 คนที่ 3 

4         
4.1 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
4.2 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
4.2 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
4.4 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้

5         
5.1 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
5.2 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
5.3 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้

ค่าเฉลี่ย IOC 0.99  
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ตารางภาคผนวกที่  4  ผลการวิเคราะห์ค่าดัชนีความสอดคลอ้ง (IOC)  ของการประเมินคุณภาพแบบ
ประเมินความพึงพอใจการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม ส าหรับผู้เช่ียวชาญ
ด้านวัดประเมินผล 

รายการประเมิน 
ผู้เช่ียวชาญ 

IOC แปลผล คนที่ 
1 

คนที่ 
2 

คนที่ 
3 

1.  ด้านเนื้อหา       
1.1  ตรงตามวัตถุประสงค์ของบทเรียน +1 +1 +1 1.00 น าไปใช้ได ้
1.2 การใช้ภาษา ง่ายต่อการท าความเข้าใจ +1 +1 +1 1.00 น าไปใช้ได ้
1.3 การจัดล าดับเนื้อหาแต่ละเร่ืองมีความ

เหมาะสม 
+1 +1 +1 1.00 น าไปใช้ได ้

1.4 เนื้อหามีความยากง่าย เหมาะสมกับ
ผู้เรียน 

+1 +1 +1 1.00 น าไปใช้ได ้

1.5 เนื้อหาที่น าเสนอให้เป็นความรู้ที่มี
ประโยชน์ 

+1 +1 +1 1.00 น าไปใช้ได ้

1.6  เนื้อหาตรงกับสิ่งที่สนใจ +1 +1 +1 1.00 น าไปใช้ได ้
2.  ด้านการออกแบบ      
   2.1  หน้าจอสวยงาม ดึงดูด น่าสนใจ +1 +1 +1 1.00 น าไปใช้ได ้

2.2  สีของตัวอักษร อ่านง่าย สบายตา ชัดเจน +1 +1 +1 1.00 น าไปใช้ได ้
2.3  รูปแบบของตัวอักษรอ่านง่าย +1 +1 +1 1.00 น าไปใช้ได ้
2.4  ขนาดของตัวอักษรมีความชัดเจน +1 +1 +1 1.00 น าไปใช้ได ้
2.5  ภาพที่ใช้ประกอบเหมาะสมชัดเจน +1 +1 +1 1.00 น าไปใช้ได ้
2.6  มีการเช่ือมโยงเนื้อหาภายในเว็บเพจและ

กับเว็บไซต์อื่น 
+1 +1 +1 1.00 น าไปใช้ได ้

3. รูปแบบการน าเสนอ      
3.1  การน าเสนอมีความน่าสนใจ +1 +1 +1 1.00 น าไปใช้ได ้
3.2  น าเสนอบทเรียนได้อย่างชัดเจนและ

เข้าใจง่าย 
+1 +1 +1 1.00 น าไปใช้ได ้

3.3  การออกแบบเว็บไซต์ดึงดูดความสนใจ +1 +1 +1 1.00 น าไปใช้ได ้
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รายการประเมิน 
ผู้เช่ียวชาญ 

IOC แปลผล คนที่ 
1 

คนที่ 
2 

คนที่ 
3 

3.4  เปิดโอกาสให้มีส่วนร่วมและท า
กิจกรรมในบทเรียน 

+1 +1 +1 1.00 น าไปใช้ได ้

 3.5  สามารถเลือกเรียนได้ตามความต้องการ +1 +1 +1 1.00 น าไปใช้ได ้
3.6  ทราบผลทางการเรียนได้ในทันที +1 +1 +1 1.00 น าไปใช้ได ้

4.  การเรียนรู้ร่วมกันเป็นทีม      
4.1  ผู้เรียนเข้ามาเรียนรู้บทเรียนได้ทุกที่ทุก

เวลา 
+1 +1 +1 1.00 น าไปใช้ได ้

4.2  ผู้เรียนที่อยู่ต่างพื้นที่กันสามารถเรียนรู้
ร่วมกันได้ 

+1 +1 +1 1.00 น าไปใช้ได ้

4.3  ท างานตามที่ได้รับมอบหมายในทีม +1 +1 +1 1.00 น าไปใช้ได ้
4.4  ผู้เรียนแต่ละทีมสามารถติดต่อสื่อสาร

กับเพื่อนในทีม 
      ในบทเรียนได้ 

+1 +1 +1 1.00 น าไปใช้ได ้

4.5  ผู้เรียนสามารถติดต่อสื่อสารกับเพื่อน
ต่างในทีมในบทเรียนได้ 

+1 +1 +1 1.00 น าไปใช้ได ้

4.6  ผู้ เ รียนสามารถแสดงความคิด เห็น
เกี่ยวกับช้ินงานที่ท าในทีม 
      และเพื่อนต่างทีมในบทเรียนได้ 

+1 +1 +1 1.00 น าไปใช้ได ้

ค่าเฉลี่ย IOC 1.00  
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ตารางภาคผนวกที่  5  ผลการวิเคราะห์ค่าดัชนีความสอดคลอ้ง (IOC)  ของการประเมินคุณภาพแบบ
ประเมินความพึงพอใจการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม ส าหรับผู้เช่ียวชาญ
ด้านสื่อและเนือ้หา 

รายการประเมิน 
ผู้เช่ียวชาญ 

IOC แปลผล คนที่ 
1 

คนที่ 
2 

คนที่ 
3 

1.  ด้านเนื้อหา       
1.1  ตรงตามวัตถุประสงค์ของบทเรียน +1 +1 +1 1.00 น าไปใช้ได ้
1.2 การใช้ภาษา ง่ายต่อการท าความเข้าใจ +1 +1 +1 1.00 น าไปใช้ได ้
1.3 การจัดล าดับเนื้อหาแต่ละเร่ืองมีความ

เหมาะสม 
+1 +1 +1 1.00 น าไปใช้ได ้

1.4 เนื้อหามีความยากง่าย เหมาะสมกับ
ผู้เรียน 

+1 +1 +1 1.00 น าไปใช้ได ้

1.5 เนื้อหาที่น าเสนอให้เป็นความรู้ที่มี
ประโยชน์ 

+1 +1 +1 1.00 น าไปใช้ได ้

1.6  เนื้อหาตรงกับสิ่งที่สนใจ +1 +1 +1 1.00 น าไปใช้ได ้
2.  ด้านการออกแบบ      
   2.1  หน้าจอสวยงาม ดึงดูด น่าสนใจ +1 +1 +1 1.00 น าไปใช้ได ้

2.2  สีของตัวอักษร อ่านง่าย สบายตา ชัดเจน +1 +1 +1 1.00 น าไปใช้ได ้
2.3  รูปแบบของตัวอักษรอ่านง่าย +1 +1 +1 1.00 น าไปใช้ได ้
2.4  ขนาดของตัวอักษรมีความชัดเจน +1 +1 +1 1.00 น าไปใช้ได ้
2.5  ภาพที่ใช้ประกอบเหมาะสมชัดเจน +1 +1 +1 1.00 น าไปใช้ได ้
2.6  มีการเช่ือมโยงเนื้อหาภายในเว็บเพจและ

กับเว็บไซต์อื่น 
+1 +1 +1 1.00 น าไปใช้ได ้

3. รูปแบบการน าเสนอ      
3.1  การน าเสนอมีความน่าสนใจ +1 +1 +1 1.00 น าไปใช้ได ้
3.2  น าเสนอบทเรียนได้อย่างชัดเจนและ

เข้าใจง่าย 
+1 +1 +1 1.00 น าไปใช้ได ้

3.3  การออกแบบเว็บไซต์ดึงดูดความสนใจ +1 +1 +1 1.00 น าไปใช้ได ้
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รายการประเมิน 
ผู้เช่ียวชาญ 

IOC แปลผล คนที่ 
1 

คนที่ 
2 

คนที่ 
3 

3.4  เปิดโอกาสให้มีส่วนร่วมและท า
กิจกรรมในบทเรียน 

+1 +1 +1 1.00 น าไปใช้ได ้

 3.5  สามารถเลือกเรียนได้ตามความต้องการ +1 +1 +1 1.00 น าไปใช้ได ้
3.6  ทราบผลทางการเรียนได้ในทันที +1 +1 +1 1.00 น าไปใช้ได ้

4.  การเรียนรู้ร่วมกันเป็นทีม      
4.1  ผู้เรียนเข้ามาเรียนรู้บทเรียนได้ทุกที่ทุก

เวลา 
+1 +1 +1 1.00 น าไปใช้ได ้

4.2  ผู้เรียนที่อยู่ต่างพื้นที่กันสามารถเรียนรู้
ร่วมกันได้ 

+1 +1 +1 1.00 น าไปใช้ได ้

4.3  ท างานตามที่ได้รับมอบหมายในทีม +1 +1 +1 1.00 น าไปใช้ได ้
4.4  ผู้เรียนแต่ละทีมสามารถติดต่อสื่อสาร

กับเพื่อนในทีมในบทเรียนได้ 
+1 +1 +1 1.00 น าไปใช้ได ้

4.5  ผู้เรียนสามารถติดต่อสื่อสารกับเพื่อน
ต่างในทีมในบทเรียนได้ 

+1 +1 +1 1.00 น าไปใช้ได ้

4.6  ผู้ เ รียนสามารถแสดงความคิด เห็น
เกี่ยวกับช้ินงานที่ท าในทีม และเพื่อนต่างทีมใน
บทเรียนได้ 

+1 +1 +1 1.00 น าไปใช้ได ้

ค่าเฉลี่ย IOC 1.00  
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ตารางภาคผนวกที่  6  สรุปผลการวิเคราะห์ค่าดัชนีความสอดคล้อง (IOC)  ของการประเมินคุณภาพ
แบบประเมินความพึงพอใจการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 

รายการ
ประเมิน
ข้อที ่

ผู้เช่ียวชาญ 
ด้านวัดและประเมินผล 

ผู้เช่ียวชาญ 
ด้านสื่อและเนือ้หา 

ค่า 
IOC 

 
สรุปผล 

 คนที่ 1 คนที่ 2 คนที่ 3 คนที่ 1 คนที่ 2 คนที่ 3 

1         
1.1 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.2 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.3 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.4 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.5 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.6 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.7 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.8 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.9 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.10 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.11 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้

2         
2.1 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
2.2 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
2.3 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
2.4 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้

3         
3.1 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
3.2 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
3.3 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
3.4 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
3.5 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
3.6 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
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รายการ
ประเมิน
ข้อที ่

ผู้เช่ียวชาญ 
ด้านวัดและประเมินผล 

ผู้เช่ียวชาญ 
ด้านสื่อและเนือ้หา 

ค่า 
IOC สรุปผล 

คนที่ 1 คนที่ 2 คนที่ 3 คนที่ 1 คนที่ 2 คนที่ 3  
4         

4.1 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
4.2 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
4.2 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
4.4 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้

5         
5.1 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
5.2 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
5.3 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้

ค่าเฉลี่ย IOC 1.00  
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ตารางภาคผนวกที่  7  ผลการวิเคราะห์ค่าดัชนีความสอดคลอ้ง (IOC)  ของการประเมินคุณภาพแบบ
ประเมินความสามัคคีส าหรับนักเรียนประเมินตนเอง ส าหรับผู้เช่ียวชาญด้านวัดและ
ประเมินผล 

รายการประเมิน 
ผู้เช่ียวชาญ 

IOC แปลผล คนที่ 
1 

คนที่ 
2 

คนที่ 
3 

1.  เข้าใจบทบาทหน้าที่ในทีม      
 1.1 นักเรียนเข้าใจบทบาทของตนเองใน
ฐานะผู้น าและผู้ตามที่ด ี

+1 +1 +1 1.00 น าไปใช้ได ้

 1.2 นักเรียนปฏิบัติตามข้อตกลงของการ
เป็นสมาชิกในทีม 

+1 +1 +1 1.00 น าไปใช้ได ้

 1.3 นักเรียนประชุม ปรึกษาหารือกันใน
กิจกรรมที่ได้รับมอบหมาย 

+1 +1 +1 1.00 น าไปใช้ได ้

 1.4 นักเรียนมีอัธยาศัยที่ดีในการ
ติดต่อสื่อสารกับเพื่อน 

+1 +1 +1 1.00 น าไปใช้ได ้

 1.5 นักเรียนปรึกษาหารือกันเพื่อแก้ไข
ข้อผิดพลาดภายหลังการท างาน 

+1 +1 +1 1.00 น าไปใช้ได ้

2.  การยอมรับฟังความคิดเห็น      
 2.1 นักเรียนยอมรับฟังความคิดเห็นที่
แตกต่างของเพื่อนในทีม 

+1 +1 +1 1.00 น าไปใช้ได ้

 2.2 นักเรียนมีเหตุผลเพียงพอในการ
ตัดสินใจ 

+1 +1 +1 1.00 น าไปใช้ได ้

 2.3 นักเรียนยอมรับเสียงส่วนใหญ่ 
(ผลสรุป) ของทีม 

+1 +1 +1 1.00 น าไปใช้ได ้

 2.4 นักเรียนยอมรับผลงานของสมาชิกใน
ทีม 

+1 +1 +1 1.00 น าไปใช้ได ้

 2.5 นักเรียนพร้อมที่จะปรับตัวเพื่อให้
สามารถอยู่ร่วมในทีมได ้

+1 +1 +1 1.00 น าไปใช้ได ้

 2.6 นักเรียนให้อภัยเพื่อนที่ท างานผิดพลาด +1 +1 +1 1.00 น าไปใช้ได ้
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รายการประเมิน 
ผู้เช่ียวชาญ 

IOC แปลผล คนที่ 
1 

คนที่ 
2 

คนที่ 
3 

3.  การท างานร่วมกัน      
 3.1. นักเรียนช่วยเหลือเพื่อนในทีมให้
ท างานส าเร็จด้วยความเต็มใจ 

+1 +1 +1 1.00 น าไปใช้ได ้

 3.2 นักเรียนมีความรักใคร่กลมเกลียวและ
ช่วยเหลือสมาชิกในทีมเสมอ 

+1 +1 +1 1.00 น าไปใช้ได ้

 3.3 นักเรียนเข้าร่วมท ากิจกรรมต่างๆ กับ
เพื่อนในทีมเป็นประจ า 

+1 +1 +1 1.00 น าไปใช้ได ้

 3.4 นักเรียนพัฒนาทักษะของตัวเองเพื่อเพิ่ม
ความสามารถของทีม 

+1 +1 +1 1.00 น าไปใช้ได ้

 3.5 นักเรียนตรงต่อเวลาในการท างาน
ร่วมกันเป็นทีม 

+1 +1 +1 1.00 น าไปใช้ได ้

 3.6 นักเรียนท างานที่ได้รับมอบหมายอย่าง
เต็มความสามารถ 

+1 +1 +1 1.00 น าไปใช้ได ้

4.  ผลการท างานเป็นทีม      
 4.1 งานเสร็จทันในเวลาที่ก าหนด +1 +1 +1 1.00 น าไปใช้ได ้
 4.2 นักเรียนมีความสัมพันธ์ที่ดีกับสมาชิก
ในทีม 

+1 +1 +1 1.00 น าไปใช้ได ้

 4.3 เกิดการพัฒนาทักษะในการท างานป็
นทีม 

+1 +1 +1 1.00 น าไปใช้ได ้

 4.4 เกิดการเรียนรู้ในงานที่ท าร่วมกัน +1 +1 +1 1.00 น าไปใช้ได ้
 4.5 สามารถแก้ปัญหาได้เมือ่เกิดความ
ขัดแย้งภายในทีม 

+1 +1 +1 1.00 น าไปใช้ได ้

 4.6 เกิดความรัก ความห่วงใยและความ
สามัคคีภายในทีม 

+1 +1 +1 1.00 น าไปใช้ได ้

ค่าเฉลี่ย IOC 1.00  
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ตารางภาคผนวกที่  8  ผลการวิเคราะห์ค่าดัชนีความสอดคลอ้ง (IOC)  ของการประเมินคุณภาพแบบ
ประเมินความสามัคคีส าหรับนักเรียนประเมินตนเอง ส าหรับผู้เช่ียวชาญด้านจิตวิทยา 

รายการประเมิน 
ผู้เช่ียวชาญ 

IOC แปลผล คนที่ 
1 

คนที่ 
2 

คนที่ 
3 

1.  เข้าใจบทบาทหน้าที่ในทีม      
 1.1 นักเรียนเข้าใจบทบาทของตนเองใน
ฐานะผู้น าและผู้ตามที่ด ี

+1 +1 +1 1.00 น าไปใช้ได ้

 1.2 นักเรียนปฏิบัติตามข้อตกลงของการ
เป็นสมาชิกในทีม 

+1 +1 +1 1.00 น าไปใช้ได ้

 1.3 นักเรียนประชุม ปรึกษาหารือกันใน
กิจกรรมที่ได้รับมอบหมาย 

+1 +1 +1 1.00 น าไปใช้ได ้

 1.4 นักเรียนมีอัธยาศัยที่ดีในการ
ติดต่อสื่อสารกับเพื่อน 

+1 +1 +1 1.00 น าไปใช้ได ้

 1.5 นักเรียนปรึกษาหารือกันเพื่อแก้ไข
ข้อผิดพลาดภายหลังการท างาน 

+1 +1 +1 1.00 น าไปใช้ได ้

2.  การยอมรับฟังความคิดเห็น      
 2.1 นักเรียนยอมรับฟังความคิดเห็นที่
แตกต่างของเพื่อนในทีม 

+1 +1 +1 1.00 น าไปใช้ได ้

 2.2 นักเรียนมีเหตุผลเพียงพอในการ
ตัดสินใจ 

+1 +1 +1 1.00 น าไปใช้ได ้

 2.3 นักเรียนยอมรับเสียงส่วนใหญ่ 
(ผลสรุป) ของทีม 

+1 +1 +1 1.00 น าไปใช้ได ้

 2.4 นักเรียนยอมรับผลงานของสมาชิกใน
ทีม 

+1 +1 +1 1.00 น าไปใช้ได ้

 2.5 นักเรียนพร้อมที่จะปรับตัวเพื่อให้
สามารถอยู่ร่วมในทีมได ้

+1 0 +1 0.67 น าไปใช้ได ้

 2.6 นักเรียนให้อภัยเพื่อนที่ท างานผิดพลาด +1 -1 0 0.00 ใช้ไม่ได้ 
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รายการประเมิน 
ผู้เช่ียวชาญ 

IOC แปลผล คนที่ 
1 

คนที่ 
2 

คนที่ 
3 

3.  การท างานร่วมกัน      
 3.1. นักเรียนช่วยเหลือเพื่อนในทีมให้
ท างานส าเร็จด้วยความเต็มใจ 

+1 +1 +1 1.00 น าไปใช้ได ้

 3.2 นักเรียนมีความรักใคร่กลมเกลียวและ
ช่วยเหลือสมาชิกในทีมเสมอ 

+1 +1 +1 1.00 น าไปใช้ได ้

 3.3 นักเรียนเข้าร่วมท ากิจกรรมต่างๆ กับ
เพื่อนในทีมเป็นประจ า 

+1 +1 +1 1.00 น าไปใช้ได ้

 3.4 นักเรียนพัฒนาทักษะของตัวเองเพื่อเพิ่ม
ความสามารถของทีม 

+1 +1 +1 1.00 น าไปใช้ได ้

 3.5 นักเรียนตรงต่อเวลาในการท างาน
ร่วมกันเป็นทีม 

+1 +1 +1 1.00 น าไปใช้ได ้

 3.6 นักเรียนท างานที่ได้รับมอบหมายอย่าง
เต็มความสามารถ 

+1 +1 +1 1.00 น าไปใช้ได ้

4.  ผลการท างานเป็นทีม      
 4.1 งานเสร็จทันในเวลาที่ก าหนด +1 +1 +1 1.00 น าไปใช้ได ้
 4.2 นักเรียนมีความสัมพันธ์ที่ดีกับสมาชิก
ในทีม 

+1 +1 +1 1.00 น าไปใช้ได ้

 4.3 เกิดการพัฒนาทักษะในการท างานป็
นทีม 

+1 +1 +1 1.00 น าไปใช้ได ้

 4.4 เกิดการเรียนรู้ในงานที่ท าร่วมกัน +1 +1 +1 1.00 น าไปใช้ได ้
 4.5 สามารถแก้ปัญหาได้เมือ่เกิดความ
ขัดแย้งภายในทีม 

+1 +1 +1 1.00 น าไปใช้ได ้

 4.6 เกิดความรัก ความห่วงใยและความ
สามัคคีภายในทีม 

+1 0 +1 0.67 น าไปใช้ได ้

ค่าเฉลี่ย IOC 1.00  
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ตารางภาคผนวกที่  9  สรุปผลการวิเคราะห์ค่าดัชนีความสอดคล้อง (IOC)  ของการประเมินคุณภาพ
แบบประเมินความสามัคคีส าหรับนักเรียนประเมินตนเอง 

 
รายการ
ประเมิน
ข้อที ่

ผู้เช่ียวชาญ 
ด้านวัดและประเมินผล 

ผู้เช่ียวชาญ 
ด้านจิตวิทยา 

ค่า 
IOC 

 
สรุปผล 

 คนที่ 1 คนที่ 2 คนที่ 3 คนที่ 1 คนที่ 2 คนที่ 3 

1         
1.1 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.2 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.3 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.4 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
1.5 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้

2         
2.1 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
2.2 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
2.3 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
2.4 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
2.5 +1 +1 +1 +1 0 +1 0.83 น าไปใช้ได ้

2.6 +1 +1 +1 +1 -1 0 0.50 น าไปใช้ได ้

3         
3.1 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
3.2 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
3.3 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
3.4 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
3.5 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
3.6 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
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รายการ
ประเมิน
ข้อที ่

ผู้เช่ียวชาญ 
ด้านวัดและประเมินผล 

ผู้เช่ียวชาญ 
ด้านจิตวิทยา 

ค่า 
IOC 

 
สรุปผล 

 คนที่ 1 คนที่ 2 คนที่ 3 คนที่ 1 คนที่ 2 คนที่ 3 

4         
4.1 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
4.2 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
4.2 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
4.4 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
4.5 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
4.6 +1 +1 +1 +1 0 +1 0.83 น าไปใช้ได ้

ค่าเฉลี่ย IOC 0.96  
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ตารางภาคผนวกที่  10  ผลการวิเคราะห์ค่าดัชนีความสอดคลอ้ง (IOC)  ของการประเมินคุณภาพแบบ
ประเมินความสามัคคีส าหรับครูประเมินนักเรียน ส าหรับผู้เช่ียวชาญด้านวัดและประเมินผล 

รายการประเมิน 
ผู้เช่ียวชาญ 

IOC แปลผล คนที่ 
1 

คนที่ 
2 

คนที่ 
3 

1. สมาชิกในทีมมีการจัดสรรหน้าที่ความ
รับผิดชอบอย่างเหมาะสม 

+1 +1 +1 1.00 น าไปใช้ได ้

2. สมาชิกในทีมมีความตรงต่อเวลา +1 +1 +1 1.00 น าไปใช้ได ้
3. สมาชิกในทีมเข้าใจบทบาทของตนเองในการ
เป็นผู้น าหรือผู้ตามที่ดี 

+1 +1 +1 1.00 น าไปใช้ได ้

4. สมาชิกในทีมมีความกระตือรือร้นและมุ่งมัน่
ท ากิจกรรมที่ได้รับมอบหมาย 

+1 +1 +1 1.00 น าไปใช้ได ้

5. สมาชิกในทีมมีการปรึกษาหารือเพื่อวางแผน
ในการท างาน 

+1 +1 +1 1.00 น าไปใช้ได ้

6. งานที่ได้รับมอบหมายส่งทันในเวลาที่ก าหนด 0 +1 +1 0.67 น าไปใช้ได ้
7. สมาชิกในทีมเข้าร่วมท ากิจกรรมต่างๆ กับ
เพื่อนในทีมเป็นประจ า 

+1 +1 +1 1.00 น าไปใช้ได ้

8. สมาชิกทุกคนร่วมกันรับผิดชอบในผลงานของ
ทีม 

+1 +1 +1 1.00 น าไปใช้ได ้

9. สมาชิกในทีมรู้จักและมีความสัมพันธ์ที่ดีต่อกนั +1 +1 +1 1.00 น าไปใช้ได ้
10. สมาชิกในทีมมีการรับฟังความคิดเห็นของ
ผู้อื่นและเคารพในสิทธิของผู้อื่น 

+1 +1 +1 1.00 น าไปใช้ได ้

11. สมาชิกในทีมยอมรับในความคล้ายคลึงและ
ความแตกต่างของตนเองและผู้อื่น  

+1 +1 +1 1.00 น าไปใช้ได ้

12. สมาชิกในทีมมีการแสดงความคิดเห็นซึ่งกัน
และกัน  

+1 +1 +1 1.00 น าไปใช้ได ้

13. สมาชิกในทีมร่วมกันปรับปรุงผลงาน +1 +1 +1 1.00 น าไปใช้ได ้
ค่าเฉลี่ย IOC 0.97  
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ตารางภาคผนวกที่  11  ผลการวิเคราะห์ค่าดัชนีความสอดคลอ้ง (IOC)  ของการประเมินคุณภาพแบบ
ประเมินความสามัคคีส าหรับครูประเมินนักเรียน ส าหรับผู้เช่ียวชาญด้านจิตวิทยา 

รายการประเมิน 
ผู้เช่ียวชาญ 

IOC แปลผล คนที่ 
1 

คนที่ 
2 

คนที่ 
3 

1. สมาชิกในทีมมีการจัดสรรหน้าที่ความ
รับผิดชอบอย่างเหมาะสม 

+1 +1 +1 1.00 น าไปใช้ได ้

2. สมาชิกในทีมมีความตรงต่อเวลา +1 +1 +1 1.00 น าไปใช้ได ้
3. สมาชิกในทีมเข้าใจบทบาทของตนเองในการ
เป็นผู้น าหรือผู้ตามที่ดี 

+1 +1 +1 1.00 น าไปใช้ได ้

4. สมาชิกในทีมมีความกระตือรือร้นและมุ่งมัน่
ท ากิจกรรมที่ได้รับมอบหมาย 

+1 +1 +1 1.00 น าไปใช้ได ้

5. สมาชิกในทีมมีการปรึกษาหารือเพื่อวางแผน
ในการท างาน 

+1 +1 +1 1.00 น าไปใช้ได ้

6. งานที่ได้รับมอบหมายส่งทันในเวลาที่ก าหนด 0 +1 +1 0.67 น าไปใช้ได ้
7. สมาชิกในทีมเข้าร่วมท ากิจกรรมต่างๆ กับ
เพื่อนในทีมเป็นประจ า 

+1 +1 +1 1.00 น าไปใช้ได ้

8. สมาชิกทุกคนร่วมกันรับผิดชอบในผลงานของ
ทีม 

+1 +1 +1 1.00 น าไปใช้ได ้

9. สมาชิกในทีมรู้จักและมีความสัมพันธ์ที่ดีต่อกนั +1 +1 +1 1.00 น าไปใช้ได ้
10. สมาชิกในทีมมีการรับฟังความคิดเห็นของ
ผู้อื่นและเคารพในสิทธิของผู้อื่น 

+1 +1 +1 1.00 น าไปใช้ได ้

11. สมาชิกในทีมยอมรับในความคล้ายคลึงและ
ความแตกต่างของตนเองและผู้อื่น  

+1 0 0 0.33 ใช้ไม่ได้ 

12. สมาชิกในทีมมีการแสดงความคิดเห็นซึ่งกัน
และกัน  

+1 0 0 0.33 ใช้ไม่ได้ 

13. สมาชิกในทีมร่วมกันปรับปรุงผลงาน +1 +1 +1 1.00 น าไปใช้ได ้
ค่าเฉลี่ย IOC 0.87  
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ตารางภาคผนวกที่  12  สรุปผลการวิเคราะห์ค่าดัชนีความสอดคลอ้ง (IOC)  ของการประเมินคุณภาพ
แบบประเมินความสามัคคีส าหรับครูประเมินนักเรียน 

รายการ
ประเมิน
ข้อที ่

ผู้เช่ียวชาญ 
ด้านวัดและประเมินผล 

ผู้เช่ียวชาญ 
ด้านจิตวิทยา 

ค่า 
IOC 

 
สรุปผล 

 คนที่ 1 คนที่ 2 คนที่ 3 คนที่ 1 คนที่ 2 คนที่ 3 

1 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
2 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
3 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
4 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
5 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
6 0 +1 +1 0 +1 +1 0.67 น าไปใช้ได ้
7 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
8 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
9 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
10 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
11 +1 +1 +1 +1 0 0 0.67 น าไปใช้ได ้
12 +1 +1 +1 +1 0 0 0.67 น าไปใช้ได ้
13 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้

ค่าเฉลี่ย IOC 0.92  
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ตารางภาคผนวกที่  13  ผลการวิเคราะห์ค่าดัชนีความสอดคลอ้ง (IOC)  ของการประเมินคุณภาพ 
แบบประเมินผลงานนักเรียน ส าหรับผู้เช่ียวชาญด้านวัดและประเมินผล 

รายการประเมิน 
ผู้เช่ียวชาญ 

IOC แปลผล คนที่ 
1 

คนที่ 
2 

คนที่ 
3 

1. ความสมบูรณ์ของช้ินงาน 
    มีการก าหนดวัตถุประสงค์ชัดเจน มี
รายละเอียดเนื้อหาครบถ้วน มีการจัด
องค์ประกอบและออกแบบได้สวยงาม 

+1 +1 +1 1.00 น าไปใช้ได ้

2. ความเหมาะสมของเนื้อหาที่น าเสนอ 
    เนื้อหาสาระสัมพันธ์กับช่ือเร่ืองที่ก าหนด 
เป็นประโยชน์และทันสมัยมีข้อมูลสนับสนุน
และแหล่งอ้างอิงชัดเจน 

+1 +1 +1 1.00 น าไปใช้ได ้

3. การจัดวางข้อความ รูปภาพเหมาะสม 
    มีการใช้ขนาดตัวอักษรที่อ่านง่าย ชัดเจน จัด
วางข้อความ รูปภาพ ภาพเคลื่อนไหวมาใช้
ประกอบกันและใส่เทคนิคพิเศษอย่าง
เหมาะสม 

+1 +1 +1 1.00 น าไปใช้ได ้

4. มีการเช่ือมโยงอย่างเหมาะสม 
   มีการใส่ปุ่มเพ่ือควบคุมการท างานในสไสลด์ 
และสามารถเช่ือมโยงข้อมลูกันได้อย่าง
เหมาะสม 

+1 +1 +1 1.00 น าไปใช้ได ้

5. การแทรกเทคนิคพิเศษอย่างเหมาะสม 
   มีการแทรกเสียงและวิดีโออย่างเหมาะสม
รวมทั้งมีการใช้ Text Entry และ Click Box 
เพื่อเพิ่มปฏิสัมพันธ์ระหว่างผู้ใช้กับสื่อได้อย่าง
เหมาะสม 

+1 +1 +1 1.00 น าไปใช้ได ้

ค่าเฉลี่ย IOC 1.00  
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ตารางภาคผนวกที่  14  ผลการวิเคราะห์ค่าดัชนีความสอดคลอ้ง (IOC)  ของการประเมินคุณภาพ 
แบบประเมินผลงานนักเรียน ส าหรับผู้เช่ียวชาญด้านสื่อและเนือ้หา 

รายการประเมิน 
ผู้เช่ียวชาญ 

IOC แปลผล คนที่ 
1 

คนที่ 
2 

คนที่ 
3 

1. ความสมบูรณ์ของช้ินงาน 
    มีการก าหนดวัตถุประสงค์ชัดเจน มี
รายละเอียดเนื้อหาครบถ้วน มีการจัด
องค์ประกอบและออกแบบได้สวยงาม 

+1 +1 +1 1.00 น าไปใช้ได ้

2. ความเหมาะสมของเนื้อหาที่น าเสนอ 
    เนื้อหาสาระสัมพันธ์กับช่ือเร่ืองที่ก าหนด 
เป็นประโยชน์และทันสมัยมีข้อมูลสนับสนุน
และแหล่งอ้างอิงชัดเจน 

+1 +1 +1 1.00 น าไปใช้ได ้

3. การจัดวางข้อความ รูปภาพเหมาะสม 
    มีการใช้ขนาดตัวอักษรที่อ่านง่าย ชัดเจน จัด
วางข้อความ รูปภาพ ภาพเคลื่อนไหวมาใช้
ประกอบกันและใสเ่ทคนิคพิเศษอย่าง
เหมาะสม 

+1 +1 +1 1.00 น าไปใช้ได ้

4. มีการเช่ือมโยงอย่างเหมาะสม 
   มีการใส่ปุ่มเพ่ือควบคุมการท างานในสไสลด์ 
และสามารถเช่ือมโยงข้อมลูกันได้อย่าง
เหมาะสม 

+1 +1 +1 1.00 น าไปใช้ได ้

5. การแทรกเทคนิคพิเศษอย่างเหมาะสม 
   มีการแทรกเสียงและวิดีโออย่างเหมาะสม
รวมทั้งมีการใช้ Text Entry และ Click Box 
เพื่อเพิ่มปฏิสัมพันธ์ระหว่างผู้ใช้กับสื่อได้อย่าง
เหมาะสม 

+1 +1 +1 1.00 น าไปใช้ได ้

ค่าเฉลี่ย IOC 1.00  
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ตารางภาคผนวกที่  15  สรุปผลการวิเคราะห์ค่าดัชนีความสอดคลอ้ง (IOC)  ของการประเมินคุณภาพ 
แบบประเมินผลงานนักเรียน 

รายการ
ประเมิน
ข้อที ่

ผู้เช่ียวชาญ 
ด้านวัดและประเมินผล 

ผู้เช่ียวชาญ 
ด้านสื่อและเนือ้หา 

ค่า 
IOC 

 
สรุปผล 

 คนที่ 1 คนที่ 2 คนที่ 3 คนที่ 1 คนที่ 2 คนที่ 3 

1 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
2 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
3 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
4 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้
5 +1 +1 +1 +1 +1 +1 1.00 น าไปใช้ได ้

ค่าเฉลี่ย IOC 1.00  
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ตารางภาคผนวกที่  16  ผลการวิเคราะห์ค่าดัชนีความสอดคลอ้ง (IOC)  ของการประเมินคุณภาพ
แบบทดสอบ  

ข้
อที่ 

ผู้เช่ียวชาญด้านวัดและ
ประเมินผล 

IOC แปลผล 

ผู้เช่ียวชาญด้านสื่อ 
และเนื้อหา 

IOC แปลผล 
คนที่1 คนที่2 คนที่ 3 คนที่ 

1 
คนที่ 2 คนที่ 3 

1 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
2 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
3 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
4 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
5 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
6 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
7 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
8 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
9 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้

10 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
11 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
12 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
13 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
14 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
15 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
16 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
17 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
18 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
19 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
20 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
21 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
22 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
23 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
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ข้อ
ที ่

ผู้เช่ียวชาญด้านวัดและ
ประเมินผล 

IOC แปลผล 

ผู้เช่ียวชาญด้านสื่อ 
และเนื้อหา 

IOC แปลผล 
คนที่1 คนที่2 คนที่ 3 คนที่ 

1 
คนที่ 2 คนที่ 3 

24 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
25 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
26 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
27 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
28 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
29 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
30 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
31 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
32 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
33 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
34 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
35 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
36 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
37 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
38 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
39 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้
40 +1 +1 +1 1.00 น าไปใช้ได ้ +1 +1 +1 1.00 น าไปใช้ได ้

ค่าเฉลี่ย IOC 1.00  ค่าเฉลี่ย IOC 1.00  
 
 จากนั้นท าการคัดเลอืกข้อสอบจ านวน 30 ข้อ ตามวัตถุประสงค์ ดังนี้ ข้อที่ 1 , 2 , 3 , 4 , 5 ,  
6 , 7 , 8 , 9 , 11 , 14 , 15 , 16 , 17 , 18 , 19 , 20 , 21 , 22 , 23 , 25 , 26 , 29 ,31 , 32 , 33 , 36 , 37  และ 
40 
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ตารางภาคผนวกที่  17  แสดงผลการประเมินเว็บช่วยสอนแบบการเรียนรู้เป็นทีมของผู้เช่ียวชาญด้าน
สื่อและเนื้อหา 

รายการประเมิน ค่าเฉลี่ย S.D. แปลผล 
1.  เนื้อหา    

1.1  ความสอดคล้องของเนื้อหากับจุดประสงค์ 4.00 .00 มากที่สุด 
1.2  เนื้อหาครบถ้วนสมบูรณ์ 3.67 .58 มากที่สุด 

1.3  ความเหมาะสมกับระดับผู้เรียน 3.67 .58 มากที่สุด 

1.4  การจัดล าดับหัวข้อ 4.00 .00 มากที่สุด 

1.5  ความเหมาะสมของปริมาณเนือ้หา 4.00 .00 มากที่สุด 

1.6  ความถูกต้องของเนื้อหา 4.00 .00 มากที่สุด 

1.7  ความชัดเจนในการอธิบายเนื้อหา 4.00 .00 มากที่สุด 

1.8  ความยากง่ายของเนื้อหา 3.67 .58 มากที่สุด 

1.9  ความต่อเนื่องของเนื้อหา 3.00 .00 มาก 
1.10 ความถูกต้องของภาษาที่ใช้ 3.67 .58 มากที่สุด 
1.11 ความเหมาะสมของการสรุปเนื้อหา 3.00 .00 มาก 

เฉลี่ยรวมด้านเนื้อหา 3.70 .10 มากที่สุด 
2.  การจัดวางรูปแบบเว็บเพจ    

    2.1  การน าเสนอมีความน่าสนใจ 3.33 .58 มาก 
2.2  น าเสนอบทเรียนเข้าใจง่าย 4.00 .00 มากที่สุด 

2.3  ผู้เรียนมีปฏิสัมพันธ์กับบทเรียน 4.00 .00 มากที่สุด 

2.4 สีที่ใช้มีความเหมาะสม สวยงาม 3.33 .58 มาก 
เฉลี่ยรวมการจัดวางรูปแบบเว็บเพจ 3.67 .14 มากที่สุด 

3.  ภาษา/ตัวอักษร    

3.1  ขนาดตัวอักษรมีความเหมาะสม  4.00 .00 มากที่สุด 

3.2   ลักษณะสีของตัวอักษรมีความเหมาะสม 4.00 .00 มากที่สุด 

3.3   ลักษณะของตัวอักษรมีความเหมาะสม 4.00 .00 มากที่สุด 

รายการประเมิน ค่าเฉลี่ย S.D. แปลผล 
3.4   การวางต าแหน่งของตัวอักษร 4.00 .00 มากที่สุด 

3.5   ความถูกต้องของภาษาที่น ามาใช้ 4.00 .00 มากที่สุด 
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รายการประเมิน ค่าเฉลี่ย S.D. แปลผล 
3.6   ความชัดเจนของตัวอักษร 3.67 .58 มากที่สุด 

เฉลี่ยรวมด้านภาษา/ตัวอักษร 3.94 .10 มากที่สุด 
4.  รูปภาพประกอบ    

4.1  รูปภาพสอดคล้องกับเนื้อหา 4.00 .00 มากที่สุด 

4.2  ความคมชัดของรูปภาพประกอบและพื้นหลัง 3.33 .58 มาก 

4.3  การวางต าแหน่งของรูปภาพ 4.00 .00 มากที่สุด 

4.4  ความถูกต้องของภาพที่น ามาใช้ 4.00 .00 มากที่สุด 

เฉลี่ยรวมด้านรูปภาพประกอบ 3.83 .14 มากที่สุด 
5.  การเชื่อมโยง    

5.1 การเช่ือมโยงเนื้อหาแต่ละบท 4.00 .00 มากที่สุด 

5.2 การเช่ือโยงภายในเว็บเพจ 4.00 .00 มากที่สุด 

5.3 การเช่ือมโยงกับเว็บไซต์อื่นๆ 4.00 .00 มากที่สุด 

เฉลี่ยรวมด้านการเช่ือมโยง 4.00 .00 มากที่สุด 
เฉลี่ยรวมทุกด้าน 3.83 .05 มากที่สุด 

 
ตารางภาคผนวกที่  18  แสดงค่าความยาก (p) และค่าอ านาจจ าแนก (r) จากการท าแบบทดสอบ  

จ านวน 30 ข้อ  ที่น าไปทดสอบกับเรียนที่ไม่ใช่กลุ่มตัวอย่างจริง  จ านวน  30 คน  
ข้อที ่ H L ผู้ตอบถูก p r สรุปผล 

1 12 5 17 0.57 0.47 ใช้ได้ 
2 11 4 15 0.50 0.47 ใช้ได้ 
3 10 5 15 0.50 0.33 ใช้ได้ 
4 12 6 18 0.60 0.40 ใช้ได้ 
5 13 6 19 0.63 0.47 ใช้ได้ 
6 9 3 12 0.40 0.40 ใช้ได้ 
7 10 5 15 0.50 0.33 ใช้ได้ 
8 13 5 18 0.60 0.53 ใช้ได้ 
9 12 3 15 0.50 0.60 ใช้ได้ 

10 11 4 15 0.50 0.47 ใช้ได้ 
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ข้อที ่ H L ผู้ตอบถูก p r สรุปผล 
11 9 4 13 0.43 0.33 ใช้ได้ 
12 14 5 19 0.63 0.60 ใช้ได้ 
13 13 5 18 0.60 0.53 ใช้ได้ 
14 12 6 18 0.60 0.40 ใช้ได้ 
15 10 3 13 0.43 0.47 ใช้ได้ 
16 9 2 11 0.37 0.47 ใช้ได้ 
17 13 5 18 0.60 0.53 ใช้ได้ 
18 8 2 10 0.33 0.40 ใช้ได้ 
19 13 5 18 0.60 0.53 ใช้ได้ 
20 12 5 17 0.57 0.47 ใช้ได้ 
21 11 6 17 0.57 0.33 ใช้ได้ 
22 10 3 13 0.43 0.47 ใช้ได้ 
23 9 4 13 0.43 0.33 ใช้ได้ 
24 12 6 18 0.60 0.40 ใช้ได้ 
25 10 4 14 0.47 0.40 ใช้ได้ 
26 11 5 16 0.53 0.40 ใช้ได้ 
27 13 6 19 0.63 0.47 ใช้ได้ 
28 12 4 16 0.53 0.53 ใช้ได้ 
29 9 3 12 0.40 0.40 ใช้ได้ 
30 8 2 10 0.33 0.40 ใช้ได้ 

 
ข้อสอบที่ผ่านเกณฑ์ตอ้งมีค่าความยากง่าย (p) ระหว่าง 0.20-0.80 และ ค่าอ านาจจ าแนก (r)  

ตั้งแต่ 0.20 ขึ้นไป  
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ตารางภาคผนวกที่  19  แสดงสัดส่วนของผู้ที่ตอบถูก (p) และสัดส่วนของผู้ที่ตอบผิด (q) จากการท า
แบบทดสอบ จ านวน30 ข้อ ที่น าไปทดสอบกับนกัศึกษาที่ไม่ใช่กลุม่ตัวอย่างจริง จ านวน 
30 คน 

ข้อที ่ H L ผู้ตอบถูก p q pq 
1 12 5 17 0.57 0.43 0.25 
2 11 4 15 0.50 0.50 0.25 
3 10 5 15 0.50 0.50 0.25 
4 12 6 18 0.60 0.40 0.24 
5 13 6 19 0.63 0.37 0.23 
6 9 3 12 0.40 0.60 0.24 
7 10 5 15 0.50 0.50 0.25 
8 13 5 18 0.60 0.40 0.24 
9 12 3 15 0.50 0.50 0.25 

10 11 4 15 0.50 0.50 0.25 
11 9 4 13 0.43 0.57 0.25 
12 14 5 19 0.63 0.37 0.23 
13 13 5 18 0.60 0.40 0.24 
14 12 6 18 0.60 0.40 0.24 
15 10 3 13 0.43 0.57 0.25 
16 9 2 11 0.37 0.63 0.23 
17 13 5 18 0.60 0.40 0.24 
18 8 2 10 0.33 0.67 0.22 
19 13 5 18 0.60 0.40 0.24 
20 12 5 17 0.57 0.43 0.25 
21 11 6 17 0.57 0.43 0.25 
22 10 3 13 0.43 0.57 0.25 
23 9 4 13 0.43 0.57 0.25 
24 12 6 18 0.60 0.40 0.24 
25 10 4 14 0.47 0.53 0.25 
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ข้อที ่ H L ผู้ตอบถูก p q pq 
26 11 5 16 0.53 0.47 0.25 
27 13 6 19 0.63 0.37 0.23 
28 12 4 16 0.53 0.47 0.25 
29 9 3 12 0.40 0.60 0.24 
30 8 2 10 0.33 0.67 0.22 

     pq 7.25 
 
ตารางภาคผนวกที่  20  แสดงค่าคะแนนก าลังสอง  จากการท าแบบทดสอบจ านวน 30 ข้อ ที่น าไป

ทดสอบกับนักเรียนที่ไม่ใช่กลุ่มตัวอย่างจริง  จ านวน 30 คน 
นักเรียนคนที่ X X2 

1 27 729 
2 27 729 
3 26 676 
4 25 625 
5 25 625 
6 24 576 
7 23 529 
8 23 529 
9 23 529 
10 23 529 
11 23 529 
12 22 484 
13 22 484 
14 21 441 
15 20 400 
16 19 361 
17 18 324 
18 16 256 



209 
 

นักเรียนคนที่ X X2 

19 15 225 
20 13 169 
21 12 144 
22 11 121 
23 11 121 
24 10 100 
25 10 100 
26 9 81 
27 9 81 
28 9 81 
29 8 64 
30 8 64 
 X = 532 X2 = 10,706 

 

การค านวณค่าความเช่ือมั่นของแบบทดสอบใช้สูตร KR -20 (Kude-Richardson Formula 20) 

                    Rtt  = 
1n

n


  







 


2
1

tS

pq  

 เมื่อ     n = 30 และ pq = 7.25     

  S2   =  
2

22

N

xxN    

  S2   =   
2

2

30

53210,706 x 30        

  S2  =   42.40 
  

  Rtt   = 
130

30


 










40.42

25.7
1  

  Rtt   = 0.86 
 ค่าความเช่ือมั่นของแบบทดสอบมีค่าเท่ากับ 0.86 
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ตารางภาคผนวกที่ 21 แสดงคะแนนแบบทดสอบวัดผลการเรียนรู้ก่อนเรียนและหลังเรียนด้วยบทเรียน
บนเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 

นักเรียนคนที่ 
คะแนนกอ่นเรียน 

30 คะแนน 
คิดเป็นร้อยละ 

คะแนนหลังเรียน 
30 คะแนน 

คิดเป็นร้อยละ 

1 15 50.00 25 83.33 
2 10 33.33 24 80.00 
3 6 20.00 29 96.67 
4 14 46.67 28 93.33 
5 0 0.00 26 86.67 
6 9 30.00 25 83.33 
7 13 43.33 28 93.33 
8 18 60.00 28 93.33 
9 10 33.33 30 100.00 

10 10 33.33 29 96.67 
11 8 26.67 24 80.00 
12 10 33.33 29 96.67 
13 9 30.00 30 100.00 
14 5 16.67 27 90.00 
15 7 23.33 30 100.00 
16 7 23.33 25 83.33 
17 6 20.00 28 93.33 
18 6 20.00 29 96.67 
19 11 36.67 28 93.33 
20 15 50.00 29 96.67 
21 16 53.33 27 90.00 
22 18 60.00 29 96.67 
23 15 50.00 30 100.00 
24 13 43.33 28 93.33 
25 17 56.67 30 100.00 
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นักเรียนคนที่ 
คะแนนกอ่นเรียน 

30 คะแนน 
คิดเป็นร้อยละ 

คะแนนหลังเรียน 
30 คะแนน 

คิดเป็นร้อยละ 

26 13 43.33 28 93.33 
27 8 26.67 29 96.67 
28 7 23.33 29 96.67 
29 11 36.67 27 90.00 
30 9 30.00 26 86.67 
31 10 33.33 25 83.33 
32 10 33.33 28 93.33 
33 12 40.00 29 96.67 
เฉลี่ย 10.55 35.15 27.76 92.53 
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ตารางภาคผนวกที ่ 22  แสดงคะแนนผลการประเมินผลงานเป็นทีม 

กลุ่มที ่

คะแนนการประเมิน 

รวม 
สรุประดับ
คุณภาพ 

คว
าม
สม

บูร
ณ์ข

อง
ชิ้น

งา
น 

คว
าม
เห
มา
ะส

มข
อง

เน
ื้อห

าท
ี่น า
เส
นอ

 

กา
รจั
ดว
าง
ข้อ

คว
าม
 

รูป
ภา
พแ

ละ
ใส
่เอ็ฟ

เฟ
็ค

อย่
าง
เห
มา
ะส

ม 
มีก

าร
เชื่อ

มโ
ยง
อย่
าง

เห
มา
ะส

ม 

กา
รแ
ทร

กเท
คน

ิคพ
ิเศษ

อย่
าง
เห
มา
ะส

ม 

 กลุ่มที่ 1 
2 4 4 3 3 4 18.00 ดีมาก 
3 4 4 3 4 4 19.00 ดีมาก 
4 4 4 3 3 4 18.00 ดีมาก 
5 4 4 3 3 4 18.00 ดีมาก 
6 4 4 3 4 4 19.00 ดีมาก 
7 4 4 4 4 4 20.00 ดีมาก 
8 4 4 4 4 4 20.00 ดีมาก 
คร ู 4 4 4 4 4 20.00 ดีมาก 
เฉลี่ย 4.00 4.00 3.38 3.63 4.00 19.00 ดีมาก 

 กลุ่มที่ 2 
1 4 4 3 4 3 18.00 ดีมาก 
3 4 4 3 4 4 19.00 ดีมาก 
4 3 4 3 4 3 17.00 ดี 
5 4 4 3 4 3 18.00 ดีมาก 
6 3 3 3 4 4 17.00 ดี 
7 3 4 4 4 4 19.00 ดีมาก 
8 4 4 3 4 4 19.00 ดีมาก 
คร ู 4 4 4 4 4 20.00 ดีมาก 
เฉลี่ย 3.63 3.88 3.25 4.00 3.63 18.38 ดีมาก 
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กลุ่มที ่

คะแนนการประเมิน 

รวม 
สรุประดับ
คุณภาพ 

คว
าม
สม

บูร
ณ์ข

อง
ชิ้น

งา
น 

คว
าม
เห
มา
ะส

มข
อง

เน
ื้อห

าท
ี่น า
เส
นอ

 

กา
รจั
ดว
าง
ข้อ

คว
าม
 

รูป
ภา
พแ

ละ
ใส
่เอ็ฟ

เฟ
็ค

อย่
าง
เห
มา
ะส

ม 
มีก

าร
เชื่อ

มโ
ยง
อย่
าง

เห
มา
ะส

ม 

กา
รแ
ทร

กเท
คน

ิคพ
ิเศษ

อย่
าง
เห
มา
ะส

ม 

 กลุ่มที่ 3 
1 4 4 4 4 4 20.00 ดีมาก 
2 3 3 3 3 4 16.00 ดี 
4 3 3 3 4 4 17.00 ดี 
5 4 4 4 3 4 19.00 ดีมาก 
6 3 3 3 4 4 17.00 ดี 
7 4 4 3 3 3 17.00 ดี 
8 4 4 4 3 4 19.00 ดีมาก 
คร ู 4 4 4 3 3 18.00 ดีมาก 
เฉลี่ย 3.63 3.63 3.50 3.38 3.75 17.88 ดี 

 กลุ่มที่ 4 
1 4 4 4 4 4 20.00 ดีมาก 
2 3 3 3 3 4 16.00 ดี 
3 4 4 4 4 3 19.00 ดีมาก 
5 4 4 4 4 4 20.00 ดีมาก 
6 3 3 3 4 3 16.00 ดี 
7 4 4 4 3 3 18.00 ดีมาก 
8 4 4 4 4 3 19.00 ดีมาก 
คร ู 4 4 4 4 4 20.00 ดีมาก 
เฉลี่ย 3.75 3.75 3.75 3.75 3.50 18.50 ดีมาก 
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กลุ่มที ่

คะแนนการประเมิน 

รวม 
สรุประดับ
คุณภาพ 

คว
าม
สม

บูร
ณ์ข

อง
ชิ้น

งา
น 

คว
าม
เห
มา
ะส

มข
อง

เน
ื้อห

าท
ี่น า
เส
นอ

 

กา
รจั
ดว
าง
ข้อ

คว
าม
 

รูป
ภา
พแ

ละ
ใส
่เอ็ฟ

เฟ
็ค

อย่
าง
เห
มา
ะส

ม 
มีก

าร
เชื่อ

มโ
ยง
อย่
าง

เห
มา
ะส

ม 

กา
รแ
ทร

กเท
คน

ิคพ
ิเศษ

อย่
าง
เห
มา
ะส

ม 

 กลุ่มที่ 5 
1 4 4 3 4 4 19.00 ดีมาก 
2 4 3 4 3 4 18.00 ดีมาก 
3 4 4 3 4 3 18.00 ดีมาก 
4 3 4 4 4 3 18.00 ดีมาก 
6 3 3 3 4 3 16.00 ดี 
7 4 4 3 4 4 19.00 ดีมาก 
8 4 4 4 4 4 20.00 ดีมาก 
คร ู 3 4 4 3 3 17.00 ดี 
เฉลี่ย 3.63 3.75 3.50 3.75 3.50 18.13 ดีมาก 

 กลุ่มที่ 6 
1 2 4 4 4 4 18.00 ดีมาก 
2 3 3 3 4 3 16.00 ดี 
3 4 3 4 4 3 18.00 ดีมาก 
4 4 4 3 4 3 18.00 ดีมาก 
6 3 4 3 3 3 16.00 ดี 
7 4 3 2 3 3 15.00 ดี 
8 4 4 3 4 3 18.00 ดีมาก 
คร ู 3 3 3 3 3 15.00 ดี 
เฉลี่ย 3.38 3.50 3.13 3.63 3.13 16.75 ดี 
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กลุ่มที ่

คะแนนการประเมิน 

รวม 
สรุประดับ
คุณภาพ 

คว
าม
สม

บูร
ณ์ข

อง
ชิ้น

งา
น 

คว
าม
เห
มา
ะส

มข
อง

เน
ื้อห

าท
ี่น า
เส
นอ

 

กา
รจั
ดว
าง
ข้อ

คว
าม
 

รูป
ภา
พแ

ละ
ใส
่เอ็ฟ

เฟ
็ค

อย่
าง
เห
มา
ะส

ม 
มีก

าร
เชื่อ

มโ
ยง
อย่
าง

เห
มา
ะส

ม 

กา
รแ
ทร

กเท
คน

ิคพ
ิเศษ

อย่
าง
เห
มา
ะส

ม 

 กลุ่มที่ 7 
1 4 4 3 4 4 19.00 ดีมาก 
2 3 4 4 4 4 19.00 ดีมาก 
3 4 3 3 4 4 18.00 ดีมาก 
4 3 4 3 4 3 17.00 ดี 
5 4 3 3 3 3 16.00 ดี 
6 3 3 3 4 3 16.00 ดี 
8 4 4 3 3 3 17.00 ดี 
คร ู 3 3 4 4 3 17.00 ดี 
เฉลี่ย 3.50 3.50 3.25 3.75 3.38 17.38 ดี 

 กลุ่มที่ 8 
1 2 3 3 4 4 16.00 ดี 
2 3 2 2 3 3 13.00 ดี 
3 3 3 3 4 4 17.00 ดี 
4 4 3 3 3 3 16.00 ดี 
5 3 3 3 3 3 15.00 ดี 
6 3 3 3 4 3 16.00 ดี 
7 3 4 4 3 3 17.00 ดี 
คร ู 2 3 3 3 3 14.00 ดี 
เฉลี่ย 2.88 3.00 3.00 3.38 3.25 15.50 ดี 
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ตารางภาคผนวกที่  23  แสดงผลการประเมินความสามัคคีส าหรับนักเรียนประเมินตนเอง 
รายการประเมิน ค่าเฉลี่ย S.D. แปลผล 

1.  เข้าใจบทบาทหน้าที่ในทีม    
 1.1 นักเรียนเข้าใจบทบาทของตนเองในฐานะผู้น าและ
ผู้ตามที่ดี 

3.58 .50 มากที่สุด 

 1.2 นักเรียนปฏิบัติตามข้อตกลงของการเป็นสมาชิกใน
ทีม 

3.55 .51 มากที่สุด 

 1.3 นักเรียนประชุม ปรึกษาหารือกันในกิจกรรมที่
ได้รับมอบหมาย 

3.24 .50 มาก 

 1.4 นักเรียนมีอัธยาศัยที่ดีในการติดต่อสื่อสารกับเพื่อน 3.42 .61 มาก 
 1.5 นักเรียนปรึกษาหารือกันเพื่อแก้ไขข้อผิดพลาด
ภายหลังการท างาน 

3.39 .66 มาก 

เฉลี่ยรวมด้านเข้าใจบทบาทหน้าที่ในทีม 3.44 .39 มาก 
2.  การยอมรับฟังความคิดเห็น    
 2.1 นักเรียนยอมรับฟังความคิดเห็นที่แตกต่างของ
เพื่อนในทีม 

3.82 .39 มากที่สุด 

 2.2 นักเรียนมีเหตุผลเพียงพอในการตัดสินใจ 3.45 .56 มาก 
 2.3 นักเรียนยอมรับเสียงส่วนใหญ่ (ผลสรุป) ของทีม 3.58 .56 มากที่สุด 
 2.4 นักเรียนยอมรับผลงานของสมาชิกในทีม 3.55 .62 มากที่สุด 
 2.5 นักเรียนพร้อมที่จะปรับตัวเพื่อให้สามารถอยู่ร่วม
ในทีมได ้

3.67 .60 มากที่สุด 

เฉลี่ยรวมด้านการยอมรับฟังความคิดเห็น 3.61 .36 มากที่สุด 
3.  การท างานร่วมกัน    
 3.1. นักเรียนช่วยเหลือเพื่อนในทีมให้ท างานส าเร็จด้วย
ความเต็มใจ 

3.58 .50 มากที่สุด 

 3.2 นักเรียนมีความรักใคร่กลมเกลียวและช่วยเหลือ
สมาชิกในทีมเสมอ 

3.64 .49 มากที่สุด 

 3.3 นักเรียนเข้าร่วมท ากิจกรรมต่างๆ กับเพื่อนในทีม
เป็นประจ า 

3.30 .59 มาก 
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รายการประเมิน ค่าเฉลี่ย S.D. แปลผล 
 3.4 นักเรียนมีการพัฒนาทักษะของตัวเองเพื่อเพิ่ม
ความสามารถของทีม 

3.42 .66 มาก 

 3.5 นักเรียนตรงต่อเวลาในการท างานร่วมกันเป็นทีม 3.21 .65 มาก 
 3.6 นักเรียนท างานที่ได้รับมอบหมายอย่างเต็ม
ความสามารถ 

3.58 .56 มากที่สุด 

เฉลี่ยรวมด้านการท างานร่วมกัน 3.45 .39 มาก 
4.  ผลการท างานเป็นทีม    
 4.1 งานเสร็จทันในเวลาที่ก าหนด 3.15 .71 มาก 
 4.2 นักเรียนมีความสัมพันธ์ที่ดีกับสมาชิกในทีม 3.58 .56 มากที่สุด 
 4.3 เกิดการพัฒนาทักษะในการท างานป็นทมี 3.52 .51 มากที่สุด 
 4.4 เกิดการเรียนรู้ในงานที่ท าร่วมกัน 3.64 .55 มากที่สุด 
 4.5 สามารถแก้ปัญหาได้เมือ่เกิดความขัดแย้งภายในทีม 3.64 .55 มากที่สุด 
 4.6 เกิดความสามัคคีภายในทีม 3.55 .51 มากที่สุด 

เฉลี่ยรวมด้านผลการท างานเป็นทีม 3.51 .33 มากที่สุด 
เฉลี่ยรวมทุกด้าน 3.50 .30 มากที่สุด 
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ตารางภาคผนวกที่  24  แสดงผลการประเมินความสามัคคีส าหรับครูประเมินนักเรียน 
รายการประเมิน ค่าเฉลี่ย S.D. แปลผล 

1. สมาชิกในทีมมีการจัดสรรหน้าที่ความรับผิดชอบอย่าง
เหมาะสม 

3.63 .52 มากที่สุด 

2. สมาชิกในทีมมีความตรงต่อเวลา 3.63 .52 มากที่สุด 

3. สมาชิกในทีมเข้าใจบทบาทของตนเองในการเป็นผู้น า
หรือผู้ตามที่ดี 

3.75 .46 มากที่สุด 

4. สมาชิกในทีมมีความกระตือรือร้นและมุ่งมัน่ท ากิจกรรม
ที่ได้รับมอบหมาย 

3.50 .54 มากที่สุด 

5. สมาชิกในทีมมีการปรึกษาหารือเพื่อวางแผนในการ
ท างาน 

3.88 .35 มากที่สุด 

6. งานที่ได้รับมอบหมายส่งทันในเวลาที่ก าหนด 3.50 .54 มากที่สุด 

7. สมาชิกในทีมเข้าร่วมท ากิจกรรมต่างๆ กับเพื่อนในทีม
เป็นประจ า 

3.63 .52 มากที่สุด 

8. สมาชิกทุกคนร่วมกันรับผิดชอบในผลงานของทีม 3.63 .52 มากที่สุด 

9. สมาชิกในทีมรู้จักและมีความสัมพันธ์ที่ดีต่อกนั 4.00 .00 มากที่สุด 

10. สมาชิกในทีมมีการรับฟังความคิดเห็นของผู้อื่นและ
เคารพในสิทธิของผู้อื่น 

3.63 .52 มากที่สุด 

11. สมาชิกในทีมร่วมกันปรับปรุงผลงาน 3.50 .54 มากที่สุด 

เฉลี่ยรวม 3.66 .36 มากที่สุด 
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ตารางภาคผนวกที่  25  แสดงความพึงพอใจต่อการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
รายการประเมิน ค่าเฉลี่ย S.D. แปลผล 

1.  ด้านเนื้อหา     
1.1  ตรงตามวัตถุประสงค์ของบทเรียน 3.70 0.47 มากที่สุด 
1.2 การใช้ภาษา ง่ายต่อการท าความเข้าใจ 3.70 0.47 มากที่สุด 

1.3 การจัดล าดับเนื้อหาแต่ละเร่ืองมีความเหมาะสม 3.70 0.53 มากที่สุด 

1.4 เนื้อหามีความยากง่ายเหมาะสมกับผู้เรียน 3.58 0.56 มากที่สุด 

1.5 เนื้อหาที่น าเสนอให้เป็นความรู้ที่มีประโยชน์ 3.52 0.62 มากที่สุด 

1.6  เนื้อหาตรงกับสิ่งที่สนใจ 3.18 0.73 มาก 

เฉลี่ยรวมด้านเนื้อหา 3.56 0.42 มากที่สุด 

2.  ด้านการออกแบบ    

   2.1  หน้าจอสวยงาม ดึงดูด น่าสนใจ 3.15 0.57 มาก 
2.2  สีของตัวอักษร อ่านง่าย สบายตา ชัดเจน 3.30 0.53 มาก 
2.3  รูปแบบของตัวอักษรอ่านง่าย 3.48 0.57 มาก 
2.4  ขนาดของตัวอักษรมีความชัดเจน 3.61 0.56 มากที่สุด 
2.5  ภาพที่ใช้ประกอบเหมาะสมชัดเจน 3.48 0.57 มาก 
2.6  มีการเช่ือมโยงเนื้อหาภายในเว็บเพจและกับเว็บไซต์

อื่น 
3.18 0.77 มาก 

เฉลี่ยรวมด้านการออกแบบ 3.37 0.33 มาก 
3. รูปแบบการน าเสนอ    
    3.1  การน าเสนอมีความนา่สนใจ 3.33 0.60 มาก 

3.2  น าเสนอบทเรียนได้อย่างชัดเจนและเข้าใจง่าย 3.55 0.51 มากที่สุด 
3.3  การออกแบบเว็บไซต์ดึงดูดความสนใจ 2.94 0.56 มาก 
3.4  เปิดโอกาสให้มีส่วนร่วมและท ากิจกรรมในบทเรียน 3.55 0.62 มากที่สุด 
 3.5  สามารถเลือกเรียนได้ตามความต้องการ 3.00 0.66 มาก 
3.6  ทราบผลทางการเรียนได้ในทันที 3.61 0.56 มากที่สุด 

เฉลี่ยรวมด้านรูปแบบการน าเสนอ 3.33 0.32 มาก 
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รายการประเมิน ค่าเฉลี่ย S.D. แปลผล 
4.  การเรียนรู้ร่วมกันเป็นทีม    

4.1  ผู้เรียนเข้ามาเรียนรู้บทเรียนได้ทุกที่ทุกเวลา 3.73 0.52 มากที่สุด 
4.2  ผู้เรียนที่อยู่ต่างพื้นที่กันสามารถเรียนรู้ร่วมกันได้ 3.45 0.67 มาก 
4.3  ท างานตามที่ได้รับมอบหมายในทีม 3.55 0.62 มากที่สุด 
4.4  ผู้เรียนแต่ละทีมสามารถติดต่อสื่อสารกับเพื่อนในทีม

ในบทเรียนได้ 
3.42 0.66 มาก 

4.5  ผู้เรียนสามารถติดต่อสื่อสารกับเพื่อนต่างในทีมใน
บทเรียนได้ 

3.36 0.65 มาก 

4.6  ผู้เรียนสามารถแสดงความคิดเห็นเกี่ยวกับช้ินงานที่
ท าในทีมและเพื่อนต่างทีมในบทเรียนได้ 

3.42 0.50 มาก 

เฉลี่ยรวมด้านการเรียนรู้ร่วมกันเป็นทีม 3.49 0.42 มาก 
เฉลี่ยรวมทุกด้าน 3.44 0.27 มาก 

 



 
 
 
 
 
 
 
 
 
 
 

ภาคผนวก  ง 
ตัวอย่างเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
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ขั้นตอนการใชเ้ว็บช่วยสอนแบบการเรียนรู้เป็นทมี 
 

1.  การเข้าใช้งานให้นักเรียนเข้าไปที่ http://www.kruwassana.com จะได้ดังภาพ จากนั้นคลกิปุ่ม  
"เข้าสู่เว็บไซต์" 
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2.  นักเรียนสมัครเป็นสมาชิกของเว็บไซต์ โดยคลิกที่ปุ่ม "สมัครเป็นสมาชิก" จากนั้นกรอกขอ้มูล ช่ือ
ผู้ใช้  รหัสผ่าน  ข้อมูลส่วนตัว แล้วกดปุ่ม "สร้าง account ใหม่" จากนั้นน า ช่ือผู้ใช้และรหัสผ่านที่
ได้มาลงทะเบียนเข้าเว็บไซต์   
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3.  เมื่อเข้าสู่ระบบได้แล้วให้เลือกวิชาเรียน "การน าเสนอสื่อประสม"  
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4.  หน้าแรกของรายวิชา 
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5.  การจัดการเรียนการสอนในสัปดาห์ที่ 1 นักเรียนต้องท าแบบทดสอบก่อนเรียนก่อนโดยคลิกที่เมนู  
"แบบทดสอบก่อนเรียน" 

 
 

 

 
 
6.  จากนั้นให้นักเรียนอ่านจุดประสงค์การเรียนรู้จากเมนู "จุดประสงค์การเรียนรู้" ในสัปดาห์ที่ 1 
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7.  นักเรียนแบ่งทีมการเรียนโดยคลิกที่เมนู "แบ่งทีมส าหรับการเรียน"   
 
 

 
8. โดยนักเรียนจะสนทนากันผ่านห้องสนนทนาออนไลน์ 
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9.  หัวหน้าทีมแต่ละทีมตั้งกระทู้ของทมีตนเองเพื่อให้สมาชิกในทีมเข้ามาแลกเปลี่ยนเรียนรู้ข้อมูล
ต่างๆ ซึ่งกันและกัน 
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10.  นักเรียนสามารถดูวิดีโอประกอบการเรียน 
 

 
 
11.  ใบงานประกอบการเรียน 
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12.  เมื่อนักเรียนเรียนครบตามเนื้อหาที่จัดไว้ให้นักเรียนท าแบบทดสอบในแต่ละสัปดาห์ ซ่ึงเมื่อ
นักเรียนสอบเสร็จระบบจะแสดงคะแนนผลการทดสอบให้ในทันที 
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13.  นักเรียนท าแบบประเมินความสามัคคีจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
 

 
 
14.  นักเรียนท าแบบประเมินความพึงพอใจจากการเรียนด้วยเว็บช่วยสอนแบบการเรียนรู้เป็นทีม 
 

 

 
 



 
 
 
 
 
 
 
 
 
 
 

ภาคผนวก  จ 
ตัวอย่างผลงานนักเรียน 
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กลุ่มที่ 1 เร่ือง ASEAN 
 

 

แสดงหน้าแรก 

 

แสดงหน้าเมนูและการเช่ือมโยงไปยังเนื้อหาส่วนต่างๆ 
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แสดงการจัดวางข้อความ รูปภาพ และ การใช้ค าสั่ง Rollover Caption 

 

แสดงการใช้เครื่องมือ Click Box เพื่อสร้างแบบทดสอบ  
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กลุ่มที่ 2 เร่ือง HISTORY 
 

 
 

แสดงหน้าแรก และเมนูเพื่อการเช่ือมโยงไปยังเนื้อหาส่วนต่างๆ 
 
 
 
 
 
 
 
 
 

 
 
 

แสดงการจัดวางข้อความ  
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แสดงการจัดวางข้อความ รูปภาพ และ การใช้ค าสั่ง Rollover Caption 
 

 
 

แสดงการใช้เครื่องมือ Text Entry เพื่อสร้างแบบทดสอบ  
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กลุ่มที่ 3 เร่ือง สถานที่ท่องเที่ยวในประเทศไทย 
 
 

 
 

แสดงหน้าแรก และเมนูเพื่อการเช่ือมโยงไปยังเนื้อหาส่วนต่างๆ 
 

 
 
 
 
 
 
 
 
 
 
 
 

แสดงการจัดวางข้อความ รูปภาพ และ การใช้ค าสั่ง Rollover Caption 
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แสดงการจัดวางข้อความ 
 

 
 

แสดงการใช้เครื่องมือ Click Box เพื่อสร้างแบบทดสอบ  
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กลุ่มที่ 4 เร่ือง ระบบต่างๆในร่างกาย 
 

 
 

แสดงหน้าแรก และเมนูเพื่อการเช่ือมโยงไปยังเนื้อหาส่วนต่างๆ 
 

 
 

แสดงการจัดวางข้อความ รูปภาพ และ การใช้ค าสั่ง Rollover Caption 
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แสดงการน าวิดีโอมามาน าเสนอบนสื่อประสม 
 

 
 

แสดงการใช้เครื่องมือ Click Box เพื่อสร้างแบบทดสอบ  
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กลุ่มที่ 5  เร่ือง อาหารไทยนานาชนิด 
 

 

แสดงหน้าแรก และเมนูเพื่อการเช่ือมโยงไปยังเนื้อหาส่วนต่างๆ 

 

แสดงการจัดวางภาพและเมนูเพื่อการเช่ือมโยงไปยังเนื้อหาย่อยส่วนต่างๆ 
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แสดงการจัดวางข้อความ รูปภาพ และ การใช้ค าสั่ง Rollover Caption 

 

แสดงการใช้เครื่องมือ Click Box เพื่อสร้างแบบทดสอบ  
 
 
 



243 
 

กลุ่มที่ 6 เร่ือง ประเพณีของไทย 4 ภาค 
 

 

แสดงหน้าแรก และเมนูเพื่อการเช่ือมโยงไปยังเนื้อหาส่วนต่างๆ 

 

แสดงการจัดวางภาพและเมนูเพื่อการเช่ือมโยงไปยังเนื้อหาย่อยส่วนต่างๆ 
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แสดงการจัดวางข้อความ รูปภาพ และ การใช้ค าสั่ง Rollover Caption 

 

แสดงการใช้เครื่องมือ Text Entry เพื่อสร้างแบบทดสอบ  
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กลุ่มที่ 7 เร่ือง อุทยานแห่งชาติเขาใหญ่ 
 

 
 

แสดงหน้าแรก และเมนูเพื่อการเช่ือมโยงไปยังเนื้อหาส่วนต่างๆ 
 

 
 

แสดงการจัดวางข้อความ รูปภาพ และ การใช้ค าสั่ง Rollover Caption 
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แสดงการน าวิดีโอมาน าเสนอบนสื่อประสม 
 

 
 

แสดงการใช้เครื่องมือ Click Box เพื่อสร้างแบบทดสอบ  
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กลุ่มที่ 8  เร่ือง เทศกาลต่างๆ 
 

 
 

 

แสดงหน้าแรก และเมนูเพื่อการเช่ือมโยงไปยังเนื้อหาส่วนต่างๆ 
 

 

 
 

แสดงการจัดวางข้อความ รูปภาพ 
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แสดงการใช้เครื่องมือ Click Box และ Text Entry เพื่อสร้างแบบทดสอบ  
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